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ĮŽANGA 
 
 

parčiai plečiantis informacinių sistemų kūrimo galimybėms 
keičiasi daugelio žmogaus veiklos sričių darbo aplinka. Te-

chnologijų plėtra turi įtakos programinės įrangos kūrimo procesams, 
naujų metodų paieškai, skirtai informacijai ir žinioms kaupti, skleisti, 
valdyti. 

Informacijos supratimas siejamas su veiklos kompiuterizavimo 
procesais, naujomis technikos rūšimis, informacijos apdorojimo, 
saugojimo ir perdavimo technologijomis. Informacija ir žinios tampa 
ekonominiu ištekliumi, jos yra labiausiai kvalifikuotos ir kūrybiš-
kiausios intelektualiosios žmogaus veiklos produktas. 

Informacija yra reikšminga šiuolaikiniame gyvenime, šiam 
procesui turi įtakos keletas veiksnių. Daugelyje dalykinių sričių di-
dėja veiklos procesų įvairovė, spartėja kompiuterinių priemonių raida 
ir taikymas, įgalinantys supaprastinti šių procesų valdymą. Informa-
cija tampa vis labiau prieinama ir efektyviau perimama. Informacinės 
visuomenės raidos procesai pereina į naują etapą, vadinamą žinių vi-
suomenės kūrimo etapu, kuriame nemažiau svarbiu ištekliumi tampa 
žmogaus žinojimo veiksniai, praktika ir įgūdžiai bei jų išsaugojimo 
skaitmeninėje erdvėje metodai ir galimybės. Žinoma, pirminiai fak-
tai, stebimų reiškinių charakteristikos, įvardijami kaip duomenys 
apie mūsų pasaulį, sudaro informacijos turinio pagrindą. Be tikslių 
duomenų negausime ir apibendrinančių rezultatų, negalėsime priimti 
reikiamų sprendimų. Todėl šioje knygoje daugiausia dėmesio bus 
skiriama duomenų struktūroms ir jų valdymo galimybėms, tinkamų 
programinių priemonių parinkimui. 

Duomenys kompiuterinėse sistemose turi savo struktūras, val-
domas programinėmis priemonėmis. Realus pasaulis kompiuteryje 
gali būti vaizduojamas pasitelkiant modeliavimo priemones. Todėl 
svarbu mokėti įvertinti ir pateikti šiuos modelius, sugebėti tinkamai 
pasirinkti modeliavimo metodus, grafinės notacijos būdus, padedan-
čius išreikšti taikomosios srities ypatumus kompiuterinėse sistemose. 

S 
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Autorių indėlis rašant vadovėlį yra toks: D. Dzemydienė pa-
rašė įžangą, 1, 2, 3.1–3.6, 4.12 skyrius. R. Naujikienė parašė 3.7–3.8, 
4.1–4.11 skyrius. Knygoje įvertinta autorių ilgamečio darbo su stu-
dentais bei sudėtingų informacinių sistemų kūrimo patirtis. D. Dze-
mydienė atstovauja Lietuvos teisės universitetui ir Matematikos ir 
informatikos institutui, kuriame įgyta mokslinio ir pedagoginio darbo 
patirtis leido išsamiau pažvelgti į informacinių sistemų kūrimo pro-
cesą ir susisteminti dėstomą teorinę medžiagą. R. Naujikienė at-
stovauja Lietuvos teisės universitetui ir turi didelę darbo kompiuteriu 
mokymo patirtį, kuri leido parinkti originalias praktines užduotis ir 
metodinius nurodymus. 

Esant dabartinei situacijai iš būsimojo specialisto pirmiausia 
bus reikalaujama efektyvaus darbo su naujomis informacinėmis te-
chnologijomis. Būsimiesiems valdymo specialistams svarbu suprasti 
organizacijų aplinką ir susipažinti su pagrindinėmis duomenų išraiš-
kos priemonėmis, modeliais bei valdymo ypatumais, užtikrinančiais 
efektyvesnius darbo metodus. Reikšmingą vaidmenį šiame kontekste 
vaidina duomenų bazių valdymo sistemos. Jų teikiamos duomenų 
apdorojimo priemonės suteikta galimybę lengviau tvarkyti ir valdyti 
duomenis, juos išsaugoti, rūšiuoti, vykdyti paiešką, skleisti informa-
ciją kompiuterių tinkluose. Savarankiški įgūdžiai, įgyti atliekant 
praktines užduotis pagal šiame vadovėlyje pateiktus metodinius nu-
rodymus, skatins taikyti modernias kompiuterines technologijas ir 
ieškoti naujų galimybių susipažinti su šiuolaikinėmis informacinėmis 
sistemomis bei technologijomis. 

Programinės įrangos kūrėjai, siūlantys savo produktus ir siste-
mas įstaigų darbuotojams, yra korporacijos Microsoft, Borland, Lo-
tus, IBM, Corel Systems ir kt. Kuriamos atvirojo kodo sistemos, vei-
kiančios Linux ar Unix operacinėje sistemoje. Šiuo metu langų val-
dymo operacinės sistemos autoriai siūlo šiai aplinkai sukurtą paketų 
rinkinį Microsoft Office, kuriame yra viena geriausių tekstų tvar-
kymo sistemų – Word, grafinis skaidrių rengimo paketas 
PowerPoint, elektroninių lentelių-skaičiuoklių valdymo programinė 
įranga Excel, duomenų bazių valdymo sistema Access, elektroninio 
pašto programa, interneto svetainių kūrimo priemonės FrontPage ir 
kt. Populiari šiuo metu naudojama skaičiuoklė Microsoft Excel. Pa-
saulyje, be šios programinės įrangos, dar naudojamos skaičiuoklės: 
Lotus 1-2-3 (ją sukūrė Lotus Development, 1995 m. tapusi įmonės 
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IBM padaliniu) ir Quattro Pro (ją 1994 metais sukūrė įmonė Borland 
International). Quattro Pro skaičiuoklių valdymo sistema vėliau įėjo 
į Novel firmos Perfect Office programų rinkinį. Savo galimybėmis 
Microsoft Excel šiuo metu lenkia kitas minėtas sistemas. Ši programa 
turi daugiau kaip 300 funkcijų. Tai programa, su kuria patogu ne tik 
skaičiuoti, bet ir įvairiapusiškai analizuoti duomenis, programuoti, 
atlikti statistinius tyrimus. 

Vadovėlyje supažindinama su skaičiuoklėmis Excel, duomenų 
bazių valdymo sistema Access, interneto svetainių kūrimo priemo-
nėmis. Autorių nuomone, ši knyga bus naudinga visiems norintiems 
susipažinti su šiuolaikinėmis informacinių sistemų kūrimo galimy-
bėmis, išsiugdyti gebėjimą dirbti su duomenų valdymo struktūromis 
ir informacinėmis sistemomis. 

Autorės dėkoja Lietuvos teisės universiteto Valstybinio val-
dymo fakulteto Teisinės informatikos katedros vedėjui profesoriui  
R. A. Petrauskui ir jos darbuotojams už patarimus, suteiktą prog-
raminę įrangą, kurios priemonėmis dėstytojai skatinami mokyti stu-
dentus naudotis šiuolaikinėmis informacinėmis technologijomis. Dė-
kojame Matematikos ir informatikos instituto Programų sistemų in-
žinerijos skyriaus darbuotojams ir vadovui profesoriui A. Čaplinskui, 
kurių patarimai ir diskusijos padėjo tiksliau susisteminti dėstomą teo-
rinę medžiagą. Dėkojame recenzentams profesoriui P. G. Adomėnui 
ir profesoriui V. Šalteniui už pateiktas pastabas. Nuoširdžiai dėko-
jame visiems prisidėjusiems prie šio darbo. 
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1.1. INFORMACIJOS IŠTEKLIŲ TURINYS  
       IR FORMOS 

 

 
nformacinės sistemos kuriamos bei naudojamos daugelyje žmo-
gaus veiklos sričių. Jos leidžia naudotis tikslia ir laiku gaunama 

informacija, yra skirtos palengvinti valdymo sprendimų priėmimą ir 
efektyviai atlikti planavimo, valdymo ir administravimo, koordina-
vimo ir kontrolės funkcijas. Tinkamai sukurtos informacinės val-
dymo sistemos teikia žinių apie organizacijos veiklos praeitį, dabartį, 
numatomą ateitį ir organizacijai svarbius vidaus bei išorės įvykius. 
Informacinės valdymo sistemos padeda analizuoti ir vizualizuoti in-
formaciją, palengvina įvairaus lygio vadovų ir administratorių darbą. 

Informacinėse valdymo sistemose esantys duomenys atspindi 
organizacijos, įmonės, įstaigos veiklos rezultatus ir aplinkos veiks-
nius, darančius įtaką šiai veiklai. Informacinėse sistemose informa-
cija apie organizacijai ir aplinkai svarbius asmenis, veiklą, daiktus ir 
procesus turėtų būti kaupiama ir pateikiama žmogui patogia forma. 

Informacijos samprata siejama su informacinės veiklos kom-
piuterizavimu, naujomis technikos rūšimis, šiuolaikinėmis informa-
cijos apdorojimo, saugojimo ir perdavimo technologijomis [20; 25]. 
Kaupiama informacija ir žinios padeda taupyti visuomeninio, mate-
rialiojo, intelektinio darbo išteklius. Informacija atlieka strateginį 
vaidmenį šiuolaikinėje veikloje, sprendimų priėmimo procesuose. 

Informacinės visuomenės raidos procesams pereinant į naują 
etapą, vadinamą žinių visuomenės kūrimo etapu, svarbiais ištekliais 
tampa informacija, žmogaus žinojimo veiksniai, praktika ir įgūdžiai 
bei jų išsaugojimas skaitmeninėje erdvėje. Atsižvelgiant į šiuolaiki-
nio visuomenės išsivystymo lygį ypač daug dėmesio skiriama infor-
macinių ir komunikacinių technologijų potencialui plėtoti [9; 14; 23]. 
Numatoma daugybė su šiomis technologijomis susijusių ekonominių, 
socialinių politinių veiklos krypčių. Su informacinių technologijų 
plėtros procesais susijusi Europos Sąjungos užimtumo politika, ku-
riami elektroninės Europos veiksmų planai. Informacinių, komunika-

I 
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cinių technologijų taikymas lemia ir naujų darbo formų atsiradimą, 
skatina sudaryti visų gyventojų užimtumo žinių visuomenėje sąlygas, 
pavyzdžiui, visiems prieinamą nuotolinį mokymąsi, visuomenės 
skaitmeninį raštingumą, viešųjų paslaugų modernizaciją [15; 19; 25]. 

Atsiranda naujos vadovavimo formos ir paslaugų rūšys: elekt-
roninės vyriausybės kūrimas ir jos informacinių išteklių vadyba, 
elektroninė komercija, nuotolinis bendradarbiavimas [13; 20]. 

Šiuolaikinių informacinių ir komunikacinių technologijų plė-
tojimasis sudaro palankias sąlygas naudotis internetu ir kitomis mo-
biliojo ryšio priemonėmis. Atsiranda daugybė paslaugų, teikiamų per 
internetą, rūšių: elektroninė komercija, diskusijų svetainės, mokesčių 
mokėjimas, virtualios įstaigos ir nuotolinio projektavimo laboratori-
jos, duomenų bazės, dirbančios tiesioginės kreipties (On-Line) re-
žimu. 

Efektyvus informacinių ir komunikacinių technologijų taiky-
mas skatina atsirasti naujas darbo organizavimo formas. Šie veiksniai 
daro pozityvią įtaką darbo kokybei: didina atsakomybę, darbo pro-
duktyvumą, padeda geriau valdyti informacijos srautus. Visa tai lei-
džia mėgautis darbu, padaryti jį efektyvesnį bei pertvarkyti darbą or-
ganizacijoje bei už jos ribų. Tokie pokyčiai vyksta daugelyje taiko-
mųjų sričių: viešojo administravimo ir valdymo, medicinos diagnos-
tikos, automatinio projektavimo, nuotolinio mokymo ir kitose srityse. 

Informacinė sistema suprantama kaip struktūrizuotas procesų ir 
procedūrų rinkinys, kuriame duomenys yra kaupiami, organizuojami 
ir pateikiami vartotojui. Informacinė sistema – tai darbo praktikos, 
informacijos, žmonių ir informacinių technologijų, skirtų organiza-
cijos tikslams siekti, kompleksas. Informacines sistemas sudaro 
programinė, techninė įranga, žmonės, duomenys. 

Pagal turinį informacijos ištekliai skirstomi į: 
 Valdymo; 
 Teisinius; 
 Finansinius-ekonominius; 
 Mokslinius; 
 Reklaminius ir pan. 

Pagrindiniai informacijos išteklių tipai: 
 Informacijos šaltinis; 
 Informacijos paslauga, kaip naudinga veikla;  
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 Informacijos produktas, kaip naudingas produktas, tenki-
nantis vartotojų poreikius; 
 Informacinė sistema. 

Pagal nuosavybės formą informacijos ištekliai gali būti skirs-
tomi į: 

 Valstybinius; 
 Nevalstybinius; 
 Mišrių nuosavybės formų. 

Informacinių sistemų kokybę nusako: 
 Informacijos šaltinio patikimumas; 
 Tikslumas; 
 Operatyvumas; 
 Paieškos kalbų paprastumas ir aiškumas; 
 Minimalios paieškos laiko sąnaudos; 
 Informacinės paieškos lankstumas; 
 Galimybė gauti diferencijuotą informaciją; 
 Pateikiamos informacijos išsamumas; 
 Informacijos struktūra; 
 Ryšio kokybė. 

Nuo informacijos kokybės priklauso ir jos vertė, tačiau nerei-
kia pamiršti, kad vertė susijusi ir su subjektyviais veiksniais. 
 
 
 
1.2. DUOMENYS, INFORMACIJA, ŽINIOS 
 

nformacinėje aplinkoje egzistuoja tokios sąvokos kaip duomenys, 
informacija ir žinios. Kad suvoktume šių sąvokų prasmės skirtu-

mus, pateiksime jų interpretaciją remdamiesi pranešimo sąvoka [30]. 
Pranešimas yra grupė simbolių, kurie yra saugomi, apdorojami 

ir perduodami informacinėje organizacijos sistemoje. Kitais žodžiais 
tariant, organizacijos informacija yra saugoma, apdorojama ir per-
duodama kaip pranešimai. Pranešimo turinys, cirkuliuojantis infor-
macinėje organizacijos sistemoje, turi skirtingus reikšmių lygius. Jie 
priklauso nuo to, ką pranešimas veikia – duomenis, informaciją ar 
žinias. Galima išskirti tris pranešimų reikšmių lygius, egzistuojančius 
informacinėje sistemoje (1.1. pav.). 

I 
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1.1 pav. Pranešimų reikšmės lygiai 
 

Duomenys – tai faktai apie stebimus tikrovės objektus, proce-
sus, veiklą. Duomenys yra simbolių grupės, kurių pranešimo reikš-
mės lygmuo sąlygiškai žemiausias – tai pirminiai faktai ir pažiūros. 
Vykstant kai kuriems sprendimų priėmimo procesams duomenys 
naudojami tiesiogiai. Daugeliu atvejų duomenys yra grupuojami, 
įvairiomis formomis apibendrinami ir transformuojami, kad taptų 
informacija, naudojama priimant sprendimus, duomenis apibendri-
nančia pranešimo forma. Informacijos vertė sąlygiškai didesnė negu 
duomenų. Ji naudojama priimant sprendimus, vertinant realią situa-
ciją. Žinių reikšmės lygmuo aukščiausias, kadangi jos vaizduoja 
žmogaus žinojimo veiksnius, samprotavimus, taisykles, kurie poten-
cialiai galės būti panaudoti būsimose sprendimo situacijose. 

Iš ateities informacinių sistemų tikimasi efektyvių priemonių, 
skirtų įgyti, palaikyti, išsaugoti, manipuliuoti ir pateikti daug skirtin-
gos informacijos. Naujos kartos sistemos reikalauja vartotojui palan-
kios bendravimo aplinkos (sąsajos), samprotavimo galimybių ir dife-
rencijuotos prieigos prie didelių informacinių bazių. Informacija 
šiuolaikinėje informacinių technologijų išsivystymo aplinkoje turi 
tenkinti bendrus reikalavimus: 

 Informacija turi būti suprantama naudojant atitinkamą nuo-
rodų struktūrą (kontekstą); 

 Informacija turi būti tinkama tenkinti aktualius poreikius 
vykstant sprendimų priėmimo procesui; 

 

   žinios 
 

 

   informacija 
 

  

  duomenys 

 

      reikšmės vertė 
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 Informacija turi būti nauja ir veiksminga; 
 Informacija turi skatinti (padėti) pasirinkti tinkamą spren-
dimą. 

Veiksmai organizacijoje priklauso nuo atitinkamo organizaci-
jos valdymo lygmens sprendimų priėmimo proceso rezultatų. 

 
 
 

1.3. INFORMACIJOS VAIDMUO SKIRTINGUOSE  
       VALDYMO LYGMENYSE 
 

nformacines valdymo sistemas pagal atliekamas funkcijas galima 
suskirstyti į keletą architektūrinių lygmenų: organizacinės, val-

dymo, informacijos ir technologijų valdymo bei veiklos teisinio reg-
lamentavimo struktūros [6]. Kiekvienas šių architektūrinių lygmenų 
turi tam tikro pobūdžio tarpusavyje susijusias funkcijas ir struktūrą. 

Organizacinį informacinių valdymo sistemų lygmenį nusako: 
 Organizacijos struktūra; 
 Taisyklės, operatyvios duomenų kaupimo ir apdorojimo 
procedūros; 
 Organizacijos funkcijos, pagrindinė veikla, gamyba, finan-
sai, buhalterinė apskaita, išteklių paskirstymas; 
 Išteklių planavimas ir valdymas, žmogiškieji ištekliai. 

Kiekviena įstaiga, įmonė ar organizacija turi vidinę valdymo 
struktūrą, kurios kiekvienas struktūrinis elementas atlieka tam tikras 
funkcijas, yra pavaldus kitiems arba valdo žemesnio lygio struktūri-
nius komponentus. Tai organizacinės politikos dalis. Todėl informa-
cinėse valdymo sistemose nustatant bendrą valdymo struktūrą, duo-
menų srautus, informacinius procesus į tai turi būti atsižvelgta. 

Pagal organizacijos valdymo struktūrą bei hierarchiją galima 
išskirti kelis sistemos hierarchinius lygmenis, kuriuos dar praėjusio 
šimtmečio septintajame dešimtmetyje aprašė R. N. Anthony [2]. 
Kalbant apie sprendimų priėmimo sistemos ir hierarchinę organiza-
cijos struktūrą reikėtų pažymėti skirtumus tarp kelių skirtingų spren-
dimų priėmimo funkcinių sričių: strateginio planavimo, vadovavimo 
valdymo, operacijų valdymo. 

I 
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Strateginio planavimo ir valdymo srityje sprendimų priėmimas 
susijęs su tikslais ir jų pokyčiais, nustatant bendrą ir ilgalaikę institu-
cijos veiklos politiką.  

Vadovavimo valdymo srityje sprendžiami planavimo ir val-
dymo uždaviniai. Jie dažniausiai susiję su efektyvaus išteklių sura-
dimo ir paskirstymo klausimais.  

Operacijų valdymas turi garantuoti efektyvų operacijų atli-
kimą, remiantis specifinėmis taisyklėmis, pasirinktomis aukštes-
niuose lygmenyse.  

Toks valdymo sričių suskirstymas buvo pavadintas Anthony 
taksonomija. Ji apibūdina skirtumus tarp struktūrinio ir nestruktū-
rinio problemų sprendimo.  

Kiekvienas šių lygmenų skiriasi duomenų apdorojimo operaty-
vumu, kaupiamos informacijos apibendrinimo galimybėmis, veiklos 
ypatumais [20]. Strateginės valdymo sistemos yra ilgalaikės politi-
kos, darbo organizavimo, planavimo, strategijų generavimo ir kitus 
strateginio valdymo uždavinius spręsti padedančios sistemos. Jos 
skirtos organizacijų vadovams sudaryti tiek trumpalaikes, tiek ilga-
laikes prognozes, organizacijos veiklos, ir biudžeto paskirstymo pla-
nus bei numatyti ilgalaikius darbo jėgos pokyčius [13; 25; 20]. 

Aukščiausiojo lygmens vadovams pirmiausia rūpi strateginis 
planavimas ir kontrolė. Tad jiems reikalinga suderinta ir glausta in-
formacija, kad būtų galima įvardyti, nustatyti arba parengti bendrą-
sias veiklos kryptis ir įvertinti bendrą veiklos lygį. Turimos informa-
cijos nauda vertinama pagal jos kokybę, aktualumą, kiekybę ir tin-
kamumą valdyti. Nors šio lygmens strateginėms valdymo sistemoms 
išsamią informaciją teikia vadybos ir sprendimų palaikymo sistemos, 
planuojant strategiją svarbiausi yra išoriniai informacijos šaltiniai, 
teikiantys žinių apie ekonomines sąlygas, technologijos plėtotę, kon-
kurentų veiksmus. Šią informaciją sunkiau surinkti ir kompiuteri-
zuoti nei vidaus informaciją, nes papildomi duomenų šaltiniai orga-
nizacijai nepriklauso. 

Taktinio valdymo lygmens informacinės sistemos skirtos vidu-
tinio lygio vadovams, atsakingiems už strategijos, planų, tikslų, už-
davinių vykdymą [13; 17; 20]. 

Taktiniam valdymui vykdyti kuriama keletas informacinių val-
dymo sistemų tipų. Galima būtų išskirti vadybos informacines siste-
mas, pritaikytas bendram organizacijos valdymui, darbo priemonių, 
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išlaidų kontrolei, personalo išdėstymo ir perskirstymo analizei atlikti. 
Sprendimų priėmimo ir paramos sistemos – tai patariančiosios siste-
mos, kurios remdamosi informacijos analize palengvina sprendimų 
priėmimo procesus įvairiuose valdymo lygmenyse. Pavyzdžiui, to-
kios sistemos padeda vadovams priimti sprendimus dėl gamybos 
apimties, realizacijos galimybių, atlikti pajamų ir išlaidų analizę. 

Transakcijų lygmens informacinėmis valdymo sistemomis 
naudojamasi organizuojant ir kontroliuojant kasdienę veiklą, ele-
mentarias duomenų apdorojimo operacijas. 

Transakcijų apdorojimo sistemos yra elementarių operacijų at-
likimo ir jų panaudojimo sistemos (pvz., duomenų įrašymo, pakei-
timo, ištrynimo, perdavimo ir panašių operacijų). Transakcijos atlie-
kamos organizuojant ir kontroliuojant kasdienę duomenų apdorojimo 
veiklą. 

Transakcijų valdymo sistemos užtikrina elementarių operacijų 
su duomenimis atlikimą (duomenų įvedimo, keitimo, panaikinimo 
operacijas). Šios sistemos skirtos rutininei veiklai, tokiai kaip pinigų 
pervedimas bei išmokos, kasdieninė medžiagų bei užsakymų kont-
rolė, darbuotojų darbo laiko apskaita, gamybiniai tvarkaraščiai ir 
kita. Atliekami informacinių sistemų uždaviniai yra konkrečiai api-
brėžti ir sustruktūrinti. Atliktų transakcijų duomenys, tokių kaip me-
džiagų, finansų cirkuliacija, ataskaitos, pateikiami aukštesnio lyg-
mens valdymo struktūroms. 

Technologinę informacinių valdymo sistemų dalį sudaro: 
 Įvairi elektroninė, kompiuterinė bei ryšio aparatūra 
(Hardware); 
 Programinė įranga (Software); 
 Informacijos saugojimo technologijos (Storage); 
 Komunikacinės technologijos ir informaciniai tinklai 
(Networks). 

Žinių lygmens valdymo sistemos parankios specialistams 
(inžinieriams, architektams ir kt.) bei biurų darbuotojams, kurian-
tiems naujas žinias ir dokumentus. 

Žinių valdymo sistemų pagrindą sudaro žinių bazės ir įvairūs 
sprendimų priėmimo modeliai. Šios sistemos įgalina aprūpinti konk-
rečias darbo vietas. Pasitelkiant žinių sistemas kuriamos inžinerinės, 
administracinės, projektavimo, vadybos, analitinės, teisės patariamosios 
sistemos, kompiuterizuotos specialistų darbo vietos [10; 11; 18; 17; 29]. 



1.3. Informacijos vaidmuo skirtinguose valdymo lygmenyse 17 

Šio lygmens informacinės valdymo sistemos skirtos kurti, or-
ganizuoti ir integruoti į organizacijos veiklą naujas žinias bei padėti 
organizacijai vykdyti šią veiklą intelektualių kompiuterinių sistemų 
priemonėmis. Šiuo metu tai greičiausiai besiplėtojančių ir populiarė-
jančių sistemų sritis. 

Šios informacinės sistemos skirtos daugelio lygių organizacijų 
darbuotojams, žmonėms, sugebantiems kurti žinių potencialą (tai in-
žinieriai, teisininkai, gydytojai bei mokslininkai). Jų pagrindinė už-
duotis – kurti naują informaciją ir žinias. Taip pat žmonėms, naudo-
jantiems sukurtąjį potencialą, kuriems svarbu įgyti daugiau žinių, ap-
doroti, bet ne kurti informaciją (pvz., sekretoriai, administratoriai, 
buhalteriai arba vadybininkai). 

Darbuotojai, sugebantys sukurti žinių potencialą, dirba specia-
lizuotose žinių kūrimo sistemų darbo vietose, skirtose inžinieriams, 
architektams, vadybininkams ir pan. 

Biurų automatizavimo sistemomis naudojamasi rengiant ir 
įforminant dokumentus, sudarant ir kontroliuojant darbo grafikus. 

Informacinės valdymo sistemos, skirtos operatyvinei kontrolei 
atlikti, kasdien turi pateikti vadovui labai patikimą ir smulkią infor-
maciją. Vadovas turi būti nuolat informuojamas, kokia organizacijos 
finansinė būklė, kiek ir kokių sunaudojama medžiagų ir t. t. 

Biurų automatizavimo sistemose užtikrinama programinė ap-
linka, kai rengiami dokumentai, sudaromi ir tikrinami darbo grafikai, 
kalendoriniai planai, paskirstomos patalpos, organizuojami susi-
rinkimai. Be paplitusios ir gerai žinomos tekstų apdorojimo pro-
graminės įrangos [27], naudojama ir sudėtinga dokumentų apdoro-
jimo įranga, skanavimo ir archyvavimo bei darbo organizavimo si-
stemos. Dokumentai kompiuteriniais tinklais persiunčiami kitiems 
padaliniams, klientams, viršininkams bei archyvuojami kompiuteri-
nėse laikmenose. Todėl kyla asmens duomenų apsaugos, perduo-
damų duomenų saugumo, dokumentą pasirašiusio asmens identifika-
vimo pagal skaitmeninį parašą problemų. 

Vadybos informacinės sistemos sukurtos orientuojantis į vidi-
nius organizacijos veiklos procesus [20]. Jos skirtos viduriniojo lyg-
mens vadovams. Šio lygmens vadovams rūpi jų vadovaujamų skyrių 
veikla dabar ir ateityje, todėl jie turi žinoti svarbius įvykius, galinčius 
turėti įtakos jų vadovaujamiems skyriams. Vadybos informacinės si-
stemos parodo esamą bei buvusią organizacijos būklę ir yra skirtos 
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kontroliuoti darbo priemones bei išlaidas, taip pat analizuoti perso-
nalo paskirstymą ir perskirstymą. Jos paprastai fiksuoja ir apibend-
rina organizacijos savaitinius, mėnesinius ir metinius (o ne kiekvie-
nos dienos) rezultatus bei įvykius. Rezultatai pateikiami įvairių ata-
skaitų pavidalu. 

Sprendimų palaikymo sistemos skirtos įvairaus lygio vado-
vams, tačiau jose naudojama tiek vidinė organizacijos informacija, 
tiek duomenys iš kitų informacinių sistemų bei išorinių šaltinių [8; 
20]. Tokios sistemos paprastai turi didžiules analitines ir modeliuo-
jamąsias galimybes. Tai leidžia analizuoti duomenis ir informaciją, 
modeliuoti įvairius procesus ir priimti pusiau struktūrinius ir struktū-
rinius sprendimus. Šios sistemos paprastai dirba interaktyviu režimu: 
vadovas gali taikyti priartėjimo metodus, pateikti sistemai naujus 
klausimus, įvesti arba keisti duomenis ir žiūrėti, kaip valdymo spren-
dimas keičia galutinius organizacijos veiklos rezultatus. 

Žinios, padedančios atlikti vykdomos veiklos įvertinimą ir 
kontrolę (pvz., diagnozuoti pažeidimus), apima daugelio skirtingų 
veiklos sričių duomenis, informaciją [8; 13]. Šiame procese svarbu 
nustatyti, kokie žmogaus žinojimo aspektai ir kokiu būdu įtraukiami į 
samprotavimo metodus ir problemos sprendimo strategijas [10; 11]. 
Skirtingų tipų dalykinės srities problemos paprastai reikalauja skir-
tingų strategijų ir samprotavimo metodų taikymo kompiuterinėje si-
stemoje. 

 
 
 

1.4. DUOMENŲ STRUKTŪROS TAIKOMOSIOSE IR  
       SISTEMINĖSE PROGRAMOSE 
 

augelis realaus pasaulio komponentų kompiuterių sistemose 
turi būti išreiškiami per tam tikrus modelius, galinčius turėti 

matematines išraiškos galimybes, grafines vaizdavimo notacijas, 
programinės įrangos organizavimo ir valdymo būdus. Programinės 
įrangos sistemose taikomos duomenų struktūros, leidžiančios iš-
reikšti tokius kompleksinius elementus kaip aibė, eilė, sąrašas, sąra-
šas su rodyklės tipo kintamaisiais ir sąrašinėmis dinaminėmis duo-
menų struktūromis, dėklai (laikina informacijos saugykla) ir panašiai  

D 
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[12]. Duomenų apdorojimo programų veiksmingumas ir aiškumas 
priklauso nuo duomenų saugojimo būdo. Uždavinį spręsti paprasčiau 
logiškai susietus duomenis saugant tam tikslui skirtose sudėtinėse 
duomenų struktūrose. Pagal savo savybes duomenys skirstomi į kla-
ses, vadinamas duomenų tipais: sveikieji skaičiai priklauso skaičių 
tipui, duomenys, turintys dvi logines reikšmes (taip ir ne, angl. true 
ir false), priklauso loginiam tipui, tekstiniai ar simboliniai duomenys 
priklauso simboliniam duomenų tipui (Char naudojamas žymėti to-
kio tipo duomenis Paskalio programavimo kalba ir UML, Text – 
duomenų bazių valdymo sistemoje Access). 

Norint apibrėžti duomenų tipą patogiausia nagrinėti bendrąsias 
duomenų tipų savybes, būdingas daugeliui aukšto lygio programa-
vimo kalbų, kurias suformulavo C. A. R. Horas (C. A. R. Hoare, 1975): 

 Tipas apibrėžia klasę reikšmių, kurias gali įgyti kintamasis 
ar reiškinys. 
 Kiekviena reikšmė priklauso vienam ir tik vienam tipui. 
 Konstantos, kintamojo arba reiškinio tipą galima nustatyti iš 
konteksto arba iš paties operando pavidalo, neatsižvelgiant į 
reikšmes, gautas atliekant programą. 
 Kiekvienos operacijos operandų ir rezultato tipai yra api-
brėžti. Kai skirtingų tipų operacijos žymimos tais pačiais 
simboliais (pvz., „+“ yra ir sveikųjų, ir realiųjų skaičių su-
dėtis), laikoma, kad toks simbolis yra daugiareikšmis ir 
žymi skirtingas operacijas. Kokią konkrečiai operaciją jis 
žymi, visada galima nustatyti transliuojant programą. 
 Kiekvieno tipo reikšmių savybės ir su šiomis reikšmėmis 
vykdomų operacijų savybės apibrėžiamos aksiomomis. 

Informacija apie tipus aukšto lygio kalbose leidžia išvengti be-
prasmių konstrukcijų programoje arba jas rasti ir nustatyti, kaip 
duomenys vaizduojami kompiuteryje ir kokie veiksmai su jais atlie-
kami. 

Matematikoje vartojami duomenų tipai: Dekarto sandaugos, 
žymėtosios sąjungos, aibės, funkcijos, sekos, rekursinės struktūros ir 
pan. 

Duomenų tipai bei duomenų struktūrinimo būdai į programa-
vimo praktiką atėjo kartu su aukšto lygio programavimo kalbomis. 

Svarbu žinoti, iš kokių elementų sudaryti duomenys ir kaip jie 
išdėstyti atmintyje, t. y. kokia yra duomenų sandara, kokie veiksmai 
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atliekami su duomenimis. Svarbios yra leistinos manipuliavimo 
duomenų tipais ir jų apdorojimo funkcijos, todėl panagrinėsime pa-
grindinius ir svarbiausius struktūrinius duomenų tipus. Kad tinkamai 
pasirinktume duomenų struktūras ir priskirtume joms reikiamus 
duomenų tipus, svarbu išmanyti loginę ir fizinę duomenų organiza-
ciją duomenų bazėse. Loginė duomenų organizacija – tai elementų 
išdėstymo tvarka, naudojama sudarant duomenų apdorojimo algorit-
mus, o fizinė duomenų organizacija – tai duomenų išdėstymo tvarka 
atminties įrenginiuose. Pagal duomenų aprašymo tikslumą priklausys 
ir jų apdorojimo algoritmų realizavimas programavimo kalbomis. 
Kad suprastume, kuo skiriasi duomenų modeliai (reliaciniai, tinkli-
niai), specialūs sistemos darbo su duomenimis programų paketai 
(duomenų bankai, duomenų bazių valdymo sistemos, žinių bazės), 
taip pat svarbu žinoti, kokiomis duomenų struktūromis jie gali mani-
puliuoti. 

 
 
1.4.1. Paprastieji, struktūriniai ir abstraktieji  
          duomenų tipai 
 
Pagal reikšmių struktūrinimo laipsnį duomenų tipai skirstomi į 

dvi klases: 
 Paprastuosius; 
 Struktūrinius. 

Paprastųjų tipų reikšmės yra nedalomos, o struktūrinių tipų 
reikšmės yra sudarytos iš kitų – paprastųjų ar struktūrinių reikšmių. 

Paprastieji duomenų tipai: simboliniai, sveikieji, realieji, lo-
giniai, vardiniai, atkarpos, nuorodos. 

Struktūriniai duomenų tipai: masyvai, įrašai, struktūros, De-
karto sandauga, alternatyva (junginys), aibė, bylos (komponentų se-
kos), rekursyviosios struktūros. 

Abstraktieji duomenų tipai, kaip galima spręsti iš pačios sąvo-
kos, yra tipai, kuriuose atsiribojama nuo dalies jų savybių, šiuo at-
veju – nuo jų reikšmių atvaizdų. 

Patys paprasčiausi duomenų saugojimo ir apdorojimo būdai 
naudojami tada, kai duomenys surašomi į tiesines duomenų struktū-
ras. Tiesinę struktūrą galima įsivaizduoti kaip aibę elementų, su-
jungtų į vieną eilę. 
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Aibė – tai to paties tipo logiškai susijusių objektų rinkinys. 
Masyvas – tai vienodo tipo kintamųjų rinkinys, vadinamas 

vienu vardu. Kiekvienam rinkinio kintamajam kompiuterio atmintyje 
yra skiriama vieta. Kintamieji vadinami masyvo nariais arba ele-
mentais, kiekvienas jų turi savo numerį arba indeksą. 

Tekstams vaizduoti ir apdoroti yra numatomi keli duomenų ti-
pai. Vienas jų – simbolinis (Char), apibrėžiantis vieno simbolio 
duomenį. Tačiau parankiau dirbti ne su pavienėmis teksto raidėmis, o 
su jų junginiais: žodžiais, sakiniais ar tiesiog simbolių rinkiniais. 
Tam tikslui yra naudojamos eilutės. 

Eilutė – tai struktūrinis duomenų tipas, aprašantis simbolių 
seką. 

Programavimo kalbose veiksmų abstrahavimo priemonės yra 
funkcijos ir procedūros. Jų vartotojams svarbu tik tai, kokie veiksmai 
atliekami su duomenimis, o ne kaip šie veiksmai atliekami. 

Duomenų tipas gali būti apibrėžiamas savo duomenų reikšmių 
aibe ir operacijomis, atliekamomis su šiomis reikšmėmis. 

 
 
1.4.2. Dinaminės duomenų struktūros 
 
Loginė duomenų organizacija – tai elementų išdėstymo tvarka, 

naudojama duomenų apdorojimo algoritmuose, o fizinė duomenų or-
ganizacija – tai duomenų išdėstymo tvarka atminties įrenginiuose.  

Duomenų išdėstymo būdų yra labai daug, o veiksmai su duo-
menimis, duomenų apdorojimo funkcijos yra kelios: paieška, įrašy-
mas, šalinimas, pertvarkymas (rūšiavimas), suspaudimas ir pan. 

Nuorodos tipas leidžia iš paprastųjų ir struktūrinių tipų konst-
ruoti sudėtingas dinamines duomenų struktūras [12]. 

Rodyklė – tai statinis kintamasis, saugantis kokio nors atminti-
nės baito adresą. 

Sąrašas – tai struktūra, kurioje duomenys surašyti tam tikra 
tvarka. Sąrašų pavyzdžiai: darbuotojų sąrašai, kuriuose nurodyti var-
dai, pavardės, pareigos, atlyginimas. Daugeliu atvejų viena sąrašo 
eilutė charakterizuoja objektą, kuriam aprašyti reikalingi keli duo-
menų tipai. Pavyzdžiui, darbuotojų sąrašo vardai ir pavardės priski-
riami eilutės tipo kintamiesiems, o parduodamų prekių kiekiai – rea-
liojo tipo kintamiesiems. 
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Kiekviena sąrašo eilutė paprastai pateikiama įrašu. 
Sąrašas nėra vien tik paprastas jį sudarančių įrašų rinkinys. Įra-

šai privalo būti tarpusavyje susiję, kad būtų galima nustatyti jų eilės 
tvarką sąraše. Todėl kiekviename sąrašo įraše, vadinamame gran-
dimi, turi būti nuoroda į tolesnę grandį.  

Sąrašus galima sudaryti vartojant įrašų masyvus. 
Dinaminis sąrašas sudaromas iš įrašų, kurių kiekvienas turi ro-

dyklę į tolesnį sąrašo narį. 
Dirbant su dinaminiais sąrašais reikia mokėti: 

 Suformuoti sąrašą; 
 Peržiūrėti (išspausdinti) sąrašą; 
 Atlikti paiešką sąraše (rasti reikiamą grandį); 
 Įterpti naują grandį; 
 Pašalinti grandį. 

Tokios struktūros labai plačiai naudojamos ne tik taikomo-
siose, bet ir sisteminėse programose. Pavyzdžiui, dėkluose yra sau-
gomi pertraukiamų procesų parametrai, organizuojami lokalūs duo-
menys. Eilės yra populiari pagalbinių (buferinių) atminčių, kuriose 
kaupiami iš lėtų įrenginių gaunami arba į juos siunčiami duomenys, 
organizavimo priemonė. Eilių sudarymas ir valdymas būdingas ma-
sinio aptarnavimo sistemose. Su sąrašo tipo struktūromis dirbama 
duomenų bazėse, skaičiuoklėse ir kitose programinėse sistemose. 

Sąrašas gali turėti skirtingas organizavimo formas. Jas galima 
suskirstyti į tokias rūšis: 

 Tiesinis dinaminis sąrašas; 
 Dėklas; 
 Eilė; 
 Tiesinis dvikryptis sąrašas; 
 Žiedinis sąrašas; 
 Lizdinis sąrašas; 
 Medžio formos sąrašas. 

Su šiomis duomenų struktūromis operuoja daugelis taikomųjų 
programų, tokių kaip Excel, Access ir kt. Vykdant programas nagri-
nėjami įvairūs duomenų struktūrų veiksmai, tokie kaip sąrašo forma-
vimas, spausdinimas, elementų paieška, įterpimas, šalinimas. 
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1.4.3. Rodyklės 
 
Kiekvienam programoje aprašytam kintamajam kompiliatorius 

skiria atminties lauką, kurį apibūdina tokie parametrai: adresas, 
lauko dydis, saugomų duomenų tipas ir reikšmė [12]. Kintamojo pa-
vadinimas programos tekste nurodo, kad turi būti manipuliuojama jo 
reikšme. Apsiriboti manipuliavimu vien tik kintamųjų reikšmėmis 
galima tik paprastus skaičiavimo algoritmus aprašančiose progra-
mose. 

Sudėtingesnėse taikomosiose ir sisteminėse programose, ku-
riose yra aktualūs racionalaus dinaminio atminties paskirstymo, di-
naminių struktūrų sudarymo ir kompiuterio įrangos valdymo fiziniu 
lygmenimi klausimai, tenka manipuliuoti ne tik atmintyje saugomo-
mis reikšmėmis, bet ir adresais. Adresų reikšmėms saugoti skirtos 
rodyklės, kurių aprašų sintaksė yra 

<duomenų_tipas>*<kintamojo_vardas>. 
Programos tekste struktūra *<vardas> reiškia, kad turi būti 

vartojama rodyklės nurodomo lauko reikšmė. Rodyklėms gali būti 
suteikiamos tik to tipo objektų, kuriems apibrėžti jos buvo skirtos, 
reikšmės. Pavyzdys: 

int x, *px; 
px = &x. 
Priskyrimo operatorius px = &x rodyklei px suteikia kintamojo 

x adreso reikšmę, todėl į x reikšmę galima kreiptis per vardą x ir 
struktūrą *px. 

Rodyklė – tai kintamasis, kurio reikšmė yra elemento (kinta-
mojo, masyvo, struktūros ar kt.) adresas. 

 

 
 

1.2 pav. Rodyklės žymėjimo pavyzdys 
 
 

Programos darbo metu rodyklėmis susietus elementus galima 
šalinti, sukurti ir prijungti naujus. Tuomet užimamos atminties dydis 
padidėja arba sumažėja. 
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1.4.4. Dinaminis sąrašas 
 
Dinaminis sąrašas – tai rodyklėmis susietų vienodo tipo ele-

mentų seka. Dinaminį sąrašą sudaro pradžios rodyklė ir vienodų di-
naminių kintamųjų seka (1.3 pav.). Iš pradžios rodyklės paeiliui ga-
lima judėti per visus elementus nuo pirmo iki paskutinio, nes kinta-
mieji yra susieti rodyklėmis. Paskutinio elemento ryšio lauke yra są-
rašo pabaigos žyma – tuščia rodyklė (NULL). 
 

 
 

1.3 pav. Dinaminio sąrašo žymėjimo pavyzdys 
 
 

Čia elementas vaizduojamas kaip stačiakampis, padalintas į 
tiek dalių, kiek yra laukų elemento duomenų ir adreso struktūroje. 
Duomenų lauke saugomos reikšmės. Rodyklės tipo lauke saugomas 
adresas (nuoroda į kitą sąrašo elementą). Nuoroda pavaizduota linija 
su rodykle gale. Šios linijos pradžia yra nuorodos lauko viduje. Jeigu 
nuoroda neegzistuoja, tuomet linija nėra brėžiama ir laukas lieka tuš-
čias. Tai reiškia, kad adreso reikšmė neapibrėžta. Realiose progra-
mose tokia situacija yra neleistina. Būtina užrašyti tuščio adreso 
reikšmę – konstantą NULL. 

Tiesinio dinaminio sąrašo struktūra programoje gali būti apra-
šoma vienu arba dviem sakiniais: 
   Struct List {  
  int Sk; 
  Struct List *next; 
  } *First 
arba 
   Struct List { 
  int Sk; 
  Struct List *next;  
  };  
   List *First. 
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Su dinaminiu sąrašu gali būti atliekami tokie veiksmai kaip: 
sąrašo formavimas (keltis); sąrašo spausdinimas (išvestis); vieno ar 
kelių elementų paieška; naujų elementų įterpimas; vieno ar kelių 
elementų šalinimas; sąrašo tvarkymas ir kt. 
 
 

1.4.5. Dėklas 
 
Dėklas (stack) yra tokia duomenų struktūra, kai prieinamas tik 

vėliausiai įrašytas elementas. Programa gali perskaityti jo reikšmę ir 
pašalinti jį iš dėklo arba įrašyti prieš jį naują elementą. Dėklas yra 
paprasčiausiai ir lengviausiai tvarkomas tiesinis dinaminis sąrašas. 
Dėklo duomenų struktūrą apibūdina principas „paskutinis įeina, pir-
mas išeina“ (angl. LIFO – Last In, First Out). Grafiškai dėklas gali 
būti pavaizduotas vertikalia struktūra, kurios viršūnė yra piešinio vir-
šuje. 
 

 
 

1.4 pav. Dėklo struktūra 
 
 

Dėklas realizuojamas dinaminiu sąrašu arba masyvu rodykle 
nurodant paskutinį elementą (dėklo viršūnę). Norint dirbti su dėklu 
reikalingos dvi funkcijos: naujo elemento prijungimo prie sąrašo 
pradžios ir pirmojo elemento pašalinimo iš sąrašo (prieš tai šis ele-
mentas yra naudojamas atliekant veiksmus). 
 
 

1.4.6. Eilė 
 
Eilė – duomenų struktūra, kai nauji elementai įrašomi į galą, o 

esami elementai šalinami iš pradžios (1.5 pav.). 
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1.5 pav. Eilės žymėjimo pavyzdys 
 
 

Eilės nuo dėklų skiriasi tik tuo, kad į jas duomenys yra siun-
čiami ir iš jų atrenkami priešinguose sąrašo galuose. Pertvarkant 
dėklą į eilę galima vieną jo tvarkymo procedūrą palikti, o antrąją rei-
kia perrašyti atliekant rekursyvią sąrašo peržiūrą, t. y. ieškant eilės 
pabaigos. Suradus pabaigą, eilė papildoma tokiu pat būdu kaip ir 
dėkle. 

Eilės pabaigos paieškai naudoti rekursyviojo arba ciklinio jos 
elementų perrinkimo būdą yra neracionalu. Toks paieškos būdas gali 
būti pateisinamas tik trumpose eilėse. Tvarkant ilgas eiles, jų ele-
mentų perrinkimo patartina vengti. Tai galima padaryti eilę papildant 
galinio elemento rodykle, kurios reikšmė būtų vartojama ir keičiama 
eilę papildant naujais elementais. Norint atlikti tokios eilės išorinį ap-
rašymą rekomenduojama sudaryti dviejų rodyklių struktūrą ir ją 
tvarkyti modifikuotomis dėklo tvarkymo funkcijomis. Norint iš eilės 
padaryti dėklą, reikia sudaryti dar vieną funkciją, kuri leistų pašalinti 
galinius eilės elementus. Dėklas yra dviguba eilė, kurios elementai 
įrašomi arba šalinami ir viename, ir kitame gale. 

Pagrindinis tiesinių sąrašų trūkumas yra tas, kad juose galima 
atlikti tik nuoseklų elementų perrinkimą. Dėl to sulėtėja juose esan-
čių duomenų paieška, tampa neefektyvios su paieška susijusios tvar-
kymo operacijos. Siekiant išvengti šių tiesinių sąrašų trūkumų, yra 
sukurtos įvairios tiesinių sąrašų modifikacijos. Pavyzdžiui, tiesi-
niame sąraše sudarant eilę, jis yra papildomas išorine rodykle, lei-
džiančia greitai papildyti sąrašą nauju elementu, įrašant jį į galą. To-
kio paties poveikio galima pasiekti žiedinėje tiesinio sąrašo modifi-
kacijoje. Tačiau abi šios modifikacijos nepalengvina paieškos pagal 
požymį ir galinio elemento šalinimo operacijų. 
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1.4.7. Dvikryptis sąrašas 
 
Paieškai ir elementams šalinti labiau tinka dvikryptė tiesinių 

sąrašų modifikacija [12], kurios elementuose yra dvi rodyklės, ro-
dančios pirmesnį ir tolimesnį iš gretimų elementų, ir viena arba dvi 
išorinės rodyklės (1.6 pav.). Tokiuose sąrašuose galima nuo bet kurio 
jų elemento prieiti prie visų kitų elementų. 

 

 
 

1.6 pav. Dvikryptis tiesinis sąrašas 
 

Dvikryptis sąrašas gali būti laikomas dviejų vienkrypčių są-
rašų kompozicija, todėl jo tvarkymo funkcijos yra panašios į šių są-
rašų tvarkymo funkcijas. Pagrindinis skirtumas yra tas, kad atliekant 
tvarkymo operacijas reikia formuoti dvi rodykles. Be to, galima su-
daryti universalias elementų įterpimo ir šalinimo operacijas, kurios 
tinka visiems, ne tiktai galiniams sąrašo elementams. Dvikrypčio di-
naminio sąrašo struktūra gali būti aprašoma taip: 
   struct sar{; 
  int sk; 
  sar * de; 
  sar * ka; 
  }. 

Pradžioje sąrašas būna tuščias. Todėl pirmojo elemento ro-
dyklės Pr (pradžia) ir galinio elemento rodyklės G (galas) reikšmės 
turi būti nulinės – NULL. Tuščias sąrašas nusakomas deklaruojant 
nulines pirmojo ir galinio elemento rodykles: 

sar *P = NULL, *G = NULL. 
Dinaminio sąrašo elementas dažniausiai saugo tam tikro dy-

džio pagal kontekstą susietą informaciją apie vieną objektą. Sąrašo 
ilgis priklauso nuo objektų skaičiaus. Tačiau viename elemente ga-
lima saugoti informaciją apie kelis objektus, pavyzdžiui, studento se-
sijos pažymius. Toks dinaminis sąrašas vadinamas lizdiniu. 
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Lizdiniu yra vadinamas sąrašas tokių elementų, kurių kiekvie-
name telpa kelių objektų masyvas. Elementai vadinami lizdais. Lizdo 
pavyzdys pateikimas 1.7 pav. 

 

 
 

1.7 pav. Lizdinio sąrašo pavyzdys 
 

Kartais lizdą patogu vaizduoti pasitelkiant sudėtingesnį dina-
minį sąrašą. Tuomet lizdo masyvas keičiamas dinaminio sąrašo ro-
dykle. Toks sąrašo pavyzdys pateikiamas 1.8 pav. 
 

 
 

1.8 pav. Lizdinio sąrašo su sudėtingo dinaminio sąrašo  
elementais pavyzdys 

 

Sąrašo srityje Studentas saugoma: 
 Studento pavardė, vardas ir studijų knygelės numeris; 
 Studento mokymosi vidurkis; 
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 Lauko Sek rodyklė nurodo kitą studentą; 
 Lauko Egz rodyklė nurodo studento egzaminų sąrašą. 

Egzaminų sąrašo elemento lauke eg saugomas egzamino pava-
dinimas, lauke p – įvertinimas, o lauke kitas – rodyklė į kito egza-
mino duomenis. Jeigu studentas dar nelaikė egzaminų, jų sąrašas bus 
tuščias ir rodyklės reikšmė bus NULL. 

Tokia struktūra naudojama, kai nežinoma, kiek vietos reikės 
skirti tam tikriems duomenims. Darbas su tokiu sąrašu yra labai pa-
našus į darbą su dviem tiesiniais sąrašais. 

 
 
1.4.8. Medžio tipo struktūros 
 
Sąrašas, kurio elementų ryšio tvarkos negalima išdėstyti vie-

noje grandinėje, vadinamas netiesiniu. Tai grafus vaizduojantys sąra-
šai. Čia viršūnės atitinka sąrašo elementų reikšmes, o viršūnes jun-
giantys lankai atitinka rodyklėmis aprašomus jų ryšius. Nuo grafo 
viršūnių sujungimo būdų priklauso jo savybės, grafo viršūnių perrin-
kimo būdai. Veiksmų su sąrašais sudėtingumas priklauso nuo grafų 
struktūros ir duomenų apdorojimo algoritmų. 

Patys paprasčiausi ir dažniausiai naudojami yra medžio tipo 
netiesiniai sąrašai, kurių elementus galima išdėstyti į kelis hierarchi-
jos (pavaldumo) lygius taip, kad pradiniame, nuliniame, lygyje būtų 
tik vienas elementas, o į kiekvieną hierarchijos lygio elementą vestų 
tiktai viena nuoroda ir tik iš aukštesnio hierarchijos lygio elemento 
(1.9 pav.). 

Medžio tipo struktūras aprašant programomis, paprastai ribo-
jamas nuorodų į žemesnius hierarchijos lygius (rodyklių) skaičius 
[12]. Jeigu medis apribojamas dviem nuorodomis, jis vadinamas bi-
nariniu. 

Binarinių medžių elementai aprašomi taip pat kaip ir dvikryp-
čių sąrašų elementai – ryšio dalyje formuojant dvi nuorodas. Tiktai 
priimta šias nuorodas žymėti kitokiais vardais, pabrėžiant, kad me-
džio šakos nukreiptos į dešinę arba kairę pusę (de, ka): 
   Struct medis {; 
  void *data; 
  medis *ka; 
  medis * de; 
  }. 
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1.9 pav. Medžio tipo struktūros pavyzdys 
 
 

Binariniai medžiai labai gerai tinka organizuoti tokioms duo-
menų saugojimo struktūroms, iš kurių dažnai tenka pagal požymius 
atrinkti pavienius elementus arba nedideles jų grupes. Aprašant me-
džio tipo struktūras taip pat reikia apibrėžti jų formavimo, tvarkymo 
bei apdorojimo procedūras. 

Dažnai programose pasitaiko tarpusavyje susijusių kintamųjų 
ir jų reikšmių. Pavyzdžiui, datą galima apibūdinti trimis reikšmėmis 
– metais, mėnesiu, diena. Visus tris datos komponentus programose 
pavadinant skirtingais vardais galima jais operuoti kaip atskirais 
komponentais. Kai operuojame viena data, nepatogumų nejaučiame. 
Jų kyla norint skaičiuoti laiko intervalų trukmes. 
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Šiame skyriuje nagrinėsime informacines sistemas, jų projek-
tavimo ypatumus, taikymo galimybes bei kūrimo klausimus. Pateikti 
universalią informacinės sistemos sąvokos apibrėžtį bus sunku, nes 
informacinių sistemų turinys, valdymo aplinka ir netgi esmė nuolat 
keičiasi. Tai priklauso nuo epochos, technologijų išsivystymo, inži-
nerinių sprendimų, organizacijų valdymo konteksto ir kultūros. 
 
 
 
2.1. INFORMACINIŲ SISTEMŲ SAMPRATA 
 

iuolaikines informacines sistemas nagrinėsime vertindami jų 
taikymo efektyvumą organizacijų valdymo, administravimo, 

verslo procesuose ir veikloje [11; 13; 14; 21; 22]. Šiuolaikiniuose va-
dybos procesuose, be informacinės sistemos sąvokos, vartojama ir 
informacijos sistemos sąvoka. Jų prasmė šiek tiek skiriasi. 

Informacinę sistemą galima apibrėžti kaip kompleksą kompo-
nentų, skirtų įvairių rūšių duomenims ir informacijai rinkti, saugoti, 
apdoroti, laikyti bei skleisti, siekiant tam tikrų organizacijos tikslų ir 
taikant kompiuterines technologijas. 

Informacinės sistemos neatskiriamos nuo technologijų ir te-
chninės įrangos (kompiuterių, telekomunikacijų priemonių ir pan.). 
Jų pobūdį ir galimybes dažniausiai nulemia naudojamos technologi-
jos. Tačiau pati technika savaime dar nėra technologija. Dabartinės 
informacinės sistemos įvaizdį galima sieti su kompiuteriu. Kompiu-
teris, kol su juo nėra susiejamos idėjos, tikslai, sprendžiamos pro-
blemos, uždaviniai ir tam tikri sugebėjimai, tėra metalo ir plastiko 
konstrukcija. Taigi minėtąsias kompiuterines sistemas galima laikyti 
technologijomis, kai jos tiesiogiai susiejamos su informaciniais tiks-
lais, problemomis, poreikiais ir žmonių veikla. 

Informacijos sistemų kūrėjai privalo būti susipažinę su taiko-
mąja sistema (verslo, teisės, administravimo, technologijų ar kt.), ku-
riai bus skiriama informacijos sistema, ir atsižvelgti į vartotojų rei-
kalavimus. 

Nagrinėjant informacinę sistemą, būtina paminėti aplinką, ku-
rioje ji funkcionuos. Organizacijos informacinė sistema kartu yra ir 
žmonių darbo įgūdžių, informacijos, informacinių technologijų ir 
veiklos procesų derinys. Su ja dirba žmonės – operatoriai, vartotojai 

Š 
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ir pan. Įdiegta informacinė sistema veikia ir formuoja reikiamą in-
formaciją, pranešimus apie rezultatus. Veikiant informacinei siste-
mai, ji yra pastoviai aptarnaujama, sekamas jos darbas, šalinami ap-
tikti jos komponentų defektai bei gedimai. Be to, ji turėtų būti nuo-
latos tobulinama. Sistemai veikiant rekomenduojama pildyti jos 
eksploatacijos žurnalą, fiksuoti jame visus sistemos darbo sutrikimus 
ir visas vartotojų pareikštas pastabas apie sistemos darbą. 
 
 
 
2.2. INFORMACINĖS SISTEMOS GYVAVIMO  
       CIKLAS 
 

nformacinė sistema kuriama laikantis tam tikrų tokioms siste-
moms taikomų kūrimo principų pagal pasirinktus kūrimo ir gyva-

vimo ciklo modelius, skaidomus į etapus. Informacinių sistemų kū-
rimo ciklo modelių siūloma gana daug, pavyzdžiui, tradicinis, evo-
liucinis, greito prototipo sukūrimo, kaskadinis ir kt. [6]. 

Informacinės sistemos gyvavimo ciklas apima laikotarpį nuo 
šios sistemos sumanymo (koncepcijos) iki veikimo pabaigos. Infor-
macinės sistemos kūrimas – tai procesas, apimantis organizacijos 
tikslų, vartotojų poreikių bei galimybių analizę, siūlymo rengimą 
(sprendimų rengimą, įvertinimą, parinkimą, dokumentavimą), pro-
jektavimą, diegimą, palaikymą, tobulinimą. Formuluojant sistemos 
kūrimo tikslus, konkretizuojami šių siekių įgyvendinimo kriterijai ir 
apribojimai. Jie formuoja sistemos funkcinę dalį, kurią sudaro kom-
piuterizuojamos valdymo funkcijos ir taikomieji kompleksai. 

Siūlome panagrinėti tradicinį informacinės sistemos kūrimo 
ciklą. 

Tradicinis informacinės sistemos gyvavimo ciklas susideda iš 
šešių pagrindinių etapų. Jie gali būti skaidomi ir detalizuojami: 

I. Tyrimas ir planavimas: 
1.1. Sistemos nagrinėjimo poreikių nustatymas. 
1.2. Pradinis tyrimas. Dalykinės srities ribų nustatymas. 

Esamų sistemų tyrimas. 
1.3. Informacinių ir komunikacinių technologijų pasirinki-

mas. 

I
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II. Analizė: 
2.1. Problemos apibrėžimas. 
2.2. Egzistuojančių sistemų ir technologijų įvertinimas. 
2.3. Vartotojų reikalavimų ir naujos sistemos apribojimų 

nustatymas ir apibrėžimas. 
 

 

 

 

 

 

 
 

 
2.1 pav. Tradicinis sistemos kūrimo ciklas 

 
 

III. Projektavimas: 
3.1. Koncepcinis, loginis ir architektūrinis projektavimas. 

Rekomenduojamo loginio modelio (koncepcinio, logi-
nio arba architektūrinio projekto) sudarymas. 

3.2. Sistemos projektavimas (bendras projektavimas ir siste-
mos specifikacija). 

3.3. Detalus (arba specifinis) projektavimas. 
3.4. Fizinis projektavimas. 

IV. Konstravimas: 
4.1. Sistemos konstravimas. 
4.2. Testavimas. 
4.3. Instaliavimas, konvertavimas. 
4.4. Derinimas. 
4.5. Priežiūra įdiegus. 

V. Taikymas: 
5.1. Sistemos taikymas siekiant operatyviai įvesti konkre-

čios taikomosios srities duomenis. 

Tyrimas ir planavimas 

Diegimas ir plėtojimas Analizė 

Taikymas Projektavimas 

Konstravimas 
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5.2. Eksploatacija ir pokyčių įvertinimas. 
5.3. Sistemos taikymas analogiško pobūdžio taikomosiose 

srityse. 
VI. Diegimas ir plėtojimas. 

6.1. Informacinės sistemos ir programų sistemos tiražavi-
mas. 

6.2. Veikiančios sistemos naudojimas ir priežiūra. 
6.3. Sistemos kūrimas, plėtojimas ir tobulinimas. 

 
 
 

2.3. INFORMACINĖS SISTEMOS ANALIZĖ 
 

nformacinės sistemos analizės etapą galima skaidyti į smulkes-
nius etapus: 

1. Struktūros analizės; 
2. Užduočių analizės; 
3. Sąveikos (bendravimo) analizės; 
4. Dokumentų analizės; 
5. Duomenų analizės; 
6. Procesų analizės. 
1) Struktūros analizės metu nusakoma: 

 Organizacinė sistemos struktūra (kas veikia?); 
 Hierarchinė sistemos struktūra. 

2) Užduočių analizės metu nusakoma: 
 Kas yra atliekama (kokios operacijos yra atliekamos); 
 Kas atlieka šias operacijas; 
 Kada operacijos yra atliekamos; 
 Kodėl yra atliekamos operacijos. 

Aprašant kiekvieną operaciją nustatoma: 
 Kokie duomenys ir informacija yra naudojami operacijai 
atlikti (pradiniai duomenys); 

 Kokie duomenys ir informacija gaunami atlikus operaciją 
(rezultatai); 

3) Sąveikos (bendravimo) analizės metu nustatoma: 
 Operacijų ryšiai; 
 Sistemos elementų sąveikos (bendravimo) ryšys. 

I

2.3. Informacinės sistemos analizė 
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4) Atliekant dokumentų analizę aprašomi dokumentai ir proto-
kolai (ataskaitos), kurie bus pateikiami dalykinėje srityje. 

5) Vykstant duomenų analizei aprašomos ir atskleidžiamos su-
dėtingų dalykinių sričių duomenų struktūros. 

6) Atliekant procesų analizę pateikiama informacija apie tai, 
kokia tvarka bus atliekamos operacijos. 

 
 
 

2.4. INFORMACINĖS SISTEMOS KONCEPCIJOS  
       APRAŠYMAS 

 
nformacinės sistemos projektuojamos laikantis tam tikros meto-
dikos ir/arba metodologijos. Metodika nusako bendrus sistemos 

kūrimo principus, priemones, jų taikymo metodus. Per pastarąjį de-
šimtmetį viena iš dominuojančių sistemų kūrimo metodologinių 
krypčių yra vadinamoji struktūrinė sistemų analizė ir projektavimas. 
Struktūrinė sistemų analizė yra viena iš kertinių sąvokų, ji naudo-
jama apibūdinant tam tikro pobūdžio sistemų kūrimo metodą. Nema-
žiau svarbi struktūrinės funkcinės analizės metodų kryptis. 

Visi metodai, įgalinantys analizuoti, projektuoti, standartizuoti 
sistemos kūrimą, apibendrintai vadinami metodologija. Struktūrinės 
analizės metodas skirtas sistemos analizės ir projektavimo etapams. 
Struktūrinės sistemų analizės principai formaliai apibrėžiami kaip 
tam tikra metodologija [4; 30]. 

Kiekvienoje šių metodologijų turi būti keli pagrindiniai kom-
ponentai: 

 Įrankiai, priemonės ir modeliai, skirti naujiems vartotojų 
reikalavimams aprašyti, analizuoti ir specifikuoti bei anali-
zuoti ir įvertinti egzistuojančias sistemas. 
 Sukurta tam tikro tipo bendros struktūros darbo aplinka, lei-
džianti nustatyti, kurie įrankiai, priemonės, modeliai ir for-
malizmai yra naudotini tam tikroje sistemos kūrimo proceso 
stadijoje ir kaip jie yra tarpusavyje jungiami. 

Informacinių sistemų projektavimo metodikai būdingi penki 
pagrindiniai aspektai: 

 Priemonių ir technologijų aibės formavimas nustatant, kuri 
iš jų geriausia kiekvieno etapo situacijai valdyti. 

I 
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 Darbo aplinkos kūrimo metodikos siūlymas laikantis stan-
dartų arba siekiant ją standartizuoti. Ši metodika nusako pa-
grindinius analizės ir projektavimo procesų etapus. 
 Skirtumo tarp fizinio ir loginio sistemos požiūrių nustaty-
mas ir jų naudojimas. 
 Vartotojo vaidmens peržiūra sistemos kūrimo procese. 
 Duomenų struktūrų, būtinų kaip propaguojamo projekta-
vimo pagrindas, panaudojimas. 

Sistemos projektavimo etape struktūrizuojama informacija, 
kuri bus svarbi organizacijos informaciniams objektams aprašyti ir 
vertinti. Pagrindinis projektavimo komponentas yra informacinės si-
stemos koncepcinis modelis, išreiškiantis sampratą, kaip sistema bus 
sudaryta ir kaip ji veiks (2.2 pav.). Čia nagrinėjami inžinerijos ir si-
stemų inžinerijos reikalavimų klausimai. Koncepciniam modeliui su-
daryti gali būti taikomi įvairūs metodai, semantiniai modeliai, grafi-
nių notacijų priemonės ir kt. 

Semantiniai modeliai, susiję su abstrakcijos apibrėžimo me-
chanizmais – klasifikacija, agregacija, apibendrinimu ir asociacija, 
dalykinę sritį leidžia projektuoti ir nagrinėti kaip tikrovės modelį, 
tam tikrame abstrakcijos lygmenyje atsiribojant nuo konkrečių duo-
menų. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.2 pav. Informacinės sistemos projektavimo etapai 

 

          DALYKINĖ        Srities žinių 
             SRITIS           įgijimas ir
               modeliavimas 

       Įvertinimas 
                     KONCEPCINIS
                         MODELIS

               REIKALAVIMŲ 
                INŽINERIJA                                

                                                           Projektavimas 
                        Testavimas/ 
                        koregavimas 
                                       
                                

                                                                                                 DIEGIAMA 
                                                      SISTEMA

                SISTEMŲ INŽINERIJA 

2.4. Informacinės sistemos koncepcijos aprašymas 
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Šiuo metu populiari objektinė projektavimo metodika [3]. Jos 
pagrindu sukurta unifikuota modeliavimo kalba UML tampa stan-
dartu aprašant sistemos struktūrą ir veikimo principus [6; 16]. Ži-
noma, egzistuoja ir kitos projektavimo metodikos, pavyzdžiui, ARIS, 
ORACLE, KADS ir pan. [4; 6]. 

Objektinės diagramų konstravimo priemonės (technique) skir-
tos objektų struktūroms ir elgsenai grafiškai vaizduoti ir jas specifi-
kuoti programavimo sistemose. 

Sudarant koncepcinius modelius grafinės išraiškos priemonės 
vadinamos diagramomis. Projektuojant informacines sistemas nau-
dojamos įvairios diagramų rūšys: 

 Objektų (struktūrų) diagramos; 
 Būsenų perėjimo diagramos; 
 Sąveikos diagramos; 
 Įvykių diagramos; 
 Kontekstinės diagramos; 
 KADS interpretacinės diagramos [4]; 
 Duomenų srautų diagramos. 

 
 
 

2.5. OBJEKTINĖ INFORMACINIŲ SISTEMŲ  
       PROJEKTAVIMO METODIKA 
 

istema dažniausiai apibūdinama struktūros ir veiklos terminais. 
Veikla nurodo tai, kaip pasaulis keičiasi laike. Struktūra galima 

apibūdinti (specifikuoti) įvairias objektų konfigūracijas, pavyzdžiui, 
darbuotojai, dokumentai, projektai. Veiklos (elgsenos) specifikacija 
galima aprašyti tokius procesus kaip darbuotojo įdarbinimas, prane-
šimas apie darbuotojo pensijos amžių ir pan. 

Objekto tipas yra idėja, samprata, kurią mes taikome įvairiems 
mūsų žinias sudarantiems dalykams arba objektams apibrėžti. Žmo-
nės sąvokas taiko objektams apibūdinti. Terminas objekto tipas gali 
būti vartojamas ir vietoj sąvokos. 

Mūsų tikrovė susideda iš realiai egzistuojančių objektų, ku-
riuos įvardijame sąvokomis, turinčiomis savo tipus. Sąvokų termi-
nais mes kalbame apie konkrečius ir abstrakčius reiškinius, objektus, 
procesus, rezultatus ir pan.  Kuriant  kompiuterines  sistemas  svarbu,  

S 
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kad mūsų kuriamas modelis kuo geriau atspindėtų tikrovę ir atitiktų 
objektus, kuriems mūsų sąvokos bus taikomos ir kuriems atspindėti 
skaitmeninėje erdvėje bus kuriami atitinkami objektai. 

 
 

2.5.1. Objektų klasės 
 
Objektą mes išskiriame pagal jo klasifikacinius požymius ir 

įvardijame tam tikra sąvoka (terminu) [3]. Ši sąvoka tarsi apibrėžia 
tam tikro objekto tipą, taikomą šios klasės objektams apibūdinti. Mes 
išskiriame stalų, asmenų, baldų, įmonių ir kitas objektų klases. Kiek-
viena ši klasė turi konkrečius objektus, t. y. klasės egzempliorius. 
Pavyzdžiui, apibūdindami konkretų stalą, kurio inventoriaus numeris 
15, turėsime omenyje konkretų stalų klasės egzempliorių. 

Klasė – aibė objektų, kuriuos sieja struktūros ir elgesio ben-
drumas. Bet kuris objektas yra klasės egzempliorius. 

Tipas – tai tarsi reikalavimas, kurį turi tenkinti objektas, kad 
patektų į klasę. Individualumas – tai objekto savybės, išskiriančios jį 
iš visų kitų objektų. Klasė skirta atvaizduoti objektų rinkinį. 

Apibrėždami sąvokas (konceptus, esybes) taikome: 
 Klasifikaciją – ja išskiriame objektų klases pagal jų skiria-
muosius, prasminius bruožus; 

 Apibendrinimą – jo pagrindu apibendriname vieną objektų 
klasę kita, pavyzdžiui, stalai ir kėdės gali būti apibendri-
nami sąvoka baldai; 
 Asociaciją – ja nusakome ryšius ir apibūdiname, kaip 
objektai susiejami tarpusavyje; 
 Agregavimą – juo nusakome, iš kokių sudedamųjų dalių 
sudaryti objektai ir jų klasės. 

 
 

2.5.2. Klasių dalijimas ir skirstymas 
 
Sąvoka dalijimas ir skirstymas vartojama tam, kad galėtume 

aprašyti aibės padalijimą į nesutampančius poaibius. Padalytosios 
dalies viduje poaibiai negali sutapti. Tuo tarpu padalinių potipiai gali 
iš dalies sutapti. 
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Padalijimas gali būti traktuojamas kaip objekto tipo aibės su-
skirstymas/padalijimas į skirtingas nesutampančias grupes (potipius). 

Pavyzdžiui, vienas būdas padalinti tipą asmenys yra suskirstyti 
jį į potipius vyrai ir moterys, kitas būdas – padalinti pagal tam tikrą 
amžių ir lytį. 

Asmenų tipas dalijamas visiškai kitaip, kai atsižvelgiama į tai, 
ar asmuo tarnautojas ar ne. 

Taigi kiekvienas objektų tipas gali būti padalintas/suskirstytas 
remiantis įvairiais aspektais. 

Pavyzdžiui, asmuo gali būti vieno iš poaibių vaikai, suaugu-
sieji, pensininkai egzempliorius. Tačiau tą pačią asmenų aibę dalijant 
pagal lytį, bus moteriškosios ir vyriškosios giminės poaibiai. Rink-
dami, kuriai grupei priskirti asmenį, vartojame ARBA tipo tvirtinimą. 
Galimybė sujungti keletą skirtingų idėjų, taikant IR tipo tvirtinimus 
gaunama, kai naudojamas daugybinis padalijimas. Kai tokios žinios 
yra automatizuojamos, semantikos aprašymo priemonės turi operuoti 
gerai apibrėžtu reikšmės tvirtinimu. 

 
 
2.5.3. Objektų klasių ryšių tipai 
 
Objektų tipų jungčių rinkinys formuoja tam tikros rūšies ob-

jektų tipą, vadinamą ryšio tipu. Ryšio (sąryšio) tipai ir žymėjimas yra 
priemonės, kuriomis aprašomos objektų jungtys (asociacijos). 

 
Asociacijos ryšiai 
 
Asociacijos ryšių priemonės padeda suvokti, kaip prasmingai 

susieti įvairių tipų objektus. 
Pavyzdžiui, nagrinėjame dvi objektų klases: organizacija ir 

asmenys, ir jų susiejimo ryšį, išreiškiantį asmenų įdarbinimą tam tik-
roje organizacijoje. 2.3 pav. iliustruojamas tokio tipo asociacijų ryšys 
ir jo grafinis vaizdavimas UML kalba [3]. 

Asociacija grafiškai žymima linija. 
Stačiakampio formos viršūnės – gana tinkama vaizdavimo 

priemonė objektų klasei apibrėžti. 
Objektų tipai apima objektų aibes. Asociacijos vaizduoja ob-

jektų aibių ryšius. 
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2.3 pav. Asociacijos ryšio tarp dviejų objektų klasių vaizdavimas 
 
 

Pavyzdžiui, visi sąryšių egzemplioriai sudaro aibę ryšių, pa-
žymėtų asmens įdarbinimo idėja, išreiškiama asociacijos ryšiu. 

Daugianaris (n narių) ryšys yra objektas, susiejantis kitus ob-
jektus, kai ryšio tipo egzemplioriai yra tam tikros n narystės. Dau-
gianariškumo apribojimus išreiškia ryšio kardinalumo sąvoka. 

Vaizdavimas pažymint (mapings) – tai sąryšiai, leidžiantys 
asociacijas, sąsajas traktuoti bendrąja prasme. Vaizdavimas nėra 
traktuojamas apskritai. Jis turi kryptį, kurią mes nusakome galvo-
dami apie sąryšį. Organizacija įdarbina asmenis, o asmenys dirba or-
ganizacijoje. 

Vaizdavimas dinaminiame pasaulyje tarsi nusako procesą. 
Praktiškai, kai nusakoma galimybė taikyti tokį vaizdavimą dinami-
niame pasaulyje, jis reikalauja proceso. 

Vaizdavimas, kurio metu visada kaip rezultatas pateikiamas 
vienas objektas, vadinamas vienareikšmiu. 

Pavyzdžiui, kai norime, kad būtų pateiktas rezultatas apie as-
mens biologinę motiną, kiekvienas objektas iš objektų klasės asmuo 
vaizduoja vienintelį objektų klasės moterys objektą. 

Kai vaizdavimas gali grąžinti tam tikrą skaičių objektų, jis yra 
daugiareikšmis. 

Pavyzdžiui, organizacijoje dirba daug asmenų, t. y. organiza-
cijoje Sauluva dirba (yra įdarbinti) Martynas, Juozas, Dana ir kt. 

 
 
Ryšio kardinalumo apribojimo samprata 
 
Kardinalumo apribojimas nurodo minimalų ir maksimalų skai-

čių objektų, kurie gali būti gaunami kaip ryšio vaizdavimo rezultatas. 

Organizacija Asmenys 

įdarbina 

dirba
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Kardinalumas nurodo skaičių, vaizduojantį objektų egzemplio-
rių skaičių, gaunamą kaip ryšio rezultatą ieškant konkrečių klasių eg-
zempliorių. Gali būti nusakomi tokie kardinalumo apribojimo tipai: 
1:1 (vienas su vienu), 1:n (vienas su daugeliu), n:m (daugelis su dau-
geliu). Ryšių kardinalumo apribojimų žymėjimas taip pat gali įvai-
ruoti. 

Pavyzdžiui, asmuo gali dirbti keliose organizacijose (t. y. ryšio 
kardinalumo tipas bus 1:n) 

 
Kompozicija (agregavimas) 
 
Kompozicijos ryšiu nusakomas semantinis mechanizmas api-

brėžia, kaip iš komponuojamų dalių sudaroma visuma. Kompozicija 
gali būti vadinama agregavimu. Agregavimo antonimas būtų dekom-
pozicija. 

Kompozicijos ryšiu galima apibrėžti objekto (daikto, reiškinio 
ar pan.) sudedamąsias dalis. Pavyzdžiui, burlaivis sudarytas iš atskirų 
dalių, tokių kaip valtis, burė, inkaras ir kt. Kompozicijos ryšys gali 
būti suprantamas daug konceptualiau ir subjektyviau, pavyzdžiui, 
kaip santuoka – vyras ir žmona, komisija – kompetentingų narių 
grupė. 
 
 
 
 
 
 
 
 

2.4 pav. Agregavimo ryšio žymėjimas UML kalba 
 

Objektų diagramos naudojamos parodyti objektų egzistavimą 
ir jų ryšius loginiame sistemos projekte. 

Objektai sąveikauja per savo ryšius su kitais objektais, perduo-
damus pranešimus ir kitais bendravimo būdais. 

Ryšys tarp dviejų objektų gali būti tada ir tik tada, jeigu yra 
asociacija tarp atitinkamų objektų klasių. Ši asociacija gali pasireikšti 
ir kaip kiti santykiai, pavyzdžiui, paveldėjimo ar turėjimo. 

Agregatas Dalis_1 

Dalis_n 

Agregacinis ryšys (has_part)  
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Asociacijos ryšio tarp dviejų klasių nustatymas reiškia kelią 
(ryšį) tarp šių klasių egzempliorių – šiuo keliu vienas objektas gali 
siųsti pranešimus kitam. 

 
Apibendrinimas 
 
Kad geriau suvoktume klasifikavimo ir apibendrinimo ryšius, 

panagrinėkime pavyzdį. Tarkime, mums reikia susisteminti ir surū-
šiuoti drabužių spintos turinį. Žiūrėdami į drabužių spintą mes ma-
tome, atpažįstame ir išskiriame (t. y. klasifikuojame) joje esančius 
objektus: paltus, lietpalčius, švarkus, marškinius ir t. t. Šią saugojimo 
vietą mes galime pavadinti paltų-lietpalčių-švarkų-marškinių-... 
spinta. Kuo daugiau daiktų joje saugosime, tuo ilgesnis ir gremėzdiš-
kesnis bus tokio tipo pavadinimas. Tačiau įvesdami į žodyną šiuos 
daiktus apibendrinančią sąvoką, galime supaprastinti ne tik pavadi-
nimą, bet ir teisingiau išreikšti kai kuriuos semantinius mūsų aplin-
kos aspektus. 

Apibendrinimas įgalina vartoti sąvokas, apibrėžiančias tai, kas 
bendra tokios klasės egzemplioriams. Taigi turėtume pagalvoti, kuri 
daug bendresnė sąvoka galėtų nusakyti tokias sąvokas kaip paltas, 
lietpaltis, švarkas, marškiniai? Žinoma, visas šias sąvokas galima 
būtų pavadinti drabužiais. Dar bendresnės sąvokos yra prekės arba 
namų ūkio daiktai, materialūs daiktai ir pan. 

Apibendrinimas yra sąvokos išskyrimo veiksmas arba rezul-
tatas (t. y. objekto tipas), kurio turinys visiškai apima vieną ar keletą 
kitų sąvokų. 

Apibendrinimas leidžia teigti, kad visi specifinio objekto tipo 
egzemplioriai yra taip pat daug bendresnio objekto tipo egzemplio-
riai, bet ne atvirkščiai. 

Pavyzdžiui, švarkas ir lietpaltis yra aprangos objektai. Tačiau 
ne visi aprangos objektai yra švarkai ir lietpalčiai. 

Apibendrinimu mes galime apibrėžti objektų tipų hierarchiją 
formuodami vis bendresnius objektų tipus. 

Pavyzdžiui, gyvybės forma yra daug bendresnis objekto tipas 
(supertipas) negu žmogus, tuo tarpu žmogus yra bendresnė sąvoka 
negu moteris. 

Apibendrinimo ryšiai diagramoje aprašomi kryptine linija su 
nenuspalvinta rodykle. 
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Žemesnė apibendrinimo klasė 

apibendrinimo ryšys (is_a) 

Aukštesnė apibendrinimo klasė 

 
 
 
 
 
 
 
 
 
 

2.5 pav. Apibendrinimo ryšys 
 
 
 

Objektai yra egzemplioriai, jie gali būti klasifikuojami. Klasi-
fikacija ir apibendrinimas/specializacija yra skirtingi dalykai, turintys 
skirtingas hierarchijas. 

Susipažinome su keliais skirtingais objektų hierarchijos apra-
šymo būdais: 

 Klasifikacija – kai tam tikro tipo objektai yra jungiami į 
bendrą klasę (galima sudaryti jų poaibius, aibes, superai-
bes). 
 Apibendrinimu – kai nustatomi tam tikri objektų tipų 
apibendrinimai (ši hierarchijos forma bus apibrėžiama is_a 
ryšiais tarp klasių). 

 Kompozicija (agregavimu) – kai tam tikra visuma sudaroma 
iš tam tikrų sudedamųjų dalių (ši hierarchijos forma apibrė-
žiama has_part ryšiais tarp klasių). 
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2.6. ADMINISTRAVIMO INFORMACINĖS SISTEMOS  
       PROJEKTAVIMAS 
 

io skyriaus tikslas – susipažinti su informacinės sistemos pro-
jektavimo etapais, išsamiau panagrinėti informacinės sistemos, 

skirtos konferencijai administruoti, kūrimo etapus. 
Nagrinėsime konferencijos organizavimo ir administravimo in-

formacinės sistemos kūrimo pavyzdį. Siūlome administracinę si-
stemą projektuoti pagal objektinę projektavimo metodiką, taikant 
unifikuotą modeliavimo kalbą UML [3; 16]. 

Duomenų bazę siūlome kurti pasitelkiant reliacinio tipo duo-
menų bazių valdymo sistemas (DBVS), pavyzdžiui, MS Access. 

 
 
2.6.1. Konferencijos organizavimo ir  
          administravimo informacinė sistema 
 
Apibrėžiant ir nusakant organizacijos informacinę sistemą tu-

rėtų būti nagrinėjami tokie klausimai: 
 Konferencijos administravimo sistemos apibūdinimas; 
 Tikslai; 
 Informacinės sistemos kūrimo ciklas; 
 Informacinės sistemos koncepcija (informacinių objektų 
aprašymo sistema); 
 Sprendžiami uždaviniai; 
 Duomenų srautų modeliai; 
 Administracinės informacinės sistemos prototipo sukūrimas 
ir rekomendacijos bei kita. 

 
Konferencijos administravimo sistema  
 
Konferencijos dažniausiai organizuojamos pagal tam tikrą 

tematiką, atitinkančią kintamus besidominčių asmenų ir organizacijų 
probleminių klausimų ciklus. Konferencijos dažniausiai vyksta skir-
tingose geografinėse vietose, periodiškai renkantis šalį ir miestą, ku-

Š

2.6. Administravimo informacinės sistemos projektavimas 



2 skyrius. INFORMACINĖS SISTEMOS 
 

46

riame yra konferencijos tematiką reprezentuojančios ir dalyvaujan-
čios šios srities darbe pagrindinės organizacijos ir mokslininkai. 

Kuriant informacinę sistemą dažniausiai reikia taupyti jai 
skirtus ekonominius išteklius ir tenka kurti kompiuterinę sistemą, 
kuri būtų skirta ne vienai specifinei konferencijai administruoti, bet 
būtų pritaikoma daugeliui tokio pobūdžio uždavinių spręsti. Tad in-
formacinės sistemos kūrėjų tikslas – kooperuotis su kitais šios srities 
darbuotojais ir kurti standartizuotą konferencijų organizavimo si-
stemą, kuri būtų visų naudojama tokio pobūdžio konferencijų darbui 
organizuoti. Matyt nesvarbu, ar tokią informacinę sistemą kursime 
tarptautinei, ar vietinei respublikinei konferencijai administruoti. 

Kuriama kompiuterinė konferencijos administravimo sistema 
bus skiriama registruoti ir administruoti konferencijos dalyvius bei 
parengti konferencijos programą. Šioje dalyje nebus nagrinėjami to-
kie klausimai kaip konferencijos biudžeto tvarkymas ir apskaita, 
viešbučių kambarių rezervavimas, ir dalyvių laisvalaikio planavimas, 
konferencijos darbų spausdinimas. 

 
2.6.2. Tikslų nustatymas 
 
Vartotojai dažniausiai nori, kad sistema atliktų tam tikras 

funkcijas, todėl svarbu apibrėžti pagrindinius informacinės sistemos 
tikslus ir vartotojų reikalavimus. Pagal kontekstą nusakomi tokie rei-
kalavimai kaip sistemos funkcionalumas, trumpai apibūdinama tai-
komoji sritis, technologijos, sąlygos, objektinė sistema ir darbų vyk-
dymo eiga. Kiekvienas šis reikalavimas toliau bus detalizuojamas 
apibūdinant/aiškinant konkrečius sistemos kūrimo komponentus. 

Pagrindiniai konferencijos administravimo informacinės siste-
mos reikalavimai pateikti 2.1 lentelėje. 

 
2.1 lentelė. Konferencijos administravimo informacinės sistemos  
                   reikalavimai 

 
Funkcionalumas Sistema turės padėti administruoti tarptautinės kon-

ferencijos programą, dalyvių registraciją bei infor-
macijos jiems suteikimą. 

Vartotojai Programinis komitetas, organizacinis komitetas, 
konferenciją administruosiantys vietinio personalo 
nariai, dalyviai. 
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Technologijos Vietinis kelių kompiuterių tinklas, serveris, interne-
tas bei pastoviu režimu (On-Line) veikianti duomenų 
bazė. 

Sąlygos Užtikrinama tam tikra duomenų apsauga. 
Objektinė sistema  Tarptautinės konferencijos rengimas registruojant 

dalyvius, straipsnius ir rengiant konferencijos pro-
gramą. 

Darbų eiga Pirmiausiai sukuriamos administravimo priemonės, 
vėliau – asmenų, planuojančių ir rengiančių konfe-
renciją, bendravimo aplinka, taip pat bendravimo su 
konferencijos dalyviais priemonės ir konferencijos 
programos vykdymo pagal numatytą darbų eigą 
planas. 

 

Šie apibendrinti reikalavimai turėtų būti toliau detalizuojami 
kuriant informacinę sistemą. 

 

2.6.3. Koncepcinis projektavimas 
 
Nagrinėjant konferencijos organizavimo informacinės sistemos 

projektavimo etapą aprašoma koncepcinė duomenų struktūros sche-
ma. Projektuojamosios objektų klasių struktūrų diagramos aprašo-
mos renkantis UML kalbos konstrukcijas. 

Išskiriamos pagrindinės objektų klasės: asmenys ir straipsniai. 

 
 

2.6 pav. Konferencijos administravimo informacinės sistemos  
pagrindinės duomenų klasės 

2.6. Administravimo informacinės sistemos projektavimas 
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Klases apibūdina jų parametrai, pavadinimai ir operacijos. As-
menų klasė apibrėžiama tokiais parametrais kaip asmens_ID; pa-
vardė; vardas; pareigos; organizacija, šalis ir kt. 

Išskiriamos apibendrinančios klasės, įvertinant konkrečius jų 
suskirstymo variantus ir diagramoje išreiškiant objektų klasių poai-
bius, kurie bus svarbūs ir turės įtakos kuriant informacinės sistemos 
duomenų bazę. 

Straipsniai šiame pavyzdyje apibendrina plenarinių prane-
šimų, apžvalginių pranešimų, techninių pranešimų, mokslinių prane-
šimų klases (2.6. pav.). 

Schemoje nurodomi nagrinėjamoje dalykinėje srityje svarbūs 
agregavimo ryšiai. 

 

 
 
 

2.7 pav. Konferencijos administravimo informacinės sistemos duomenų 
struktūros klasių diagrama 
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Pavyzdžiui, jei yra svarbu, iš kokių sudedamųjų dalių sudary-
tas straipsnis, agregavimo ryšiais diagramoje išreiškiame jo sudėtines 
dalis: santrauką, įžangą, problemos formulavimą, rezultatus ir pan. 

Taip pat nurodomi asociacijų ryšiai. Įvardytais asociacijų ry-
šiais diagramoje pažymime, kad asmenys pateikia straipsnius, 
straipsniai yra recenzuojami ir pan. (2.7. pav.), apibrėžiame asocia-
cijos ryšių kardinalumo apribojimus. 
 
 
 
2.7. DALYKINĖS SRITIES DUOMENŲ SRAUTŲ  
        MODELIAVIMAS 
 

alykinę sritį (DS) galima nagrinėti daugeliu aspektų. Informa-
ciniai DS modeliai vaizduoja informacinę DS struktūrą. DS 

duomenų srautų modeliai skirti modeliuoti DS vykstančią veiklą. 
Dalykinėje srityje vykstančią veiklą galima skaidyti į duo-

menų, dokumentų, pinigų, gaminių ar kitokiais srautais siejamus 
procesus. Jeigu veikla yra reguliari, kiekvieną tokį procesą galima 
traktuoti kaip gaunamų srautų pertvarkymo (transformavimo) pagal 
tam tikras taisykles procedūrą. Procesų vykdymo taisyklės mode-
liuojamos pagal atitinkamus algoritmus. 

Dalykinės srities srautams modeliuoti naudojama speciali kon-
cepcinio modeliavimo kalba, vadinama duomenų srautų diagramų 
kalba [6; 30]. 

Duomenų srautų diagramomis galima aprašyti ir rankines, ir iš 
dalies kompiuterizuotas, ir visiškai kompiuterizuotas bei automati-
zuotas veiklas. 

Duomenų srautų diagramų kalbos konstrukcijos yra šios: 
 Duomenų srautas; 
 Procesas; 
 Duomenų saugykla (duomenų bazė, informacinė sistema 
arba skaičiuoklėse saugoma duomenų struktūra); 

 Veiklos agentas. 
Duomenų srautų diagramų kalboje duomenų srautais vadi-

nami nustatytos struktūros duomenų perdavimo kanalai. 
Duomenų srautų pavidalu vyksta duomenų mainai tarp pro-

cesų, duomenų bazių ir išorinių agentų. Jais gali būti perduodami ir 

D 

2.7. Dalykinės srities duomenų srautų modeliavimas 
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nevienalytės struktūros duomenų paketai. Komandas ir visus kitus 
valdančiuosius duomenis duomenų srautais perduoti draudžiama. 

Duomenų srautai vaizduojami kryptį žyminčiomis rodyklėmis. 
Rodyklė rodo srauto kryptį. Ji žymima perduodamo srauto pavadi-
nimu arba jo santrumpa. 

Duomenų srautų diagramų kalboje procesais vadinamos gau-
namų duomenų srautų transformacijos, atliekamos pagal iš anksto 
žinomas taisykles. 

Procesas gali kurti naujus srautus, keisti gautų srautų struktūrą, 
kaupti tam skirtose saugyklose (duomenų bazėse) gautų srautų ele-
mentus arba kokiu nors būdu juos apdoroti. 

Procesai vaizduojami paženklintais apskritimais, kuriuose įra-
šomas proceso pavadinimas arba jo santrumpa. 

Duomenų srautų diagramų kalboje veiklos agentais vadinami 
modeliuojamos veiklos išorėje esantys reikalingų pradinių duomenų 
šaltiniai arba jos galutinių rezultatų vartotojai. 

Agentai rodo, iš kur ateina pradiniai modeliuojamos veiklos 
srautai ir kur siunčiami šios veiklos rezultatai. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.8 pav. Pagrindiniai duomenų srautų modelio komponentai 

1 agento 
pavadinimas 

1 proceso 
pavadinimas 

Duomenø bazës 
pavadinimas 

1 duomenø 
srauto 

pavadinimas 
 

2 proceso 
pavadinimas 

* 
 

3 duomenø srauto 
pavadinimas 

2 duomenø srauto 
pavadinimas 

2 agento 
pavadinimas 
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Duomenų srautų kalba turi ir tam tikrų procedūrinių elementų, 
t. y. srautų jungimo (konjunkcijos) ir išskyrimo (disjunkcijos) vaiz-
davimo galimybių. 

Jeigu reikia pavaizduoti kelis vienam procesui perduodamus 
duomenų srautus, kurie turi ateiti arba būti išsiųsti tuo pačiu metu, 
juos reikia pažymėti konjunkcijos (IR) ženklu (susieję srautų linijas 
lanku jį pažymime*). Konjunkcijos ženklas jungia kelis duomenų 
srautus, perduodamus procesui arba išsiunčiamus iš jo vienu metu. 

Skiriama griežtoji ir negriežtoji srautų disjunkcija. 
Griežtoji srautų disjunkcija (ARBA) žymima pliuso (+) ženklu. 

Jeigu šis ženklas jungia kelis duomenų srautus, tai reiškia, kad vienu 
metu procesas gali priimti arba siųsti tik vieną iš srautų. 

Negriežtoji srautų disjunkcija žymima # ženklu. Šis ženklas 
rodo, kad tuo pačiu metu procesas gali priimti arba perduoti bet kokį 
srautų derinį. 

 

 

2.7.1. Žodinis dalykinės srities  
          aprašymas 
 

Panagrinėsime, kaip sudaromas duomenų srautų modelis pa-
reiškimų ir pranešimų apie nusikaltimus tyrimo dalykinėje srityje. 
Pirmiausia susipažinsime su veiklos etapais. 

Policijos komisariato pareiškimų ir pranešimų apie nusikalti-
mus tyrimo procesai yra tokie: 

 Pareiškėjai pateikia raštiškus pareiškimus/pranešimus apie 
nusikaltimus ir perduoda juos budėtojų skyriui (pareiškėjai gali būti 
fiziniai, juridiniai asmenys bei pareigūnai). Pareiškimai taip pat prii-
mami paštu. Tokiu atveju jie atsiunčiami į komisariato sekretoriatą ir 
iš jo perduodami budėtojų skyriui. 

 Visi gauti pareiškimai registruojami įvykių registracijos 
knygoje, t. y. registracijos žurnale, ir įrašomi į registracijos (apskai-
tos) duomenų bazę. 

2.7. Dalykinės srities duomenų srautų modeliavimas 
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 Pirminį įvykio tyrimą organizuoja budėtojas. Jis atlieka nu-
kentėjusiojo pirminę apklausą, jeigu yra liudytojų, apklausia ir juos. 
Šio proceso metu surašomas paaiškinimų protokolas. 

 Į įvykio vietą siunčiama operatyvinė tardymo grupė. 

 Operatyvinė tardymo grupė ištiria įvykio vietą, surašo vie-
tos apžiūros protokolą: nubraižo įvykio schemą, fotografuoja, surašo 
patikslintos liudytojų apklausos duomenis. Apžiūros protokolo duo-
menys įrašomi į registracijos knygą. 

 Policijos komisariato padalinio vadovas, susipažinęs su nu-
sikaltimo bylos medžiaga, paveda įvykį ištirti (išnagrinėti) atitin-
kamam pareigūnui (tardytojui). Pavedimas vykdyti šį tyrimą ir parei-
gūno asmens duomenys įrašomi į registracijos knygą. 

 Budėtojas informuoja pareigūną. Pareigūnas (tardytojas), 
gavęs pavedimą tirti pareiškimą, pasirašo registracijos knygoje, pat-
virtindamas, kad jį gavo. Per tris dienas arba vėliausiai per 10 parų 
tardytojas, analizuojantis bylos medžiagą, priima vieną iš šių spren-
dimų: 

• Kelti baudžiamąją bylą; 
• Atsisakyti kelti baudžiamąją bylą; 
• Medžiagą perduoti tirti pagal teritorinį ar tarnybinį paval-

dumą. 
Priimtas sprendimas įrašomas į registracijos knygą. 
 
 

 

2.7.2. Pranešimų apie nusikaltimus tyrimo  
          duomenų srautų modelis 
 

Pagal žodinį dalykinės srities aprašymą (2.7.1. skyrius) suda-
romas duomenų srautų modelis (2.9 pav.). 
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2.9 pav. Pranešimų apie nusikaltimus tyrimo  
duomenų srautų modelis 

Atsakymas 

Klausimas 

+

# 

 
Pareiškėjas 

Pareiškėjas 

Registracija 
kom. sekretoriate 

Registracija 
budėtojų dalyje 

Budėtojų grupė 

Registracijos 
knyga Nr.1 DB registracijos 

knyga Nr.1 

Nukentėjusysis 

Įvykį matę 
liudytojai 

Vietos 
apžiūra 

Vietos apžiūros 
protokolas Apklausos 

protokolas 

Bylos tyrimas 

Kelti baudžia-
mąją bylą 

Medžiagą perduoti 
tirti pagal teritorinį 

pavaldumą 

Atsisakyti kelti 
baudžiamąją bylą 

Pirminis  
tyrimas 

2.7. Dalykinės srities duomenų srautų modeliavimas 



2 skyrius. INFORMACINĖS SISTEMOS 
 

54

 
2.8. IŠSKIRSTYTOSIOS INFORMACINĖS SISTEMOS 
 

idelės kompiuterinės sistemos projektuojant dažniausiai iš-
skirstomos, t. y. informacijos apdorojimo procesai išdalijami 

(išskirstomi) į keletą kompiuterių [6]. 
Lokaliai veikiančios vadinamosios personalinės sistemos nėra 

išskirstomos ir yra suprojektuotos veikti viename personaliniame 
kompiuteryje ar darbo stotyje. 

Įterptinės sistemos veikia viename procesoriuje arba integruo-
toje procesorių grupėje. 

Išskirstytų sistemų programinė įranga veikia laisvai integruo-
toje grupėje kartu veikiančių procesorių, sujungtų į bendrą visumą 
tinklu. 

Išskirstytosios sistemos pasižymi tokiomis savybėmis kaip: 
bendras išteklių naudojimas, jos yra gana atviros. Atsiranda galimy-
bių daugelį informacijos apdorojimo procesų vykdyti lygiagrečiai. 
Šie procesai yra: 

 Išteklių dalijimasis; 
 Atvirumas; 
 Lygiagretumas; 
 Galimybė išplėsti sistemos architektūrą; 
 Klaidų toleravimas. 

Norint įdiegti tokias sistemas dažniausiai reikia daugiaproceso-
rinės, kliento-serverio, objektų skirstymo architektūros, objekto už-
klausos tarpininkų ir pagrindinių CORBA standartų. CORBA yra 
tarptautinis standartas – tarpinė programinė priemonė, skirta išskirs-
tytų objektų bendravimui valdyti. 

Išskirstytos sistemos architektūrinio projektavimo procesas 
apima sistemos struktūros kūrimo etapą, kai sistema suskaidoma į 
keletą pagrindinių posistemių ir yra nustatomos šių posistemių ko-
munikavimo priemonės. Valdymo modeliavimas apima ryšių tarp 
skirtingų sistemos dalių valdymo modelius ir nustato modulinės si-
stemos dekompoziciją, kai nustatytos posistemės yra išskaidomos į 
skirtingose darbo stotyse veikiančius modelius. 

Architektūrinis projektavimas apima ankstyvąją sistemos pro-
jektavimo proceso stadiją, palaiko ryšį tarp specifikacijos ir projek-
tavimo proceso; jis dažnai vykdomas lygiagrečiai su kai kuriais spe-

D 
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cifikacijos veiksmais, kai nustatomos didesnės sistemos dalies kom-
ponentų identifikacijos ir jų bendravimo sąlygos. 

Sistemos architektūra susijusi su programinės įrangos spren-
dimais, nustatančiais sistemos architektūrinį, valdymo ir posistemių 
dekomponavimo modelius. Didelės sistemos retai kada paklūsta vie-
nam architektūriniam modeliui. Sistemos dekompozicijos modeliai 
gali turėti saugyklų, kliento-serverių ir abstrakčius mašinų modelius. 
Valdymo modeliai susideda iš centralizuoto valdymo ir valdymo 
procesų modelių. 

Srities architektūrinius modelius nusako modulinės dekompo-
zicijos modeliai, susidedantys iš duomenų srautų ir objektų bendra-
vimo modelių. Specialūs srities architektūriniai modeliai yra abst-
raktūs tam tikroje veiklos srityje veikiantys modeliai. Jie gali būti 
konstruojami abstrahuojant egzistuojančias sistemas arba idealizuo-
jant nurodomus modelius. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.10 pav. Išskirstytos kliento-serverio sistemos struktūros pavyzdys 
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Išskirstytųjų sistemų architektūros tipai gali būti grindžiami 
kliento-serverio arba išskirstytų objektų architektūra. Kliento-serve-
rio architektūros sistemose paskirstytas paslaugas kviečia klientai. 
Paslaugas teikiantys serveriai traktuojami skirtingai nei klientai, ku-
rie naudojasi paslaugomis. Išskirstytų objektų architektūros siste-
mose nėra skirtumo tarp klientų ir serverių. Bet kuris objektas siste-
moje gali tiekti ir naudotis kitų objektų paslaugomis. 

Programinė įranga, valdanti ir užtikrinanti skirtingų išskirsty-
tosios sistemos elementų darbą, yra sistemos viduje ir yra tarpinė si-
stemos darbo procesų dalis. Tarpinės programinės priemonės pa-
prastai yra standartizuotos. Programinės įrangos pavyzdžiai gali būti 
transakcijas vykdantys monitoriai, duomenų konverteriai, komunika-
vimo kontrolės priemonės. 

Kliento-serverio architektūroje taikomosios programos yra 
sumodeliuotos kaip aibė serverių tiekiamų paslaugų ir kaip aibė 
klientų, naudojančių šias paslaugas. Klientai žino, kokie yra serve-
riai, bet serveriai nebūtinai žino, kas yra jų klientai. Klientai ir serve-
riai yra kaip loginiai procesai visoje sistemoje. 

Taikomųjų programų architektūra turi tam tikrus lygmenis: 
 Vaizdavimo lygmuo, skirtas sistemos vartotojų skaičiavimo 
rezultatams vaizduoti ir vartotojo duomenims įvesti; 

 Taikomosios programos vykdymo lygmuo, skirtas progra-
mos specifinėms funkcijoms atlikti (pvz., tokios banko si-
stemos funkcijos kaip sąskaitos atidarymas, sąskaitos užda-
rymas ir t. t.). 
 Duomenų valdymo lygmuo, skirtas sistemos duomenų ba-
zėms valdyti. 

Išskirstytų objektų architektūroje tarp klientų ir serverių nėra 
skirtumų, t. y. kiekviena skirstoma esybė yra objektas, teikiantis pa-
slaugas kitiems objektams ir priimantis jas iš kitų objektų. Objektai 
bendrauja (komunikuoja) per tarpines programines priemones, vadi-
namas objekto užklausos tarpininkais (programinės įrangos magist-
ralė). Išskirstytų objektų architektūrą projektuoti dažniausiai yra su-
dėtingiau nei klientų-serverių sistemas. 

Išskirstytų objektų architektūros pranašumai pasireiškia tuo, 
kad sistemos projektuotojas gali atidėti sprendimą, kur ir kaip pa-
slaugos turėtų būti teikiamos. Tai atvira sistemos architektūra, lei-
džianti pagal reikalavimus prijungti naujus išteklius, ji yra lanksti ir 
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išplečiama. Išskirstytų objektų architektūros sistemoje galima dina-
miškai perskirstyti sistemos funkcijas ir objektus, migruojančius per 
tinklą pagal tam tikrus reikalavimus. 

Išskirstytų objektų architektūra gali būti naudojama: 
 Kaip loginis modelis, leidžiantis konstruoti ir organizuoti 
sistemą. Šiuo atveju yra galvojama, kaip pateikti programos 
funkcijas tiktai išreiškiant paslaugomis ir paslaugų deri-
niais; 
 Kaip lankstus metodas kliento-serverio sistemai įdiegti. 
Loginis sistemos modelis yra kliento-serverio modelis, bet 
ir klientai, ir serveriai yra realizuojami kaip išskirstyti ob-
jektai, susisiekiantys per programinės įrangos magistralę. 

 
 
 

2.9. INFORMACINIŲ SISTEMŲ KONTROLĖ IR  
       APSAUGA 
 

nformacinių sistemų, kaip ir kitų kompiuterinių sistemų, atžvilgiu 
dažniausiai atliekama bendroji ir taikomoji kontrolė. Žinoma, 

slaptai informacijai saugoti reikia užtikrinti ir papildomas duomenų 
saugos priemones. 

Bendroji kontrolė taikoma visoms kompiuterizuotoms siste-
moms. Ji vykdoma jau sistemos projektavimo metu ir apima progra-
minės bei techninės įrangos tikrinimą, garantuoja operacijų tikslumą, 
duomenų saugumą, administracinę tvarką. Jei bendroji kontrolė nėra 
taikoma, kompiuterinė sistema tampa nepatikima. 

Įdiegimo kontrolė vykdoma įvairiuose taškuose, siekiant įsiti-
kinti, kad sistemos kūrimo procesas yra tinkamai valdomas. Tikri-
nama programų kokybė, parengta dokumentacija. Sistemos galimy-
bės įvertinamos pagal formalią kainos/naudos metodiką. Kontrolė 
suteikia pagrindą pritarti (arba ne) sistemos diegimui. 

Sisteminių programų kontrolė apima operacinės sistemos dalis, 
kompiliatorius, failų, operacijų, įrašų tvarkymo ir kitų paslaugų pro-
gramas. Minėtosios programos tiesiogiai tvarko duomenis ir jų failus. 

Aparatūros kontrolė. Sistemos aparatūra turi būti fiziškai ap-
saugota ir prieinama tik asmenims, turintiems leidimus. Įėjimas į 
patalpas, kuriose yra kompiuterių, turi būti apribotas. Terminalai ir 

I
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mikrokompiuteriai, esantys kitose vietose, gali būti tik užrakina-
muose kambariuose. Kompiuterinė įranga turi būti apsaugota nuo 
gaisro, aukštos temperatūros, drėgmės. Jeigu kompiuterių darbas or-
ganizacijai ypač svarbus, numatomas jų avarinis dubliavimas, įsigy-
jama atsarginių elektros energijos šaltinių. 

Kompiuterio operacijų kontrolė padeda patikrinti, ar duomenų 
apdorojimo ir saugojimo operacijos vykdomos teisingai. Nenormalių 
operacijų baigmių atveju atliekamos atkūrimo procedūros, daromos 
atsarginės kopijos. Operacijų kontrolė apima ir rankines procedūras, 
skirtas surasti klaidas arba jų išvengti. Visi kompiuterių darbo sutri-
kimai turi būti fiksuojami ir analizuojami. 

Duomenų apsauga užtikrina failų informacijos laikmenose 
saugumą. Leistinas tik sankcionuotas duomenų įvedimas, atliekamas 
dalinis įvedamų duomenų patikrinimas. Duomenų saugumas gali būti 
užtikrinamas keliais lygiais: 

 Duomenų bazėmis gali naudotis tik asmenys, turintys lei-
dimą; 
 Tam tikromis programinėmis slaptumo priemonėmis yra 
apribojama prieiga prie kompiuterinių sistemų, saugančių 
svarbius duomenis (pvz., sisteminės programos tikrina 
slaptažodžius, identifikacinių kortelių duomenis ir pan.); 
 Duomenų bazėms apsaugoti taikomosiose programose nau-
dojami papildomi slaptažodžiai. 
 Siunčiami duomenys yra šifruojami, naudojami jų šifro rak-
tai, kriptogramos. 

Administracinė kontrolė – tai taisyklės, standartai ir procedū-
ros, užtikrinančios tinkamą kontrolės sistemą. Svarbiausia – funkcijų 
atskyrimas, kontrolės procedūros, priežiūra. 

Funkcijų atskyrimas yra fundamentalus bet kokios organizaci-
jos vidaus kontrolės principas. Darbo funkcijos turi būti paskirstytos 
taip, kad kuo labiau sumažintų klaidų ir savanaudiškų manipuliacijų 
organizacijos turtu tikimybę. Asmenys, atsakingi už operacinę si-
stemą, negali inicijuoti operacijų, keičiančių duomenis. Atsakomybė 
už įeigą, apdorojimą, išeigą paskirstoma skirtingiems žmonėms. In-
formacinių sistemų skyrius yra atsakingas už duomenų ir programų 
failus, o vartotojai – už duomenų įvedimą ir klaidų taisymą. 

Kontrolės procedūros apibūdina formalius informacinių si-
stemų operacijų tikrinimo standartus. Procedūros turi būti vadovų 
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oficialiai patvirtintos. Jose turi būti aiškiai apibrėžiama atsakomybė 
ir atskaitomybė. 

Personalo, dalyvaujančio atliekant kontrolės operacijas, prie-
žiūra užtikrina numatytą darbų eigą. Priežiūra padeda pastebėti trū-
kumus, ištaisyti klaidas ir nukrypimus nuo standartinių procedūrų. 
Be tinkamos priežiūros net ir geriausia kontrolės sistema gali būti 
neveiksminga. 

Taikomoji kontrolė kiekvienu atveju yra unikali. Kontrolė pa-
deda užtikrinti konkrečios programos įvedamų duomenų tikslumą, 
išsamumą, apsaugą. Ją sudaro įvedimo, apdorojimo ir išvedimo ope-
racijų kontrolė. 

Kontrolės sistemos sudėtingumas, joje naudojamos procedūros 
turi atitikti duomenų svarbą. Pavyzdžiui, finansiniai duomenys ap-
saugos požiūriu yra svarbūs, o studentų mokymo duomenys – mažiau 
svarbūs. Etalonų duomenys yra svarbesni už konkrečių matmenų 
objektus. Nevienodos svarbos duomenims taikytinos skirtingos kont-
rolės procedūros. 

Reta informacinė sistema naudoja visas minėtąsias kontrolės 
procedūras. Tai būtų brangu sukurti ir sudėtinga panaudoti. Sprendi-
mas kurti kontrolės sistemą turi būti pagrįstas kainos/naudos analize, 
įvertinant klaidų pasirodymo tikimybę. Reikia parinkti tokias kont-
rolės procedūras, kurios pakankamai apsaugotų sistemą ir nesuma-
žintų jos efektyvumo.  

2.9. Informacinių sistemų kontrolė ir apsauga 
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3.1. DUOMENŲ BAZĖS SAMPRATA 

 
ažniausiai duomenų bazė suprantama kaip kartu saugomų ir 
susijusių duomenų, skirtų apdoroti kompiuteriu, visuma. Duo-
menys atitinka tam tikros realaus pasaulio dalies (taikymo ar 

dalykinės srities), skirtos kompiuterizuoti, modelį [1; 7; 21]. 
Kita duomenų bazės samprata yra platesnė, ji apima ne tik 

tvarkingai saugomus duomenis, bet ir programinę įrangą, skirtą 
duomenų bazėms kurti ir įvairiais būdais apdoroti. 

Pagrindinis struktūrinis dalykinės srities vienetas yra esybė. 
Tai labai panašu į objektų klases objektinėje projektavimo metodi-
koje. Esybėmis vadinamos realaus pasaulio dalykų klasės, t. y. visa 
tai, ką galima apibūdinti bendriniais daiktavardžiais [6]. Projektuo-
jant duomenų bazes aptinkamos fizinės ir koncepcinės esybės. Fizi-
nės esybės – tai daiktai, reiškiniai, procesai, subjektai, agentai ir pan. 
Koncepcinės esybės – tai sąvokos, idėjos. Konkrečios esybės reali-
zacijos vadinamos esybių egzemplioriais. Nagrinėjant pavyzdį apie 
asmenis, asmuo yra esybė, konkretus asmuo Jonas Jonaitis yra jos 
egzempliorius. 

Kuriant informacines sistemas, dažniausiai domimasi ne viso-
mis konkrečios srities esybėmis, o tik tomis, kurios yra svarbios nag-
rinėjimo tikslais. Dažniausiai analizuojamos pagrindinės esybių ka-
tegorijos: 

 Asmenys (organizacijų darbuotojai, klientai, tiekėjai ir 
pan.); 
 Buvimo vietos (organizacijos, paslaugų tiekimo, gamybos, 
saugojimo vietos); 
 Kitos materialios esybės (gaminiai, nuosavybė, inventorius, 
finansinės sutartys, pajamos); 
 Teisinės ir kitos nematerialios esybės (veiklą reglamentuo-
jantys teisiniai aktai, intelektinė nuosavybė, organizacijos 
padalinių struktūra). 

Duomenų bazių pavyzdžiai: konferencijos dalyvių ir pateiktų 
straipsnių duomenų bazė, bibliotekos kartoteka, telefonų abonentų 
knyga, pirkėjų užsakymų registracijos žurnalas, gyventojų registras ir 
kita. 

D



3 skyrius. DUOMENŲ BAZĖS IR JŲ VALDYMO SISTEMOS 62

Duomenys saugomi ir apdorojami ne bet kaip, o laikantis tam 
tikrų susitarimų, taisyklių. Kitaip tariant, duomenys duomenų bazėje 
yra sutvarkyti tam tikru būdu. 

Duomenų bazė – tai struktūrizuota duomenų saugykla, kurioje 
saugomi duomenys ir informacija apie realius modeliuojamos daly-
kinės srities objektus, procesus, įvykius arba reiškinius. Duomenų 
bazė turi būti organizuojama taip, kad būtų patogu apdoroti ir valdyti 
tiek bendrą šios informacijos visumą, tiek atskiras jos dalis. 

Reiktų skirti vadinamąjį fizinį ir loginį duomenų organizavimą. 
Pirmasis nurodo duomenų fizinio išdėstymo kompiuterio atmintyje 
būdus, o antrasis – duomenų struktūros vaizdavimą – modelį, 
reikalingą vartotojams, projektuotojams. 

Kuriant duomenų bazes reikia laikytis tam tikrų reikalavimų: 
 Duomenys turi būti integruoti; 
 Duomenys turi būti organizuoti vengiant jų pertekliaus; 
 Turi būti laikomasi nepriklausomybės principo. 

Duomenų integruotumas reiškia, kad visi duomenys kaupiami 
ir saugomi kartu, nustačius jų tarpusavio ryšius. Taip saugomus 
duomenis dažniausiai naudoja ne vienas, o keli vartotojai. 

Nepertekliaus savybė nusako duomenų organizavimo princi-
pus, kai duomenys yra struktūrinami ir saugomi vengiant jų dublia-
vimo, kartojimosi. Šių tikslų pasiekiama tinkamai projektuojant lo-
ginį duomenų bazės modelį, kai duomenys išskaidomi į atskiras len-
teles, taikant duomenų normalizavimo principus. Šie principai nu-
sako duomenų struktūrinimo būdus, leidžiančius sutvarkyti duomenų 
bazę iki reikiamos normalinės formos. Išskiriamos pirma, antra, tre-
čia ir ketvirta (I, II, III ir IV) normalinės formos. Normalizuojant 
duomenis jie skaidomi į lenteles, lentelėms priskiriami duomenis sie-
jantys papildomi laukai. 

Turinti perteklių duomenų bazė yra neefektyvi, per didelė, 
operatyvioji paieška trunka daug ilgiau. Kai sukuriamos kelios duo-
menų kopijos, joms veltui eikvojama atmintis, o modifikuojant duo-
menis tenka kelis kartus naudoti tas pačias atnaujinimo operacijas. 
Be to, kai duomenų kopijos atitinka skirtingas atnaujinimo stadijas, 
tai gali lemti prieštaringos informacijos pateikimą. 

Duomenų nepriklausomybė reiškia, kad modifikuojant duo-
menis jų apdorojimo taikomosios programos nesikeičia. 
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Koncepcinis modelis projektuojamas neatsižvelgiant į konkre-
čių duomenų ir programinės įrangos versijas. 

 
 
 

3.2. KLASIKINIAI DUOMENŲ BAZIŲ MODELIAI  
 

agal tai, kokiu būdu duomenys jungiami į visumą, išskiriami 
pagrindiniai, šiuo metu vadinami klasikiniais, duomenų organi-
zavimo (tvarkymo) modeliai: reliacinis, hierarchinis, tinklinis. 

Populiarus tampa objektinis duomenų modeliavimas. Atsižvelgiant į 
tai, koks modelis naudojamas organizuojant duomenis, galima 
išskirti ir duomenų bazių rūšis: 

 Reliacinės duomenų bazės; 
 Tinklinės duomenų bazės; 
 Hierarchinės duomenų bazės; 
 Objektinės duomenų bazės. 

Pastaruoju metu bene populiariausios duomenų bazių valdymo 
sistemos, kuriose duomenys organizuojami pagal reliacinį modelį. 
Tokios bazės vadinamos reliacinėmis. 

 
 
3.2.1. Reliacinės duomenų bazės 
 
Reliacinės duomenų bazės – tai duomenų bazės, kuriose mo-

deliuojamos dalykinės srities esybės išreiškiamos lentelėmis ir jų ry-
šiais. 

Reliacinė duomenų bazė yra tokia duomenų visuma, kurioje 
informacija (duomenys) saugoma dvimatėse lentelėse [1]. Lentelę 
sudaro eilutės ir stulpeliai, taigi lentelės forma yra įprasta ir supran-
tama vartotojui. Lentelės eilutės vadinamos įrašais, jie atitinka konk-
rečias objektų klasės egzempliorių parametrų reikšmes. Stulpeliai 
vadinami laukais (kortedžais, domenais). Laukams suteikiami pava-
dinimai (pvz., Užsakymo numeris, Pirkėjo kodas ir pan.), atitinkantys 
objektų klasės parametro semantinę prasmę. Reliacinės duomenų ba-
zės modelis turi tenkinti reliacinės algebros reikalavimus. 

P

3.2. Klasikiniai duomenų bazių modeliai 
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Bet kurios eilutės ir bet kurio stulpelio sankirtoje įrašomas 
konkretus duomuo, atitinkantis jo semantiką (t. y. prasmę). Stulpelio 
ir eilutės sankirtoje (ląstelėje) gali būti įrašyta tik viena duomenų 
elemento reikšmė, o ne reikšmių rinkinys. 
 
 
 
 
 
Užsakymo 
numeris 

Pirkėjo 
kodas 

Prekės kodas Užsakymo data Užsakyta
s kiekis 

101 1 – 12693 KC9872 2004 01 26 210 
252 3 – 87022 MB3300 2004 04 27 2 
541 3 – 87022 CN9872 2004 01 28 15 
008 3 – 87022 AL2599 2004 06 29 20 
105 1 – 05376 DA1832 2005 01 29 5 
206 2 – 91633 DC9872 2004 02 30 41 
547 2 – 91634 DB6633 2004 11 30 120 
 
 
 
 
 

3.1 pav. Užsakymų registracijos žurnalo duomenų bazės elementai 
 
 

Reliacinėse duomenų bazėse kiekviena lentelė turėtų būti ku-
riama laikantis tam tikrų reikalavimų: 

 Laukuose turi būti saugomi vienarūšiai duomenys, t. y. 
kiekvieno lauko reikšmės turi būti vieno tipo. Tačiau skir-
tinguose laukuose gali būti įvairių tipų duomenys. 
 Visi įrašai turėtų būti vienodai organizuoti. 
 Lentelėje negali būti tuščių arba identiškų įrašų, t. y. įrašų, 
kurių visi duomenys kartojasi, nors atskiri duomenų ele-
mentai gali būti tušti arba kartotis. 

 Įrašų ir laukų išdėstymo tvarka lentelėje nėra svarbi.  
Atliekant duomenų apdorojimo operacijas lentelės eilutės ir 

stulpeliai gali būti peržiūrimi bei redaguojami bet kokia tvarka. 

Įrašas 
Laukas 

Lauko pavadinimas 

Duomenų elementas 
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Lentelės pavadinamos prasminiais vardais (arba jų trumpi-
niais). Laukų, priklausančių pirminiam raktui (raktai yra laukai arba 
laukų grupės, kurių įgyjamos reikšmės nesikartoja), vardai pabrau-
kiami. Toks užrašas vadinamas lentelės schema. Pavyzdžiui, Užsa-
kymo registracijos lentelės schema gali būti aprašoma taip: 

Užsakymai (užsakymo numeris, pirkėjo kodas, prekės kodas, 
užsakymo data, užsakytas kiekis). 

Reliacinėje duomenų bazėje lentelės gali būti siejamos tarpu-
savyje. Ryšį tarp atskirų lentelių nustato bendri, sutampantys tų len-
telių laukai, dar vadinami siejančiaisiais laukais. Taip susietų lentelių 
visuma ir apibrėžia reliacinį modelį. Kitaip negu rodykliniuose 
duomenų modeliuose, kuriuose ryšiams iliustruoti naudojamos ro-
dyklės, reliaciniame modelyje nėra atskirų elementų ryšiams vaiz-
duoti – jie išreiškiami lentelėse (siejančiais laukais ir jų ryšiais). Šie 
siejantys laukai tampa pertekliniais, tačiau jie yra reikalingi. Pertek-
liniai laukai dažniausiai įvedami dėl dviejų priežasčių: 

a) Daliai lentelių reikalingi laukai, skirti suformuoti pirminius 
raktus, t. y. vienareikšmius lentelių įrašų identifikatorius; 

b) Kai kurioms lentelėms reikalingi laukai, kurie nėra pirmi-
niai raktai (ar jų dalis), bet naudojami nustatyti ryšiams. 

Pagal ryšio kardinalumo apribojimų rūšis skiriami trijų rūšių 
ryšių apribojimai – vienas su vienu (one-to-one), vienas su daugeliu 
(one-to-many), daugelis su daugeliu (many-to-many). 

Tačiau dažniausiai duomenų bazių valdymo sistemos leidžia 
išreikšti tik du pirmuosius kardinalumo apribojimo tipus. Todėl pro-
jektuojant loginį modelį reikia atsižvelgti į šiuos apribojimus. 

Bet kurią duomenų struktūrą galima vaizduoti tiek rodyklių, 
tiek lentelių forma. 

 
 

3.2.2. Hierarchinis duomenų modelis 
 
Hierarchinės duomenų bazės – tai tokios duomenų bazės, ku-

riose dalykinės srities esybės sudaro hierarchinę struktūrą (pvz., me-
dis). 

Pagrindinis hierarchinių duomenų bazių trūkumas – ribota 
prieiga prie saugomų esybių (pvz., norint rasti esybę D1, reikia žinoti 
A0, B0 ir C1) reikšmes.  

3.2. Klasikiniai duomenų bazių modeliai 
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3.2 pav. Hierarchinės duomenų bazės modelis,  
išreiškiamas medžio tipo struktūra 

 
 
3.2.3. Tinklinis duomenų modelis 
 

Tinklinės duomenų bazės – tai tokios duomenų bazės, kuriose 
dalykinės srities esybės sudaro tinklinę duomenų struktūrą (pvz., to-
kią struktūrą gali išreikšti orientuotas grafas, kai rodyklės turi kryptį, 
arba tinklas). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.3 pav. Tinklinės duomenų bazės pavyzdys.  
Duomenų bazė sudaryta pasitelkiant kryptinį grafą 

A0

B0 B1

C0 C1 C2 C3 C4

D0 D1
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G H
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Pagrindinis tinklinių duomenų bazių trūkumas – ribota prieiga 
prie saugomų esybių. Pranašumas – galima sudaryti tokius ryšius, 
kurie geriausiai išreikštų esybių paieškos tikimybę. 
 
 
 
3.3. RELIACINIŲ DUOMENŲ BAZIŲ  
       PROJEKTAVIMAS 
 

uomenų bazės projektavimo rezultatas yra loginė duomenų ba-
zės struktūra. Sprendžiant šį uždavinį ieškoma kuo geresnio re-
zultato, kad duomenų bazė turėtų kiek galima daugiau gerų 

savybių. Duomenų bazės struktūros kokybei įvertinti gali būti 
taikomi formalūs metodai, padedantys kuo optimaliau suprojektuoti 
duomenų bazės struktūrą. 

Reliaciniame modelyje duomenys pateikiami lentelėmis. Ma-
tematikoje lentelę atitinka santykis (angl. relation). Lentelės stulpe-
liai gali būti vadinami atributais arba parametrais. Duomenų bazių 
terminologijoje jie vadinami laukais. Stulpelis turi turėti prasminį 
pavadinimą – tai atributo pavadinimas. Visų leistinų stulpelio reikš-
mių aibė vadinama domenu pavadinimas. 

Reliacinio modelio kūrimo procesas susideda iš keleto žings-
nių, kuriuos labai svarbu taisyklingai atlikti: 

 Identifikuoti visus atributus, kurie bus naudojami kuriamoje 
duomenų bazėje. 

 Identifikuoti atitinkamus esybių tipus, kuriems bus sudaro-
mos lentelės su tam tikrais atributais (išskirtais laukais), 
taikant taisykles, leisiančias minimizuoti duomenų dublia-
vimą ir išvengti pertekliaus (šiam tikslui taikomos priemo-
nės vadinamos normalizacija). 

 Identifikuoti lentelių ryšius, kurie pagal prasmę sujungs 
atributus, išskirtus reikiamuose esybių tipuose. Tai atlie-
kama pažymint, kuris iš kiekvienos lentelės atributų yra 
jungiamasis elementas. Kiekvienas jungiamasis atributas 
vaizduos vieną ryšio „vienas su daugeliu“ galą. 

Pateiktieji atributai, esybių tipai ir ryšiai sudarys panašaus 
pobūdžio kaip esybių modelis reliacinio modelio diagramą. Šiuos du 

D

3.3. Reliacinių duomenų bazių projektavimas 
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modelius būtų galima palyginti ir pasirinkti tokį, kuris atspindėtų 
geriausias savybes. 

Norint nustatyti geriausią duomenų modelio, kuris tinkamiau-
siai atspindėtų sistemos veiklos reikalavimus, struktūrą, įvertinama 
esybių tipų pasirinkimo kokybė, nustatomi optimalūs išskiriamų 
laukų ilgiai, įvertinami kiekvienos lentelės įrašų kiekiai, taigi pro-
jektas yra tobulinamas, modelis koreguojamas. 

Duomenų bazė turėtų būti projektuojama laikantis duomenų 
vientisumo principų, optimaliai išnaudojant užimamą kompiuterinę 
atmintį, vengiant duomenų pertekliaus, duomenų atnaujinimo ano-
malijų ir kitų problemų. Aptarsime pagrindines problemas, pasitai-
kančias projektuojant duomenų bazes. 

 Duomenų perteklius – tai duomenų pasikartojimas, dub-
liavimas duomenų bazėje. 

 Duomenų vientisumas – duomenų suderinimas (tikslumas ir 
neprieštaringumas) duomenų bazėje. 

 Atnaujinimo anomalija – duomenų tarpusavio prieštaravi-
mas dėl duomenų pertekliaus ir dalinio atnaujinimo. 
 Pašalinimo anomalija – nenumatytas duomenų praradimas 
dėl kitų duomenų šalinimo. 
 Įvedimo anomalija – kai neįmanoma įvesti duomenų dėl 
kitų duomenų nebuvimo. 

Duomenų vientisumo sąlygos – tai vartojamų sąvokų (katego-
rijų), nuorodų vientisumo, funkcinių ryšių ir pan. reikalavimai. 

Reliacinėje lentelėje eilutės dažniausiai yra konkrečių realaus 
pasaulio objektų (esybių, asociacijos ryšių) atvaizdai. Duomenų 
vientisumo reikalavimai siejasi su lentelės rakto sąvoka ir viena-
reikšmiška objektų identifikacija. Norėdami duomenų bazėje rasti 
duomenų apie konkretų objektą (egzempliorių), turime žinoti rakto 
reikšmes. Objektas neturi reikšmės duomenų bazėje, jei bent viena 
rakto atributo reikšmė yra nežinoma. Todėl pagal sąvokų (kategorijų) 
vientisumo reikalavimą joks lentelės rakto atributas nė vienoje 
eilutėje negali turėti tuščios (NULL) reikšmės. 

Kitame skyriuje detaliau aptarsime, kaip suprantamas duo-
menų bazės raktas. 
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Nuorodų vientisumo reikalavimas gali būti formuluojamas 
taip: kiekvieno išorinio rakto reikšmė duomenų bazėje turi sutapti su 
viena pirminio rakto reikšme lentelėje, kurią nurodo išorinis raktas. 

 
 
3.3.1. Duomenų bazės rakto samprata 
 
Kad lentelėje saugomus duomenis būtų galima vienareikšmiš-

kai identifikuoti, įvedama rakto sąvoka. 
Raktas – tai minimali atributų aibė, vienareikšmiškai apibrė-

žianti kiekvieno atributo reikšmę eilutėje (t. y. konkretų lentelės 
įrašą). Lentelės L raktu vadinamas toks jos atributų aibės poaibis R, 
kurio: 

 Rakto atributų reikšmės vienareikšmiškai apibrėžia visų 
lentelės L atributų reikšmes, t. y. dviejų skirtingų lentelės 
eilučių visų rakto aibės R atributų reikšmės negali sutapti 
(vienareikšmiška identifikacija). 
 Nė vienas rakto atributų aibės R poaibis neturi turėti viena-
reikšmiškos identifikacijos (pertekliaus nebuvimas). 

Norėdami geriau suprasti rakto funkciją duomenų bazėje, pa-
nagrinėkime Asmenų lentelę. Šioje lentelėje saugomi duomenys ati-
tinka realaus pasaulio asmenų klasės egzempliorius. Būna tokių at-
vejų, kai du skirtingi asmenys turi tą pačią pavardę ir vardą, pavyz-
džiui, Jonaitis Jonas šioje lentelėje gali kartotis. Tačiau duomenų ba-
zėje turime atskirti šiuos du skirtingus asmenis (t. y. jų įrašus lente-
lėje Asmenys). Siekiant vienareikšmiškai identifikuoti reikiamą rea-
lybės vienetą, projektuojant duomenų bazę reikia turėti raktą, kuris 
vienareikšmiškai nusakytų konkretų realybės objektą. Tokiu atveju 
skirtingi tikrovės objektai, turintys tą patį pavadinimą, bus atskiriami 
ir duomenų bazėje. Duomenų lentelės raktas gali būti vienas atributas 
arba kelių atributų derinys. 

Renkantis raktą, kuris vienareikšmiškai identifikuotų įrašus 
Asmenų lentelėje, galimi keli būdai: 

 Raktas gali būti kelių laukų (parametrų), pavyzdžiui, trijų 
laukų derinys {Vardas, Pavardė, Gimimo data}; 
 Raktas gali būti vienas laukas, tačiau tada jis turi 
vienareikšmiškai nusakyti kiekvieną esybę, pavyzdžiui, pa-

3.3. Reliacinių duomenų bazių projektavimas 
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pildomai įvestas laukas, nurodantis asmens tabelio numerį, 
asmens kodą, arba tiesiog identifikatorius (ID). Konkreti šio 
lauko reikšmė vienareikšmiškai nurodys reikiamą egzemp-
liorių. 

Laukas ID gali būti nurodomas kaip Asmenų lentelės raktas. 
Pasirinkti raktą, sudarytą iš keleto atributų, yra gana sudėtinga 

ir kai kuriose duomenų bazių valdymo sistemose tai nėra atliekama. 
Todėl lengviau nurodyti vieną atributą ir jį naudoti kaip raktą, kuris 
vienareikšmiškai identifikuotų reikiamą lentelės įrašą. 

Raktas, kurį sudaro daugiau nei vienas atributas, vadinamas 
sudėtiniu raktu. 

Lentelėje gali būti keli atributų rinkiniai, turintys rakto savybę. 
Jie vadinami galimais raktais. Raktas, kuriuo lengviau ir paprasčiau 
naudotis, pažymimas pirminiu raktu. Kiti raktai yra antriniai. 

 

3.3.2. Duomenų bazės struktūros normalizacija 
 
Norint taisyklingai suprojektuoti reliacinę duomenų bazę, rei-

kia laikytis normalizacijos principų. 
Normalizacija – tai procesas, leidžiantis laikantis tam tikrų 

taisyklių išskaidyti duomenis į lenteles, siekiant supaprastinti ryšius, 
išvengti duomenų dubliavimosi, išlaikyti duomenų vientisumą. Nor-
malizacija leidžia reliacinėms lentelėms suteikti standartinį pavidalą, 
išvengiant nesklandumų, kurių atsiranda dėl neteisingo duomenų ba-
zės projektavimo. 

Lentelių skaidymu vadinamas lentelės padalijimas į kelias 
lenteles, siekiant išvengti anomalijų ir neprarasti duomenų vienti-
sumo. 

Taigi panagrinėkime duomenų normalizacijos procesą. Daž-
niausiai duomenų bazės lentelių struktūra projektuojama išskiriant 
pirmą (1 NF), antrą (2 NF), trečią (3 NF) ir ketvirtą (4 NF) normali-
nes formas. 

 
3.3.3. Pirma normalinė forma  
 
Pirma normalinė forma – tai tokia duomenų išskaidymo į at-

skiras lenteles forma, kai visos atributų reikšmės yra atomai. 
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Atomu laikoma reikšmė, kuri nėra nei aibė, nei sąrašas, t. y. 
atomo reikšmės nesudaro tokių junginių, kurie gali būti išreiškiami 
aibėmis, pasikartojančiomis grupėmis ar sąrašais. 

Kitais žodžiai tariant, pirma normalinė forma – tai toks lentelių 
skaidymo būdas, kai konkretus kiekvieno lauko duomuo (reikšmė) 
nesudaro aibės. 

Pirmos normalinės formos (1 NF) reikalavimas duomenų bazės 
lentelėms yra per silpnas, kad lentelių schemą būtų galima laikyti 
suprojektuota pakankamai gerai. Todėl nagrinėjamos ir aukštesnės 
eilės normalinės formos. Kuo aukštesnė normalinė forma, tuo didesni 
reikalavimai keliami duomenų bazės schemai. 

Aukštesnėms normalinėms formoms apibrėžti naudojama 
funkcinio ryšio sąvoka. Jo esmė – vienų atributų reikšmės eilutėje 
turi vienareikšmiškai apibrėžti kitų atributų reikšmes. 

Projektuojant duomenų bazę pirmiausia identifikuojami atri-
butai. Nustatant išskiriamų parametrų sąrašą taikoma keletas stan-
dartizuotų veiksmų. 

 
 
Pardavimo važtaraštis 
 
Važtaraščio Nr. 

 

 
Pirkėjo Nr. 

 

 
Pirkėjo vardas 

 

 
 
 
 
 
 
 
Pirkėjo adresas 
  

Pirkėjo pavardė 
 

 
  

Važtaraščio data 
 

 
 
Prekės 
Nr. Prekės pavadinimas Kiekis 

   
   
   
   

 
3.4 pav. Važtaraščio pavyzdys 
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Projektuojant duomenų struktūros pirmą normalinę formą (1 
NF) taikoma taisyklė, įvedanti esybių tipų sąrašo sudarymo apribo-
jimus, t. y. esybės tipui (lentelei) negalima priskirti tokių atributų, dėl 
kurių esybės (sinonimai – objektas, įrašas) toje pačioje lentelėje 
kartotųsi. 

Panagrinėkime konkretų pavyzdį – važtaraščių apskaitos duo-
menų bazės schemos sudarymą. 

Pavyzdžiui, esybės tipo Pardavimo važtaraštis visi atributai, 
susiję su konkrečių prekių pardavimu, gali pasireikšti keletą kartų. 
Suprantama, kad pirkėjas, kurio važtaraštis pildomas, gali pirkti daug 
skirtingos rūšies prekių. 

Funkcinio ryšio terminais, jeigu atributas keletą kartų kartojasi 
toje pačioje esybės lentelėje, negalima nurodyti, kad bus rasta tik 
viena kiekvieno rakto reikšmė. Dėl šios priežasties kartojimąsi le-
miančius parametrus skaidome į lenteles. 

 
Dokumentas Pardavimo važtaraštis 

Nenormalizuota 
forma 

Pirma 
normalinė 
forma 

Antra 
normalinė 
forma 

Trečia 
normalinė 
forma 

Važtaraščio Nr. 
Pirkėjo Nr. 
Važtaraščio data 
Pirkėjo vardas 
Pirkėjo pavardė 
Pirkėjo adresas 
Prekės Nr. 
Prekės pavadinimas 
Prekių kiekis 
 

   

    
 

3.5 pav. Pardavimo važtaraščio atributų identifikacija  
prieš sudarant normalines formas 

 

Taigi normalizacija reikalauja, kad sudarant pirmos normalinės 
formos esybių tipų sąrašą būtų pašalintos visos grupės (lauko 
reikšmių aibės arba sąrašai). 
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Pardavimo važtaraščio struktūrą projektuojant į duomenų ba-
zės struktūrą, pirmiausiai taikoma pirmos normalinės formos suda-
rymo taisyklė, pagal kurią atributų sąrašas (3.6 pav.) skaidomas į dvi 
lenteles. Vienoje yra grafos Važtaraščio Nr.; Pirkėjo Nr.; Važtaraš-
čio data; Pirkėjo vardas; Pirkėjo pavardė; Pirkėjo adresas; kitoje – 
Važtaraščio Nr.; Prekės Nr.; Prekės pavadinimas; Prekių kiekis (3.6 
pav.). Lentelių pirminiai raktai pabraukti. 
 
Dokumentas Pardavimo važtaraštis 

Nenormalizuota 
forma 

Pirma  
normalinė 
forma 

Antra 
normalinė 
forma 

Trečia 
normalinė 
forma 

Važtaraščio Nr. 
Pirkėjo Nr. 
Važtaraščio data 
Pirkėjo vardas 
Pirkėjo pavardė 
Pirkėjo adresas 
Prekės Nr. 
Prekės 
pavadinimas 
Prekių kiekis 
 
 

Važtaraščio Nr. 
Pirkėjo Nr. 
Važtaraščio data 
Pirkėjo vardas 
Pirkėjo pavardė 
Pirkėjo adresas 
 
 
 
 
Važtaraščio Nr. 
Prekės Nr. 
Prekės 
pavadinimas 
Prekių kiekis 
 

  

    
 

3.6 pav. Pirmos normalinės formos sudarymas 
 
 

3.3.4. Antra normalinė forma 
 
Antrą ir trečią normalines formas riboja funkcinė priklauso-

mybė. Jos rodo ryšius tarp raktinių ir neraktinių atributų. 
Funkcinė priklausomybė (FP) – vieno atributo reikšmė korte-

dže (stulpelyje) vienareikšmiškai apibrėžia kito atributo reikšmę.  

3.3. Reliacinių duomenų bazių projektavimas 
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Funkcinės priklausomybės F ryšio kairiosios dalies atributai 
vadinami determinantu. Determinantas – tai atributai, kurių reikšmės 
apibrėžia kitų atributų reikšmes. Funkcinio ryšio sąvoka yra sąvokos 
lentelės visraktis apibendrinimas. 

Lentelė L(R) yra antros normalinės formos (2 NF) f sąryšių ai-
bės F atžvilgiu, jeigu ji yra pirmos normalinės formos ir kiekvienas 
jos nepirminis atributas visiškai priklauso nuo kiekvieno lentelės L 
rakto R. 

Antra normalinė forma – toks atributų sąrašo išskaidymas, kai 
kiekvienas neraktinis atributas funkciškai priklauso nuo viso rakto 
(visų raktinių atributų), t. y. negali priklausyti nuo rakto dalies (vieno 
iš rakto atributų). 
 
Dokumentas Pardavimo važtaraštis 

Nenormalizuota 
forma 

Pirma  
normalinė 
forma 

Antra 
normalinė 
forma 

Trečia 
normalinė 
forma 

Važtaraščio Nr. 
Pirkėjo Nr. 
Važtaraščio data 
Pirkėjo vardas 
Pirkėjo pavardė 
Pirkėjo adresas 
Prekės Nr. 
Prekės 
pavadinimas 
Prekių kiekis 
 

Važtaraščio Nr. 
Pirkėjo Nr. 
Važtaraščio data 
Pirkėjo vardas 
Pirkėjo pavardė 
Pirkėjo adresas 
 
 
 
 
Važtaraščio Nr. 
Prekės Nr. 
Prekės 
pavadinimas 
Prekių kiekis 
 

 
 
 
 
 
 
 
 
 
 
Važtaraščio Nr. 
Prekės Nr. 
Prekių kiekis 
 
 
Prekės Nr. 
Prekės 
pavadinimas 
 

 

    
 

3.7 pav. Antros normalinės formos sudarymas 
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Kad duomenų struktūra tenkintų antros normalinės formos rei-
kalavimus, vykdomi keli skaidymo etapai: 

 Sukuriama nauja lentelė, kurios atributai yra pradinės lente-
lės atributai, netenkinantys funkcinės priklausomybės są-
lygų. Funkcinės priklausomybės determinantas tampa nau-
jos lentelės raktu. 
 Atributas, esantis dešinėje FP pusėje, išmetamas iš pradinės 
lentelės.  
 Jeigu yra daugiau negu viena FP, pažeidžianti 2 NF, tai pir-
mieji du etapai kartojami esant kiekvienai papildomai FP. 
 Jeigu vienas determinantas turi kelias FP, tai visi nuo jo 
funkciškai priklausantys atributai surašomi kaip neraktiniai 
atributai į lentelę, kurios raktas bus determinantas. 

Važtaraščio duomenų bazės struktūros sudarymo pavyzdyje 
antra normalinė forma sudaroma taip, kaip pavaizduota 3.7. pav. 
 
 

3.3.5. Trečia normalinė forma 
 
Lentelė L(R) yra trečios normalinės formos (3 NF) f sąryšių 

aibės F atžvilgiu, jeigu ji yra 1 NF ir nėra pirminių atributų, tranzity-
viai priklausančių nuo rakto. 

Trečia normalizacijos taisyklė nurodo, kad ne tik kiekvienas 
atributas turi būti priklausomas nuo rakto, bet jis taip pat neturi 
funkciškai priklausyti nuo kitų sąrašo atributų. 

Yra ir kitas 3 NF kriterijus, bet jis logiškai yra silpnesnis. Šis 
kriterijus teigia, kad lentelė tenkina 3 NF, jeigu ji neturi tranzityvinių 
priklausomybių. 

Tranzityvinė priklausomybė atsiranda, kai neraktinis atributas 
funkciškai priklauso nuo vieno ar daugiau neraktinių atributų. 

Trečios normalinės formos aprašymo pradininkai yra Boisas ir 
Koddas [5], todėl ši forma kartais literatūroje dar vadinama Boiso-
Koddo normaline forma. 

Taikant Boiso-Koddo kriterijų atsižvelgiama į šiuos atvejus: 
 Neraktinis atributas priklauso nuo raktinio atributo, įeinan-
čio į sudėtinį raktą (pažeidžia 2 NF kriterijų); 

3.3. Reliacinių duomenų bazių projektavimas 
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 Raktinis atributas, įeinantis į sudėtinį raktą, priklauso nuo 
neraktinio atributo.O tai reiškia, kad tenkinama ir tranzi-
tyvinės priklausomybės sąlyga. 

Trečios normalinės formos sudarymo pavyzdys pateikiamas 
3.8 pav. 

 
Dokumentas Pardavimo važtaraštis 

Nenormalizuota 
forma 

Pirma  
normalinė 
forma 

Antra 
normalinė 
forma 

Trečia 
normalinė 
forma 

Važtaraščio Nr. 
Pirkėjo Nr. 
Važtaraščio data 
Pirkėjo vardas 
Pirkėjo pavardė 
Pirkėjo adresas 
Prekės Nr. 
Prekės pavadinimas 
Prekių kiekis 
 

Važtaraščio Nr. 
Pirkėjo Nr. 
Važtaraščio data 
Pirkėjo vardas 
Pirkėjo pavardė 
Pirkėjo adresas 
 
 
 
 
Važtaraščio Nr. 
Prekės Nr. 
Prekės pavadinimas 
Prekių kiekis 
 

 
 
 
 
 
 
 
 
 
 
Važtaraščio Nr. 
Prekės Nr. 
Prekių kiekis 
 
 
Prekės Nr. 
Prekės 
pavadinimas 
 

Važtaraščio Nr. 
Pirkėjo Nr. 
Važtaraščio data 
 
 
Pirkėjo Nr. 
Pirkėjo vardas 
Pirkėjo pavardė 
Pirkėjo adresas 
 
 

    
 

3.8 pav. Trečios normalinės formos sudarymas 
 
 

3.3.6. Ketvirta normalinė forma 
 
Ketvirtajai normalinei formai apibrėžti funkcinio ryšio sąvokos 

nepakanka. Tam įvedama funkcinį ryšį apibendrinanti daugiareikš-
mio ryšio sąvoka.  
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Sudarant ketvirtą normalinę formą, atributų išskaidymas į len-
teles turi tenkinti 3 NF ir nepriklausyti daugeliui reikšmių. 

Lentelės, turinčios 1 NF, reikšmės negali būti reikšmių aibė. 
Bet yra daug modeliavimo situacijų, reikalaujančių, kad atributo 
reikšmė būtų aibė. Pavyzdžiui, universiteto dėstytojas dėsto kelis 
dalykus ir dalyvauja keliose komisijose. Yra keletas tokio pavyzdžio 
realizavimo reliacinėje duomenų bazėje būdų, tai minimalaus įrašų, 
turinčių tuščias reikšmes, skaičiaus užtikrinimas, sąrašinių reikšmių 
likvidavimas. 

 
 
 

3.4. DUOMENŲ BAZIŲ VALDYMO SISTEMOS 
 
uomenų bazės valdymo sistema (DBVS) vadinama programinė 
įranga, skirta duomenų bazėms kurti, saugoti ir įvairiais būdais 
apdoroti.  
Svarbiausios duomenų bazių valdymo sistemų funkcijos yra šios: 

 Duomenų bazės struktūros projektavimas; 
 Duomenų bazės pildymas, kaupimas, redagavimas; 
 Naršymas ir judėjimas duomenų bazėje; 
 Duomenų peržiūra, paieška, rikiavimas ir kitas tvarkymas; 
 Taikomųjų vartotojo programų kūrimas; 
 Ataskaitų kūrimas. 

Bet kurią DBVS sudaro priemonės duomenų bazės struktūrai 
projektuoti, duomenims įvesti, papildyti ir modifikuoti. Šiuolaikinė 
DBVS suteikia vartotojui galimybes lengvai surasti ir atrinkti reika-
lingus duomenis pagal vieną ar kelis kriterijus, juos rikiuoti, gru-
puoti, vaizduoti pageidaujama forma. Tam tikrais laiko tarpais su-
kauptą informaciją reikia apibendrinti, atlikti jos analizę, vykdyti 
matematinius, statistinius skaičiavimus ir kurti įvairių formų ata-
skaitas. Vartotojai prireikus rašo bei derina savas taikomąsias pro-
gramas, naudodamiesi tam tikromis DBVS priemonėmis. DBVS turi 
atlikti ir daug kitų svarbių funkcijų: duomenų apsaugą, jų tikslumo, 
neprieštaringumo ir išsamumo kontrolę, išsaugoti DB kopijas ir kt. 

Daugelį šiuolaikinių DBVS sudaro tokios dalys: 
 Duomenų tvarkymo dialoginė aplinka;  

D 

3.4. Duomenų bazių valdymo sistemos 
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 Duomenų aprašymo ir manipuliavimo jais kalba; 
 Programų generatoriai. 

Dialoginė aplinka yra viena svarbiausių šiuolaikinių DBVS 
dalių. Ji skirta interaktyviam darbui su DBVS atliekant veiksmus su 
visa DB arba atskirais įrašais. Šiuolaikinės dialoginės aplinkos sutei-
kia vartotojui galimybę pasirinkti jam priimtiniausią darbo su DB 
stilių. Galimi keli darbo su DB būdai: 

 Grafinių, vizualių priemonių panaudojimas; 
 Specialios instrukcijos ir kt. 

Operacijoms atlikti naudojamas užklausų mechanizmas. Už-
klausos rezultatas – tai arba pagal tam tikras sąlygas atrinkti duome-
nys, arba tam tikri pakeitimai lentelėje. Duomenų bazės užklausos 
formuojamos specialia struktūrizuota užklausų kalba. Reliacinėse 
duomenų valdymo sistemose naudojama struktūrizuota užklausų 
kalba SQL (Structured Query Language). 

Kita duomenų bazių valdymo sistemų funkcija – duomenų 
administravimas (duomenų apsauga nuo neteisėto panaudojimo, di-
delio vartotojų skaičiaus, duomenų vientisumo palaikymas). 

Duomenų bazių valdymo sistemas (toliau – DBVS) sąlygiškai 
galima suskirstyti į tokias kategorijas: 

 Lokaliosios DBVS (pvz., MS Access, Paradox); 
 Nuotolinės kliento-serverio (angl. client-server) DBVS 
(pvz., My SQL, Sybase, Oracle, InterBase). 

Duomenų bazės vadinamos lokaliomis, kai duomenys, jų bazių 
valdymo sistema ir klientams skirta darbo su duomenimis dalis yra 
tame pačiame kompiuteryje. Paprastai tokią duomenų bazę sudaro 
vienas failas (pvz., MS Access valdo failus, kurių plėtinys yra 
*.mdb). Tokios architektūros duomenų bazės netinka 
išskirstytosioms informacinėms sistemoms realizuoti.  

Grafiniai instrumentai pagal savo veikimo principą skirstomi į 
projektavimo, dizaino, žynio-patarėjo ir meniu funkcijas atliekančias 
sistemas. Projektavimo sistemos suteikia galimybę vartotojui pačiam 
laisvai pasirinkti, ką ir kaip projektuoti. Meistrai ir meniu sistemos 
leidžia iš pateikiamų galimų veiksmų sąrašų (meniu) išsirinkti rei-
kiamas komandas, o vartotojui telieka patvirtinti savo pasirinkimą iš 
daugelio siūlomų veiksmų sekų. Be minėtųjų instrumentų, dažnai 
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naudojami konstruktoriai, padedantys rašyti sudėtingas duomenų ap-
skaitos ir lyginimo išraiškas, formules ir pan. 

Kita svarbi DBVS dalis yra duomenų aprašymo ir manipulia-
vimo jais kalba. Ji skirta kurti taikomąsias programas, t. y. tokias 
programas, kurias vartotojas ar jų grupė naudoja konkretiems, speci-
finiams uždaviniams spręsti. Į tokios kalbos sudėtį įeina duomenų 
aprašymo ir manipuliavimo jais instrukcijos (komandos). Aprašant 
duomenis nurodoma DB lentelių struktūra, raktiniai laukai, atskirų 
lentelių ryšiai. Manipuliavimo duomenimis instrukcijos – tai dau-
gybė įvairios paskirties komandų, skirtų tiesiogiai apdoroti duomenų 
elementus (laukų reikšmes), lentelių įrašus, lenteles ar visą DB. 

Iš daugybės manipuliavimo duomenimis instrukcijų į savaran-
kišką grupę išskiriamos vadinamosios užklausos. Jos aprašomos ir 
vykdomos atitinkama kalba. Viena plačiausiai naudojamų užklausų 
kalbų yra SQL (Structured Query Language – struktūrizuota už-
klausų kalba). Tai gana paprasta kalba, turinti aiškias standartizuotas 
instrukcijas. Ši kalba įtraukta į daugumą DBVS. 

Modernios DBVS turi programų generatorius. Tai specialūs 
instrumentai, skirti automatizuoti programų rašymą, palengvinti 
vartotojų, ypač programuotojų, darbą kuriant taikomąsias programas. 
Generatoriai įgalina žymiai sumažinti darbo sąnaudas, kai reikia 
programuoti daug laiko reikalaujančias ir dažnai pasikartojančias, 
pavyzdžiui, ekrano apipavidalinimo, veiksmų (meniu) juostų, ata-
skaitų sudarymo ir kitas operacijas. 

 
 

3.5. PAGRINDINIAI DUOMENŲ BAZĖS KŪRIMO  
       IR REDAGAVIMO ETAPAI 
 

agrindiniai darbo su duomenų baze etapai yra: 
  Duomenų bazės struktūros projektavimas; 

 Duomenų bazės užpildymas duomenimis; 
 Duomenų bazės struktūros redagavimas ir duomenų atnau-
jinimas. 

Naujos DB kūrimas prasideda nuo bazės struktūros, t. y. bazės 
lentelių struktūros projektavimo. Formuojant konkrečios lentelės 
struktūrą, nurodomi: 

P

3.5. Pagrindiniai duomenų bazės kūrimo ir redagavimo etapai 
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 Lentelės laukų pavadinimai; 
 Laukų duomenų tipai; 
 Laukų ilgiai; 
 Duomenų formatai; 
 Priskiriamos rakto funkcijos, indeksuojami laukai. 

Papildomai gali būti nurodyti ir kiti dalykai, pavyzdžiui, duo-
menų laukų formatai, nutylėtos laukų reikšmės, t. y. reikšmės, ku-
riomis laukas užpildomas automatiškai. Vykdomos dalinės įvedamų 
duomenų kontrolės funkcijos. Suformavus lentelių struktūrą, nusta-
tomi raktiniai ir lenteles siejantys laukai, nurodomi ryšių, reikalingų 
lentelėms susieti į vientisą duomenų bazę, tipai. 

Baigus kurti DB struktūrą, bazė užpildoma konkrečiais varto-
tojo duomenimis. Vėliau duomenų bazę tenka redaguoti (įterpti 
naujus įrašus, pasenusius duomenų elementus pakeisti naujais ir 
pan.). DBVS leidžia redaguoti ir DB struktūrą, ir jos turinį, t. y. 
duomenų elementus.  

Redaguojant DB struktūrą, daugiausia tenka: 
 Keisti lauko duomenų tipą, dydį; 
 Įterpti papildomą lauką; 
 Šalinti nebereikalingą lauką. 

Čia pažymėtina, jog geriau iš karto detaliai apgalvoti ir supro-
jektuoti efektyvią DB struktūrą, kad vėliau netektų jos keisti. Žymiai 
dažniau reikia redaguoti DB turinį, o ne bazės struktūrą. Svarbiausios 
DB turinio redagavimo operacijos yra šios: 

 Naujo įrašo įterpimas; 
 Atskiro lauko ar viso įrašo užpildymas konkrečiais 
duomenimis (reikšmėmis); 
 Įrašo laukų reikšmių modifikavimas; 
 Įrašo pašalinimas. 

Šiomis operacijomis nesunku konstruoti kitas, sudėtingesnes 
operacijas. Pavyzdžiui, galima automatiškai pakeisti tam tikro lauko 
reikšmes visoje lentelėje, išvalyti lauką ar net visą lentelę. 

DB turiniui redaguoti labai plačiai naudojamos vadinamosios 
formos. 

Forma – tai tam tikras langas, skirtas vaizduoti ir redaguoti 
laukų reikšmes iš vienos ar kelių DB lentelių. Langas atitinkamai 
apipavidalinamas, laukų reikšmės jame išdėstomos laisva tvarka ir 
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vaizduojamos vartotojui patogiu formatu. Formoje turi būti ir duo-
menų vaizdavimo valdymo įrankiai, dar kitaip vadinami naršymo 
įrankiais. 

Galimos konkretaus užsakymo duomenų turinio redagavimo 
formos pavyzdys pateiktas 3.9 paveiksle. 
 
 
Užsakymo numeris           0331                        Data      2004 01 26 
Pirkėjas                             Jankauskienė 
Prekė         Kompiuteris              
Kiekis        10 
Kaina        5000,00 
                   Kitas              Ankstesnis                Išėjimas 
 
Aiškinamasis tekstas 
      Lauko reikšmė 
   Valdymo mygtukai 
 

3.9 pav. Duomenų įvedimo formos pavyzdys 
 

Įrankiai pateikiami kaip tam tikri mygtukai, skirti atitinka-
miems nurodymams atlikti, „pereiti prie tolesnio įrašo“, „redaguoti 
įrašą“ ir pan. Formos naudojamos ne tik DB redaguoti, bet ir įvesti 
naujiems duomenims, peržiūrėti, surasti reikiamą įrašą lentelėje. 
 
 
 
3.6. DUOMENŲ PAIEŠKOS PRIEMONĖS 
 

aieška yra manipuliavimo duomenimis operacija ar operacijų 
seka, kurios paskirtis – iš vienos arba kelių DB lentelių surasti 
konkrečius duomenis. Paieška yra viena svarbiausių 

manipuliavimo duomenimis operacijų. Be šios operacijos 
neįmanoma atlikti daugelio kitų operacijų (įrašų modifikavimo, 
įterpimo, pašalinimo). Vartotojui labai aktualu paiešką atlikti greitai, 
patogiai, lanksčiai. Galima teigti, kad paieškos greitis nulemia viso 
darbo su DB efektyvumą.  

P

3.6. Duomenų paieškos priemonės 
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Paiešką duomenų bazėje galima organizuoti: 
 Naudojantis grafiniais, vizualiaisiais instrumentais; 
 Rašant instrukcijas specialia kalba. 

Užklausos duomenų bazėse atlieka informacines paslaugas. Jos 
skirtos informacijos paieškai atlikti. 

Microsoft Access turi kelis užklausų tipus: 
 Atrankos užklausos, vykdančios duomenų paiešką pagal at-
rankos kriterijus (Select Query), skirtos ieškoti įrašų ir re-
zultatą pateikti lentelės forma; 

 Apibendrintos užklausos. Jos gali būti vadinamos suves-
tinėmis, kryžminėmis suvestinėmis užklausomis (Crosstab 
Query), agregatinėmis užklausomis. Tokio tipo užklausos 
pateikia statistinių skaičiavimų (sumos, kiekio, vidurkio) 
rezultatus, gautus pagal lentelės laukų duomenis, skaičiuo-
jant juos pagal reikiamus požymius; 
 Duomenis keičiančios užklausos. Jos skirtos duomenų įra-
šams arba struktūrai keisti. Pavyzdžiui, duomenims trinti, 
naujoms lentelėms kurti, joms keisti (Action Query) ir pan.: 

Delete Queries – pašalina iš lentelės nereikalingus įra-
šus; 
Update Queries – pakeičia reikiamus įrašus; 
Append Queries – lentelės gale prideda naujus įrašus, 
neatitinkančius reikalaujamų kriterijų; 
Make-Table Queries – iš atrinktų įrašų sukuria naujas 
lenteles; 

 Užklausos įvedant parametrus (Parameter Query) leidžia 
įvesti atrankos sąlygas. Šiuo atveju užklausa prašo įvesti 
ieškomo parametro reikšmę ir tuomet atrenka įrašus, kurių 
šie parametrai sutampa. 

Su duomenų paieškos, užklausų bei ataskaitų kūrimo priemo-
nėmis plačiau susipažinsime praktiniuose darbuose. 
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3.7. DUOMENŲ BAZIŲ PRAKTINIAI DARBAI  
       IR METODINIAI NURODYMAI 
 
 

3.7.1. Konferencijos organizavimo duomenų  
          bazės kūrimas 

 
1. Darbo tikslas 
 
Išmokti teisingai sudaryti duomenų bazės loginę struktūrą, 

duomenų saugojimo lenteles ir ryšius tarp lentelių. Sukurti duomenų 
įvedimo formas. Susipažinti su duomenų bazių valdymo sistemos 
(DBVS) Microsoft Access darbo aplinka. 

 
2. Darbo užduotys 
 
1. Sukurkite naujos duomenų bazės loginę struktūrą, skirtą 

konferencijos dalyviams registruoti. 
2. Iškvieskite programą MS Access. Pasirinkite naujos duo-

menų bazės kūrimo režimą. 
3. Programai pasiūlius, išsaugokite savo naujai kuriamą duo-

menų bazę diske, pavyzdžiui, C, D, savo sukurtame kataloge. Duo-
menų bazei suteikite prasminį pavadinimą. 

Visos kuriamos lentelės bus saugomos vienoje bendroje duo-
menų bazėje, kuri saugant įvardijama prasminiu semantiniu pavadi-
nimu, pavyzdžiui, Konferencija.mdb. 

4. Sukurkite naują duomenų saugojimo lentelių loginę struk-
tūrą, skirtą konferencijos dalyviams registruoti. Pavadinkite lenteles 
Autoriai, Organizacijos ar pan. Išsiaiškinkite galimus laukų duomenų 
tipus, jų panaudojimo prasmę ir formatus. Nurodykite prasminius 
duomenų laukų pavadinimus, pasirinkite duomenų formato tipus ir 
laukų ilgius. 

5. Įveskite duomenis į lentelę Autoriai. 
6. Sukurkite naują duomenų saugojimo lentelę, skirtą straips-

niams ir recenzentų duomenims įvesti. Suteikite lentelėms semanti-
nius pavadinimus, pavyzdžiui, Straipsniai, Recenzentai. Nustatykite 
duomenų tipus ir laukų ilgius. 
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7. Įveskite duomenis apie konferencijai pateiktus straipsnius ir 
recenzentus ir panašiai bei sukurkite šias esybes siejančias lenteles. 
 

3. Metodiniai nurodymai 
 
Kaip iškviesti programą Microsoft Access ir išsaugoti duo-

menų bazės failą? 
Iškviečiant programą Access (Start→Programms→Microsoft 

Access), programa siūlo pasirinkti iš sąrašo ir atverti sukurtą duo-
menų bazę arba kurti naują (3.10 pav.). Norint atverti jau sukurtą 
duomenų bazę (Open an existing file), ji yra pasirenkama iš sąrašo. 
Jeigu sukurtosios duomenų bazės pavadinimo nėra, pasirenkama 
komanda More files. Norint kurti naują duomenų bazę, pasirenkamas 
Blank Access database veiksmas. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.10 pav. Duomenų bazės kūrimo langas su pasirinktais 
parametrais naujai duomenų bazei kurti 

 
 

Pradedant kurti naują duomenų bazę, programa pasiūlo ją iš-
saugoti. Šį duomenų bazės failą išsaugokite kietajame diske, pava-
dindami, pavyzdžiui, konferencija.mdb. 

Šiame DB faile bus saugomi visi sukurti duomenų bazės ele-
mentai: lentelės, formos, užklausos, ataskaitos, jų pakeitimai ir pa-
pildymai. 
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3.11 pav. Duomenų bazės pavadinimo ir išsaugojimo  

vietos parinkimo langas 
 
 

Visi veiksmai atliekami taip, kaip ir vykdant komandą 
File→Save As. Pasirenkamas diskas, aplankas, duomenų bazės failui 
suteikiamas pavadinimas ir spaudžiamas Create mygtukas. 
 

Duomenų bazės sandaros elementai 
Atitinkamu pavadinimu išsaugojus naują duomenų bazę pro-

grama atveria darbo langą, kuriame pateikiami duomenų bazės sude-
damųjų dalių kūrimo objektai (Objects). Jie yra pagrindiniai išvardyti 
duomenų bazės sandaros elementai, kuriais galima kurti: 

 Lenteles (Tables), jose laikomi pagal duomenų apdorojimo 
poreikius sugrupuoti duomenys; 

 Formas (Forms), jos leidžia pasirinkti patogią formą 
duomenims įvesti, redaguoti ir peržiūrėti; 
 Užklausas (Queries), jose aprašomi ieškomų duomenų 
atrankos kriterijai bei atrenkamų duomenų grupavimo bū-
dai; 
 Ataskaitas (Reports), remiantis jomis galima pateikti iš ba-
zės išrinktus duomenis, skaičiavimų rezultatus, iliustracijas, 
suteikiančias duomenims tam tikrą apipavidalinimą. Jos gali 
būti pateiktos ekrane ir spausdinamos; 
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 Makrokomandas (Macros), jomis galima automatizuoti 
dažnai kartojamų komandų grupių vykdymą; 

 Modulius (Modules), jų dėka atliekami duomenų apdoro-
jimo aprašymai DBVS programavimo kalba Visual Basic. 

Pradedant kurti duomenų bazę šių objektų sąrašai būna tušti. 
Didelės apimties duomenų bazėse įvairių tipų objektai gali būti 

jungiami į grupes, sukurtųjų grupių valdymo mygtukai yra grupės 
srityje (Groups). Jeigu grupių nėra, šioje srityje būna tuščia grupė 
Favorites. 

 
Kaip sudaryti lentelės projektą, pasirinkti duomenų tipus ir 

nustatyti laukų ilgius? 
Duomenų bazė pradedama kurti loginio modelio projektu (3.3. 

skyrius). Suprojektuosime konferencijos dalyvių duomenų lentelę 
įvesdami laukų pavadinimus, jų tipus ir laukų ilgius. Naujai duomenų 
lentelei kurti pasirenkamas objektas Tables ir dukart spragtelint kai-
riuoju pelės klavišu pasirenkamas darbo režimas Create table in 
Design view. Pradėti kurti lentelę galima ir kitu būdu, t. y. pasirinkus 
objektą Tables spaudžiamas mygtukas New, pasirodžiusiame dialogo 
lange New Table spaudžiamas ir pasirenkamas Design view režimas. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.12 pav. Lentelės kūrimo įrankių pasirinkimas 

Duomenų 
bazės lentelės 
kūrimas 
projektavimo 
įrankiais 

Duomenų įkėlimo 
mygtukas 

Projektavimo 
mygtukas 
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Stulpelyje Field Name įvedame laukų pavadinimus. Stulpelyje 
Date Type svarbu tinkamai nustatyti įvedamų duomenų tipą. Field 
Size dalyje nustatomas maksimalus lauko dydis. 

Yra dešimt galimų duomenų tipų: teksto (Text), didelės atmin-
ties aprašymo (Memo), skaitmeninės (Number), automatinio skaitik-
lio (AutoNumber), loginio (Yes/No), pinigų (Currency), datos ir laiko 
(Date/Time), įterpiamų objektų (OLE object), hipernuorodų (Hyper-
link). 
 
3.1 lentelė. Laukų tipai 
 

Duomenų tipas Savybės ir reikšmė 
Teksto 
(Text) 

Simbolių rinkiniai. Didžiausias teksto lauko ilgis yra 255 
simboliai. 

Aprašymo 
(Memo) 

Ilgi simbolių rinkiniai, kurių simbolių skaičius viršija 255. 
Lauko ilgis gali būti iki 65 535 simbolių. Šie laukai negali 
būti raktiniai ir neindeksuojami. Jie lentelėse nėra saugomi, 
jose paprastai yra nuorodos į šiuos laukus, todėl lentelėse 
greičiau vyksta duomenų rūšiavimas ir paieška. 

Skaitmeninis 
(Number) 

Skaitmeniniai duomenys – tai įvairaus formato skaičiai, 
kurie gali būti naudojami atliekant matematinius 
skaičiavimus. Šio tipo duomenys gali būti 1, 2, 4, 8, ar 16 
baitų ilgio. Tai priklauso nuo lauko dydžio (Field Size). 
Long Integer dydis yra 4 baitai ir tai yra sveikųjų skaičių 
atkarpa nuo –2147483648 iki 2147483648. 

Automatinio 
skaitiklio 
(AutoNumber) 

Automatiškai formuojamos įrašams žymėti skirtos skaitinės 
reikšmės, jų laukas yra 4 baitų ilgio. Programa 
automatiškai formuoja šį lauką, padidindama jį vienetu 
arba atsitiktiniu būdu. Maksimalus įrašų skaičius lentelėje 
esant šiam laukui turi neviršyti 2 milijardų. 

Loginis 
(Yes/No) 
 

Taip/ne tipo laukas arba įjungta/išjungta. Programa Access 
naudoja reikšmę – 1, esant taip tipo laukui, reikšmę 0, 
esant ne tipo laukui. Šis laukas negali būti raktas, tačiau jį 
galima indeksuoti. 

Pinigų 
(Currency) 

Fiksuoto kablelio skaičiai, įvairių valiutų piniginiams 
vienetams išreikšti. 15 ženklų skiriama sveikajai daliai ir 4 
– trupmeninei. Gali būti skaičiavimų argumentai. 

Datos ir laiko 
(Date/Time) 

Galima įvesti datą nuo 100 iki 9999 metų. Lauko ilgis – 8 
baitai. Access suteikia galimybę rinktis įvairius datos ir 
laiko formatus. 

Įterpiamų objektų 
(OLE object) 

Iliustracijoms, vaizdo įrašams, garsui, dokumentams 
saugoti skirtas lauko duomenų tipas. 

Hipernuorodos 
(Hyperlink) 

Interneto adresai arba nuorodos su diskuose laikomais 
failais. Hipernuorodos užrašymo ilgis – iki 2048 simbolių. 
Šis laukas negali būti raktinis ar indeksuojamas. 
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3.2 lentelė. Skaitmeninių laukų atmainos 
 

Atmaina Dydis Savybės 
Baitas (Byte) 1 baitas Sveikųjų skaičių atkarpa nuo 0 iki 

255 
Sveikasis (Integer) 2 baitai Sveikųjų skaičių atkarpa nuo  

–32768 iki +32767 
Dideli sveikieji skaičiai 
(Long Integer) 

4 baitai Sveikųjų skaičių atkarpa nuo  
–2147483648 iki +2147483647 

Dešimtainiai (Decimal) 12 baitų 28 ženklų tikslumo sveikieji skaičiai 
Realusis (Single) 4 baitai Slankiojo kablelio skaičiai nuo  

–3,402823E38 iki +3,402823E38 
Dvigubo tikslumo 
(Double) 

8 baitai Slankiojo kablelio skaičiai nuo 
 –1,79769313486231E308 iki 
+1,79769313486231E308 

Sisteminės žymos 
(Replication_ID) 

16 baitų Unikalių sisteminių nuorodų 
reikšmės 

 
3.3 lentelėje pateiktas Autorių lentelės projektas, siūlomi laukų 

pavadinimai, laukų tipai ir jų ilgiai bei jų struktūros kūrimo pavyzdys 
(3.13. pav.). Sukūrus lentelės struktūrą pasirenkamas raktinis laukas 
(pvz., Autoriaus ID). Šis laukas turi būti indeksuotas ir nedubliuojamas. 

Jeigu įvedant duomenis į lentelę lauko ilgis pasirodys per 
trumpas ir duomuo, pavyzdžiui, vardas, pavardė ar panašiai, netilps, 
tuomet lauko ilgį darbo metu galėsite pakeisti, koreguodami loginę 
DB projekto struktūrą. Šiuo atveju kiti įvesti duomenys pildant len-
telę ar formą nedings. 
 
3.3 lentelė. Lentelės Autoriai projektas 
 

Lauko pavadinimas Lauko tipas Lauko ilgis 
Autoriaus_ID AutoNumber  
Vardas Text 15 
Pavardė Text 20 
Mokslo_laipsn_pedag_moksl_vard Text 20 
Organizacijos_santrumpa Text 5 
Pareigos Text 30 
Telefonas_faksas Text 30 
El_paštas Hyperlink 25 
Fotografija OLE  
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3.13 pav. Lentelės Autoriai laukai ir laukų tipai 
 
 

3.4 lentelėje pateikiamas Recenzentų lentelės projektas, siū-
lomi laukų pavadinimai, laukų tipai ir jų ilgiai. Jeigu lauko ilgis įve-
dant duomenis į lentelę pasirodo trumpas ir duomuo, pavyzdžiui, 
vardas, pavardė ar pan., netelpa tuomet lauko ilgį darbo metu galima 
pakeisti. Analogiškai sukuriamos kitos lentelės: Straipsniai, Organi-
zacijos ir pan. 
 
 
3.4 lentelė. Lentelės Recenzentai struktūra 
 

Lauko pavadinimas Lauko tipas Lauko ilgis 
Recenzento_ID AutoNumber  
Vardas Text 15 
Pavardė Text 20 
Mokslo_laipsn_ 
pedag_moksl_vard 

Text 20 

Organizacijos_santrumpa Text 5 
Pareigos Text 30 
Telefonas_faksas Text 30 
El_paštas Hyperlink 25 
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3.14 pav. Lentelės Recenzentai laukai ir laukų tipai 
 
 
    3.5 lentelė. Lentelės Straipsniai struktūra 
 

Lauko pavadinimas Lauko tipas Lauko ilgis 
Straipsnio_ID AutoNumber  
Straipsnio_pavadinimas Text 70 
Tema Text 30 
Raktažodis Text 35 
Puslapių_skaičius Number Long Integer 

 
 
 
 
 
 
 
 
 
 
 
 
 

3.15 pav. Lentelės Straipsniai laukai ir laukų tipai 
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   3.6 lentelė. Lentelės Organizacijos struktūra 
 

Lauko pavadinimas Lauko tipas Lauko ilgis 
ID AutoNumber  
Organizacijos_santrumpa Text 5 
Organizacijos_pavadinimas Text 35 
Miestas Text 15 
Adresas Text 45 
Pašto_kodas Text 10 
Šalis Text 20 

 
 
 
 
 
 
 
 
 
 
 

3.16 pav. Lentelės Organizacijos laukai ir laukų tipai 
 
   3.7 lentelė. Siejamosios lentelės Autoriu_STR_susiejimas struktūra 
 

Lauko pavadinimas Lauko tipas Lauko ilgis 
Straipsnio_ID Number Long Integer 
Autoriaus_ID Number Long Integer 
Autorių_eilės_tvarka Number Byte 

 
 
 
 
 
 
 
 
 
 

3.17. pav. Autorių ir straipsnių siejamosios lentelės laukai ir laukų tipai 
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Laukų pavadinimus gali sudaryti ne tik raidės, bet ir skaitme-
nys, tarpai bei specialieji simboliai, išskyrus kablelį, šauktuką, tašką 
ir laužtinius skliaustus. Pavadinimai negali prasidėti tarpu, didžiau-
sias leidžiamas pavadinimo ilgis – 64 simboliai. 

Svarbu tinkamai parinkti ir teisingai įvesti lauko pavadinimą, 
nustatyti įvedamų duomenų tipą ir lauko ilgį, nuo to priklausys vė-
lesnis darbas ir įvedamų duomenų kokybė. 

Jeigu lentelėje pateikti laukų pavadinimai, duomenų tipai ir 
laukų ilgis netenkina, juos galima keisti. Galima keisti ir lentelių pa-
vadinimus (Rename). 

 
Kaip nustatomi laukų dydžiai ir jų formatai? 
Sudarius lentelės projektą reikia nurodyti kiekvienam laukui 

priskiriamus minimizuojančius parametrus: 
 Laukų dydžius (Field Size), nustatant maksimalų skiriamą 
atitinkamo tipo duomenų lauko skilčių skaičių; 
 Įvedamų duomenų formatus (Format); 
 Įvedimo formas (Imput Mask); 
 Įrašomas pradines reikšmes (Default Value); 
 Lauko reikšmių tikrinimo parametrus (Validation Rule);  
 Indeksavimo savybes (Indexed) ir kt. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.18 pav. Aktyvaus lauko formatavimo parametrų parinkimas 

Laukų dydžių ir formatavimo 
parametrų parinkimo sritys 



3.7. Duomenų bazių praktiniai darbai ir metodiniai nurodymai 93 

Kaip duomenis įvesti į lentelę? 
Duomenis į lentelę galima įvesti pasirenkant objektą Table ir 

dukart spragtelint kairiuoju pelės klavišu ties lentelės pavadinimu. 
Darbo lauke atsiras lentelė, kurią bus galima pildyti. Užpildžius arba 
norint nutraukti pildyti reikia uždaryti lentelės (Table) langą. 

Kai kurių laukų tipų duomenys (pvz., OLE objects, MEMO) 
gali būti įvedami tik sukūrus duomenų įvedimo formą. Pavyzdžiui, 
jeigu norime įvesti fotografiją, t. y. OLE tipo lauką, sukuriame ati-
tinkamą duomenų įvedimo formą (Forms). Jeigu patogiau dirbti su 
duomenų įvedimo forma, tai duomenis į lentelę galima įvesti naudo-
jant formas. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.19 pav. Lentelės Autoriai duomenys 
 
 
 
 
 
 
 
 
 
 
 
 

3.20 pav. Lentelės Straipsniai duomenys 
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Kontroliniai klausimai 
 

1. Kokias funkcijas atlieka duomenų bazių valdymo sistema? 
2. Išvardykite jums žinomas duomenų bazių valdymo sistemas? 
3. Kokios svarbiausios DBVS Microsoft Access dalys? 
4. Išvardykite pagrindinius darbo su duomenų baze etapus. 
5. Kaip sudaromas lentelės projektas? 
6. Kaip redaguojamas lentelės projektas? 
7. Kokie galimi DBVS MS Access duomenų tipai? 
8. Kokio tipo duomenys nesaugomi lentelėse? 
9. Kaip duomenis įvesti į lentelę? 
 
 

3.7.2. Lentelių ryšių nustatymas duomenų bazėje 
 

1. Darbo tikslas 
 
Išmokti sudaryti lentelių ryšių projektą, išsiaiškinti ryšio savy-

bes bei atmainas, mokėti redaguoti ryšius. 
 

2. Praktinio darbo užduotys 
 

1. Iškvieskite jau pradėtą kurti konferencijos duomenų bazę. 
2. Išsiaiškinkite, kokiu tikslu nustatomi lenteles siejantys ryšiai. 
3. Pasirinkite lenteles, tarp kurių nustatysite ryšius. 
4. Nustatykite ryšį tarp tą pačią prasmę turinčių laukų, esančių 

skirtingose lentelėse. 
5. Išsiaiškinkite ryšio savybes bei mokėkite jį redaguoti dirbdami ry-

šio projekto lange. 
6. Išsiaiškinkite, kokios gali būti ryšio atmainos. 
7. Išsaugokite sudarytąjį lentelių ryšių projektą, išmokite jį iškviesti 

ir redaguoti. 
 

3. Metodiniai nurodymai 
 

Kaip iškviesti dirbti egzistuojančią duomenų bazę? 
Iškvieskite programą Microsoft Access, dialogo langelyje 

Microsoft Access suaktyvinkite Open an existig file, pažymėkite 
duomenų bazės pavadinimą ir ją atverkite. 
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3.21 pav. Diske esančios duomenų bazės atvėrimo langas 
 
 

Jeigu šiame dialogo langelyje jūsų konferencijos duomenų ba-
zės pavadinimo nėra, suaktyvinkite More Files, dialogo langelyje 
Open suraskite duomenų bazę ir ją atverkite. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.22 pav. Duomenų bazės pasirinkimas, norint ją atverti 
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Lentelės ryšių samprata 
Duomenis saugoti lentelėse yra patogu, su jais lengva ir pa-

prasta dirbti, nes informacija išskaidoma į kelias lenteles. Norint pa-
teikti informaciją iš kelių lentelių, reikia nustatyti lenteles siejančius 
ryšius, t. y. apibrėžti laukų, esančių skirtingose lentelėse ir turinčių tą 
pačią prasmę, ryšius (plačiau galima susipažinti 3.3. skyriuje). 

Parengus duomenų bazės lentelių projektą labai svarbus darbo 
etapas yra nustatyti skirtingose lentelėse esančių ir tas pačias reikš-
mes turinčių laukų ryšius. Tai palengvina duomenų paiešką, padeda 
remiantis kelių lentelių duomenimis sudaryti užklausas ir ataskaitas. 

 
Lentelių ryšių nustatymas 
Norint nustatyti lentelių ryšius reikia: 

 Vykdyti komandą Tools→Relationships, kuri iškviečia ko-
mandos projekto langą Relationships ryšiams tarp lentelių 
sudaryti; 

 Vykdyti komandą Relationships→Show Table, dialogo lan-
ge Show Table leidžiančia pasirinkti lenteles, tarp kurių 
sudaromi ryšiai. 

 
 
 
 
 
 
 
 
 
 
 
 
 

3.23 pav. Lentelių ryšių nustatymo dialogo langas 
 
 

Lentelių ryšiai sudaromi ryšių projekto lange Relationships. 
Šiame projekto lange reikia patogiai išdėstyti lenteles, kad sudarytas 
lentelių ryšio projektas būtų aiškus. 
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Laukus siejančių ryšių nustatymas 
Sudarant ryšį tarp skirtingose lentelėse esančių, tačiau tą pačią 

prasmę turinčių laukų, pažymimas vienas laukas, spaudžiant kairįjį 
pelės klavišą pažymimas kitas laukas. Atleidus pelės klavišą patei-
kiamas ryšio redagavimo langas Edit Relationships. Parenkamas ry-
šio tipas: vienas su vienu (1:1), vienas su daugeliu (1:N), arba dau-
gelis su vienu (N:1). Ryšiai reliacinėse duomenų bazėse, nesinaudo-
jant pirminiais raktais, formuojami gana retai. 
 
 
 
 
 
 
 
 
 
 
 
 

3.24 pav. Lentelių ryšių redagavimo langas 
 
 

Ryšių redagavimas 
Redaguoti ryšį galima ties jau suformuoto ryšio linija spau-

džiant dešinįjį pelės klavišą ir vykdant kontekstinio meniu komandą 
Edit Relationships. 

Ryšių redagavimo lange Edit Relationships galima pažymėti 
šias ryšių savybes: 

 Ryšio integralumas (Enforce Referential Integrity). Ryšio 
integralumas rodo, kad išorinio rakto lauke negali būti tokių 
lauko reikšmių, kurių nėra pagrindinės lentelės valdančia-
jame lauke. Pateiktame pavyzdyje ryšio redagavimo lange 
Edit Relationships valdantysis laukas yra Straipsnio_ID iš 
lentelės Straipsniai, išorinio rakto laukas yra Straipsnio_ID 
iš lentelės Autorių_STR_susiejimas. 
 Kaskadinis susietų laukų atnaujinimas (Cascade Update 
Related Fields). Pavyzdžiui, jeigu lentelėje Straipsniai pa-
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keičiamas straipsnio identifikatorius, jis atnaujinamas ir len-
telėje Autorių_STR_susiejimas. 
 Kaskadinis susietų įrašų naikinimas (Cascade Delete Rela-
ted Records). Pavyzdžiui, pašalinus Straipsnio_ID iš lente-
lės Straipsniai, straipsniai bus šalinami ir iš lentelės Auto-
rių_STR_susiejimas. 

 
Ryšio atmainos parinkimas 
Ryšio redagavimo lange Edit Relationships mygtuku Join Type 

galima parinkti ryšio atmainą (kardinalumo apribojimus). Nuspaudus 
mygtuką Join Type pateikiamas dialogo langas Join Properties. 
Jame matyti trys galimos ryšio atmainos. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.25 pav. Ryšio savybių parinkimo langas 
 
 

Parinktoji lentelių ryšio atmaina nurodo lentelių pavaldumo 
kryptį ir susijusių įrašų atrinkimo būdą užklausose: 

1. Ryšys apima tik tuos įrašus, kuriuose laukų reikšmės su-
tampa; 

2. Ryšys apima visus pirmosios lentelės ir tuos antrosios lente-
lės įrašus, kurių ryšio laukų reikšmės yra pirmoje lentelėje; 

3. Ryšys apima visus antrosios lentelės ir tuos pirmosios lente-
lės įrašus, kurių ryšio lauko reikšmės yra antroje lentelėje. 
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Lentelių ryšių projekto langas 
Ryšių rodyklės matyti, kai yra įjungtas ryšio integralumo po-

žymis (Enforce Referential Integrity). 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.26 pav. Lentelių ryšių projekto langas 
 

Redagavimo lange Edit Relationships parinktos ryšio savybės 
gali būti keičiamos, pakeitimai patvirtinami mygtuku Ok. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.27 pav. Ryšio savybės keitimo langas 
 
 

Redaguojant ryšių tipai keičiami iškviečiant papildomų ryšio 
savybių langą. Tai atliekama spaudžiant Join Type mygtuką. 
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3.28 pav. Ryšio savybių parinkimo langas 
 
 

Kaip išsaugoti sudarytąjį lentelių ryšio projektą? 
Duomenų bazės ryšių projektas įrašomas į kuriamos duomenų 

bazės failą. Esant ryšių projekto lange reikia paspausti priemonių 
juostoje esantį mygtuką Save arba vykdyti ekvivalentiškas išsaugo-
jimo komandas. Tačiau ir uždarant MS Access langą visi aprašymai 
išlieka duomenų bazės faile. 

 
 
Kontroliniai klausimai 
 

1. Kokia komanda pradedamas kurti lentelių ryšio projektas? 
2. Tarp kokių lentelių laukų paprastai sudaromi ryšiai? 
3. Kokius ryšių tipus žinote ir kokia jų prasmė? 
4. Kam reikalingi skirtingų lentelių ryšiai? 
5. Kaip pakeisti jau sukurtą ryšio projektą? 
6. Kaip ryšiai redaguojami? 
7. Kas yra ryšio integralumas, kokios yra kitos ryšio savybės? 
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3.7.3. Duomenų įvedimo formos ir  
          jų projektavimas 

 
1. Darbo tikslas 
 
Išmokti sukurti patogią duomenų įvedimo formą ir įvesti bei 

redaguoti duomenis naudojantis bazėse esančiomis duomenų įve-
dimo formomis. 

 
2. Praktinio darbo užduotys 
 

1. Iškvieskite jau pradėtą kurti konferencijos duomenų bazę. 
2. Sukurkite autorių duomenų įvedimo formą. 
3. Pakeiskite autorių duomenų įvedimo formos projektą. 
4. Į autorių duomenų formas įkelkite autorių nuotraukas. 
5. Išmokite redaguoti duomenis naudodami duomenų įvedimo for-

mas. 
6. Išmokite rinktis, pridėti ir užpildyti įrašą ir jį ištrinti. 
7. Sukurkite straipsnių duomenų įvedimo formą. 

 
3. Metodiniai nurodymai 
 
Kam reikalingos duomenų įvedimo formos?  
Didelėms lentelėms tvarkyti patogu naudoti duomenų įvedimo 

formas, kurios ekrane pateikia vieną įrašą, ir suteikia galimybę jį re-
daguoti bei pereiti prie kito įrašo. Formą galima kurti savarankiškai 
bei naudojantis vedliu (Wizard). 

Formos (Forms) leidžia pasirinkti patogią formą duomenims 
įvesti, juos redaguoti ir peržiūrėti, jos naudojamos įterpti OLE ob-
jektams, pavyzdžiui, nuotraukoms, duomenis iliustruojantiems pa-
veikslėliams, MEMO laukams ir panašiai. 
 

Kaip kurti duomenų įvedimo formos projektą? 
Suaktyvinkite objektą Forms, paspauskite mygtuką New, dia-

logo langelyje New Form pasirinkite formos tipą, pavyzdžiui, Auto-
Form: Columnar, dalyje Chose the table or query where… iš sąrašo 
pasirinkite, iš kokių duomenų formą sudarote, pavyzdžiui, lentelę 
Autoriai. 
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3.29 pav. Duomenų įvedimo formos kūrimo langas 
 

Jeigu duomenų įvedimo formos projektas nėra patogus dirbti 
su duomenimis, jį galite pakeisti. Esant pažymėtai formai, pavyz-
džiui, Autoriai, spauskite projektavimo mygtuką Desing. Galite pa-
keisti nuotraukos dydį bei praplėsti matomas laukų ribas, perkelti 
laukus į patogią dirbti vietą. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.30 pav. Duomenų įvedimo formos projektavimo langas  
 
 

Formos laukus galima apipavidalinti automatiškai: kai matyti 
formos projekto langas, reikia vykdyti komandą Format→ AutoFormat 
ir pasirinkti pažymėtų laukų formatavimo tipą. 
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Formą galima papildyti paveikslais ir piešiniais. Jeigu esant 
aktyviam projekto langui įvykdoma komanda Insert→Picture ir failo 
užklausos lange nurodomas piešinio failo pavadinimas, į formą įke-
liamas piešinys. Formoje matomą piešinį galima perkelti į norimą 
vietą bei pakeisti jo matmenis. 

Naudojant pagalbinę atmintį Clipboard piešinius galima tie-
siogiai perkelti iš kitų programų. 

 

 
 

3.31 pav. Formos laukų apipavidalinimas vykdant komandą 
Format→AutoFormat 

 
 

Kaip naudoti formą, skirtą duomenims įvesti bei jiems reda-
guoti? 

Du kartus spaudžiant kairįjį pelės klavišą ties formos pavadi-
nimu atveriama forma, kurioje yra jai priskirtos lentelės duomenys, 
kuriuos galima tvarkyti standartinėmis tekstų redagavimo priemonė-
mis. Judėti iš vieno lauko į kitą žemyn galima spaudžiant klavišus 
<Enter> arba <Tab>, o į viršų – klavišus <Shift>+<Tab>. 
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Judėti nuo įrašo prie įrašo galima šiais mygtukais: 
 
         prie pirmojo įrašo                     prie paskutiniojo įrašo 
 
 
 pridėti naują įrašą 

 
3.32 pav. Lentelės įrašų perrinkimo valdymo mygtukai 

 
 
                                                                        Įterpti naują įrašą 
                                                                                                   Pašalinti įrašą 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3.33 pav. Formos Autoriai pirmojo įrašo duomenų langas 

 
 

Įterpti nuotrauką į OLE tipo lauką galima komanda Paste iš-
kviečiant kontekstinį fotografijos lauko meniu, pasitelkiant pagalbinę 
iškarpų atmintį Clipboard. 
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Į OLE tipo lauką galima įterpti duomenis ir iš failo. Tuomet 
vykdoma komanda Insert Object ir standartiniu būdu parenkamas 
failas. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.34 pav. Fotografijos įterpimo kontekstinis meniu 
 

Naudojantis formomis galima laisvai judėti nuo įrašo prie 
įrašo, įterpti nuotraukas. Svarbu, kad nuotraukos dydis atitiktų for-
moje laukui skirtą dydį. Esant dydžių skirtumui reikia keisti formos 
projektą arba įterpiamos nuotraukos dydį. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.35 pav. Formos papildymas fotografija 
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3.36 pav. Fotografijos parametrų keitimas  
vykdant komandą Properties 

 
 

Įvykdžius kontekstinio meniu komandą Properties OLE tipo 
objektui skirtame lauke gaunamas dialogo langelis Bound Object 
Frame: Fotografija, skyrelyje Format galima parinkti tinkamus api-
pavidalinimo parametrus, pavyzdžiui, aukštį, plotį, specialius efek-
tus, rėmelių stilių, išdėstymą ir panašiai. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.37 pav. OLE tipo objekto apipavidalinimo  
parametrų parinkimo langas 
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Kaip sukurti straipsnių registracijos duomenų įvedimo formą? 
Straipsnių duomenų įvedimo forma kuriama analogiškai kaip ir 

autorių duomenų įvedimo forma. Esant aktyviam Forms objektui 
mygtuku New vykdoma komanda, skirta naujai formai įvesti. Įvyk-
džius komandą dialogo lange New Form parenkamas formos tipas 
bei šaltinis, iš kurio bus imami pradiniai duomenys, t. y. jau egzis-
tuojanti lentelė Straipsniai. 
 
 
 
 
 
 
 
 
 
 
 
 

 
3.38 pav. Duomenų įvedimo formos Straipsniai kūrimas 

 
Forma su jai priskirtos lentelės  pirmojo įrašo duomenimis 

(3.39 pav.) atveriama suaktyvinant objektą Forms ir pasirenkant su-
kurtos formos pavadinimą, pavyzdžiui, Straipsniai. 
 
 
 
 
 
 
 
 
 
 
 
 

3.39 pav. Formos Straipsniai pirmasis įrašas 
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Kontroliniai klausimai 
 

1. Kokius žinote lentelės duomenų įvedimo ir redagavimo formų kū-
rimo būdus? 

2. Kaip pakeisti jau sukurtos formos projektą? 
3. Kokius veiksmus reikia atlikti į formą įkeliant grafinį vaizdą? 
4. Kaip naudojant formą galima įterpti naują lentelės įrašą arba paša-

linti jame esantį? 
5. Kokio tipo laukai yra matomi formose, tačiau nematomi lentelėse? 
 
 
 

3.7.4. Duomenų paieška, rūšiavimas ir filtravimas  
          duomenų bazėje 

 

1. Darbo tikslas 
 
Išmokti atlikti paiešką Microsoft Access duomenų bazėje, tai-

kant įvairius paieškos būdus bei sąlygas. 
Išsiaiškinti, kaip panaudoti skirtingus duomenų atrankos (filt-

ravimo) būdus: filtravimą pagal požymius, filtravimą taikant sąlygas 
ir filtro pertvarkymą į užklausą. 
 

2. Darbo užduotys 
 

1. Iškvieskite programą MS Access. Atverkite sukurtą duomenų bazę. 
2. Atlikite duomenų paiešką konkrečioje lentelėje (pvz., Autoriai) pa-

gal konkretų lauko pavadinimą (pvz., Organizacija: „VU“ ir pan.). 
3. Susipažinkite su įvairiais paieškos būdais. 
4. Atlikite duomenų filtravimą konkrečioje lentelėje (pvz., iš  lentelės 

Autoriai išrinkite visus vienos organizacijos autorius). 
5. Atlikite duomenų filtravimą pagal filtravimo sąlygas, nustatydami 

santykio operatorius. 
6. Sudarykite filtrą naudodami duomenų formas. 
7. Suprojektuokite keletą naudojimosi išplėstiniu filtru būdų ir 

išsaugokite juos kaip užklausas. 
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3. Metodiniai nurodymai 
 

Kaip atlikti paiešką, norint surasti duomenis? 
Norint atlikti paiešką atveriama lentelė ir vykdoma komanda 

Edit→Find. Komandos dialogo lange Find and Replace nurodoma, 
ką reikia rasti (Find what), pavyzdžiui, autorių, kurio pavardė – Pau-
liukas. Išskleidžiamame sąraše išrenkamas tinkamas lyginimo būdas 
(Match): 

 Norint, kad sutaptų bet kuri lauko reikšmės dalis, pasiren-
kama Any Part of Field; 
 Norint, kad sutaptų visas laukas, – Whole Field; 
 Norint, kad sutaptų lyginamojo lauko pradžia, – Start of 
Field. 

 
 
 
 
 
 
 
 
 
 
 
 
 

3.40 pav. Komandos Edit→Find paieškos sąlygų langas 
 
 

Paspaudus paieškos mygtuką (Find Next) programa lentelėje 
suranda pirmą atitinkantį sąlygas įrašą. Dar kartą paspaudus mygtuką 
Find Next programa suranda kitą sąlygas tenkinantį įrašą arba patei-
kia pranešimą, kad tokio įrašo nėra. 

Spaudžiant dialogo lango Find and Replace mygtuką More>> 
paieškos sąraše (Search) galima pasirinkti paieškos kryptį: aukštyn 
(Up), žemyn (Down), visoje lentelėje (All). 

Jeigu reikia skirti didžiąsias ir mažąsias raides, įjungiamas 
jungiklis Match Case. 
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3.41 pav. Komandos Edit→Find paieškos  
krypties pasirinkimo būdas 

 
 

Kaip atlikti duomenų paiešką ir pakeisti juos kitais duome-
nimis? 

Norint lentelėje surasti duomenis ir juos pakeisti kitais, teksto 
įvedimo žymiklį reikia nustatyti reikiamame duomenų stulpelyje ir 
vykdyti komandą Edit→Replace. Pateikto dialogo lango Find and 
Replace dalyje Replace What nurodykite, ką keisite, o lauko dalyje 
Replace With nurodykite naują lauko reikšmę. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.42 pav. Duomenų paieškos ir keitimo langas 
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Įvairesnes paieškos sąlygas galima sudaryti naudojant šabloną 
(metasimbolius, kaukę): 

* – bet kokiai simbolių grupei surasti; 
? – vienam simboliui surasti. 
Pavyzdžiui, *is – ieškoma visų duomenų, turinčių galūnę -is, 

?????? – ieškoma duomenų, susidedančių iš šešių simbolių. 
 

Kaip atlikti lentelės duomenų filtravimą išrenkant juos pagal 
pažymėtas reikšmes? 

Norint iš lentelės išrinkti norimus duomenis, filtruojama pagal 
atitinkamą lauko reikšmę. Vienas iš būdų filtravimui atlikti yra pa-
žymėti reikiamą duomenį lentelėje (pvz., LTU) ir vykdyti komandą 
Record→Filter→Filter by Selection. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.43 pav. Duomenų filtravimas lentelėje pagal išranką 
 
 

Įvykdžius komandą ekrane bus matyti įrašai, sutampantys su 
pažymėtąja reikšme. Atlikus lentelės filtravimą galima parinkti kitą 
atrankos kriterijų (naują filtrą pagal kito lauko reikšmę), taip bus ga-
lima atrinkti duomenis pagal kelių laukų reikšmes. 

Norint, kad matytųsi visi pradiniai lentelės duomenys filtra-
vimo atsisakoma, vykdant pagrindinio meniu komandą Records→ 
Remove→Filter/Sort arba spaudžiant mygtuką Remove Filter. 
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3.44 pav. Filtravimo panaikinimo komandos 

 
Kaip atlikti duomenų filtravimą lentelėje pagal sąlygas? 
Filtravimą atliksime konkrečioje lentelėje, pavyzdžiui, Auto-

riai. 
Norint atlikti filtravimą pagal filtro pateiktas reikšmes, vyk-

doma komanda Record→Filter→Filter by Form. Įvykdžius komandą 
atsiveria tuščia lentelė, kurioje reikia pasirinkti arba įrašyti filtro or-
ganizavimo priemones: 

 Iš išskleidžiamų sąrašų parenkamos atrankos reikšmės; 
 Naudojant tinkamus operatorius įrašomos sąlygos, pagal 
kurias bus filtruojami duomenys. 

 
3.8 lentelė. Filtravimo sąlygų aprašų tipai 
 

Filtro organizavimo priemonė 
Aprašo 

tipas 
Realizavimo 

priemonė 
Filtravimo rezultatas 

Viso 
sutapimo 

Ieškoma konkrečios 
lauko reikšmės 

Rodomi įrašai, kurių reikšmės sutampa 
su filtro reikšme 

Dalinio 
sutapimo 

Operatorius Like Rodomi įrašai, tenkinantys šabloną, 
pavyzdžiui, Like „P*“ 

Atkarpos Operatorius 
Between 

Rodomi įrašai, kurių intervale yra lauko 
reikšmės, pavyzdžiui, Between 3 and 7 

Santykio Santykio operatoriai Rodomi įrašai, tenkinantys santykį, 
pavyzdžiui, >5 

Filtravimo ir jo 
panaikinimo mygtukas 
(Remove Filter) 
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Pavyzdžiui, turime išrinkti visus LTU autorius, kurių pavardės 
prasideda raide P, parašiusius straipsnių informacinių technologijų 
tematika. 
 
 
 
 
 
 
 
 
 
 

3.45 pav. Komandos Record→Filter→Filter by Form dialogo  
langas ir filtravimo sąlygų užrašymo būdai 

 
 

Gautojoje lentelėje atitinkamuose laukuose įrašykite arba pa-
rinkite šias filtravimo sąlygas: 

 Pavardės lauke nurodykite sąlygą, kad pavardė prasidėtų 
raide, t. y. Like „P*“; 
 Organizacijos santrumpos lauke nurodykite reikiamą filtra-
vimo reikšmę – „LTU“; 

 Temos lauke nurodykite reikšmę „Informacinės technologi-
jos“. 

Įvykdę komandą gausite pagal nustatytas atrankos filtro sąly-
gas išrinktus duomenis. 
 

Kaip atrinktus duomenis surikiuoti lentelėje? 
Norint filtruotus įrašus surikiuoti lentelėje reikia perkelti žy-

miklį į rikiavimo stulpelį ir vykdyti rūšiavimo komandas Records→ 
Sort→Sort Ascending – didėjimo tvarka arba Records→Sort→Sort 
Descending – mažėjimo tvarka.  

Norint surikiuoti duomenis pagal kelis požymius, reikia pažy-
mėti šiuos požymius (laukų pavadinimus), laikant nuspaudus klavišą 
<Shift> ir kairiuoju pelės klavišu spragtelint ties laukų antraštėmis. 
Taip galima išrinkti tik gretimus laukus. Išrinktieji požymiai rikiuo-
jami iš kairės į dešinę. 
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Kaip atlikti duomenų filtravimą naudojant duomenų formas? 
Gali būti vykdomas ne tik duomenų bazės lentelių, bet ir formų 

duomenų filtravimas. Norint atlikti formų duomenų filtravimą reikia 
sukurti lentelės formą: pažymėti formos objektą ir dvigubu paspau-
dimu atverti duomenis, esančius formoje, pavyzdžiui, ankstesniame 
darbe sukurtą formą Autoriai. 

Norint atlikti duomenų filtravimą išrenkant autorių iš LTU 
arba VU įrašų parenkama organizacijos santrumpa – LTU, formos 
apačioje spaudžiamas mygtukas Or ir parenkama organizacijos san-
trumpa VU. Vykdomas filtravimas ir gaunami duomenų įrašai, pa-
teikti tam tikra forma. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.46 pav. Duomenų filtravimo būdai formoje Autoriai 
 
 

Kaip sukurti išplėstinį filtrą? 
Išplėstinis filtravimas turi daugiau pranašumų: 

 Galima pasirinkti keletą rikiavimo (rūšiavimo) būdų; 
 Galima naudoti sudėtingas atrankos sąlygas (pagal daugelį 
rekvizitų); 
 Filtrą galima išsaugoti kaip užklausą; 
 Filtrą galima naudoti pakartotinai. 
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Norint sukurti išplėstinį autorių duomenų lentelės filtrą reikia 
suaktyvinti duomenų bazės objektą Lentelės ir atverti autorių duo-
menų lentelę. Esant atvertai autorių duomenų lentelei vykdoma ko-
manda Record→Filter→Advanced Filter/Sort. 

Sudarant išplėstinį filtrą atrankos ir rūšiavimo sąlygos aprašo-
mos filtro projekto lange, nusakant kriterijus ir duomenų rūšiavimo 
būdą. Criteria „LTU“ – bus atrinkti visi įrašai, kuriuose yra organi-
zacijos santrumpa LTU, duomenys atlikus filtravimą bus išdėstyti 
pagal pavardes abėcėlės tvarka (Ascending). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3.47 pav. Duomenų lentelės Autoriai išplėstinio filtro kūrimas 

 
 
 

Filtrą galima išsaugoti kaip užklausą vykdant komandą File→ 
Save As Query ir suteikti užklausai pavadinimą, pavyzdžiui, Filtras1. 
Tuomet prireikus bus galima vykdyti užklausą pagal sudarytą filtrą 
(Filtras1) ir gauti duomenis, atrinktus pagal sudarytas filtravimo 
sąlygas. 
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3.48 pav. Filtras, kaip užklausos išsaugojimo pavyzdys, vykdant  
komandą File→Save As Query, suteikiant pavadinimą Filtras 1 

 
 
 

Dalyje Criteria užrašomos atrankos sąlygos. Jos gali būti nu-
statomos: 

 Pagal konkrečią lauko reikšmę, pavyzdžiui, jeigu reikalingi 
konkrečios organizacijos autoriai, dalyje Field iš konkrečios 
lentelės pasirenkamas lauko pavadinimas, tarkime, Autoriai. 
Lauke Organizacijos santrumpa ir dalyje Criteria kabutėse 
įrašoma konkreti tekstinio lauko reikšmė, pavyzdžiui 
„LTU“; 
 Pagal konkrečių lauko reikšmių disjunkciją ir konjunkciją 
(OR, AND); 
 Santykio operatorių ir lyginamąją reikšmę: daugiau >, ma-
žiau <, nelygu <> ir kt. 

Pavyzdžiui, taip atrodo duomenys, išfiltruoti renkantis organi-
zaciją LTU ir išdėstyti pagal pavardes abėcėlės tvarka. 
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3.49 pav. Duomenys, gauti atlikus filtravimą lentelėje Autoriai,  
išdėstyti abėcėlės tvarka 

 
 

Galima filtruoti ir pagal logiką „nelygu“. Jeigu dalyje Criteria 
įrašytume <>„Baniulis“ (<> reiškia nelygu), būtų rodomi įrašai, ku-
riuose nėra pavardės Baniulis. 

Pavyzdžiui, jeigu norime išrinkti ne LTU ir ne VU institucijų 
asmenis, lauko Organizacijos_santr dalyje Criteria turėtų būti nuro-
doma: <>„LTU“ AND <>„VU“. Toks filtras nerodo LTU ir VU auto-
rių, todėl lieka tik kitų institucijų autoriai. 

 
 
Kontroliniai klausimai 
 

1. Kaip atliekamas lentelės duomenų filtravimas pagal išranką? 
2. Kaip šalinamas lentelės duomenų filtras? 
3. Ką reiškia filtravimo sąlyga: Like „D*“? 
4. Kuo skiriasi formos pavidalo filtras nuo lentelės filtro? 
5. Kaip sudaromas išplėstinis filtras? 
6. Kokia komanda leidžia išsaugoti filtrą kaip užklausą? 
7. Kokias sąlygas galima naudoti sudarant išplėstinį filtrą? 
8. Kam yra skirtos išplėstinio filtro projekto sritys: Field, Sort ir 

Criteria? 
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3.7.5. Dialoginių užklausų atlikimo būdai 
 

1. Darbo tikslas 
 
Išsiaiškinti, kokie duomenų apdorojimo būdai atliekami vyk-

dant užklausas, kokie yra užklausų tipai. Išmokti duomenų bazėje 
kurti dialogines užklausas. 

 
2. Darbo užduotys  
 

1. Iškvieskite programą MS Access. Atverkite sukurtąją duomenų 
bazę. 

2. Išsiaiškinkite, kokie yra užklausų tipai ir kokiais atvejais jie 
naudojami. 

3. Atlikite dialoginę užklausą, pavyzdžiui, formuodami ją iš lentelių 
Autoriai ir Organizacijos. Užklausos tikslas – išsiaiškinti tikslų 
autoriaus adresą. 

4. Susipažinkite su užklausos projekto langu bei projekto sudarymo 
būdais. 

5. Susipažinkite su reiškinių konstruktoriumi ir jo naudojimu vykdant 
užklausas. 

 
3. Metodiniai nurodymai 
 
Kokie yra užklausų tipai ir kokius duomenų apdorojimo bū-

dus jos vykdo? 
Duomenų bazei pateikiamos užklausos vykdo informacines pa-

slaugas. Užklausos suteikia galimybes: 
 Iš vienos arba kelių tarpusavyje susijusių lentelių išskirti 
reikalingus duomenis; 
 Su duomenimis, pateiktais duomenų bazėje, atlikti skaičia-
vimus; 
 Gauti pageidaujamą duomenų lentelę; 
 Lentelėse keisti duomenis – papildyti naujais įrašais ir ša-
linti nereikalingus. 

Galima išskirti šiuos duomenų bazės užklausų tipus: 
 Atrankos užklausos (Select query). Šios užklausos sudaro-
mos norint pateikti laikiną informacijos darinį iš kelių su-
sijusių lentelių ir kitų užklausų; 
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 Lentelių kūrimo užklausos (Make-Table query) sudaromos, 
norint pateikti naujas lenteles, kuriose būtų atrankos rezul-
tatai; 
 Duomenų tvarkymo užklausos. Jos keičia duomenų bazių 
lentelių duomenis. 

 
Kaip atlikti dialoginę užklausą? 
Kai kuriais atvejais norint patikslinti duomenis (pvz., parodant 

reikiamą informaciją apie autorių) ne visuomet naudinga iš naujo nu-
statyti paieškos kriterijus (pvz., nustatyti vis kitą pavardę, norint 
gauti informaciją apie kitą autorių). Naudingiau sukurti dialoginę 
(klausiančiąją) užklausą. 

Norėdami išsiaiškini straipsnio autoriaus adresą, užklausą for-
muosime iš dviejų lentelių: Autoriai ir Organizacijos duomenų. 

Esant aktyviam duomenų bazės objektui Query spaudžiame 
priemonių juostos mygtuką New arba vykdome pagrindinio meniu 
komandą Insert→Query ir pasirenkame užklausos formavimo būdą 
Desing View. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.50 pav. Užklausos formavimo būdo pasirinkimo pavyzdys 
 
 

Dialogo lange Show Table pažymime lenteles, iš kurių duo-
menų formuosime užklausą, pavyzdžiui, Autoriai ir Organizacijos 
(žymėdami jų pavadinimus ir spausdami mygtuką Add). 
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3.51 pav. Lentelių parinkimo langas dialoginei užklausai formuoti 
 
 

Užklausos projekto langas 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.52 pav. Dialoginės užklausos projekto langas ir jos išsaugojimas 

Užklausos laukai, kurių atitikmenys yra duomenų 
lentelėse, eilutėje Show pažymėti paukščiukais. Jie 

bus rodomi suformuotoje užklausoje. 

Užklausos laukas, kurio duomenys 
įvedami vykdant užklausą 
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Klausiančioji užklausa, be lentelių laukų, į kuriuos duomenys 
surenkami iš atitinkamų lentelės stulpelių, turi papildomus laukus, 
skirtus įvesti duomenis kiekvieną kartą, kai vykdoma užklausa. 

Papildomą lauką, skirtą sutapatinti duomenis, galima įvesti 
klaviatūra arba pasitelkiant reiškinių konstruktorių. Kaip naudoti 
reiškinių konstruktorių, aprašyta toliau pateiktuose šio darbo metodi-
niuose nurodymuose. Lauke Field reikėtų įvesti šiuos duomenis: 
[Autoriai] [Pavardė] Like [Įveskite pavardę]. Čia: 

Autoriai – lentelės pavadinimas; 
Pavardė – lauko lentelėje pavadinimas; 
Like – tapatinimo operatorius, jis iš abiejų pusių atskiriamas 
tarpo ženklu; 
[Įveskite pavardę] – dialoginės užklausos pranešimo tekstas. 
Papildomo lauko Field dalyje Criteria įvedama reikšmė –1, 

apibūdinanti lyginimo sąlygas: reikšmė –1 laukų sutapatinimo sąlygą 
tenkina, reikšmė 0 sąlygos netenkina. Žymuo Show išjungiamas, kai 
užklausos rezultatui ši reikšmė nereikalinga. 

Sudarius užklausos projektą, jį reikia išsaugoti kaip užklausą, 
įvedant užklausos pavadinimą, pavyzdžiui, Autoriaus_adresas. 

Vykdant dialoginę užklausą (užklausa vykdoma dukart spau-
džiant kairįjį pelės klavišą ties užklausos pavadinimu) pirmiausiai 
pasirodys pranešimas, reikės įvesti lauko reikšmę (3.53 pav.). Ją įve-
dus programa analizuos duomenis ir juos pateiks pagal užklausos 
sąlygas. 
 
 
 
 
 
 
 
 

3.53 pav. Dialoginės užklausos langas pavardei įvesti 
 
 

Suformavus užklausą Autoriaus_adresas įvedama pavardė, pa-
vyzdžiui, Pauliukas, ir toliau pateiktoje lentelėje pagal anksčiau su-
darytą užklausos projektą gaunamas užklausos rezultatas. 
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3.54 pav. Dialoginės užklausos pateikti duomenys įvedus pavardę Pauliukas 
 

Kaip naudotis reiškinių konstruktoriumi sudarant užklausą? 
Skaičiuojamieji laukai – vieni svarbiausių užklausų ir ataskaitų 

struktūrinių elementų. Juose aprašoma, kaip iš bazėje saugomų duo-
menų gaunami vartotojui reikalingi duomenys. Duomenims laikyti 
skirtose lentelėse tokių laukų nėra. 

Reiškinių konstruktorius skirtas sudaryti sudėtingesnėms duo-
menų atrankos sąlygoms. 

Reiškinius į skaičiuojamus laukus galima įvesti klaviatūra arba 
vykdant specialią komandą, vadinamą reiškinių konstruktoriumi 
(Builder). Esant užklausos projekto lange, priemonių juostos myg-
tuku Build atveriamas reiškinių konstruktoriaus langas (Expression 
Builder). 
 

Mygtukas Build skirtas reiškinių  
konstruktoriaus langui iškviesti 

 
 
 
 

3.55 pav. Bendroji priemonių juosta 

 
Kitas būdas iškviesti reiškinių konstruktorių – esant užklausos 

projekto lange ties lauku Field spausti dešinįjį pelės klavišą ir pasi-
rodžius kontekstiniam meniu vykdyti komandą Build. Ši komanda 
atveria reiškinių konstruktoriaus langą Expression Builder. Reiškinių 
konstruktoriaus lango viršuje sudaromas reiškinio laukas, kurio ele-
mentai parenkami iš lango apačioje matomų sąrašų ir iš lango vidu-
ryje matomų dažniausiai naudojamų lyginimo operatorių sąrašo. 
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Reiškinių konstruktoriaus lango kairėje apačioje matomi sąra-
šai – tai duomenų bazės objektai: lentelės, užklausos, funkcijos, 
konstantos ir kita. Kiekvienas šis objektas gali turėti jam būdingas 
grupes arba kategorijas – tai vidurinioji reiškinių konstruktoriaus 
skiltis. Kategorijos ir grupės gali turėti reikšmes arba elementus – 
skiltis dešinėje. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.56 pav. Reiškinių konstruktoriaus langas ir priemonės,  
naudojamos sudarant užklausą 

 
 

Atliekant anksčiau aprašytą užduoties pavyzdį pavardės, esan-
čios Autorių lentelėje, lyginamos su užklausos pranešimo langelyje 
įvesta pavarde. Sudarant užklausos projektą projekto lango eilutėje 
Field iškviečiamas reiškinių konstruktorius. 

Reiškinių konstruktoriaus lange (Expression Builder) pasiren-
kama lentelė Autoriai ir dvigubu kairiojo pelės klavišo paspaudimu 
laukas Pavardė įrašomas į sudaromą reiškinio lauką. Konstruktoriaus 
lango viršuje pelės klavišu spaudžiant operatoriaus žymą Like į suda-
romą reiškinį įvedamas duomenų sutapatinimo operatorius (Like) ir 
klaviatūra laužtiniuose skliaustuose renkamas užklausos pranešimo 
tekstas [Įveskite pavardę]. 

Pasirinktas laukas   

Duomenų lentelės 
pavadinimas 

Lauko 
pavadinimas 

lentelėje 

Sutapatinimo 
operatorius 

Like 

Užklausos dialogo lango 
tekstas  

Operacijos ir 
lyginimo 

operatoriai 
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Kontroliniai klausimai 
 
1. Kokius žinote skirtingos paskirties užklausų tipus? 
2. Kokia užklausos veiksmų kūrimo seka? 
3. Kam skirtos užklausos projekto lango eilutės Field, Criteria, 

Show? 
4. Kaip užklausos rezultatus išdėstyti didėjimo arba mažėjimo tvar-

ka? 
5. Ar galima išsaugoti suformuotą užklausą? 
6. Kaip vykdomos užklausos? 
7. Kada patogu naudoti dialogines užklausas? 
8. Kam skirtas reiškinių konstruktorius? 
9. Kaip reiškinių konstruktoriumi parinkti argumentus ir funkcijas? 
 
 
 
3.7.6. Suvestinių duomenų užklausų  
          atlikimo būdai 
 

1. Darbo tikslas 
 
Išmokti duomenų bazėje atlikti suvestines užklausas. 
 

2. Darbo užduotys 
 

1. Iškvieskite programą MS Access. Atverkite sukurtą duomenų bazę. 
2. Išsiaiškinkite, kokio tipo užklausos vadinamos suvestinėmis už-

klausomis. 
3. Atlikite suvestinę užklausą, pavyzdžiui, formuodami ją iš lentelės 

Autoriai. Užklausos tikslas – pateikti autorių, parašiusių konferen-
cijai skirtus straipsnius, skaičių pagal pareigas skirtingose organi-
zacijose. 

4. Susipažinkite su suvestinės užklausos projekto langu bei projekto 
sudarymo būdu. 

5. Susipažinkite su reiškinių konstruktoriumi ir jo naudojimu vykdant 
užklausas. 
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3. Metodiniai nurodymai 
 
Kam naudojamos suvestinės užklausos ir kokius duomenų 

apdorojimo būdus jos atlieka? 
Duomenų bazėse laikomi duomenys dažnai naudojami suvesti-

nėms sudaryti. Suvestinėmis vadinami dokumentai, kuriuose yra api-
bendrinti duomenys, t. y. pagal įvairius duomenų požymius susu-
muoti rezultatai, statistiniai duomenų įverčiai ir panašiai. 

Sudarant suvestines duomenų užklausas naudojamos duomenų 
skaičiavimo funkcijos, MS Access programoje vadinamos agregati-
nėmis (Aggregate). Šių funkcijų argumentai yra duomenų bazės 
duomenys. Dažniausiai šios funkcijos naudojamos ataskaitoms suda-
ryti, tačiau jas galima taikyti ir atliekant užklausas. 

 
Kaip iškviesti projekto langą suvestinei užklausai formuoti? 
Užklausą formuosime iš lentelės Autoriai duomenų. 
Esant aktyviam duomenų bazės objektui Query spaudžiame 

priemonių juostos mygtuką New arba vykdome pagrindinio meniu 
komandą Insert→Query ir pasirenkame užklausos formavimo būdą 
Desing View. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.57 pav. Užklausos formavimo būdo Design View pasirinkimas  
 

Dialogo lange Show Table spausdami mygtuką Add išrenkame 
lenteles, iš kurių duomenų formuosime užklausą, pavyzdžiui, lentelę 
Autoriai. 



3 skyrius. DUOMENŲ BAZĖS IR JŲ VALDYMO SISTEMOS 126 

Kaip sudaryti suvestinės užklausos projektą? 
Panagrinėsime pavyzdį, kaip sudaryti suvestinį užklausos pro-

jektą, kuris pateiktų organizacijų autorių skaičių pagal dalyvaujan-
čiųjų konferencijoje pareigas. 

Suvestinės užklausos projektas sudaromas šia seka: 
 Aprašomi suvestinės užklausos laukai; 
 Vykdoma pagrindinio meniu komanda View→Totals; 
 Parenkamos tinkamos suvestinės užklausos laukų funkcijos. 

Suvestinės užklausos laukų aprašymas 
Projektuojamoje užklausoje reikalingi du grupavimo požymiai, 

esantys lentelės Autoriai laukuose Organizacijos santrumpa ir Pa-
reigos. Iš lentelės Autoriai į projekto eilutę Field pele nutempiami 
laukų Organizacijos santrumpa ir Pareigos pavadinimai. 

Projekte nurodant grupavimo laukus formuojami skaičiavimo 
argumentų laukai. Bus skaičiuojamas pavardžių skaičius, todėl į tre-
čiąjį projekto stulpelį nutempiamas laukas Pavardė. 

Įvykdžius komandą View→Totals projekto lange įterpiama 
eilutė Total, parenkamos tinkamos suvestinės užklausos laukų 
funkcijos. 

Total eilutėje organizacijos santrumpai ir pareigoms įrašyti pa-
liekami reikšmės grupavimo požymiai ir parenkama skaičiuojamo 
Pavardės lauko įrašų skaičiavimo funkcija Count. 

 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 

3.58 pav. Suvestinės užklausos projekto langas 
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Suvestinės užklausos rezultatas naudojant lentelės Autoriai 
duomenis pateikiamas 3.59 pav. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.59 pav. Suvestinės užklausos rezultatai 
 
 
 

Kontroliniai klausimai 
 

1. Kokiems duomenims pateikti naudojamos suvestinės užklausos? 
2. Kokia suvestinės užklausos veiksmų kūrimo seka? 
3. Kam skirta eilutė Total suvestinės užklausos projekto lange? 
4. Ar galima išsaugoti suformuotą suvestinę užklausą? 
5. Kaip vykdomos suvestinės užklausos? 
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3.7.7. Kelias lenteles siejančių užklausų  
          atlikimo būdai 

 
1. Darbo tikslas 
 
Išmokti atlikti užklausą susiejant kelių lentelių duomenis. At-

liekant šio tipo užklausą duomenys iš duomenų bazės atrenkami pa-
gal vartotojo sudarytą projektą. 

 
2. Darbo užduotys 
 

1. Iškvieskite programą MS Access. Atverkite sukurtą duomenų bazę. 
2. Išsiaiškinkite kelias lenteles siejančių užklausų atlikimo būdus ir 

šių užklausų naudojimo atvejus. 
3. Suprojektuokite užklausą, pavyzdžiui, formuodami ją iš lentelių 

Autoriai, Straipsniai ir Autorių_STR_susiejimas. Užklausos tikslas 
– išsiaiškinti, kokius straipsnius ir kokia tema pateikė autoriai. 

4. Susipažinkite su užklausos projekto langu bei projekto sudarymo 
priemonėmis. 

5. Sudarykite užklausą, kurį pagal temas išrinktų autorius ir jų 
straipsnius. 

 
3. Metodiniai nurodymai 
 
Kokiais atvejais naudojamos kelias lenteles siejančios už-

klausos? 
Užklausa gali būti sudaroma susiejant kelias lenteles ir iš šių 

tarpusavyje susijusių lentelių išskiriant reikalingus duomenis. Šio 
tipo užklausos priskiriamos prie atrankos užklausų (Select query). Jos 
sudaromos norint pateikti laikiną informacijos darinį iš tarpusavyje 
susijusių kelių lentelių ir jau suformuotų užklausų. 

 
Kaip sukurti kelių lentelių užklausą? 
Kai kuriais atvejais norint pateikti duomenis (pvz., kai paro-

doma reikiama informacija apie straipsnį ir jo autorių kolektyvą) juos 
reikia išrinkti iš kelių lentelių. 

Užklausą atliksime susiedami tris lenteles: Autoriai, Straips-
niai ir Autorių_STR_ susiejimas. 
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Esant aktyviam duomenų bazės objektui Query spaudžiamas 
priemonių juostos mygtukas New arba vykdoma pagrindinio meniu 
komandą Insert→Query ir pasirenkama užklausos formavimo būdas 
Design View. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.60 pav. Užklausos formavimo būdo Design View pasirinkimas  
 
 

Užklausos projekto langas 
Dialogo lange Show Table išrenkamos lentelės, iš kurių duo-

menų bus formuojama užklausa, pavyzdžiui, Autoriai, Straipsniai ir 
Autorių_STR_susiejimas (žymint jų pavadinimus ir spaudžiant myg-
tuką Add). 

Lentelių ryšių projekte nurodyti ryšiai bus pažymėti ir užklau-
sos projekto lange. 

Pasirenkami laukai iš atskirų lentelių (3.61 pav.). 
Sudarius užklausos projektą ir uždarant projekto langą, pro-

grama paprašys jį išsaugoti kaip užklausą. Tuomet reikia įvesti už-
klausos pavadinimą, pavyzdžiui, Straipsniai ir autoriai, bei jį išsau-
goti. 

Vykdant jau suformuotą užklausą duomenys bus pateikti pagal 
sudarytą užklausos projektą. 

Įvykdžius užklausą Straipsniai ir autoriai, gaunamas užklau-
sos rezultatas (3.62 pav.). 
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3.61 pav. Kelių lentelių užklausos projekto langas 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.62 pav. Kelių lentelių užklausos rezultatai 
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Kontroliniai klausimai 
 

1. Kokius žinote skirtingos paskirties užklausų tipus? 
2. Kokia yra kelias lenteles siejančios užklausos veiksmų kūrimo se-

ka? 
3. Kam skirtos užklausos projekto lango eilutės Field, Criteria, Show? 
4. Kaip užklausos rezultatus išdėstyti didėjimo arba mažėjimo tvar-

ka? 
5. Kaip redaguoti suformuotą užklausą? 

 
 
 

3.7.8. Kryžminių suvestinių duomenų užklausos 
 
1. Darbo tikslas 
 
Išmokti duomenų bazėje atlikti kryžmines suvestines užklau-

sas. 
 
2. Darbo užduotys 
 

1. Iškvieskite programą MS Access. Atverkite sukurtą duomenų bazę. 
2. Išsiaiškinkite, kokio tipo užklausos vadinamos kryžminėmis 

suvestinėmis užklausomis. 
3. Suprojektuokite kryžminę suvestinę užklausą, kurios tikslas – su-

skaičiuoti, kiek skirtingų organizacijų autorių pateikė straipsnius 
skirtingomis temomis, formuodami ją iš užklausos Straipsniai ir 
autoriai. 

4. Susipažinkite su kryžminės suvestinės užklausos formavimu 
pasitelkiant vedlį. Atlikite kryžminės suvestinės užklausos forma-
vimo etapus: 

 Vedlio lango iškvietimas kryžminei suvestinei užklausai 
formuoti; 
 Kryžminei suvestinei užklausai reikalingo duomenų šaltinio 
(lentelės, užklausos ir pan.) parinkimas; 
 Kryžminei suvestinei užklausai reikalingų eilučių požymių 
laukų parinkimas; 

 Kryžminei suvestinei užklausai reikalingo stulpelio požy-
mio lauko parinkimas; 
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 Kryžminės suvestinės užklausos lauko, skirto skaičiavi-
mams atlikti, parinkimas; 
 Kryžminės suvestinės užklausos vykdymas ir išsaugojimas. 

 
3. Metodiniai nurodymai 
 
Kam naudojamos kryžminės suvestinės užklausos? 
Kryžminės suvestinės užklausos plačiai taikomos analizuojant 

duomenis, duomenų pasiskirstymą pagal du požymius. Kryžminių 
suvestinių užklausų eilutės skiriamos vieno požymio reikšmėms, o 
stulpeliai – kito požymio reikšmėms pateikti. Pasitelkiant kryžmines 
suvestines užklausas gali būti skaičiuojamas įrašų kiekis, laukų 
reikšmių sumos, statistikos duomenys. 

Sudarant kryžmines suvestines užklausas duomenų bazėse 
naudojamos specialios Crosstab Query tipo užklausos. 

 
Kaip iškviesti vedlio langą kryžminei suvestinei užklausai 

formuoti? 
Užklausa bus formuojama iš užklausos Straipsniai ir Autoriai 

(žr. 3.7.7. praktinį darbą) duomenų. 
Esant aktyviam duomenų bazės objektui Query spaudžiamas 

priemonių juostos mygtukas New arba vykdoma pagrindinio meniu 
komanda Insert→Query bei pasirenkamas užklausos formavimo bū-
das Crosstab Query Wizard. 

Šias užklausas patogu rengti naudojantis vedliu (Wizard). 
 
 
 
 
 
 
 
 
 
 
 

3.63 pav. Kryžminės užklausos formavimo būdo  
pasirinkimas vykdant komandą Insert→Query 
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Kaip parinkti kryžminei suvestinei užklausai reikalingą duo-
menų šaltinį? 

Įvykdžius komandą Insert→Query atveriamas Qrosstab Query 
Wizard langas, kuriame reikia parinkti duomenų šaltinį, pavyzdžiui, 
užklausą Straipsniai ir autoriai.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.64 pav. Kryžminės užklausos duomenų šaltinio parinkimas 
 
 

Parinkus šaltinį – užklausą Straipsniai ir autoriai  – ir paspau-
dus mygtuką Next, bus atvertas langas eilutėms skirto požymio lau-
kui parinkti. 

 

Kaip parinkti kryžminei suvestinei užklausai atlikti reikalin-
gus eilučių požymių laukus? 

Iš sąrašo Available Fields mygtuku > perkeliame eilutėms 
skirto požymio lauko pavadinimą Organizacijos santrumpa į sąrašą 
Selected Fields. Sudarant kryžmines suvestines užklausas suvestinių 
eilutėse gali būti keli skirtingi laukai, tuomet duomenys bus paskirs-
tomi pagal kelis požymius. 

Mygtuku Next pereinama į stulpelių požymio parinkimo langą. 
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3.65 pav. Eilutės požymio laukų  parinkimas 
 

Kaip parinkti kryžminei suvestinei užklausai atlikti reikalingą 
stulpelio požymio lauką? 

Šis langas yra analogiškas eilučių parinkimo langui, tačiau čia 
galima parinkti tik vieną lauko pavadinimą. Stulpelio pavadinimui 
kurti rinksimės Temos lauką. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.66 pav. Stulpelio požymio laukų  parinkimas 
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Kaip parinkti kryžminės suvestinės užklausos lauką, skirtą 
skaičiavimams atlikti? 

Spaudžiant mygtuką Next atveriamas dar vienas langas, ku-
riame reikia nurodyti lauko pavadinimą, skirtą skaičiavimams atlikti. 
Vykdant kryžminę suvestinę užklausą bus skaičiuojamas autorių kie-
kis, todėl reikia pažymėti lauko reikšmę Pavardė, o funkcijų grupėje 
– įrašams skaičiuoti skirtą funkciją Count. 

Sąraše Functions funkcijų rinkinys priklauso nuo pasirinkto 
lauko duomenų tipo. Esant skaitinėms ir tekstinėms reikšmėms pa-
teikiamas skirtingas funkcijų sąrašas. Mūsų pateiktame pavyzdyje 
matyti funkcijų sąrašas, skirtas dirbti su teksto lauku. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.67 pav. Lauko, skirto skaičiavimams kryžminėje  
užklausoje atlikti, parinkimas 

 
 

Esant pažymėtam jungikliui Yes, Include row sums turi būti 
skaičiuojamos kiekvienos eilutės duomenų sumos. 
 

Kaip išsaugoti ir vykdyti kryžminę suvestinę užklausą? 
Paskutiniame kryžminės suvestinės užklausos lange nurodo-

mas užklausos pavadinimas, ji formuojama mygtuku Finish. 
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3.68 pav. Kryžminės užklausos išsaugojimo ir vykdymo langas 

 
 

Darbo rezultatas – kryžminė suvestinė duomenų lentelė, ku-
rioje matyti autorių iš skirtingų organizacijų ir tų pačių organizacijų 
autorių, rašančių viena tematika, skaičius. 
 
 
 
 
 
 
 

3.69 pav. Kryžminės užklausos rezultatų lentelė 
 
 
Kontroliniai klausimai 
 

1. Kokiems duomenims pateikti naudojamos kryžminės suvestinės 
užklausos? 

2. Kokia yra kryžminės suvestinės užklausos veiksmų kūrimo seka? 
3. Kokie požymių laukai parenkami kryžminėje suvestinėje užklau-

soje? 
4. Ar galima išsaugoti suformuotą kryžminę suvestinę užklausą? 
5. Kaip vykdomos kryžminės suvestinės užklausos? 
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3.7.9. Lentelių kūrimo, papildymo, įrašų šalinimo,  
          duomenų keitimo užklausos 
 
1. Darbo tikslas 
 
Išmokti duomenų bazėje formuoti išvestinę lentelę, sukurti už-

klausas, leidžiančias pildyti arba šalinti įrašus ir pakeisti lauko len-
telės reikšmes. 
 

2. Darbo užduotys 
 
1. Iškvieskite programą MS Access. Atverkite sukurtąją duomenų 

bazę. 
2. Išsiaiškinkite, kokio tipo užklausos vadinamos lentelių kūrimo ir 

prijungimo užklausomis. 
3. Atrankos užklausai suteikite lentelės kūrimo funkciją, pavyzdžiui, 

užklausai Suvestinė suteikite lentelių kūrimo funkciją, kad ši už-
klausa formuotų duomenų bazės lentelę, kurios pavadinimas – Su-
vestinė. 

4. Panaikinkite sukurtosios užklausos lentelės kūrimo funkciją. 
5. Išsiaiškinkite, kaip sudaryti lentelių papildymo užklausas? 
6. Išsiaiškinkite, kaip sudaromos įrašų šalinimo iš lentelės užklausos, 

sukurkite įrašų šalinimo užklausą. 
7. Išsiaiškinkite, kaip organizuojamos lentelės duomenų keitimo už-

klausos, sukurkite duomenų keitimo užklausą. 
 

3. Metodiniai nurodymai 
 
Kokiu tikslu duomenų bazėse naudojamos lentelių kūrimo ir 

prijungimo užklausos? 
Visos anksčiau nagrinėtos užklausos vadinamos atrankos už-

klausomis, nes duomenis iš duomenų bazės jos atrenka pagal varto-
tojo nurodytas sąlygas. Tokių užklausų lentelės formuojamos kas-
kart, kai tik vykdoma užklausa, patys užklausų lentelės duomenys 
nėra saugomi. 

Jeigu atrinkimo užklausos rezultatus reikia išsaugoti kaip len-
telę ir laikyti su kitais duomenų bazės duomenimis, atrankos už-
klausą reikia pertvarkyti į lentelės kūrimo užklausą. 
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Kaip pertvarkyti užklausą, kad ji virstų nauja duomenų bazės 
lentele? 

Duomenų bazę papildysime nauja suvestinės užklausos lentele. 
Jeigu anksčiau sudarytą suvestinių užklausą reikia išsaugoti 

kaip naują lentelę, atliekami šie veiksmai: 
 Pagrindinio lango užklausų objekte pažymimas užklausos 
pavadinimas Suvestinė; 
 Nuspaudžiamas mygtukas Design ir atveriamas užklausos 
projekto langas; 
 Vykdoma pagrindinio meniu komanda Query→Make Table 
Query. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.70 pav. Lentelės kūrimo užklausos langas 
 
 

Įvykdžius komandą Query→ Make Table Query pateikiamas 
langas Make Table, skirtas naujai kuriamos lentelės pavadinimui, pa-
vyzdžiui, Suvestinė, įvesti. Atlikus nurodytus veiksmus suvestinės at-
rankos užklausai suteikiama lentelės kūrimo funkcija. Lentelė suku-
riama, priemonių juostos mygtuku Run arba komanda Query→Run. 
Vykdant lentelių kūrimo užklausą išvestinė duomenų lentelė kiek-
vieną kartą perrašoma iš naujo. 
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3.71 pav. Kuriamos lentelės pavadinimo įrašymo langas 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.72 pav. Lentelės kūrimo komandos  
Query→Run vykdymas 

 
 

Kaip atšaukti lentelės kūrimo funkcijas? 
Suvestinės užklausos projekto lange vykdant komandą 

Query→Select Query galima panaikinti lentelės kūrimo ir palikti tik 
atrankos funkciją, t. y. grįžti prie buvusių užklausos funkcijų, pavyz-
džiui, Suvestinės užklausos. 
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3.73 pav. Lentelės kūrimo iš užklausos funkcijos panaikinimo komanda  

 
 

Kaip sudaryti lentelių papildymo užklausas? 
Kai duomenis reikia papildyti, užklausą patogu pertvarkyti į 

lentelės papildymo užklausą, kuri atrenkamus įrašus prijungtų prie 
lentelėje esančių įrašų. Vykdant prijungimo užklausą nekuriama 
nauja lentelė, todėl iš pradžių reikia sukurti užklausos rezultatams 
pritaikytą tuščią lentelę. 

Lentelių papildymo užklausa vykdoma komanda Query→ 
Append Query. 

Pavyzdžiui, lentelės papildymo užklausa galėtų būti vykdoma į 
suvestinių lentelę įrašant metus, o vėliau, kitais metais, rengiant 
naujas konferencijas, šiuos duomenis papildant naujais. 

 
Kaip sudaromos duomenų šalinimo užklausos? 
Tarkime, iš suvestinės lentelės reikia pašalinti įrašus, kurių or-

ganizacijos santrumpa – VU. 
Sudarant šalinimo užklausą užklausos projekto lange reikia pa-

sirinkti lentelę Suvestinė ir vykdyti komandą Query→Delete Query. 
Ši komanda suformuoja projekto eilutę Delete. 
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Į pirmąjį stulpelio lauką perkelkime simbolį *, nurodantį, kad į 
šalinimo užklausą turi būti įtraukiami visi lentelės laukai. Žyma 
From nurodo, kad iš šios lentelės bus šalinami įrašai. Žyma Where 
informuoja, kad tai – šalinamų įrašų požymių aprašymo stulpelis. 

Toliau pateiktame lange parodytas dialoginės užklausos lango 
projektas suvestinės lentelei sudaryti.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3.74 pav. Šalinimo įrašų užklausos projekto langas 

 
Baigta formuoti ši lentelė vykdant užklausą pateikia vartotojui 

dialogo langą, skirtą šalinamo įrašo organizacijos santrumpai įrašyti. 
 
 
 
 
 
 

3.75 pav. Dialogo langas šalinamų įrašų  
organizacijos santrumpai įvesti 

 
Panašiai lentelėse parengiamos ir kaskadinio šalinimo užklau-

sos, atrenkančios duomenis pagal ryšius vienas su daugeliu. Kad už-
klausa vyktų sėkmingai, reikia, jog būtų įjungta ryšio savybė Cas-
cade Delete Related Records. 
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Kaip atliekamos duomenų keitimo užklausos? 
Tarkime, reikia organizuoti dialoginę užklausą, leidžiančią su-

vestinių lentelėje pakeisti organizacijos santrumpą. Tuomet reikia: 
 Sudaryti duomenų keitimo užklausos projekto langą ir įkelti 
į jį lentelės, kurios duomenis keisime, pavadinimą; 
 Vykdyti pagrindinio meniu komandą Query→Update Query; 
 Į Field lauką perkelti keičiamo lauko pavadinimą; 
 Eilutėje Update to laužtiniuose skliaustuose įrašyti prane-
šimą, kuris bus pateikiamas įvedant naują lauko reikšmę; 
 Eilutėje Criteria įrašyti pranešimą, kuris bus pateikiamas 
įvedant naują lauko reikšmę; 
 Išsaugoti pakeitimo užklausą arba ją iškart vykdyti. 

 
 
 
 
 
 
 
 
 
 

3.76 pav. Duomenų keitimo užklausos formavimo langas vykdant komandą 
Query→Update Query ir duomenų keitimo užklausos išsaugojimas 

 
Vykdant keitimo užklausą programa pateikia du dialogo langus 

naujai ir senai reikšmėms įrašyti. 
 

Kontroliniai klausimai 
 

1. Nurodykite veiksmus, reikalingus atliekant lentelių kūrimo už-
klausą. 

2. Paaiškinkite, kaip galima sukurti užklausą, skirtą papildyti lentelę 
naujais duomenimis. 

3. Kokia užklausos įrašų šalinimo iš lentelės veiksmų kūrimo seka?  
4. Kokia užklausos lauko reikšmių keitimo lentelėse veiksmų kūrimo 

seka? 
5. Kaip vykdomos sukurtos užklausos? 
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3.7.10. Ataskaitos duomenų bazėje 
 
1. Darbo tikslas 
 
Išsiaiškinti, kam skirtos ataskaitos, kokiems duomenų apdoro-

jimo būdams vykdyti reikalingos ataskaitos. Išmokti duomenų ba-
zėje, sukurtoje programa Microsoft Access, sudaryti ir išspausdinti 
ataskaitą. 

 
2. Darbo užduotys  
 

1. Iškvieskite programą MS Access. Atverkite sukurtą duomenų bazę. 
2. Išsiaiškinkite, kam skirtos ataskaitos ir kaip jos apdoroja duome-

nis. 
3. Sudarykite ataskaitą, pavyzdžiui, formuodami ją iš užklausos 

Straipsniai ir autoriai pagal konferencijoje dalyvaujančių autorių 
sąrašą, sugrupuokite juos pagal temas, skaitomus pranešimus ir 
autorių eilės tvarką. 

4. Susipažinkite, kaip ataskaita formuojama pasitelkiant vedlį. 
5. Išspausdinkite ataskaitą. 

 
3. Metodiniai nurodymai 
 
Kam naudojamos ataskaitos (Reports) ir kokiems duomenų 

apdorojimo būdams vykdyti jos skirtos? 
Duomenų bazių ataskaitos padeda parengti patogius duome-

nims analizuoti ir gražios išvaizdos dokumentus bei juos spausdina. 
Ataskaitų duomenų šaltiniai gali būti duomenų bazių lentelės ir už-
klausos. Lentelių bei užklausų duomenys taip pat gali būti spausdi-
nami nerengiant ataskaitų, tačiau taip išspausdinti duomenys dažnai 
netenkina dokumentams keliamų reikalavimų – yra neišvaizdūs, 
juose nėra patogu peržiūrėti ir analizuoti duomenis. 

Projektuojant ataskaitas duomenų šaltiniai pasirenkami iš vie-
nos arba kelių tarpusavyje susijusių lentelių, tuo pat metu galima 
naudotis ir užklausose išskirtais duomenimis. Ataskaitoms projek-
tuoti naudojamas jų projekto langas arba ataskaitų kūrimo vedliai, 
pateikiantys šablonus, kuriuos vartotojas gali pritaikyti kurdamas sa-
vo ataskaitą ir įvesdamas į juos reikiamus lentelių ir užklausų laukus. 
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Ataskaitose duomenys grupuojami ir rikiuojami pagal varto-
tojo parinktus duomenis, į jas galima įterpti grupavimo požymius, 
skaičiavimo laukus ir susumuoti duomenis. 

Rengiant ataskaitas galima rinktis įvairias dokumento išdės-
tymo formas, šablonus, grupavimo ir duomenų rikiavimo būdus. Yra 
galimybė nustatyti lapo dydį, jo padėtį ir paraštes. 

Pasitelkiant duomenų bazėje pateiktus lentelių ir užklausų duo-
menis galima sudaryti ir spausdinti įvairiausius ataskaitų projektus. 
 

Kaip išspausdinti sudarytą ataskaitą pagal užklausos duome-
nis? 

Mūsų tikslas – kokybiškai išspausdinti konferencijoje daly-
vaujančių autorių sąrašą pagal temas ir skaitomus pranešimus bei 
autorių eilės tvarką. 

Duomenų bazėje šie duomenys jau yra. Jie suformuoti prakti-
niame darbe, nurodančiame, kaip vykdyti kelių lentelių užklausą 
Straipsniai ir autoriai. 

Esant aktyviam duomenų bazės objektui Reports dukart spau-
džiant kairįjį pelės klavišą pasirenkamas ataskaitos formavimo būdas 
Create report by using wizard. 

Pasirinkus atskaitos kūrimo priemonę – ataskaitų vedlį – ir at-
sivėrus langui Report Wizard, šiame lange pasirenkamas duomenų 
šaltinis, pavyzdžiui, jau anksčiau sukurta užklausa Straipsniai ir au-
toriai. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.77 pav. Formuojamos ataskaitos laukų parinkimas 



3.7. Duomenų bazių praktiniai darbai ir metodiniai nurodymai 145 

Šiame lange pažymimi visi ataskaitai sudaryti reikalingi laukai. 
Užklausos Straipsniai ir autoriai laukai pažymimi spaudžiant > 
mygtuką, jie perkeliami į Selected Fields sritį, tai atlikus spaudžia-
mas mygtukas Next ir atliekamas kitas žingsnis – parenkami grupa-
vimo požymiai (3.78 pav.). 

 
 
 
 

 
 
 
 
 
 
 
 

3.78 pav. Grupavimo požymių pateikimas 
 
 

Spaudžiant mygtuką Next pereinama į grupių lygių parinkimo 
langą. 
 
 
 
 
 
 
 
 
 
 
 
 

3.79 pav. Grupių lygių pateikimas 
 
 

Atliekant šį žingsnį parenkami grupavimo požymiai (3.79 pav.). 
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Pavyzdžiui, lauką Tema išskiriame kaip aukščiausio lygio 
grupę, pažymėdami jį ir spausdami > mygtuką. Tai atlikus spau-
džiant mygtuką Next pereinama į kitą žingsnį. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.80 pav. Duomenų rikiavimo tvarkos ataskaitoje parinkimo langas 
 

Šis Report Wizard langas (3.80 pav.) skirtas parinkti duomenų 
rikiavimo tvarką. Jo kairėje matyti ataskaitos vaizdas, dešinėje – ke-
turi laukai, skirti rikiavimo požymiams nustatyti. Mygtuku Ascen-
ding nurodoma duomenis išdėstyti abėcėlės tvarka. Paspaudus šį 
mygtuką jo užrašas pasikeičia į Descending, tuomet parinktieji duo-
menys išdėstomi priešinga negu abėcėlės tvarka. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.81 pav. Ataskaitos išdėstymo lape būdai 
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Ataskaitų apipavidalinimas 
Apipavidalinimo (Layout) srityje galima parinkti vieną iš šešių 

ataskaitos išdėstymo lape būdų. Pasirenkamas būdas yra pateikiamas 
kairėje lango dalyje. Dalyje Orientation pasirenkama vertikali 
(Portrait) arba horizontali (Landscape) lapo padėtis. Įjungtas jungik-
lis Adjust the field width so all fields fit on a page rodo, kad ataskai-
tos matmenys turi tilpti popieriaus lape. 
 
 
 
 
 
 
 

 
 
 
 

 
3.82 pav. Duomenų apipavidalinimo ataskaitoje parinkimo langas 

 

Šiame Report Wizard lange parenkami antraščių ir teksto šrif-
tai, kairėje pusėje pateikiamas pasirinktojo šrifto vaizdas. 
 
 
 
 
 
 
 
 
 
 
 
 

 
3.83 pav. Vedlio langas ataskaitai peržiūrėti ir formuluoti 
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Paskutiniame vedlio lange sudarytai ataskaitai suteikiamas pa-
vadinimas ir paspaudžiamas mygtukas Finish. 

Esant aktyviam Preview the report parametrui (3.83 pav.), pa-
spaudus Finish ataskaitą bus galima peržiūrėti. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.84 pav. Ataskaitos peržiūros langas 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.85 pav. Ataskaitos projekto langas 

Mygtukas Office-Links 
leidžia sukurti sąsają ir 
ataskaitą perduoti į kitą 
programą, pavyzdžiui, 
Excel arba įrašyti kaip 
Word dokumentą. 
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Jeigu netenkina duomenų padėtis lape arba kurie nors ata-
skaitos duomenys yra nereikalingi, esant suformuotai ataskaitai 
Straipsniai ir autoriai, paspaudus priemonių juostos mygtuką Design 
galima iškviesti projekto langą ir atlikti ataskaitos redagavimo veik-
smus. 

Etiketės tekstus galima redaguoti tiesiogiai įrašant simbolius ar 
pakeičiant juos naujais. Kad ataskaitos projekto lange esantys laukai 
vienas kito neuždengtų, galima sumažinti šrifto dydį arba padidinti 
įvedamo lauko plotį. 

Ataskaitoje galima naudoti bazės funkcijas. Jas galima atverti 
priemonių juostos mygtuku Build. Ataskaitą galima išspausdinti 
vykdant komandą File→Print. Dialogo lango Print lauke Name pa-
renkamas spausdintuvas, kuriuo bus spausdinama ataskaita. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

3.86 pav. Spausdinimo parametrų nustatymas 
 

Dalyje Print range parenkama spausdinamos ataskaitos dalis, 
nurodanti, kas bus spausdinama: 

 Visa ataskaita – All; 
 Ataskaitos lapai, kurių lapų numerių intervalas yra nurodo-
mas laukuose From (nuo) To (iki). 
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Dalyje Kopijų skaičius (Number of Copies) nurodomas ata-
skaitos kopijų skaičius. 

Jungikliu Collate nurodoma ataskaitos spausdinimo tvarka, 
jeigu spausdinama ne viena kopija. 

Mygtuku Setup atveriamas paraščių parinkimo langas. 
 
 
 
 
 
 
 
 
 
 
 
 

3.87 pav. Paraščių matmenų parinkimas 
 

Nustatomos lapo paraštės: viršaus – Top; apačios – Bottom; 
kairioji – Lefft; dešinioji – Right. 

Jungikliu Print Data Only įjungiamas juodraštinis spausdinimo 
variantas. Etikečių duomenys, linijos ir kiti dekoratyviniai elementai 
nespausdinami. 

Skyrelyje Stulpeliai (Columns) galima pasirinkti ataskaitos 
duomenų išdėstymo būdą. 
 
 
 
 
 
 
 
 
 
 

 
 

3.88 pav. Ataskaitos duomenų išdėstymas stulpeliais 
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Kontroliniai klausimai 
 

1. Kam skirtos duomenų bazių ataskaitos? 
2. Kokia ataskaitų kūrimo seka? 
3. Ar galima išsaugoti sudarytą ataskaitą? 
4. Kaip vykdoma ataskaitos peržiūra? 
5. Kaip ataskaitą išspausdinti popieriuje? 
6. Kaip iškviesti ataskaitos projekto langą ir kokius jau sudarytos ata-

skaitos pakeitimus galima atlikti projekto lange? 
7. Kam skirtas reiškinių konstruktorius (Build)? 
8. Kaip reiškinių konstruktoriumi parinkti parametrų lyginimo ir ki-

tas duomenų apdorojimo funkcijas? 
 
 
 
3.8. INFORMACIJOS PATEIKIMO PRAKTINIAI  
       DARBAI 
 

3.8.1. Serijinių laiškų rašymas naudojant  
          duomenų bazę 

 
1. Darbo tikslas 
 
Šio praktinio darbo tikslas – išmokti automatiškai rašyti seriji-

nius laiškus pasitelkiant duomenų bazės adresus. 
Serijiniams laiškams būdinga tai, kad pagrindinis tekstas ne-

kinta ir yra kartojamas visuose laiškuose, tik įrašant skirtingus rekvi-
zitus, pavyzdžiui, adresą, gavėjo vardą, pavardę, datą. 

Norint automatiškai įrašyti reikiamus rekvizitus, galima pasi-
naudoti sukurtos duomenų bazės, skaičiuoklių bei teksto redaktorių ir 
lentelių duomenimis. 

 
2. Darbo užduotys 

 
1. Iškvieskite MS Word programą. 
2. Paruoškite laiško spausdinimo šabloną. Atitinkamai parinkite 

spausdinamo lapo dydį, paraštes, autoriaus rekvizitų išdėstymo 
vietą bei laiško tekstą. 
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3. Surinkite laiško šablono tekstą (teksto pavyzdys pateiktas prakti-
nio darbo pabaigoje) ir išsaugokite jį, suteikdami failui pavadi-
nimą, pavyzdžiui, sablonasAM.doc. 

4. Iš duomenų bazės įterpkite užpildomų rekvizitų laukų pavadini-
mus, pasinaudokite konferencijos duomenų bazėje esančia lentele 
Autoriai. Failą išsaugokite diske (D:) aplanke Studentas arba dis-
kelyje (A:). 

5. Susiekite laiško šabloną ir duomenų bazės lentelę Autoriai ir 
parenkite laiškų rinkinį, skirtą visiems autoriams, esantiems duo-
menų bazės lentelėje Autoriai. Parengtąjį laiškų rinkinį išsaugokite 
suteikdami failui prasminį pavadinimą, pavyzdžiui, laiskai_ 
visiems.doc. 

6. Susiekite laiško šabloną ir duomenų bazę parengdami laiškų rin-
kinį, skirtą keliems adresatams, esantiems duomenų bazėje, pa-
vyzdžiui, kurių įrašų numeriai nuo 4-to iki 6-to imtinai. Išsaugo-
kite konkretaus laiškų rinkinio failą, suteikdami prasminį pavadi-
nimą, pavyzdžiui, laiskai_4_6.doc.  

7. Prieš spausdindami peržiūrėkite, kaip atrodo laiškai. 
8. Išsiaiškinkite, kaip sukurtą laišką galima būtų išsiųsti elektroniniu 

paštu, pavyzdžiui, pirmajam autoriui. Jūsų kompiuteryje turėtų 
būti instaliuota elektroninio pašto programa, pavyzdžiui, Outlook 
Express. 

9. Baikite dirbti su MS Word programa. 
 

3. Metodiniai nurodymai 
 
Kaip parinkti popieriaus lapo dydį, padėtį ir paraštes? 
Įvykdykite komandą File→Page Setup. Iš dialogo lango pasi-

rinkite skyrelį Paper Size. Iš išplėstinio sąrašo pasirinkite A4 formato 
lapo matmenis (210x297 mm). Puslapio padėties nustatymo (Orien-
tation) grafoje pasirinkite Portrait, t.y. vertikalią lapo padėtį. Iš iš-
plėstinio sąrašo Apply To pasirinkite Whole Document – visą doku-
mentą. Iš dialogo lango pasirinkite skyrelį Margins. Teksto įvedimo 
laukuose įrašykite, kokių matmenų paraščių norėsite: 

 Top – viršutinė paraštė – 3 cm, 
 Bottom – apatinė paraštė – 1 cm, 
 Left – kairioji paraštė – 2,5 cm, 
 Right – dešinioji paraštė – 1 cm. 
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Kaip į laiško šabloną įterpti duomenų bazės laukų pavadini-
mus? 

Į pasirinktąjį puslapį įrašykite pagrindinį laiško tekstą, kuris 
bus pastovus. Norint į laiško šabloną įterpti laukus, reikia vykdyti 
komandą Tools→Mail Merge ir atsivėrusiame lange Mail Merge 
Helper pasirinkti komandą Form Letters, skirtą kurti laiško formą. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.89 pav. Laiško formos pasirinkimo komandos  
Tools→Mail Merge dialogo langas 

 
 

Jeigu aktyviame lange yra parašytas laiško šablonas, rinkitės 
Active Window režimą, priešingu atveju sukursite naują dokumentą 
(New Main Document). 
 
 
 
 
 

3.90 pav. Klausiamasis dialogo langas laiško šablonui kurti  
tame pačiame aktyvaus lango dokumente arba naujame dokumente 

 

Vykdydami komandą Open Data Source atverkite duomenų 
šaltinį, kad galėtumėte iš anksčiau parengtų duomenų bazės laukų 
paimti adresato rekvizitų. 
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3.91 pav. Duomenų šaltinio parinkimas  
(Open Data Source) 

 

Open Date Source dialogo lange suraskite savo konferencijos 
duomenų bazės failą, pavyzdžiui, konferencija.mdb, ir jį atverkite. 
 
 
 
 
 
 
 
 
 
 
 
 

 
3.92 pav. Duomenų šaltinio, papildančio sukurtą  

laiško šabloną, atvėrimo langas 
 
Atvertosios duomenų bazės struktūros Microsoft Access dia-

logo lange suraskite reikiamą lentelę (pvz., Autoriai) ir spauskite Ok. 
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3.93 pav. Lentelės Autoriai pasirinkimo ir jos  
laukų įterpimo į laiško šabloną pavyzdys 

 
Programos MS Word langas pasipildys Mail Merge įrankių 

(mygtukų) juosta su pasirinktos duomenų bazės lentelės struktūra. 
Nustatykite teksto įvedimo žymiklį į atitinkamas rekvizitų vietas 
laiško šablone ir iš Insert Merge Field sąrašo pasirinkite tinkamus, 
laukus (pvz., Moksl_laipsn_pedagog_moksl_vard, Vardas, Pavardė). 

Toliau pateiktame šablono lange tamsesniame fone matyti jau 
įterpti laukų pavadinimai. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.94 pav. Įterpiamų lentelės Autoriai laukų sąrašas 
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Kaip susieti šabloną su duomenų bazės įrašais? 
Jūsų sukurtas šablono failas ir failas, susietas su duomenų ba-

zės įrašais, t. y. parengti laiškai, yra du skirtingi failai, turintys skir-
tingus pavadinimus. 

Organizuodami darbą taip, kad šablonas ir parengti laiškų rin-
kiniai būtų saugomi skirtinguose failuose, galėsite prireikus panau-
doti šabloną, jį papildyti ar keisti – parengti laiškus tik konkretiems 
adresatams, juos redaguoti ir pan. 

Paspauskite įrankių juostos Mail Merge mygtuką (Merge). 
Gautame komandos dialogo lange Merge pažymėkite New document. 
Rengdami laiškus visiems adresatams suaktyvinkite All, jeigu norite 
parengti laiškus konkrečiai adresatų grupei, į laukus įveskite duo-
menų bazės įrašų intervalą: From (nuo) To (iki). Kai pasirinksite pa-
rametrus, vykdykite laiškų formavimo komandą Merge. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.95 pav. Laiškų rengimo visiems autoriams  
dialogo langas 

 
 

Kaip peržiūrėti laiškų rinkinio failą? 
Jeigu darbą norite peržiūrėti, įvykdykite File→Print Preview 

komandą. Microsoft Word (Preview) lange paspauskite mygtuką 
Multiple Pages ir pasirinkite tiek puslapių, kiek laiškų esate parengę. 
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3.96 pav. Laiškų peržiūros langas 
 
 
 

Kaip išsiųsti laišką elektroniniu paštu? 
Norėdami susieti šabloną su duomenų bazės įrašais paspau-

skite mygtuką Merge (įrankių juostoje Mail Merge), lauko Merge to 
sąraše pasirinkę Electronic mail, paspauskite Setup ir iš autorių len-
telės pasirinkite elektroninio pašto adreso lauką. Kvietimą išsiųsite 
elektroniniu paštu kaip žinutės priedą. 

Pavyzdyje matyti, kaip laiškas išsiunčiamas pirmam autoriui. 
Norint, kad laiškai būtų išsiųsti visiems autoriams, komandos dialogo 
lange Merge turi būti aktyvus All parametras. 
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3.97 pav. Laiško išsiuntimo elektroniniu paštu pavyzdys 
 
 

Nustatomas duomenų bazės lentelės laukas, iš kurio bus ima-
mos elektroninio pašto adresų reikšmės (3.98 pav.). Įvedama laiško 
tema. 
 
 
 
 
 
 
 
 
 
 
 

3.98 pav. Elektroninio pašto lauko ir elektroninio  
laiško temos parinkimo langas 

 
 

Spaudžaint mygtuką Ok, paskui – Merge, pasirodo programos 
Outlook Express langas. 
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3.99 pav. Outlook Express programos langas, kuriame mygtuku  
Send laiškas išsiunčiamas nurodytam adresatui 

 
 
 

Programos Outlook Express lange spausdami mygtuką Send 
išsiųsite laišką nurodytu elektoniniu adresu. 
 
 
 

Kaip baigti dirbti su programa MS Word? 
Baigti dirbti su MS Word galima keliais būdais. Tam reikia: 

 Įvykdyti lango valdymo meniu komandą Close; 
 Įvykdyti komandą File→Exit. 
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Laiško šablono pavyzdys 
 

LIETUVOS TEISĖS UNIVERSITETAS 
Ateities g. 20, LT–2057 Vilnius 

 
 
 
 
 
 
 
 

Vilnius, 2004 m. spalio 27–28 d. 
 

INFORMACINĖS TECHNOLOGIJOS 2004 
MOKSLINĖ KONFERENCIJA 

 
KVIETIMAS 

 
Gerbiama (s) «Moksl_laipsn_pedag_moksl__vard» 
«Vardas» «Pavardė» 
 

Lietuvos teisės universitetas kviečia Jus dalyvauti mokslinėje konfe-
rencijoje „Informacinės technologijos 2004“. 

 
Konferenciją organizuoja Lietuvos teisės universiteto Valstybinio 

valdymo fakulteto Teisinės informatikos katedra. 
Konferencijos vieta – Lietuvos teisės universiteto Valstybinio val-

dymo fakulteto Teisinės informatikos katedra, Ateities g. 20, 404 auditorija  
 
Konferencijos pirmininkas  ………………………………… 
 
Mokslo sekretorė  ………………………………………… 
 
 
Faksas                   (85)271 45 71 
Telefonas             (85)271 45 72 
 
El. adresas                 infdep@ltu.lt 
http://www.ltu.lt/naujienos.html 
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3.8.2. Interneto svetainės kūrimas 
programa FrontPage 
 
1. Darbo tikslas 
 
Šio praktinio darbo tikslas – išmokti projektuoti ir kurti inter-

neto svetainę pasirenkant tematiką. 
 

2. Darbo užduotys 
 
1. Iškvieskite programą MS FrontPage 2002. 
2. Pradėkite kurti interneto svetainę, į pasirinktą diską įrašydami jos 

aplanko pavadinimą. 
3. Susipažinkite su pagrindiniu FrontPage 2002 programos langu. 
4. Paveikslėlius, kuriuos naudosite, perkelkite į Images aplanką 

tame pačiame diske. 
5. Sudarykite dalyvio anketą ir ją perkelkite į kuriamos interneto 

svetainės aplanką. 
6. Suplanuokite kuriamos interneto svetainės puslapių schemą, 

struktūrą, nustatykite hierarchijos lygmenis pagal pasirinktą tem-
atiką, pavyzdžiui, informacijai apie konferenciją skelbti. 

7. Apipavidalinkite pirmąjį svetainės puslapį, puslapio apačioje su-
kurkite nuorodas į žemesnio hierarchinio lygmens puslapius. 

8. Pirmajame svetainės puslapyje sukurkite nuorodą į teksto 
redaktoriumi MS Word sukurtą dalyvio anketos failą. 

9. Apipavidalinkite žemesnio lygmens puslapius, sudarydami juose 
lenteles, įrašykite pranešėjo vardą ir pavardę, pranešimo laiką ir 
pranešimo pavadinimą. 

10. Išsiaiškinkite, kaip publikuoti sukurtą interneto svetainę, t. y. per-
kelti svetainę į tarnybinę stotį. 

 

3. Metodiniai nurodymai 
 
Kaip pradėti kurti interneto svetainę? 
1. Įvykdykite naujos interneto svetainės kūrimo komandą 

File→New→Page or Web. Dialogo langelyje New Page or Web sky-
relyje New pasirinkite naujo tinklalapio Empty Web parametrą. 
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2. Dialogo lange Web Site Templates pasirinkite Empty Web 
parametrą. Paspauskite peržiūros mygtuką Browse, jis atvers dialogo 
langelį New Web Location, jame įrašysite tinklalapio saugojimo vie-
tos adresą. Dialogo langelyje New Web Location pasirinkite, pavyz-
džiui, D diską, Student aplanką, paspauskite mygtuką Create New 
Folder. 

3. Dialogo langelyje New Folder įrašykite aplanko pavadi-
nimą, nurodydami savo grupę ir inicialus. 

4. Paspauskite patvirtinimo komandas: Ok, Open, Ok. 
Atlikus visus veiksmus, pasirinktajame diske bus sukurtas ap-

lankas, kuriame bus saugomas kuriamas interneto svetainės puslapis, 
pavyzdžiui, D:\Student\AJWEB412. 

AJWEB412 – darbo aplanko pavadinimas, kuriame bus sau-
gomi šiam puslapiui kurti reikalingi tekstiniai, grafiniai failai bei visa 
kita informacija, reikalinga kuriant interneto svetainę. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.100 pav. Interneto svetainės darbo aplanko kūrimo langas 
 

Suaktyvinkite aplanko Folders peržiūros komandą (3.101. 
pav.). Atsivėrus langeliui Folder List pamatysite, kad nurodytame 
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aplanke, pavyzdžiui, AJWEB412, programa sukūrė papildomus ap-
lankus. Aplankai, kurių pavadinimas prasideda brūkšneliu, reikalingi 
programos darbui, čia programa laiko jai reikalingą informaciją, jų 
keisti negalima. Į aplanką Image (atvaizdas, paveikslas) įrašykite vi-
sus paveikslėlius, kuriuos planuojate naudoti internetiniame pusla-
pyje. 

 
 
 
 
 
 
 
 
 
 
 

 
3.101 pav. Interneto svetainės darbo aplanko struktūra 

 

Susipažinkite su pagrindinėmis FrontPage 2002 programos 
priemonių juostomis. 

Microsoft FrontPage lange pateikiamos pagrindinės įrankių 
juostos bei šių įrankių iškvietimo komanda View, esanti pagrindi-
niame meniu. 

Mygtukai, esantys dešinėje peržiūros (View Bar) įrankių juos-
toje, leidžia greičiau pereiti iš vieno duomenų pateikimo būdo į kitą.  

Peržiūros (View Bar) įrankių juostos mygtukai: 
 Page – peržiūrėti ir keisti Web puslapį; 
 Folders – peržiūrėti Web aplankus ir failus, jų dydį, paskuti-
nio keitimo datą; 
 Reports – ataskaita apie bendrą failų, paveikslėlių ir nuo-
rodų skaičių bei failų dydį; 

 Navigation – interneto svetainės schemos peržiūra bei jos 
keitimo galimybė; 

 Hyperlinks – interneto svetainės nuorodos; 
 Task – užduočių sąrašas. 

suaktyvinkite Folders 
komandą 
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3.102 pav. Pagrindiniai Front Page programos lango elementai 
 
 
 

Kaip sukurti konferencijos dalyvio anketą ir ją įkelti į inter-
neto svetainės aplanką? 

Į AJWEB412 aplanką įkelkite dalyvio anketą, sukurtą pro-
grama MS Word. Jeigu jos nesate sukūrę, minimizuokite FrontPage 
langą, iškvieskite MS Word programą, sukurkite dalyvio anketą, da-
lyvio anketos failą nukopijuokite į AJWEB412 aplanką. 

 

 

Peržiūros priemonių juosta (Views Bar) 

Formatavimo priemonių juosta 
(Formatting) 

Bendroji priemonių juosta 
(Standard) 
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Dalyvio anketos pavyzdys 
 

Mokslinė konferencija „Informacinės technologijos“ 
Dalyvio anketa 

 
Vardas  
Pavardė  
Pedagoginis mokslo vardas ir mokslo laipsnis  
Organizacija  
Pareigos  
Adresas  
Telefonas, faksas  
Elektroninis paštas  
Pageidaučiau dalyvauti konferencijoje ir skaityti 
pranešimą šia tema 

 

Pranešimo bendraautoriai 
Vardas  
Pavardė  
Pedagoginis mokslo vardas ir mokslo laipsnis  
Organizacija  
Pareigos  
Adresas  
Telefonas, faksas  
Elektroninis paštas  
Pageidaučiau dalyvauti konferencijoje ir skaityti 
pranešimą šia tema 

 

Anotacija  
Straipsnyje nagrinėjami pagrindiniai informacinių 
sistemų kūrimo klausimai 

 

 
 
 
Interneto svetainės schemos sudarymas 
Prieš pradėdami kurti interneto svetainę suplanuokite jos 

struktūrą. Mes siūlome kurti rengiamų konferencijų interneto svetai-
nės puslapį. Tuo tikslu parengsime tokią svetainės schemą. Bus ku-
riamas pagrindinis svetainės puslapis bei žemesnio lygmens konfe-
rencijų tematiką atitinkantys puslapiai, kuriuose skelbsime informa-
ciją apie rengiamas konferencijas. 
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3.103 pav. Interneto svetainės schemos kūrimas vykdant komandą 

View→Navigation ir pagrindinio puslapio įkėlimas 
 

Prieš pradėdami kurti svetainės schemą iškvieskite puslapių iš-
dėstymo projektą, paspauskite Views Bar įrankių juostos mygtuką 
Navigation arba vykdykite komandą View→Navigation. Pirmąjį – 
pagrindinį puslapį (Home Page) formuodami svetainės struktūrą įkel-
sime spausdami bendrosios (Standard) mygtukų juostos mygtuką 
New. 

 
 
 
 
 
 
 
 
 
 
 
 
 

3.104 pav. Žemesnio lygmens puslapių įkėlimas į kuriamą  
interneto svetainės schemą pasitelkiant kontekstinį meniu 
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Norėdami įkelti žemesnio lygmens puslapį, dešiniuoju pelės 
klavišu paspauskite aukštesnio lygmens, pavyzdžiui, pagrindinį 
(Home Page) puslapį ir vykdydami kontekstinio Meniu komandą 
New Page įkelkite žemesnio lygmens puslapius. 

Puslapių hierarchijos lygmenį galima keisti juos perkeliant 
pele į atitinkamą vietą. Vizualiai bus matyti nauja hierarchija. 

 
 
 
 
 
 
 

3.105 pav. Interneto svetainės schemos pavyzdys 
 
Kaip kuriamas pagrindinis puslapis (Home Page) ir žemes-

nių lygmenų puslapių nuorodos? 
Parenkamas puslapio fonas ir parašomas tekstas, kuris tiktų 

pagrindiniam puslapiui. 
Pavyzdžiui, pagrindiniame puslapyje parašome tekstą KON-

FERENCIJOS KONFERENCIJOS KONFERENCIJOS. Norint, kad 
tekstas judėtų, reikia jį pažymėti ir vykdyti komandą Insert→ 
Navigation... Komandos dialogo lange Insert Web Component 
parinkite judančio komponento rūšį Dynamic Effects, pasižymėkite 
slenkančios eilutės efektą Marquee, paspauskite Finish. 

 
 
 
 
 
 
 
 
 
 

 
3.106 pav. Insert→Navigation komandos langas ir parinktas  

slenkančios eilutės efektas, skirtas pažymėtam tekstui 
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Puslapio fonas parenkamas vykdant komandą Format→ 
Background. Norint įterpti paveikslėlius reikia vykdyti komandą 
Insert→Picture→From File. 

Paveikslėliai turėtų būti įrašyti į Images aplanką. Jeigu neįra-
šėte paveikslėlių, tai galite padaryti ir dabar. Suradę paveikslėlio failą 
paspauskite dešinįjį pelės klavišą ir vykdykite komandas Edit→Copy 
ir Edit→Paste Images aplanke, neuždarydami programos FrontPage 
lango. 

Norėdami pateikti nuorodas iš pagrindinio puslapio į žemesnio 
lygmens puslapius žymiklį nustatykite toje svetainės hierarchijos 
struktūros vietoje, kur turėtų būti šios nuorodos, ir vykdykite ko-
mandą Insert→Navigation… 

 
 
 
 
 
 
 
 
 
 
 
 

3.107 pav. Insert→Navigation komandos langas, kuriame  
pažymėti parametrai nuorodoms kurti 

 
 
 
 
 
 
 
 
 
 
 

3.108 pav. Horizontalus ir vertikalus nuorodų pateikimo būdas 
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3.109 pav. Interneto svetainės nuorodų į žemesnio lygmens  
puslapius pasirinkimo pavyzdys 

 
Pažymėkite žemesnio hierarchijos Child level lygmens pusla-

pius ir vykdykite komandą. 
 
Kaip sukurti nuorodą į tekstinį failą? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.110 pav. Nuorodos į tekstinį failą Dalyvio anketa kūrimo pavyzdys 
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Parašykite tekstą, kuris pagal prasmę įvardytų jūsų nuorodą, 
pavyzdžiui, Dalyvio anketa. Šį tekstą pažymėkite ir vykdykite ko-
mandą Insert→Hyperlink, tada pažymėkite failą Dalyvio anketa ir 
vykdykite komandą spausdami Ok. 

 

Kaip kuriama pagrindinio puslapio nuoroda žemesnio hie-
rarchijos lygmens puslapiuose? 

Norėdami pateikti nuorodas iš žemesnio lygmens puslapio į 
pagrindinį (Home Page) savo svetainės hierarchijos struktūros sche-
moje žymiklį nustatykite toje vietoje, kur turėtų būti ši nuoroda, ir 
vykdykite komandą Insert→Navigation. 

 
 
 
 
 
 
 
 
 
 
 
 

3.111 pav. Insert→Navigation komandos dialogo langas, kai  
kuriama nuoroda iš žemesnio lygmens puslapio į pagrindinį 

 
Pažymėkite aukščiausio lygmens pakopą Global level ir vyk-

dykite komandą. 
 
 
 
 
 
 
 

 
3.112 pav. Žemesnio lygmens puslapis interneto svetainėje, kuriame yra 

nuorodos į pagrindinį ir į to paties lygmens puslapius 
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Taip pat galima pasirinkti to paties lygmens variantą (Same 
level). Tuomet bus matyti nuorodos ir į to paties lygmens puslapius. 

 
Kaip perkelti sukurtą interneto svetainę į tarnybinę stotį? 
Norint svetainę publikuoti internete reikia ją perkelti į tarny-

binę stotį (Server) vykdant komandą File→Publish Web.  
 
 
 
 
 
 
 
 
 

3.113 pav. File→Publish Web komandos dialogo langas,  
perkeliant svetainę į tarnybinę stotį 

 
Veikiant protokolui HTTP, dialogo langelyje Publish Destina-

tion lauke Enter publish destination nurodykite WWW adresą (jis 
prasidės http://), kuriame įterpsite interneto svetainę. Nurodžius var-
totojo kodą ir slaptažodį sukurta interneto svetainė bus perkelta į tar-
nybinę stotį (Server). 

Jeigu tarnybinės stoties ryšys vykdomas FTP protokolu, dia-
logo langelyje Publish Web laukelyje Specify The location adresas 
prasidės ftp://. 
 

Kontroliniai klausimai 
 

1. Kaip valdomas programos Microsoft FrontPage 2002 darbo langas 
ir jo sudėtinės dalys? 

2. Kaip atliekamas interneto svetainės projektavimas, nustatant jos 
puslapių hierarchiją? 

3. Nuorodų į interneto svetainės puslapius kūrimas atsižvelgiant į 
puslapių hierarchiją. 

4. Kaip apipavidalinti svetainės puslapį naudojant foną bei judantį 
tekstą? 

5. Kaip sukurti nuorodą į tekstinį failą? 
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4.1. ŠIUOLAIKINĖS ELEKTRONINIŲ LENTELIŲ  
       TVARKYMO GALIMYBĖS 
 

augelis vartotojų skaičiuokles (elektronines lenteles) naudoja 
paprasčiausioms lentelėms sudaryti, dažnai nenumanydami, 

kokios galimybės glūdi jų apdorojimui skirtoje programoje. Pro-
grama Microsoft Excel galima tvarkyti tekstą, valdyti duomenų ba-
zes, atlikti sudėtingus skaičiavimus [1; 24; 26]. Šios programos ga-
limybės yra tokios didelės, kad daugeliu atveju ji yra galingesnė 
negu specializuoti teksto redaktoriai ar duomenų bazių sistemos. 
Darbo pradžioje programos Excel funkcijų įvairovė gali nustebinti, 
tačiau įgijus praktinių įgūdžių ji bus neatskiriama jūsų darbo dalis. 
Kaskart įgydami vis daugiau patirties suvoksite, kad skaičiuoklių ap-
linka skirta profesionaliam darbui, turi daug įvairiausių galimybių. 
Skaičiuoklių darbo aplinką galima priskirti prie koncepcinio mode-
liavimo programinės įrangos, turinčios funkcijų išraiškos galimybių, 
sprendėjo funkcijas, įgalinančias modeliuoti sprendimo priėmimo 
mechanizmą. 

Programa Excel gali apdoroti labai dideles duomenų apimtis, 
atlikti įvairias operacijas su duomenimis – pradedant paprasčiausiu 
sumavimu ar vidurkio skaičiavimu ir baigiant sudėtingomis komp-
leksinėmis operacijomis, kurios užrašomos ne paprastais matemati-
niais simboliais, bet specialia programavimo kalba Visual Basic [26; 
31]. 

Skaičiuoklės padeda dirbti buhalteriams, ekonomistams, sta-
tistikos specialistams. Jomis galima skaičiuoti lentelių struktūros 
duomenis, sudaryti diagramas, rinkti ir maketuoti tekstus. Informa-
cija įrašoma ir įsimenama darbo knygose (Book) – Microsoft Excel 
failuose, sudarytuose iš vieno ar kelių lapų (Sheet). 

Naujose skaičiuoklės Microsoft Excel versijose elektroninės 
lentelės sąvoka keičiama kompiuterinės darbo knygos sąvoka. Kom-
piuterinę darbo knygą sudaro darbo lapai. Tai ne kelių lentelių rinki-
nys, o nauja priemonė, suteikianti galimybę taikyti erdvinius (trima-
čius) uždavinių sprendimo modelius ir metodus, atlikti sudėtingą 
matematinę ir statistinę duomenų analizę. Be visų turėtų dalykų, 
Excel yra labai patogi ir paprasta naudoti tiek pradedantiesiems, tiek 

D 
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profesionaliems vartotojams. Sistema Microsoft Excel vartotojui su-
teikia išties plačias galimybes. 

Duomenys įvedami, apdorojami ir apskaičiuojami lentelėse, 
kurių pagrindinis elementas yra ląstelė. Lentelės ląstelės (angl. – 
cells; literatūroje naudojami terminai – langelis, narvelis, celė), gali 
būti automatiškai užpildomos pasikartojančiais arba dėsningai besi-
keičiančiais duomenimis (t. y. taikomas duomenų sekų sudarymo 
mechanizmas). 

Galima rinktis daugybę funkcijų (jų taikymas žymiai paleng-
vina darbą), skirtų ekonomikos, matematikos, statistikos, duomenų 
bazių, informatikos, logikos uždaviniams spręsti ir kt. 

Lentelės sudedamos į darbo lapus, o jie komponuojami į darbo 
knygas (Workbooks). 

Daug galimybių suteikia diagramų žynys (diagramų patarėjas, 
t. y. konstruktorius-pagalbininkas Chart Wizard); 

Sudarytoje lentelėje galima greitai atlikti regresinę ir kitą sta-
tistinę duomenų analizę. Tiesiogiai iš darbo lapo galima ruošti skaid-
res ir jas demonstruoti. Kelių lentelių duomenų analizei palengvinti 
galima pasinaudoti duomenų sujungimo (Data Consolidating) me-
chanizmu. 

Be minėtųjų galimybių, yra keletas sudėtingesnių priemonių, 
palengvinančių darbą su dideliu duomenų sąrašu. Sąrašas – tai nauja 
duomenų bazės forma skaičiuoklėse, jis naudojamas sprendžiant su-
dėtingas duomenų apdorojimo užduotis. Yra duomenų tvarkymo 
komandų grupė, leidžianti atlikti sąrašo elementų rūšiavimo, filtra-
vimo, tarpinių sumų sudarymo bei kai kurių duomenų slėpimo ope-
racijas. 

Microsoft Excel sistema turi puikias diagramų kūrimo galimy-
bes. Jas taikyti gali tiek pradedantys vartotojai, tiek šios srities profe-
sionalai. Skaičiuoklės diagramos gali būti arba dvimatės, arba trima-
tės. Diagrama – tai grafinis darbo lapo duomenų vaizdas. Pagal duo-
menų vaizdavimo formą diagramos skirstomos į tipus, pavyzdžiui, 
plotines diagramas, stulpelių, skritulines, žiedines, taškines, spindu-
lines ir kitas. Kiekvienas diagramos tipas turi nuo 1 iki 4 modifika-
cijų ir nuo 4 iki 10 automatinių formatų. Automatiniu vadinamas tam 
tikram diagramos tipui ir modifikacijai sukurtas formatas, turintis 
nustatytus keičiamus diagramos elementus. 

Nepaprastai originalus Microsoft Excel pagalbininkas yra žy-
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nys (Wizard). Taip pat yra sukurta naujų vartotojo sąveikos su pro-
grama priemonių. Funkcijų žynys aiškiai, profesionaliai pateikia 
funkcijų naudojimo ir formulių sudarymo galimybes. Pasitelkiant 
diagramų žynį tampa žymiai lengviau atlikti grafinę duomenų ana-
lizę. Jeigu sumanysite apskaičiuoti sudėtingesnio reiškinio rezultatą, 
bakstelėkite pele žynio mygtuką ir ekrane pasirodžiusiame dialogo 
langelyje pasirinkite funkciją, kurios aprašymą ir argumentų paaiški-
nimus rasite kitame dialogo langelyje. Žynys paaiškins, kaip sudaryti 
funkciją, padės surinkti argumentus, apskaičiuos jų tarpines reikš-
mes, nurodys sintaksės, logikos formulių sudarymo klaidas. 
 
 
 

4.2. SKAIČIUOKLIŲ DARBO APLINKA 
 

aip ir bet kokia programa, veikianti langų valdymo aplinkoje, 
skaičiuoklės Microsoft Excel darbo aplinka valdoma pagal 

tuos pačius principus ir tokiomis pačiomis priemonėmis: meniu ko-
mandų grupės, įrankių juostos, dialogo langai, greitieji klavišai, atsa-
kymus pažymintys mygtukai ir t. t. Skaičiuoklę vizualiai sudaro šios 
pagrindinės dalys: programos langas – stačiakampė ekrano sritis, ku-
rioje atliekami veiksmai su vartotojo duomenimis ir dokumentais. Šis 
langas turi pavadinimo juostą (Title Bar), meniu juostą (Menu Bar), 
įrankių (priemonių) juostas (Toolbars), specialią formulių įvedimo 
eilutę (Formula Bar), dokumento sritį (Document Area) ir informa-
cinę būsenos eilutę (Status Bar). 

Dokumento srityje yra svarbiausias darbo elementas – doku-
mento langas, vadinamas darbo knyga (Workbook), joje yra vaiz-
duojami vartotojo duomenys, formulės, diagramos ir visa kita, kas 
gali būti dokumente. 

Darbo knygos duomenys kompiuterio atmintyje saugomi fai-
luose (bylose), kurių plėtinys yra *.xls, pavyzdžiui, Apskaitos_ 
darbo_knyga.xls. 

Susipažįstant su skaičiuoklės darbo aplinka reikėtų išsiaiškinti 
pagrindinius jos elementus. 

Operacijos atliekamos darbo knygoje. Darbo knygą sudaro 
vienas arba keli darbo lapai (Sheet) – joje saugomi bei apdorojami 
duomenys. Darbo lapas – stačiakampė matrica, turinti 256 stulpelius 
(Columns) ir 65536 eilutes (Rows). Lapų skaičių leidžiama didinti. 

K

4.2. Skaičiuoklių darbo aplinka 
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Matricos elementai (eilučių ir stulpelių sankirtos) vadinami ląstelė-
mis (Cells). Kiekvieno stulpelio viršuje yra antraštė (Column hea-
ding), įvardijanti kiekvieną stulpelį lotyniška raide arba dviejų loty-
niškų raidžių deriniu, pavyzdžiui: A, B, C, …, AA, AB, …, DZ, EA, 
…., ZZ. Kiekvienos eilutės kairėje pusėje yra eilutės numeris arba 
antraštė (Row heading), įvardijanti eilutę. Eilutės numeris žymimas 
skaičiumi nuo 1 iki 65536. Netelpančiai į ekraną daliai pasiekti lango 
dešinėje pusėje ir apačioje yra dvi slankiosios juostos (Scrollbars). 

Ląstelė (Cell) – lentelės bazinis elementas, esantis eilutės ir 
stulpelio sankirtoje. 

Aktyvią lentelės ląstelę (Active cell) žymi stačiakampis tamsus 
rėmas, išskiriantis ją iš kitų. Aktyvioji ląstelė (Active cell) – tai darbo 
lapo ląstelė, su kurios turiniu yra šiuo momentu dirbama: į ją įvedami 
duomenys, formulė, ji redaguojama ir pan. Jeigu pažymėta daugiau 
kaip viena ląstelė – t. y. ląstelių grupė, vadinamasis ląstelių blokas 
(Cell range), aktyvi yra pirmoji pažymėta šio bloko ląstelė. Akty-
viąją ląstelę nurodo jos koordinatės. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.1 pav. Pagrindiniai Excel programos lango elementai 

Eilutės numeris Lapo pavadinimas 

Aktyvioji 
ląstelė 

Bendros paskirties (Standard) 
priemonių juosta 

Formatavimo (Formatting) 
priemonių juosta 

Komandų 
meniu juosta 

Formulės eilutė 

Stulpelio pavadinimas 
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Excel darbo knygoje gali būti ne tik darbo lapai su ląstelių mat-
ricomis, bet ir diagramų lapai (Charts), vartotojo dialogo langų lapai 
(Dialog sheets), Visual Basic kalba parašyti programų moduliai 
(Modules). 

Lentelė (Table) – pirminis eilučių ir stulpelių struktūros doku-
mentas, kuriame informacija saugoma ląstelėse. 
Sritis (Range) – lentelės ląstelių visuma, kurią sudaro stulpelio(-ų), 
eilutės(-čių) arba stačiakampio formos srities ląstelės. 

 
 
4.2.1. Komandų ir kontekstinis meniu 
 
Kaip ir kitos Windows aplinkoje veikiančios programos, Excel 

neapsieina be meniu juostos (Menu bar). Tai visiems kompiuterių 
vartotojams pažįstamas atveriamas (drop-down) meniu, kurį naudo-
jant atliekamos pagrindinės Excel operacijos. Meniu juostoje yra de-
vyni skyriai: File, Edit, View, Insert, Format, Tools, Data ir Help. 
Norint atverti meniu ir nurodyti reikiamą komandą, reikia pele baks-
telėti vieno iš devynių nurodytų meniu pavadinimą ir pasirodžius 
komandų sąrašui pasirinkti norimą komandą. Meniu juostos ir ko-
mandų turinys gali keistis. Tai priklauso nuo to, kokio tipo lapas ak-
tyvus. Šio lapo formą vartotojas gali keisti. 

Meniu juostoje pasirenkamų komandų sąrašas skirtas pagrin-
dinėms darbo funkcijoms atlikti: 

File  – darbo su lentelėmis ir jų failais komandos; 
Edit  – redagavimo komandos; 
View  – ekrano vaizdo komandos; 
Insert  – duomenų įterpimo komandos; 
Format  – formatavimo komandos; 
Tools  – darbo aplinkos konfigūravimo komandos; 
Data  – darbo su duomenų baze komandos; 
Window  – veiksmai su langais; 
Help  – aiškinamoji informacija (žinynas). 
Be pagrindinio meniu, MS Excel yra kontekstinis meniu, iš-

kviečiamas spaudžiant dešinįjį pelės klavišą. Koks kontekstinio me-
niu komandų sąrašas pateikiamas, priklauso nuo to, kurioje progra-
mos lango vietoje ir kokioje aplinkoje jis iškviestas. 
Meniu komandas vykdyti galima pele ir klaviatūra. 

4.2. Skaičiuoklių darbo aplinka 
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Norint failo atidarymo komandą vykdyti klaviatūra, reikia: 
 Paspausti klavišą <Alt>; 
 Klavišais <→> , <←> žymiklį nustatyti ties meniu File; 
 Paspausti < Enter >; 
 Klavišais <↑>, <↓> žymiklį nustatyti ties komanda Open; 
 Paspausti < Enter >. 

Šią komandą taip pat galima vykdyti spaudžiant klavišų derinį, 
t. y. <Ctrl> + <O>. 

Norint pagreitinti darbą reikia atsiminti dažniausiai naudojamų 
komandų klavišų derinius. 

 
 
4.2.2. Ląstelių koordinačių tipai 
 
Kiekvienos ląstelės padėtį MS Excel programoje rodo jos stul-

pelio ir eilutės koordinatės. Šios koordinatės – tai ląstelės adresas. 
Galima nurodyti vienos ląstelės, srities masyvo koordinates, pagal 
kurias surandami tose ląstelėse įrašyti duomenys. Ląstelių koordina-
tės gali būti santykinės, mišrios ir absoliučios. 

 
4.1 lentelė. Ląstelių koordinačių tipai ir jų žymėjimas 
 

Ląstelės koor-
dinačių tipas Žymėjimas Ląstelių koordinačių taikymo 

formulėse paaiškinimas 

Santykinės  A5 Ląstelių ir blokų santykinės koor-
dinatės formulėje pakeičiamos per 
tiek stulpelių ir eilučių, per kiek 
stulpelių ir eilučių perkeliama nu-
kopijuotoji formulė 

Absoliučios  $A$5 Ląstelių ir blokų absoliučios koor-
dinatės formulėje nekeičiamos 

Mišrios  A$5 arba $A5 Kopijuojant formules atitinkamai 
keičiamos tik santykinės koordina-
čių dalys 

 
 
Skirtingi ląstelių koordinačių tipai taikomi sudarant formules. 
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4.2.3. Įrankių juostos 
 
Įrankių juostos (Toolbars) gali būti vertikalios arba horizonta-

lios judančios stačiakampių mygtukų juostos. Jos, kaip ir meniu ko-
mandos, skirtos valdyti Excel. Akylesnis vartotojas iškart supras, kad 
visi šie spalvoti mygtukai yra ne kas kita kaip grafiškai pavaizduotos 
meniu komandos. Pavyzdžiui, šrifto, stiliaus, šrifto dydžio, lygia-
vimo įrankiai tik paprastina vartotojo darbą: norint pakeisi ląstelės 
turinio šriftą nereikia kaskart jungti meniu Format→Cells→Font. 
Mygtukai, vykdantys komandas New, Load, Save, Print, Print 
Preview, Cut, Copy, Paste, Undo, Redo, yra ne kas kita kaip meniu 
darbo su failais (File) ir redagavimo (Edit) komandos. Mygtukai 
įrankių juostose grupuojami pagal paskirtį. Dažniausiai naudojamos 
Standard, Formatting ir Drawing įrankių juostos. 
 
 
 
4.3. SKAIČIUOKLIŲ DUOMENŲ TIPAI IR  
       FORMATAI 
 

iekvieną lentelės ląstelę galima užpildyti duomenimis. Duome-
nys gali būti skirtingų tipų. Kokio tipo duomenys bus įrašyti į 

ląsteles, priklauso nuo pasirenkamų formatavimo galimybių. Ląstelė-
je esantys duomenys gali būti: 

 Skaičius; 
 Tekstas; 
 Valiuta; 
 Skaičiavimo pagal formules rezultatas; 
 Procentinė išraiška; 
 Data; 
 Laikas; 
 Pasikartojantis tekstas ir kt. 

Ląstelėse esantys duomenys gali būti formatuojami vykdant 
komandą Format→Cells. Norint tinkamai apdoroti duomenis reikia 
teisingai pasirinkti duomenų formatą, jis gali būti bendras, skaičių, 
piniginis, datos, laiko, procentinis, trupmeninis, eksponentinis, te-
ksto, specialusis, sukurtas vartotojo. 

K

4.3. Skaičiuoklių duomenų tipai ir formatai 
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4.2 pav. Duomenų formato suteikimo komandos 
 
 

Skaičiaus su dešimtaine trupmena formatu vaizduojami svei-
kieji ir realieji skaičiai. Esant šiam formatui gali būti nurodomas 
trupmeninių pozicijų skaičius bei tūkstančių skiriamasis simbolis, 
pavyzdžiui, tarpo ženklas arba taškas. Gali būti nurodomas ir nei-
giamo skaičiaus vaizdavimo būdas, skaičius gali būti apskliaudžia-
mas arba vaizduojamas kita spalva. 

Pasirinkus procentų formatą, ląstelėje įrašytas skaičius daugi-
namas iš 100, o jo dešinėje įrašomas procentų ženklas. Nurodant šį 
formatą galima pasirinkti dešimtainių ženklų skaičių po kablelio. 

Valiutos formatas naudojamas pinigų reikšmėms vaizduoti. 
Nurodomas pateiktojo skaičiaus valiutos simbolis. 

Paprastųjų trupmenų formatai suteikia skaičiams paprastųjų 
trupmenų pavidalą. Esant šiam formatui nurodomas skaitmenų skai-
čius trupmenoje. 

Eksponentinių skaičių formatas skirtas labai dideliems arba la-
bai mažiems skaičiams vaizduoti. Šio formato žymuo E+n reiškia 
skaičių, padaugintą iš 10n.  

Suteikus teksto formatą skaičiui, jis traktuojamas kaip tekstas 
ir pritraukiamas prie kairiojo ląstelės krašto. 

Pasirenkant vartotojo formatą, galima sudaryti įvairių formatų 
šablonus, taip pat kurti individualius formatus. Norint sukurti indivi-
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dualų formatą reikia: 
 Vykdyti komandą Format→Cells, pasirinkti skyrelį Number; 
 Sąraše Category pažymėti Custom formatų grupę; 
 Pateiktų formatų šablonų sąraše pažymėti tinkamiausią for-
matą; 
 Redaguoti laukelyje Type pažymėtą formatą arba įvesti vi-
sai naują formato šabloną. 

 
    4.2 lentelė. Individualiųjų formatų pavyzdžiai 
 

Formatas Įvestas skaičius Rodomas skaičius 
#.###,00 13000 13.000,00 
0.000,00 13 0.013,00 
#. 13000 13 
“Sąsk.Nr.“ 0000 13 Sąsk.Nr.00013 
(00) 000 00 00 852714571 (85) 271 45 71 
Lt* #.##0,00 1130 Lt              1.130,00 

 

Ląstelei galima suteikti pavadinimą ją pažymint ir vykdant 
komandą Insert→Name→Define. Dialogo langelyje Define Name 
paspauskite mygtukus Add ir OK. Suteikus ląstelei pavadinimą jį ga-
lima naudoti formulėse vietoje ląstelės adreso. 

Priskiriant ląstelei pavadinimą svarbu, kad jis prasidėtų raide ir 
nebūtų panašus į ląstelių koordinates. Geriausia ląstelėms suteikti 
prasminius pavadinimus, tarkime, ląstelę, kurioje įrašytas dydis ati-
tinka saugomos informacijos prasmę, pavyzdžiui, saugomą ketvirčio 
pinigų sumą, reikia pavadinti suma. 
 
 
 
 
 
 
 
 
 
 

4.3 pav. Prasminio pavadinimo ląstelei suteikimas 

4.3. Skaičiuoklių duomenų tipai ir formatai 
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Ląstelei suteikus prasminį pavadinimą, jis pakeičia ląstelės ko-
ordinates. 
 
 
 
 
 
 
 
 

4.4 pav. Ląstelės koordinačių keitimas pavadinimu  
 
 

Norint panaikinti suteiktąjį pavadinimą, reikia pažymėti ląstelę 
arba sritį, kurios pavadinimą reikia naikinti, ir vykdyti komandą 
Insert→Name→Define. Komandos dialogo langelyje reikia pažymėti 
ląstelės arba srities pavadinimą ir paspausti mygtukus Delete ir Ok. 

Vykdant komandą Insert→Comment ląstelėje gali būti rašomi 
komentarai. Atsiradus teksto rėmams įrašomas komentaras. Įrašius 
komentarą ląstelės dešinysis viršutinis kampas bus pažymėtas kita 
spalva.  

Norint peržiūrėti visus komentarus reikia vykdyti komandą 
View→Comments, pasirodys įrankių juosta Reviewing. 

Priemonių juostoje Reviewing yra aktyvus mygtukas Show/ 
Hide parodantis arba paslepiantis visus komentarus. 

 
 
 

 
 
 
 
 
 
 

4.5 pav. Duomenis paaiškinantis komentaras ir Reviewing  
priemonių juosta, skirta dirbti su komentarais 
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4.4. UŽDAVINIŲ SPRENDIMO TVARKA  
       SKAIČIUOKLĖSE 
 

irmiausiai atveriamas darbo lapas ir nurodomi pradiniai duo-
menys, tuomet įrašomos reikalingos formulės ir funkcijos. 

Jeigu lentelė bus naudojama daugiau nei vieną kartą ir joje bus įra-
šomi skirtingi duomenys, sukuriamas lentelės darbo lapo šablonas: 

 Pasirenkamos lentelės antraštės, paraštės ir kt.; 
 Įrašomi vienarūšių duomenų stulpelių pavadinimai ir nubrė-
žiamos stulpelių linijos; 
 Įrašomi pirminiai duomenys; 
 Duomenims apskaičiuoti sudaromos formulės, o duomenis 
vizualiai pateikti – diagramos; 
 Darbo lapas formatuojamas ir šablonas išsaugomas. 

Pakartotinai sprendžiant uždavinį iškviečiamas jau sudarytas 
darbo lapo šablonas, jis redaguojamas įrašant naujus duomenis. Įve-
dant duomenis atliekama tarpinio duomenų išsaugojimo diske opera-
cija. Prieš spausdinant dokumentą, jis peržiūrimas ekrane, parenkami 
spausdinimo parametrai. 
 
 
 
4.5. DARBO KNYGOS SANDARA IR JOS KŪRIMAS  
       SKAIČIUOKLĖSE 
 

4.5.1. Skaičiuoklių darbo knygos kūrimas 
Pradėjus darbą su Excel programa Excel darbo lange suku-

riama nauja tuščia knyga, kuriai laikinai suteikiamas Book1 pavadi-
nimas. Dažniausiai pasirenkamas pavadinimas, kuris atspindės sau-
gomos informacijos prasmę. Sukurti naują knygą galima ir darbo 
Excel programa metu, bendrosios paskirties (Standard) mygtukų 
juostoje spaudžiant naujos knygos mygtuką New.  

Naują dokumentą galima kurti ir vykdant File→New komandą. 
Taip galima pasirinkti dokumento šabloną, kuriuo naudojantis įve-
dami duomenys ir atliekami skaičiavimai. 

P

4.4. Uždavinių sprendimo tvarka skaičiuoklėse 
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Failo išsaugojimas diske 
Jei į diską įrašoma nauja knyga arba senąją reikia išsaugoti 

nauju pavadinimu, vykdoma komanda File→Save As. Komandos 
dialogo lange reikia: išplėstiniame sąraše Save in pažymėti diską bei 
katalogą, kuriame reikia išsaugoti failą; teksto lauke File name įvesti 
bylos pavadinimą be plėtinio. Programa prie failo pavadinimo pri-
deda plėtinius, pavyzdžiui, .xls – esant lentelėms, .xlt – šablonams. 

Jeigu failą norima išsaugoti įslaptinant (nežinantiems slaptažo-
džio neleidžiama failo nuskaityti arba redaguoti), reikia: 

 Vykdyti komandą File→Save As. Komandos dialogo lange 
Save As vykdyti Tools→General Options; 
 Lauke Password to open įrašyti pasirinktą slaptažodį, reika-
lingą failui nuskaityti; 
 Lauke Password to modify įrašyti pasirinktą slaptažodį, 
reikalingą failui redaguoti; 
 Slaptažodį pakartoti dialogo langelyje Confirm Password; 

Paspausti mygtuką Save ir dokumentas bus įrašytas į diską. 
 
 
 
 
 
 
 

4.6 pav. Failo išsaugojimas, įrašant slaptažodį failui nuskaityti 
 

Norint į diską įrašyti redaguojamą Excel dokumentą, kuris jau 
kartą buvo įrašytas, reikia paspausti bendrosios paskirties (Standard) 
mygtukų juostos mygtuką Save arba vykdyti komanda File→Save. 
 

Failo įkėlimas 
Norint įkelti iš disko bet kurį Excel failą, reikia: 

 Vykdyti komandą File→Open; 
 Open komandos dialogo lango išplėstiniame sąraše Look in 
nurodyti dokumento diską, katalogą ir išrinkti iš sąrašo failą 
bei jį atidaryti. 

Failų, su kuriais buvo dirbta paskutiniu metu, sąrašas yra File 
meniu apačioje. 
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4.5.2. Ląstelės turinio pildymas ir redagavimas 
 

Visi duomenys Excel programoje įrašomi į ląsteles. Norint ra-
šyti į ląstelę, reikia: 

 Pažymėti ląstelę, į kurią reikia įvesti duomenis; 
 Įrašyti įvedamus duomenis: tekstą, skaitmenis, formules; 
 Paspausti <Enter> arba pažymėti kitą ląstelę. 

Jeigu ekrane matyti formulės eilutė, įvedami duomenys yra at-
kartojami šioje eilutėje, o eilutės kairėje atsiranda trys papildomi 
mygtukai. Tekstas rašomas tuo šriftu, kurio pavadinimas užrašytas 
šrifto lange, esančiame formatavimo mygtukų juostoje. Jeigu šis 
šriftas neturi reikalingų simbolių, pavyzdžiui, lietuviškų raidžių, 
prieš pradedant rašyti tekstą, jį reikia pakeisti kitu šriftu. Gali būti 
formatuojami ir jau įvesti duomenys. 

Įvestus ląstelėse duomenis beveik visada tenka taisyti ir per-
tvarkyti. Excel dažniausiai atliekami tokie redagavimo veiksmai: 

 Redaguojamas ląstelės turinys; 
 Šalinami nereikalingi duomenys; 
 Perkeliami duomenys; 
 Kopijuojamos ląstelės. 

Norint atlikti veiksmus su ląstelėje ar srityje esančiais duome-
nimis, juos reikia pažymėti. 
 
4.3 lentelė. Ląstelių žymėjimo veiksmai 
 

Žymimas 
objektas Veiksmo aprašymas 

Ląstelė 
 

Spragtelėti ties išskiriama ląstele pele arba krypčių rodyklių 
klavišais; į šią ląstelę perkelti lentelės žymiklį. 

Sritis 
 

Spragtelėti pele ties kampine srities ląstele ir traukti pelės 
rodyklę iki kitos srities kampinės ląstelės. 

Eilutė arba 
stulpelis 

Spragtelėti antraštėje ties eilutės numeriu arba stulpelio 
pavadinimu. 

Sudėtinė sritis Pažymėti pirmą sritį, tada laikant nuspaudus <Ctrl> klavišą, 
išskirti papildomas sritis. 

Visa lentelė 
 

Spragtelėti pele ties stačiakampiu, esančiu stulpelių ir eilučių 
pavadinimų sankirtoje (virš 1 eilutės į kairę nuo A stulpelio). 

Lapas 
 

Spragtelėti pele ties lapo pavadinimu lapų sąrašo eilutėje, 
esančioje programos lango apačioje. 

Keli lapai 
 

Laikant nuspaustą <Ctrl> klavišą, spragtelėti pele ties 
reikiamų lapų pavadinimais lapų sąrašo eilutėje. 
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Ląstelės turinio redagavimas 
Ląstelės turinį redaguoti galima formulės eilutėje arba tiesio-

giai ląstelėje. 
Norint redaguoti duomenis formulės eilutėje reikia pažymėti 

redaguojamą ląstelę, spragtelėti pele reikiamoje formulės eilutės 
vietoje, redaguoti ląstelės turinį, baigus redaguoti paspausti klavišą 
<Enter> arba pereiti prie kitos ląstelės. 

Norint redaguoti duomenis tiesiogiai ląstelėje reikia pažymėti 
redaguojamą ląstelę, paspausti funkcijų klavišą <F2> arba du kartus 
spragtelėti pele ląstelėje, redaguoti ląstelės turinį, baigus redaguoti – 
paspausti <Enter> arba pereiti prie kitos ląstelės. 

 

Ląstelių turinio naikinimas 
Norint panaikinti vienos ląstelės (arba srities) turinį, reikia pa-

žymėti ląstelę (arba sritį), kurios turinį reikia panaikinti, ir paspausti 
<Delete> klavišą arba vykdyti komandą Edit→Clear→All. 

 

Ląstelės (srities) turinio kopijavimas ir perkėlimas 
Kopijuoti arba perkelti ląstelės turinį galima esant komandi-

niam režimui, naudojant laikinąją atmintį (Clipboard) ir vykdant 
komandas Copy, Cut ir Paste. 

Naudojant komandinį režimą, reikia: 
 Pažymėti kopijuojamą (arba perkeliamą) ląstelę (arba sritį). 
 Vykdyti meniu Edit komandą Copy (Cut). Kopijuojama da-
lis apibrėžiama mirksinčia punktyrine linija. 
 Pažymėti ląstelę (arba sritį), į kurią reikia kopijuoti (per-
kelti) duomenis. 
 Vykdyti meniu Edit komandą Paste. 

Norint kopijuoti arba perkelti ląstelės turinį pele, reikia: 
 Pažymėti perkeliamą ląstelę (sritį); 
 Pelės žymiklį nustatyti ties ląstelės ribos linija, kad jis įgytų 
rodyklės pavidalą; 
 Laikant nuspaudus <Ctrl> ir kairįjį pelės klavišą (kopijuo-
jant) arba spaudžiant tik kairįjį pelės klavišą (perkeliant), 
perkelti ląstelės turinį į kitą vietą. 
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4.5.3. Formulės įrašymas į ląstelę 
 
Formulės sudaromos norint atlikti sudėtingesnius skaičiavi-

mus. Sudaroma konkrečios ląstelės arba masyvo formulė. Vėliau ji 
užpildoma kitose ląstelėse, kurių rezultatas apskaičiuojamas pagal tą 
patį algoritmą. Formulėms sudaryti naudojamos operacijos, funkci-
jos, ląstelės dažniausiai žymimos jų koordinatėmis. Kiekviena for-
mulė būtinai prasideda formulės redagavimo ženklu =. Ląstelėje gali 
matytis arba formulės reikšmė, tai yra apskaičiuotas rezultatas, arba 
pati formulė. Ką norima matyti, nurodoma meniu komandos Tools→ 
Options skyrelyje View (jei norime, kad būtų matyti formulės, jun-
giame jungiklį Formulas). 

Formulę į ląstelę įrašant rankiniu būdu, reikia: 
 Pažymėti ląstelę, kurioje reikia įrašyti formulę; 
 Įrašyti lygybės ženklą (=); 
 Įrašyti formulę; 
 Paspausti <Enter> arba pažymėti kitą ląstelę. 

Jeigu formulė įvesta klaidingai, programa informuoja apie 
klaidą. Nuspaudus mygtuką Ok, formulės eilutėje išskiriama klai-
dinga įvestos formulės dalis, tuomet būtina atlikti pataisas. 

Jeigu norime naudoti funkciją, reikia: 
 Pažymėti ląstelę, kurioje reikia įterpti funkciją; 
 Vykdyti meniu komandą Insert→Function arba spaudžiant 
mygtuką  fx . vykdyti komandą Paste Function; 
 Pirmajame Paste Function dialogo lange išskirti norimą 
funkciją ir paspausti mygtuką Ok; 
 Antrajame pateiktame funkcijos vykdymo lange įvesti rei-
kalingus parametrus – skaičius, ląstelių ar sričių adresus, 
kitas funkcijas ir spausti mygtuką Ok. 

Įvedus formulę nedelsiant apskaičiuojama jos reikšmė, ji pa-
teikiama ląstelėje. Kartais Excel vietoj formulės reikšmės ląstelėje 
rodo, kad padaryta klaida (Error value). Programa formulėje pada-
rytą klaidą žymi grotelėmis (#). Dažniausiai pasitaikančios klaidos: 

#NULL!  – klaidingai nurodyta sritis arba sudėtinė sritis; 
#REF!  – klaidingos ląstelės koordinatės; 
#VALUE! – klaidingas funkcijos argumentas ar operandas; 
#NAME? – formulėje panaudotas neatpažintas pavadinimas; 
#DIV/0! – dalyba iš nulio; 
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#N/A – formulėje nurodytos reikšmės neprieinamos; 
#NUM! – formulėje neteisingai panaudotas skaičius. 

Klaidų priežastys plačiau paaiškintos 4.9 skyriuje. 
 

4.5.4. Ląstelių masyvas 
 
Masyvas naudojamas tada, kai reikia sudaryti formules, kurios 

pateikia rezultatų rinkinį arba kurių argumentai nurodomi reikšmių 
rinkiniu. 

Masyvai gali būti dviejų tipų: 
 Ląstelių masyvas (Array range) yra stačiakampis ląstelių 
blokas; 

 Konstantų masyvas (Array constant) yra konstantų grupė, 
nurodoma kaip formulės argumentas. 

Rašydami formulę ląstelių masyvą įvedame pele žymėdami 
lentelės fragmentą, kuriame yra reikiami duomenys, pavyzdžiui, įra-
šydami jo koordinates C2:D8. 

Užrašydami konstantų masyvą, jo reikšmes apskliaudžiame fi-
gūriniais skliaustais, tos pačios eilutės reikšmes atskiriame simboliu  
\ , o eilutes – kabliataškiu, pavyzdžiui, {6\4\8;13\5\17}. 
 
4.4 lentelė. Duomenų ląstelių masyvų pavyzdžiai 
 

 
 A B C D E 
1 Veikla I ketv. 

Lt 
II ketv. 

Lt 
III ketv. 

Lt Atskaitymai

2 1. Algos 1316,00 3364,94 6621,85  
3 2. Duomenų pirkimas 5000,00 12784,72 25159,00 9994,60 
3 3. Duomenų formatavimas 4300,00 10994,86 21636,74 8791,44 
5 4. Duomenų siuntimas 1060,00 2710,36 5333,71 2167,19 
6 5. Informacijos parengimas 500,00 2710,36 2515,90 1022,26 
7 6. Vietiniai susitikimai 1000,00 2556,94 5031,80 2044,52 
8 7. Papildomos išlaidos 658,80 1684,51 3314,95  

9      

10  IŠ VISO: 13834,80 36806,70 69613,95 24020,01 

11      
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Masyvo formulė – tai formulė, kurios rezultatai pateikiami ląs-
telių masyve. 

Norint surinkti masyvo formulę, reikia: 
 Pažymėti ląstelių bloką, kuriame turi būti įrašyti formulės 
rezultatai, pavyzžiui, D2:D5; 
 Surinkti formulę, ją pradedant formulės redagavimo ženklu 
= B2:B5∗C2:C5; 
 Paspausti klavišus <Ctrl>+<Shift>+<Enter>. 

 
 
 
 
 
 
 
 
 
 
 
 

4.7 pav. Masyvo formulės panaudojimas skaičiuojant sumą 
 

Įvesta formulė bus apskliausta figūriniais skliaustais, rodan-
čiais, kad tai masyvo formulė. Masyvo formulėje (stulpelyje Suma) 
įrašyto ląstelių turinio keisti negalima. 

Ląstelių masyvų žymėjimo pavyzdžiai pateikti 4.5 lentelėje. 
 

4.5 lentelė. Ląstelių masyvų žymėjimo pavyzdžiai 
 
A5:A11 Srities, apimančios septynias A stulpelio ląsteles, esančias 5–11 

eilutėse (A5, A6, A7, A8, A9, Al0, A11), santykinės koordinatės 
B5:D6 Srities, apimančios šešias ląsteles, esančias 5–6 eilutėse ir B, C, 

D stulpeliuose (B5, C5, D5, B6, C6, D6), santykinės koordinatės 
A2, B6:C7, 
D2 

Sudėtinės srities, sudarytos iš ląstelių A2, B6, B7, C6, C7 ir D2, 
santykinės koordinatės 
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4.5.5. Elektroninės lentelės redagavimas  
          ir formatavimas 

 
Naujų stulpelių ir eilučių įterpimas 
Norint įterpti naują eilutę reikia pažymėti eilutę, virš kurios rei-

kia įterpti naują eilutę, ir vykdyti komandą Insert→Rows. 
Norint įterpti naują stulpelį reikia pažymėti stulpelį, kurio kai-

rėje reikia įterpti naują stulpelį, ir vykdyti komandą Insert→Columns. 
Jeigu vienu metu norite įterpti keletą eilučių ar stulpelių, pa-

tartina žymėti tiek eilučių (stulpelių), kiek reikia įterpti. 
Norint naikinti eilutes arba stulpelius, reikia pažymėti naiki-

namas eilutes arba stulpelius ir vykdyti komandą Edit→Delete. 
Norint pakeisti eilutės aukštį ar stulpelio plotį reikia nustatyti 

pelės rodyklę ties eilučių, stulpelių antraštėmis ant apatinės keičia-
mos eilutės linijos arba į dešinę nuo pažymėtos keičiamo stulpelio 
vietos (pelės rodyklė įgauna kryžiaus su dviem rodyklėmis pavidalą), 
paspausti pelės klavišą ir laikant jį nuspaustą traukti pelės rodyklę, 
kol eilutė arba stulpelis taps reikiamo dydžio. 

Norint pakeisti eilutės aukštį reikia pažymėti eilutę ir vykdyti 
komandą Format→Row, dialogo langelyje Row Heigt įrašyti norimą 
aukštį ir paspausti Ok. Šios komandos dialogo lange eilutės aukštis 
nurodomas punktais. Vienas punktas lygus apie 0,35 mm. 
 
 
 
 
 
 

4.8 pav. Eilutės aukščio parinkimo  
Format→Row komandos langas 

 
Norint pakeisti stulpelio plotį reikia vykdyti pagrindinio meniu 

komandą Format: 
 Pažymėti stulpelį, kurio plotį reikia pakeisti. 
 Format→Column dialogo langelyje Column Width įrašyti 
norimą plotį. Šis plotis nurodomas 10 punktų dydžio sim-
bolių skaičiumi. Maksimalus stulpelio plotis – 255 simbo-
liai. Vieno simbolio plotis – apie 2 mm. 
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4.9 pav. Stulpelio pločio parinkimo  
Format→Column komandos langas 

 

Ląstelės ir srities rėmeliai 
Norint nubrėžti arba pašalinti jau nubrėžtus rėmelius, reikia: 

 Pažymėti ląstelę ar sritį, kurią reikia apibrėžti rėmeliu; 
 Vykdyti komandą Format→Cells ir išrinkti lango skyrelį 
Border. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.10 pav. Rėmelių parinkimo priemonės 
 

 Išsirinkti linijos tipą (Style) ir spalvą (Color). 
Lango skyrelyje Border nurodyti, kur brėžti rėmelius: Outline 

– aplink sritį, Inside – srities viduje, Left – kairėje, Right – dešinėje, 
Top – viršuje ir t. t. 



4 skyrius. DUOMENŲ TVARKYMAS SKAIČIUOKLĖSE 
 

192 

Duomenų išdėstymas ląstelėse 
Į ląstelę įvesti skaičiai išlyginami pagal dešinįjį kraštą, o te-

kstas – pagal kairįjį. 
Norint numatyta tvarka išdėstyti ląstelėse esančius duomenis, 

reikia pažymėti ląstelę arba sritį ir vykdant komandą Format→Cells 
išrinkti lango skyrelį Alignment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

4.11 pav. Teksto išdėstymo parinkimo priemonės 
 

Duomenų išdėstymo ląstelėje būdai: 
 Horizontal – centruoti horizontalia kryptimi; 
 Vertical – centruoti vertikalia kryptimi; 
 Orientation – keisti teksto kryptį; 
 Wrap text – tekstą, esantį ląstelėje, išdalyti į eilutes; 
 Merge cells – sujungti ląsteles; 
 Shrink to fit – užpildyti ląstelę joje įrašyta reikšme. 

 

4.5.6. Specialūs duomenų kopijavimo būdai 
 

Norint kopijuoti arba perkelti tik dalį informacijos, esančios 
ląstelėje arba srityje, reikia tai atlikti tam tikru būdu: 

 Pažymėti kopijuojamą arba perkeliamą ląstelę arba sritį; 
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 Norint kopijuoti reikia vykdyti komandą Edit→Copy, norint 
perkelti – Edit→Cut. Kopijuojama, perkeliama dalis api-
brėžiama mirksinčia punktyrine linija. 
 Pažymėti ląstelę (arba srities kairiąją viršutinę ląstelę), į ku-
rią reikia kopijuoti (perkelti) duomenis. 
 Vykdyti komandą Edit → Paste Special; 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.12 pav. Edit→Paste Special komandos langas, skirtas kopijuoti  
ar perkelti informaciją, renkantis parametrų reikšmes 

 
 

Komandos dialogo lange Paste Special reikia pasirinkti vieną 
iš komandos parametrų. 
 

4.6 lentelė. Kopijavimo komandos Paste Special parametrų reikšmės 
 

All Įterpti visą ląstelių informaciją (formules, 
reikšmes, formatus, komentarus) 

Formulas Įterpti tik formules 
Values Įterpti tik reikšmes 
Formats Įterpti tik formatavimo parametrus 
Comments Įterpti tik komentarus 
Alle except borders Įterpti visą informaciją, išskyrus rėmelius 
Column Widths Įterpti stulpelių pločių reikšmės 
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4.7 lentelė. Kopijavimo komandos Paste Special operacijų atlikimo  
                   dalies Operation parametrų reikšmės 
 
None Kopijuojamos (perkeliamos srities) duomenis perrašyti į 

įterpimo sritį 
Add Prie įterpimo srities ląstelių reikšmių pridėti kopijuojamos 

(perkeliamos) srities duomenis 
Subtract Iš įterpimo srities ląstelių reikšmių atimti kopijuojamos 

(perkeliamos) srities duomenis 
Multiply Įterpimo srities ląstelių reikšmes padauginti iš kopijuojamos 

(perkeliamos) srities duomenų 
Divide Įterpimo srities ląstelių reikšmes padalinti iš kopijuojamos 

(perkeliamos) srities duomenų 
 
 

4.5.7. Darbo pabaigos komandos 
 
Galimi keli programos pabaigos būdai: 
1. Pele paspausti lango uždarymo mygtuką Close X; 
2. Paspausti klavišus <Alt>+<F4>; 
3. Vykdyti komandą File→Exit. 
Jeigu dokumentas buvo redaguojamas, bet pakeitimai nebuvo 

įrašyti į failą, baigiant dirbti programa pasirodo užklausa Do you 
want to save the changes you made to 'dokumento vardas', patiksli-
nanti, kaip norima išsaugoti darbo knygą. 

Tokiu atveju reikia pasirinkti vieną iš pateiktų atsakymo va-
riantų: 

Yes – išsaugoti dokumento pakeitimus; 
No – pakeitimų neišsaugoti; 
Cancel – tęsti darbą, atšaukiant komandą. 

 
 
 
 
 
 
 

4.13 pav. Darbo pabaigos informacinis pranešimas, kai dokumentas 
redaguojamas ir pakeitimai išsaugomi 
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Baigiant dirbti su programa, tie patys pranešimai bus matyti 
asistento langelyje, jeigu jis įjungtas (t. y. vykdyta komanda Help→ 
Show the Office Assistant). 

 
 

4.5.8. Lentelių rinkinio puslapių formavimas 
 
Naujai atidaryta Excel knyga turi 3 lapus (Sheet1, Sheet2, 

Sheet3). 
Norint pereiti nuo vieno lapo prie kito reikia spragtelėti pele 

ties reikiamo lapo pavadinimu lapų sąrašo eilutėje, pavyzdžiui, 
Sheet2. 
 
 
 
 
 
 
 
 
 
 
 

 
4.14 pav. Pagrindinis Excel programos langas esant aktyviam pirmam lapui  

 
Norint suaktyvinti kelis lapus iš karto, reikia paspausti klavišą 

< Ctrl >, spragtelėti pele ties reikiamų lapų pavadinimais. 
 

Darbo lapo pavadinimo keitimas 
Excel knygoje darbo lapai vadinami Sheet1, Sheet2 ir t. t. 

Knygą bus lengviau skaityti, jei lapai turės prasminius pavadinimus, 
pavyzdžiui, apskaita, planavimas, diagramos, ir pan. 

Norint suteikti lapui kitą pavadinimą, kuris nusakytų jame sau-
gomos informacijos prasmę ir leistų lengviau susirasti duomenis di-
delės apimties darbo knygoje, reikia dešiniuoju pelės klavišu sprag-
telėti ties pasirinktojo lapo pavadinimu, pavyzdžiui, Sheet1, iškviesti 
kontekstinį meniu ir vykdyti komandą Rename; klaviatūra surinkti 
kitą lapo pavadinimą. 
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4.15 pav. Excel programos langas suteikus darbo 
lapams naujus pavadinimus 

 
Naujo lapo įterpimas 
Norint įterpti naują lapą reikia: 

 Pažymėti lapą, prieš kurį reikia įterpti naują lapą; 
 Iškviesti kontekstinį meniu ir vykdyti komandą Insert; 
 Naujas lapas įterpiamas į kairę nuo pasirinktojo. 

 
 
 
 
 
 
 
 
 
 
 

4.16 pav. Naujo lapo įterpimo komanda, 
iškvietus kontekstinį meniu 

 
Darbo lapų kopijavimas ir perkėlimas 
Norint nukopijuoti ar perkelti darbo lapą (lapus) į kitą arba tą 

pačią knygą reikia: 
 Pažymėti kopijuojamą ar perkeliamą lapą;  
 Iškviesti kontekstinį meniu ir vykdyti komandą Move or 
Copy; 
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 Komandos dialogo lange Move or Copy sąraše To Book iš-
rinkti knygą, į kurią bus kopijuojamas arba perkeliamas la-
pas; 
 Sąraše Before Sheet pažymėti lapą, prieš kurį bus įterpta 
(perkeliama) kopija; 
 Kopijuojant lapą, reikia įjungti Create a Copy, perkeliant 
lapą jungiklis nejungiamas. 

 
 
 
 
 
 
 
 
 
 
 

4.17 pav. Aktyvaus lapo perkėlimo ar kopijavimo  
komanda iškvietus kontekstinį meniu 

 

Kopijuojant lapą, būsiantį toje pačioje darbo knygoje, prie jo 
pavadinimo prirašomas skaičius, pavyzdžiui, diagramos(2). 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.18 pav. Kopijuojamo ar perkeliamo lapo  
vietos parinkimo langas 



4 skyrius. DUOMENŲ TVARKYMAS SKAIČIUOKLĖSE 
 

198 

Lapo panaikinimas 
Norint naikinti nebereikalingus ar perteklinius darbo knygos 

lapus, reikia pažymėti lapą ar kelis lapus, kuriuos reikia panaikinti; 
iškviesti pažymėtojo lapo kontekstinį meniu ir vykdyti komandą 
Delete. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

4.19 pav. Kontekstinis planavimo lapo meniu 
 
 
 
4.6. FORMULIŲ SUDARYMAS  
       SKAIČIUOKLĖSE 
 

ormulės skirtos atlikti skaičiavimus lentelėse. Pagal formulėje 
nurodytas reikšmes apskaičiuojama nauja reikšmė. Sudarant 

formulę ląstelėje, kurioje turės būti įrašytas reikalingas rezultatas, 
įrašomas formulės pradžios ženklas – lygybės simbolis =. Formulėje 
nurodytos reikšmės gali būti konstantos, įrašytos pačioje formulėje, 
arba reikšmės, įrašytos ląstelėse, kurių adresai nurodyti formulėje. 
Formulėje įrašytos operacijos ir funkcijos apibrėžia, kokius veiksmus 
reikia atlikti. Sudarant formulę ląstelių ar masyvų koordinates galima 
įterpti automatiškai, pele pažymint reikiamą ląstelę arba jų masyvą. 

Formulėse naudojami aritmetiniai, teksto jungimo ir santykio 
operatoriai (4.8 lentelė). 

F 
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4.8 lentelė. Operacijų sąrašas 
 

Operacijų 
eilės tvarka 

Operacijos 
ženklas Operacija 

1 - Skaičiaus ženklo keitimas 
2 % Procentų apskaičiavimas 
3 ^ Kėlimas laipsniu 
4 * Daugyba 
 / Dalyba 

5 + Sudėtis  
 - Atimtis 

6 & Teksto fragmentų jungimas 
7 <; <= Mažiau; mažiau arba lygu 
 >; >= Daugiau; daugiau arba lygu 
 = Lygu 
 <> Nelygu 

 
 
 

Skaičiuojant rezultatus formulėse: 
 Pirmiausia apskaičiuojami skliaustuose esantys reiškiniai, 
tada atliekamos operacijos su skliaustuose esančiomis reikš-
mėmis; 
 Veiksmai atliekami pagal operacijų (pirmenybės) eilės tvar-
ką. 
 Kai operacijos tos pačios eilės, veiksmai atliekami iš kairės 
į dešinę. 

Formulės sudedamosios dalys yra operacijų ženklai, ląstelių 
koordinatės, skaičių konstantos ir funkcijos. 

Formulių pavyzdžiai: 
=B5+C10*2; 
=(B5+C10-$D$10)/4; 
=(B5+C10)*33%; 
=B$5+AVERAGE(C5:C10). 

Įrašius formules, pavyzdžiui, į D stulpelį, atitinkamoje eilutėje 
gaunami skaičiavimo pagal sudarytąsias formules rezultatai. 

 

4.6. Formulių sudarymas skaičiuoklėse 
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4.20 pav. Formulių sudarymo pavyzdžiai 
 
 

Formulės redagavimas 
Formules patogu redaguoti formulės eilutėje. Pažymėjus ląs-

telę, kurioje yra formulės rezultatas, formulės eilutėje pateikiama pati 
formulė. Elektroninės lentelės leidžia redaguoti formules pačioje 
ląstelėje. Kairiuoju pelės klavišu du kartus spragtelėjus redaguojamą 
ląstelę, formulė rodoma ląstelėje. Redaguoti baigiama, spaudžiant 
<Enter> klavišą arba jį atitinkantį mygtuką (paukščiuką) formulės 
eilutėje. 

Jeigu reikia, kad lentelėje vienu metu būtų matyti visos for-
mulės, o ne apskaičiuoti rezultatai, tai padaryti galima įjungiant for-
mulių peržiūros režimą. Tuomet reikia vykdyti komandą Tools→ 
Options bei šios komandos dialogo lango skyrelyje View įjungti 
Formulas. 
 
 
 

4.7. FUNKCIJŲ PANAUDOJIMAS 
 

asitelkdami funkcijas sparčiau sudarysime elektronines lenteles 
įvairiems skaičiavimams atlikti. Funkcijos atlieka dažnai nau-

dojamas matematinių veiksmų, teksto, statistinio duomenų apdoro-
jimo bei finansinių skaičiavimų sekas ir kitus veiksmus. 

Skaičiuoklės turi be galo daug funkcijų, kurios, kad vartoto-
jams būtų patogiau, suskirstytos į grupes: 

 Visos funkcijos, surašytos pagal abėcėlę; 

P 
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 Finansinės funkcijos; 
 Datos ir laiko funkcijos; 
 Matematinės ir trigonometrinės funkcijos; 
 Statistinės funkcijos; 
 Paieškos ir adresų funkcijos; 
 Duomenų bazės funkcijos; 
 Teksto apdorojimo funkcijos; 
 Loginės funkcijos; 
 Informacinės funkcijos; 
 Vartotojo funkcijos. 

 
 
 
 
 
 
 
 
 
 
 
 

 
4.21 pav. Excel programos funkcijų grupės su aktyviu  

visų funkcijų sąrašu 
 

Funkciją sudaro pavadinimas ir nustatyta tvarka skliaustuose 
surašyti privalomi bei neprivalomi argumentai, atskiriami kabliataš-
kiais, kableliais bei dvitaškiais. 

Bendroji funkcijos užrašymo forma: 
Funkcijos pavadinimas (a1; a2; a3;…), a1, a2, a3 – funkcijos 

argumentai. 
Funkcijos pavadinimas nurodo funkcijos paskirtį: 
SUM – sumavimo funkcija; 
AVERAGE – vidurkio skaičiavimo funkcija; 
MAX – maksimumo – didžiausios reikšmės pateikimo funkcija; 
MIN – minimumo – mažiausios reikšmės pateikimo funkcija ir 

panašiai. 
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Kiekviena funkcija gali turėti nuo 0 iki 30 argumentų. Argu-
mentai gali būti visų šešių Excel programoje naudojamų duomenų 
tipų: 

 Skaičiai, pavyzdžiui, 7; –8; 5,4; 2,5; 
 Teksto eilutės, pavyzdžiui, a; Pranešimas; 
 Loginės reikšmės, pavyzdžiui, True arba False; 
 Koordinatės, pavyzdžiui, A7:A8; G5; $F$4; 
 Masyvai, pavyzdžiui, {1\2\3; 5\6\7}; 
 Klaidos reikšmės, pavyzdžiui, #N/A; #NUM!, #VALUE! 

Funkcijos argumentas gali būti kita funkcija. AVERAGE funk-
cija gali būti SUM(A2:A8; AVERAGE(5; 9)), tuomet AVERAGE yra 
pirmojo lygmens įdėtinė funkcija. Vienoje formulėje tokių lygių 
skaičius gali būti lygus septyniems, tačiau pačios formulės ilgis ne-
gali turėti daugiau nei 1024 simbolių. 

 
 
4.7.1. Matematinės ir trigonometrinės funkcijos 
 
Sumavimo funkcija 
Norint susumuoti skaičius, taikoma sumavimo funkcija SUM 

(skaičius 1; skaičius 2, …). Sudarant šią funkciją galima naudoti iki 
trijų dešimčių argumentų. Pavyzdžiui, SUM(3;2) rezultatas – 5. 

Jeigu į ląsteles nuo A2 iki E2 įrašyti skaičiai 5, 15, 30, 40, 10, 
funkcijos argumentą galima pateikti kaip ląstelių bloką, pavyzdžiui, 
SUM(A2:E2) rezultatas bus 100. Pateikta funkcija SUM(A2:E2) yra 
ekvivalenti SUM(A2;B2;C2;D2;E2), tačiau pirmoji yra pranašesnė, 
nes turi tik vieną argumentą, o antroji – 5. 

 
 
 
 
 
 
 
 
 
 

4.22 pav. Sumavimo funkcijos pavyzdys 
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Funkcija SUM(A:A) – funkcijos argumentų adresuose nuro-
džius tik stulpelio adresą pažymima, kad bus sumuojami visi nuro-
dytojo stulpelio skaičiai. 
 
 
 
 
 
 
 
 
 
 
 

 
4.23 pav. Sumavimo funkcijos pavyzdys, sumuojant  

visus nurodytojo stulpelio skaičius 
 

SUM(2:2) – sumavimo funkcijos argumentų adresuose nuro-
dant tik eilutės adresą pažymima, kad bus sumuojami visi nurodyto-
sios eilutės skaičiai. 

 
Skaičių apvalinimo funkcijos 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.24 pav. Skaičių apvalinimo funkcijos pavyzdys 
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Funkcija ROUND(skaičius;ženklų skaičius po kablelio) apva-
lina skaičius, palikdama nurodytą ženklų skaičių po kablelio. 

ROUNDUP(skaičius;ženklų skaičius po kablelio) – apvalini-
mas prie paskutinio skaitmens pridedant vienetą. 

ROUNDDOWN(skaičius;ženklų skaičius po kablelio) – apvali-
nimas nekeičiant paskutinio skaitmens. 
 

Sandaugos funkcija 
PRODUCT(skaičius1;skaičius2;...) skirta daugybos veiksmams 

atlikti. 
Pasitelkiant šią funkciją galima sudauginti iki 30 argumentų. 

 
 
 
 
 
 
 
 
 
 
 
 
 

4.25 pav. Sandaugos funkcijos pavyzdys 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.26 Sandaugos funkcija naudojant kelis argumentus  
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Skaičiaus π funkcija 
Naudojant trigonometrines funkcijas jų argumentas dažnai pa-

teikiamas kaip skaičius π. Šio skaičiaus reikšmė – 3,14159. Skaičių π 
programa išreiškia 15 ženklų po kablelio tikslumu kaip funkciją PI(). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.27 pav. Skaičiaus π funkcija ir jos naudojimo būdas 
 
 

Trigonometrinės funkcijos 
Trigonometrinė funkcija SIN(skaičius) apskaičiuoja kampo 

sinusą. Jos argumentas gali būti nurodomas radianais, pavyzdžiui, 
=SIN(PI()/2), arba laipsniais =SIN(90*PI()/180). 
 
 
 
 
 
 
 
 
 
 
 
 

4.28 pav. Trigonometrinės funkcijos kampo  
sinuso argumentų pavyzdžiai 
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Trigonometrinė funkcija COS(skaičius) apskaičiuoja kampo 
kosinusą, o funkcija TAN (skaičius) – tangentą. 

Excel programa analogiškai skaičiuoja funkcijas ARCSIN, 
ARCCOS ir ARCTAN. 

Funkcija SQRT(skaičius) skirta kvadratinei šakniai skaičiuoti. 
Pavyzdžiui, SQRT(16) rezultatas bus 4. 

Funkcija FACT(skaičius) skirta faktorialui skaičiuoti. Pavyz-
džiui, FACT(7) rezultatas bus 5040 (1*2*3*4*5*6*7=5040). 
 
 

4.7.2. Statistinės funkcijos 
 

Vidurkio skaičiavimo funkcija 
Funkcija AVERAGE(skaičius1;skaičius2;…) nustato pateiktų 

skaičių aritmetinį vidurkį. Šiai funkcijai sudaryti galima naudoti iki 
trijų dešimčių argumentų. Ji apskaičiuoja skaičių arba ląstelių adre-
suose esančių skaičių aritmetinį vidurkį. 

 
Minimalios reikšmės išrinkimo statistinė funkcija 
Funkcija MIN(skaičius1;skaičius2;…) nustato minimalų iš pa-

teiktų skaičių. Šiai funkcijai sudaryti galima naudoti iki trijų dešim-
čių argumentų. 

Ji suranda skaičių arba mažiausią ląstelių adresuose esančių 
skaičių reikšmę. 

 
Maksimalios reikšmės pateikimo funkcija 
Funkcija MAX(skaičius1;skaičius2; …) nustato maksimalų 

skaičių. Šiai funkcijai sudaryti galima naudoti iki trijų dešimčių ar-
gumentų. 

Ši funkcija suranda skaičių arba ląstelių adresuose esančių 
skaičių didžiausią reikšmę. 

 
Ląstelių reikšmių analizės funkcijos 
COUNT(reikšmė;reikšmė;…) funkcija suskaičiuoja, kiek skai-

čių yra koordinatėmis nurodytame bloke. 
COUNTA(reikšmė;reikšmė;…) – įveda įrašytų argumentų 

skaičių, ją naudojame norėdami suskaičiuoti visas netuščias ląsteles. 
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4.29 pav. Maksimalios reikšmės pateikimo  
funkcijos naudojimo būdas 

 
 
 

4.7.3. Finansinės funkcijos 
 
Funkcija FV(rate;nper;pmt;pv;type) apskaičiuoja būsimąją in-

vesticijos vertę. Funkcijos parametrai: 
Rate – norma, pavyzdžiui, 7 proc. palūkanų; 
Nper – periodų skaičius, pavyzdžiui, jeigu mokėdami kasmet 

gautą paskolą turite grąžinti per 2 metus, nper = 2; 
Pmt – vienodų periodinių mokėjimų dydis, pavyzdžiui, kasmet 

mokate po 800 Lt; 
Pv – esamoji vertė, pavyzdžiui, pasiskolintų pinigų suma – 500 

Lt; 
Type – požymis 0, kai mokama periodo gale, 1 – kai pradžioje. 
Norint apskaičiuoti investicijos esant nurodytoms sąlygoms 

vertę, pasitelkiama FV funkcija. Esant nurodytoms sąlygoms investi-
cijos vertė sudarys 2344,37 litų. 
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4.30 pav. Investicijos vertės apskaičiavimo  
funkcijos argumentų ir rezultato pavyzdys 

 
Funkcija DB(Cost;Salvage;Life;Period;Month) fiksuoto mažė-

jančio likučio metodu suskaičiuoja turto nusidėvėjimą per tam tikrą 
laikotarpį. Šios funkcijos parametrai: 

Cost – pradinė turto kaina, pavyzdžiui, 20000; 
Salvage – liekamoji vertė baigus naudoti turtą, pavyzdžiui, 

2000; 
Life – naudojimo trukmė, pavyzdžiui, periodų skaičius, ku-

riems praėjus turtas nusidėvi iki liekamosios vertės, pa-
vyzdžiui, 5 metai; 

Period – periodų skaičius, pavyzdžiui, po 3 metų; 
Month – mėnesių skaičius pirmaisiais metais, pavyzdžiui, 6. 

 
 
 
 
 
 
 
 
 
 
 
 

4.31 pav. Turto nusidėvėjimo per tam tikrą periodą (skaičiuojant fiksuoto 
mažėjančio likučio metodu) funkcijos argumentų ir jos rezultato pavyzdys 
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Pradinė turto kaina – 20000 litų, liekamoji vertė – 2000 litų, iki 
turto susidėvėjimo liko 5 metai, norime sužinoti turto nusidėvėjimo 
vertę po 3 metų. 

Pasitelkdami DB funkciją esant nurodytoms sąlygoms apskai-
čiavome, kad turtas per trejus metus nuvertėjo 3707,06 litų. 
 
 

4.7.4. Laiko apskaitos funkcijos 
 
Laikas šiuolaikiniame gyvenime tampa labai svarbus veiksnys, 

o kartais ir vienas pagrindinių sprendimų priėmimo kriterijų. Todėl 
labai svarbu turėti galimybių atlikti laiko apskaitą ir tinkamai naudo-
tis siūlomomis laiko parametrų įvertinimo priemonėmis. 

Datos skaičiuoklėse numeruojamos skaičiais nuo 1 iki 2 958 
465. Pirmoji apskaitos data yra 1900 metų sausio 1 diena, jai suteik-
tas numeris – 1. Didžiausią numerį atitinka 9999 metų gruodžio 31 
diena. Konkreti data traktuojama kaip sveikasis skaičius, didesnis už 
1 ir mažesnis už 2958465. 

Toks datų apskaitos būdas leidžia atlikti aritmetinius veiksmus 
su datomis, lengvai keisti datų pateikimo būdą, apskaičiuoti laiko 
trukmę ir panašiai. Ląstelėje įrašytam duomeniui datos formatą ga-
lima suteikti Format Cells Number komanda. Pasirinkdami datos 
(Date) arba laiko (Time) duomenų tipą, norimą pateikimo būdą šiems 
duomenims suteiksite pasirinkdami vieną variantą iš duomenų for-
matų sąrašo. 

 
 
 
 
 
 
 
 
 
 
 
 

4.32 pav. Datų formatų sąrašas 

Datų formatai 
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Norint sukurti savą datos ar laiko formatą, reikia pažymėti 
vartotojui skirtą kategorijų grupę Custom ir iš jos pateikiamo sąrašo 
pasirinkti pageidaujamą formatą. Nusakant datų formatus taikomi kai 
kurie tam tikrą reikšmę turintys simboliai: 

 Dienai nurodyti dviejų skaičių junginiu pažymima raidžių 
grupė dd; 
 Dienai nurodyti dviejų lietuviškų raidžių junginiu, nurodan-
čiu savaitės dienas, – ddd, pavyzdžiui, Pr, An ir t. t. 
 Pateikiant visą mėnesio pavadinimą – mmmm; 
 Metų numeriui išreikšti dviženkliu skaičiumi – yy arba 
keturženkliu skaičiumi – yyyy ir kt. 

 

 
 

4.33 pav. Individualaus datos formato kūrimo būdas 
 
 

Lietuviškai išreiškiamą datų užrašymo tvarką patogiausia pasi-
rinkti per operacinės sistemos Windows Control Panel valdymo sky-
delio šalies parametrus Regional Settings Date, esančius formato nu-
statymo lange, pavyzdžiui, 2004.05.04. 

Darbo lapų ląstelėse įrašytą datą ir laiką galima naudoti suda-
rant formules ir funkcijas, nustatant einamąją kompiuterio datą, at-
liekant įvairius veiksmus su datomis. 

Atliekant aritmetinius veiksmus su datomis ir laiku, pirmiausia 
reikia žinoti vieną svarbią taisyklę: neatsižvelgiant į tai, kokiu for-
matu celėje įrašyta data, viena para datų numerių sekoje visada lygi 
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vienetui, o šio vieneto trupmeninė dalis atitinka paros laiką, t. y. va-
landas, minutes, sekundes. 

Konkrečios datų ir laiko funkcijos apskaičiuoja ir pateikia įvai-
rias tokios datos arba argumentais nurodyto laikotarpio dalis. 

Skaičiuoklė turi apie 20 datų ir laiko funkcijų [26]. Pateiksime 
bendrus dažniausiai naudojamų datų ir laiko funkcijų aprašus ir pa-
aiškinsime jų paskirtį: 

DATE(year;month;day) – funkcija, pateikianti nurodytos datos 
eilės numerį; 

DATEVALUE(date_text) – pateikia tekstu nurodytos datos ei-
lės numerį; 

DAYS360(start_date;end_date;method) – pateikia trukmę, nu-
rodydama dienų skaičių tarp pradinės start_date ir galinės end_date 
datos; 

DAY(serial_number) – pateikia eilės numeriu nurodyto mėne-
sio dieną; 

HOUR(serial_number) – pateikia eilės numeriu nurodytos da-
tos valandas; 

NETWORKDAYS(start_date;end_date;holidays) – pateikia 
darbo dienų skaičių tarp dviejų datų. Darbo dienomis nelaikomi sa-
vaitgaliai ir pažymėtos šventės; 

NOW( ) – pateikia einamąją datą ir laiką; 
TIME(hour;minute;second) – paverčia nurodytą laiką eilės 

numeriu; 
TODAY( ) – pateikia einamąją datą; 
WEEKDAY(serial_number;return_type) – pateikia eilės nume-

riu serial_number nurodytos datos savaitės dieną, kai nurodytas 
dienų numeravimo tipas return_type. 

YEAR(serial_number) – pateikia eilės numeriu nurodytos datos 
metus. 

YEARFRAC(start_date;end_date;basis) – pateikia santykinę 
metų dalį (dešimtaine trupmena), atitinkančią visų dienų, esančių 
tarp dviejų datų – start_date ir end_date – dalį metuose. Ši dalis gali 
būti skaičiuojama remiantis skirtingomis datų sistemomis (basis). 

Skaičiuoklėse yra ir kitų laiko apskaitos funkcijų, jos plačiau 
apibūdintos V. Šakio knygoje „Skaičiuoklė Excel’2000 firmos vady-
bai“. 
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4.7.5. Informacinės funkcijos 
 
Pasitelkiant informacines funkcijas galima patikrinti nuro-

dytų ląstelių ar blokų turinį ir pateikti įvairią informaciją apie ląs-
telės ar bloko reikšmės tipus, formatavimo parametrus, įrašytus 
duomenis ir pan. 
 
 
4.9 lentelė. Informacinių funkcijų pavyzdžiai 
 

Informacinės 
funkcijos aprašas Funkcijos rezultatas 

CELL(type_of_info;re
ference) 

Pateikia informaciją apie ląstelės formatą, vietą, 
įrašytus duomenis 

COUNTBLANK 
(range) 

Nurodo suskaičiuotas tuščias pažymėto bloko 
ląsteles 

INFO(type_text) Pagal teksto tipą pateikia informaciją apie 
atminties dydį, atidarytų bylų skaičių 

IS****(argumentas) 
tipo funkcijos 
(yra 11 tokio tipo 
funkcijų) 

TRUE, jei argumentas yra tam tikro tipo, 
arba  
FALSE, jei argumentas neatitinka nurodyto tipo 

IS BLANK (value) TRUE, jei ląstelė tuščia  
IS ERROR (value)  TRUE, jei argumentas yra viena iš klaidos 

reikšmių 
N(value) Paverčia reikšmę skaičiumi 

N( ) Pateikia klaidos reikšmę #N/A 

TYPE(value) Nurodo reikšmės tipą 
 
 
 

4.7.6. Loginės funkcijos 
 
Loginės funkcijos skirtos palyginti, patikrinti, sujungti argu-

mentus ir pagal sąlygą apskaičiuoti reikšmes [26]. Jos leidžia pagal 
Bulio algebros taisykles įvertinti argumentų konjunkciją (AND), 
disjunkciją (OR), neiginį (NOT). MS Excel turi šešias logines funk-
cijas. 
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4.10 lentelė. Loginių funkcijų pavyzdžiai 
 

Loginės funkcijos aprašas Pateikiama reikšmė 
AND(loginis1;loginis2;...) TRUE, jei kiekvieno argumento 

reikšmė yra TRUE, 
FALSE, jei bent vieno argumento 
reikšmė yra FALSE 

OR(loginis1;loginis2;...) TRUE, jei bent viena iš argumentų 
reikšmių yra TRUE; 
FALSE, jei visos argumentų reikšmės 
yra FALSE 

NOT(logical) TRUE, jei tikrinimo sąlygos reikšmė 
netenkinama; 
FALSE, jei tikrinimo sąlygos reikšmė 
tenkinama 

TRUE( ) Pateikiama loginė reikšmė TRUE 
FALSE( ) Pateikiama loginė reikšmė FALSE 
IF(loginė_sąlyga; 
reikšmė_jei_loginė_sąlyga_TRUE; 
reikšmė_jei_loginė_sąlyga_FALSE) 

Pateikiamas vienas iš apskaičiuotų 
reikšmės rezultatų, priklausantis nuo 
įvertintos sąlygos atsakymo (TRUE 
arba FALSE) 

 
Atliekant ekonominius skaičiavimus dažniausiai naudojama 

loginė funkcija IF. Renkantis šią funkciją galima nurodyti sudėtingą 
loginę sąlygą, sudarytą iš kitų AND ir OR loginių funkcijų. IF funk-
cija gali turėti septynis IF lygmenis. AND ir OR loginės funkcijos 
gali turėti nuo vieno iki trisdešimties argumentų. 
 
 
 
 
 
 
 
 
 
 
 

4.34 pav. Loginės funkcijos IF pavyzdys 
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Pateiktame pavyzdyje stipendijos dydis apskaičiuojamas suda-
rant dviejų lygmenų IF funkciją. 

Kiti sudėtingesni IF panaudojimo pavyzdžiai bus pateikti atly-
ginimų apskaitos praktiniuose darbuose. 
 
 

4.7.7. Paieškos ir koordinačių funkcijos 
 
Paieškos funkcijos taikomos, kai lentelėje reikia rasti nežino-

mas objekto charakteristikas, pavyzdžiui, masyvo eilučių skaičių, 
ląstelių eilučių numerius, kai duotos jų koordinatės arba kai reikia 
rasti masyvo elemento reikšmę. 

ROW(reference) – kai nurodomos masyvo koordinatės (refe-
rence), funkcija pateikia ląstelių eilučių numerius; 

ROWS(array) – kai nurodomos masyvo koordinatės (array), 
funkcija pateikia masyvo eilučių skaičių. 

Analogiškos funkcijos: 
COLUMN(reference) – kai nurodomos koordinatės, funkcija 

pateikia ląstelių stulpelių numerius; 
COLUMNS(array) – kai nurodomos masyvo koordinatės, 

funkcija pateikia masyvo stulpelių skaičių (kiekį). 
Masyvas naudojamas tada, kai reikia sudaryti formules, kurios 

pateikia rezultatų rinkinį arba kurių argumentai nurodomi reikšmių 
rinkiniu. Masyvai gali būti dviejų tipų: ląstelių masyvas (array 
range) yra stačiakampis ląstelių blokas, konstantų masyvas (array 
constant) yra konstantų grupė, nurodoma kaip formulės argumentas. 
 
 
 
4.8. DUOMENŲ BAZIŲ IR SĄRAŠO  
        ANALIZĖS KOMANDOS 
 

monių, organizacijų vadybos duomenys dažniausiai kaupiami ir 
apdorojami duomenų bazėse (DB). Duomenų bazėms aptarnauti 

sukurtos specialios programų sistemos, vadinamos duomenų bazių 
valdymo sistemomis (DBVS). Šiuo metu populiarios DBVS yra Mic-
rosoft Access, ORACLE, My SQL. Ankščiau buvo naudojamos 
FoxPro Visual; DB2 ir kt. duomenų bazių valdymo sistemos. 

Į 
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Daugumoje šių DBVS duomenys tvarkomi pasitelkiant relia-
cinį duomenų modelį, grindžiamą matematine reliacinės algebros te-
orija. 

Paprasčiausiai suprantamas reliacinis duomenų modelis – tai 
lentelėmis pateikta duomenų užrašymo forma, kurią sudaro eilutės 
(duomenų bazės įrašai), stulpeliai (duomenų bazės laukai). 

Sąrašas (ang. list) – tai pavadinimus turinčių laukų, sutvarkytų 
eilutėmis, rinkinys. Sąrašą sudarančios lentelės laukuose saugomi 
vienarūšiai duomenys. Sąrašo komponentų samprata pateikiama pa-
veikslėlyje. 

 
 

    Pirmoje eilutėje įrašyti stulpelių pavadinimai, atitinkantys laukų pavadinimus 

 

Veiklos 
pavadinimas 

 I ketv. išlaidos (Lt.) II ketv. išlaidos (Lt.) 

 Algos   1316,00 3364,94 
 Duomenų pirkimas 5000,00 12784,72 
 Duomenų formatavimas 4300,00 10994,86 
 Duomenų siuntimas 1060,00 2710,36 
 Informacijos rengimas 500,00 2710,36 
 Vietiniai susitikimai 1000,00 2556,94 
 Papildomos išlaidos  658,80 1684,51 

 

 

 
Stulpelio ląstelėse įrašyti 
vienarūšiai duomenys     

Viena sąrašo eilutė atitinka 
duomenų bazės įrašą 

 
4.35 pav. Sąrašą formuojantys komponentai 

 
 

Iš pavyzdžio matyti sąrašą formuojančių komponentų struk-
tūra. 

Pagrindiniai sąrašo bruožai: 
 MS Excel automatiškai atpažįsta sąrašą, todėl galima bet ku-
rioje lentelėje taikyti sąrašo analizės komandas. 
 Sąrašo duomenys gali būti įvairiai rūšiuojami taikant 
Data→Sort komandą; 
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 Taikant Data→Subtotals komandą galima automatiškai 
rasti dalines sąrašo eilučių grupių sumas; 
 Pasitelkiant Data→Form komandą labai paprasta peržiū-
rėti, surasti, pakeisti, pridėti arba išmesti sąrašo eilutes; 
 Taikant Data→Filter komandą galima iš sąrašo išrinkti 
duomenis pagal nuolat kintančias vartotojų užklausas. 

 
 
4.8.1. Duomenų rikiavimas – patogi duomenų  
          organizavimo priemonė 
 
Excel programa pagal abėcėlę arba atvirkštine tvarka gali ri-

kiuoti (išdėstyti, rūšiuoti) tekstinę ir skaitmeninę informaciją didė-
jimo arba mažėjimo tvarka. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.36 pav. Duomenų rikiavimo komandos Data→Sort langas 
 
 

Norint duomenis ląstelėse išdėstyti tam tikru būdu reikia pa-
žymėti vientisą stačiakampę ląstelių sritį ir vykdyti meniu komandą 
Data→Sort; sąraše Sort by išrinkti rūšiuojamą lauką. Tai gali būti 
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stulpelių numeriai, pavyzdžiui, Column1, jeigu lentelė neturi jų pa-
vadinimų arba lentelės stulpelių pavadinimai įvesti vartotojo. Išsirin-
kus stulpelį reikia pažymėti vieną iš dviejų rūšiavimo parametrų: 
abėcėlės tvarka (Ascending) arba  atvirkštine negu abėcėlės tvarka 
(Descending). Aktyvus parametras Header row nurodo, kad lentelė 
turi antraštę. Duomenis galima rūšiuoti pagal tris skirtingus laukus. 

Jeigu duomenys rūšiuojami daugiau negu pagal tris laukus, tai 
atliekama keletą kartų. Pavyzdžiui, jeigu duomenis reikia surūšiuoti 
pagal penkis laukus, iš pradžių rūšiuokite pagal du mažiausiai svar-
bius – ketvirtąjį ir penktąjį, antrą kartą rūšiuokite pagal pirmąjį, ant-
rąjį ir trečiąjį laukus. Komandos Sort dialogo langelyje svarbesnis 
laukas įrašomas pirmiau. 
 
 

4.8.2. Duomenų filtravimas 
 
Atlikdamas lentelės duomenų filtravimą vartotojas gali greitai 

atrinkti duomenis pagal norimas parametrų reikšmes. 
 
 
 
 
 
 
 
 
 
 
 
 

4.37 pav. Duomenų lentelė prieš atliekant filtravimą 
 
 

Įvedus duomenis į lentelę vykdant filtravimo komandą 
Data→Filter→AutoFilter iš sąrašo galima išrinkti atitinkamus duo-
menis, pavyzdžiui, Informatikos literatūrą, išleistą ne anksčiau kaip 
iki 1999 metų. Leidimo metų sąraše pasirinkę Custom, komandos 
dialogo lange Custom AutoFilter renkamės sąlygą daugiau arba lygu 
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(is greater than or equal to), nurodydami konkrečią skaičiaus 
reikšmę, pavyzdžiui, 1999. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.38 pav. Filtravimo sąlygų nustatymo langas 
 
 

Atlikus filtravimą pagal anksčiau nurodytas sąlygas programa 
pateikia lentelę, kurioje įrašyti išrinkti duomenys. 
 
 
 
 
 
 
 
 
 
 

4.39 pav. Duomenų lentelė atlikus filtravimą 
 
 

Norint atsisakyti filtravimo, reikia vykdyti tą pačią komandą – 
Data→Filter→AutoFilter. 
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4.9. KLAIDŲ REIKŠMĖS SKAIČIUOKLIŲ  
       PROGRAMOJE 
 

laidų atsiranda tada, kai neteisinga formulės sintaksė arba kai 
pagal parašytą formulę programa negali apskaičiuoti rezultato. 

Dažniausiai daromos klaidos: dalyba iš nulio, pažymėtoje ląstelėje 
neįrašytas skaičius, klaidingai sujungtos koordinatės, neteisingai nu-
rodytos koordinatės ir pan. Kad būtų lengviau ištaisyti klaidas, reikia 
atsiminti programos pateikiamas pagrindinių daromų klaidų reikšmes 
ir jų paaiškinimus. 
 
 
4.11 lentelė. Klaidų reikšmės 
 

Klaidų 
reikšmės Klaidos paaiškinimas 

#DIV/0! Negalima dalyba iš nulio. Reikšmę dalijate iš ląstelės, 
kurioje įrašytas nulis, arba ląstelė yra tuščia. 

#N/A  Negalima reikšmė. Negalima apskaičiuoti funkcijos ar 
formulės rezultato, nes nėra reikiamos informacijos. 
Užrašydami funkciją pateikėte klaidingus argumentus. 

#NAME? Neatpažintas pavadinimas. Klaidingai parašėte funkcijos 
pavadinimą arba duomenų bloko koordinates. 

#NULL! Klaidingai sujungtos koordinatės. Nurodant bendrus dviejų 
blokų adresus, jų koordinates reikia sujungti tarpo ženklu. 

#NUM! Klaidingas skaičius. Funkcijos argumentuose įrašytas 
klaidingas skaičius. 

#REF!  Klaidingos ląstelės koordinatės. Pašalinote ląsteles, 
nurodytas kitose formulėse. 

#VALUE!  Klaidingas argumentas arba operandas. Matematinėje 
formulėje panaudojote ląstelę su tekstu ten, kur turi būti 
skaičius. 

 

K

4.9. Klaidų reikšmės skaičiuoklių programoje 
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4.10. GRAFINIS DUOMENŲ PATEIKIMAS  
         IR VIZUALIZAVIMAS 
 

iagramos yra viena vaizdžiausių duomenų pateikimo formų. 
Diagramos iliustruoja duomenų kitimo spartą bei lygina įvai-

rius dydžius. 
Excel programa pateikia šiuos diagramų tipus [24; 26]: stulpe-

linį (Column), juostinį (Bar), linijinį (Line), skritulinį (Pie), žiedinį 
(Doughnut), plotinį (Area), spindulinį (Radar), XY taškų (Scatter), 
paviršinį (Surface), kūginį (Cone), cilindrinį (Cylinder), piramidinį 
(Pyramid), akcijų (Stock), burbulinį (Bubble), kombinuotąjį (Combi-
nation). 

Dažniausiai naudojamos stulpelinės, skritulinės ir linijinės 
diagramos. Šios diagramos gali būti pateikiamos dvimatėje (plokš-
tuminės diagramos) ir trimatėje erdvėje (erdvinės diagramos). 

Stulpelių diagramomis patogu vaizduoti diskrečius duomenis. 
Stulpelių diagramose duomenys vaizduojami kaip vienodo pločio 
stačiakampiai. Tokios diagramos dar vadinamos histogramomis (šis 
žodis kilęs iš graikų kalbos žodžių histos – stulpas, gramma – užra-
šas). Šiose diagramose stulpelio aukštis proporcingas vaizduojamam 
dydžiui. 
 
 
 

 
 
 
 
 
 
 
 
 

 
4.40 pav. Asmenų, kaltinamų padarius nusikaltimus 2003 ir 2004 metais, 

stulpelinė diagrama (pagal amžiaus grupes) 

D 
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Diagramos, kuriose vaizduojami tie patys duomenys skirtin-
gais laikotarpiais, vadinamos serijinėmis. 

Stulpelinė santykinė diagrama naudojama, kai svarbus santy-
kinis duomenų pasiskirstymas. Tokioje diagramoje stulpeliai atspindi 
vienarūšių duomenų pasiskirstymą. 
 
 
 
 
 
 
 
 
 
 
 

4.41 pav. Nusikaltimus padariusių asmenų  
amžiaus grupių pasiskirstymo 2003 ir 2004  

metais stulpelinė santykinė diagrama 
 
 

Norint pavaizduoti tolydžiai kintamų dydžių dinamiką naudo-
jamos linijinės diagramos arba grafikai. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4.42 pav. 2000–2004 m. nuteistų asmenų skaičiaus  

dinamikos linijinė diagrama. 

4.10. Grafinis duomenų pateikimas ir vizualizavimas 
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Skaičiuoklės Excel turi patogių diagramų sudarymo priemonių 
ir siūlo rinktis įvairių tipų diagramas – dvimates ir trimates. Diagra-
mos gali būti braižomos tame pačiame lape, šalia duomenų lentelių 
arba atskirame knygos lape. 

Norint kokybiškai pateikti diagramą, reikia žinoti visus diag-
ramos objektus, kurių formatus galima pasirinkti. Diagramos objek-
tai yra šie: 

 Diagramos sritis (Cart Area); 
 Diagramos pavadinimas (Chart Title); 
 Braižymo sritis (Plot Area); 
 Legenda (Legend); 
 Kategorijų ašis (Category Axis); 
 Kategorijų ašies pavadinimas (Category Axis Title); 
 Reikšmių ašis (Value Axis); 
 Reikšmių ašių pavadinimas (Value Axis Title); 
 Antroji reikšmių ašis (Secondary Value Axis); 
 Antrosios reikšmių ašies pavadinimas (Secondary Value 
Axis Title); 

 Pirmoji duomenų seka (Series 1); 
 Antroji duomenų seka (Series 2) ir t.t. 
 Duomenų žymės (Data Labels); 
 Tinklelis (Gridlines); 
 Duomenų lentelė (Data Table); 
 Kritimo linija (Drop Line); 
 Ribinė linija (High–Low Line); 
 Pagrindas (Floor), esant trimatei diagramai; 
 Sienelė (Wall), esant trimatei diagramai; 
 Kampas (Corner), esant trimatei diagramai. 

Excel diagramos braižomos su diagramų vedliu Chart Wizard, 
kuris padeda atlikti darbą, pateikdamas keturis dialogo langelius (nu-
rodydamas 4 žingsnius). 

Norint nubrėžti diagramą pagal lentelėje esančius duomenis, 
reikia: 

 Lentelėje pažymėti reikiamą duomenų sritį; 
 Mygtuku Chart Wizard iš bendrosios mygtukų juostos iš-
kviesti diagramos braižymo žynį; 
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 Atliekant pirmąjį žingsnį (Step 1 of 4) pasirinkti diagramos 
tipą; 
 Antrojo žingsnio metu (Step 2 of 4) pasirinkti duomenų iš-
dėstymo būdą; 
 Atliekant trečiąjį žingsnį (Step3 of 4) pasirinkti diagramos 
apipavidalinimą; 
 Atliekant ketvirtąjį žingsnį (Step 4 of 4) pasirinkti duomenų 
pateikimo vietą. 

 
 
 
4.11. SKAIČIUOKLĖS DARBO KNYGOS  
         SPAUSDINIMO BŪDAI 
 

kaičiuoklių Excel kuriamą knygą reikėtų ruošti tam spausdintu-
vui, kuriuo bus spausdinama. Excel knyga – tai dokumentas, 

galintis turėti daug lapų. Ją gali sudaryti ir diagramos, lentelės ir kita 
informacija. Ne visuomet reikia spausdinti visą dokumentą. 

Spausdinant knygą dalimis, reikia vykdyti meniu komandą 
File→Print. 

Iš šios komandos dialogo lango Print išplėstinio sąrašo Name 
išrenkamas spausdintuvo, kuriuo bus spausdinamas dokumentas, 
modelis. 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.43 pav. Spausdinimo komandos dialogo langas 

S 

4.11. Skaičiuoklės darbo knygos spausdinimo būdai 
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Dalyje Print range pažymima, kuriuos lapus reikia spausdinti: 
 All – spausdinti visus puslapius; 
 Pages – spausdinti kai kuriuos puslapius, t. y. laukeliuose 
From (nuo), To (iki) įrašyti spausdinamų puslapių numerių 
intervalą. 

Dalyje Print What pažymima, ką reikia spausdinti: 
 Entire Workbook – spausdinti visą knygą; 
 Active sheet(s) – spausdinti aktyvaus lapo puslapius; 
 Selection – spausdinti puslapyje pažymėtą sritį. 

Dalyje Copies nurodomas kopijų skaičius. 
 
Dokumento peržiūra prieš spausdinimą 
Prieš spausdinant dokumentą naudinga pasižiūrėti, kaip jis at-

rodys išspausdintas. Peržiūros prieš spausdinimą režimas įjungiamas 
spaudžiant bendrosios paskirties įrankių juostos mygtuką Print 
Preview arba vykdant komandą File→Print Preview. Atliekant šį 
veiksmą Excel programos lange bus matyti pirmasis spausdinamas 
lapas. Print Preview režimo metu pasikeičia ir ekrane matomi įran-
kiai. 
 
 
 
 
 
 
 
 
 
 

4.44 pav. File→Print Preview komandos langas 
 
 

Dirbant šiuo režimu galima atlikti šiuos veiksmus: 
 Mygtukais Next ir Previous puslapis po puslapio peržiūrėti 
dokumentą; 
 Mygtuku Zoom keisti puslapio vaizdo mastelį; 
 Spaudžiant mygtuką Setup keisti spausdinamo lapo para-
metrus: matmenis, padėtį, paraštes ir paraščių užrašus; 
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 Spaudžiant mygtuką Margins keisti lapo paraštes; 
 Spaudžiant mygtuką Print vykdyti spausdinimo komandą; 
 Mygtuku Close peržiūrą baigti. 

 
Spausdinamo lapo dydžio ir padėties parinkimas 
Norint parinkti lapo dydį ir paraštes, reikia vykdyti meniu ko-

mandą File→Page Setup arba, esant dokumento peržiūros režimui 
(Print Preview), nuspausti mygtuką Setup. 
 
 
 
 
 
 
 
 
 
 
 
 

4.45 pav. Spausdinamo puslapio parametrų  
nustatymo komandos langas 

 
 

Page Setup dialogo lange skyrelyje Page dalyje Orientation 
galima nustatyti spausdinamo lapo padėtį: vertikalią (Portrait) arba 
horizontalią (Landscape). 

Dalyje Scaling galima padidinti arba sumažinti spausdinamo 
objekto vaizdą. Pavyzdžiui: Adjust to – spausdinti 100 proc. dydžio 
vaizdą arba keisti spausdinamo vaizdo dydį, pavyzdžiui, 200 proc. 
vaizdą spausdinti dvigubai didesnį, 50 proc. – dvigubai mažesnį ir t. 
t. Fit to – spausdinamą vaizdą išdėstyti pagal ilgį ir plotį į tiek pusla-
pių, kiek nurodoma dešinėje. 

Dalyje Paper Size iš išplėstinio sąrašo galima išsirinkti lapo 
dydį, pavyzdžiui, A4 formato – 210x297 mm. 

Dalyje Print quality nustatoma spausdinimo kokybė nurodant 
taškų skaičių colyje. 
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Skyrelyje Margins galima parinkti paraščių matmenis: Top – 
viršutinės paraštės, Bottom – apatinės paraštės, Left – kairiosios pa-
raštės, Right – dešiniosios paraštės, Header nustatomas atstumas nuo 
viršutinio lapo krašto iki užrašo viršutinėje paraštėje. Footer nusta-
tomas atstumas nuo apatinio lapo krašto iki užrašo apatinėje paraš-
tėje. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.46 pav. File→Page Setup komandos dialogo langas.  
Skyrelis Margins paraštėms parinkti 

 
 

Skaičiuoklių Excel programa sukurtą lentelę galima išdėstyti 
spausdinamo lapo centre, horizontalia (Horizontally) arba vertikalia 
(Vertically) kryptimi. 
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4.12. SKAIČIUOKLIŲ PRAKTINIAI DARBAI  
        IR METODINIAI NURODYMAI 
 
 

4.12.1. Duomenų analizė skaičiuoklėse 
 
1. Darbo tikslas 
 
Susipažinti su skaičiuoklių darbo aplinka. Išmokti atlikti duo-

menų analizę, skaičiuoti procentus, įvertinant skirtinguose miestuose 
išaiškintų nusikaltimų skaičių. 

 
2. Darbo užduotys 
 

1. Iškvieskite Microsoft Excel programą. Susipažinkite su skaičiuok-
lės Excel pagrindiniu langu. Išmokite iškviesti nurodytas priemo-
nių juostas – bendrosios paskirties, formatavimo, braižymo. 

2. Parinkite A4 formato popieriaus lapo matmenis (210x297 mm). 
Parinkite paraščių matmenis: kairiosios – 1,9 cm, dešiniosios – 0,9 
cm, viršutinės – 1,5 cm, apatinės – 1,5 cm. 

3. Išmokite žymėti ląstelę, sritį, stulpelį, eilutę. 
4. Įveskite duomenis apie autotransporto vagystes, pateiktus 1 lente-

lėje. 
5. Atlikite skaičiavimus. Grafoje Iš viso suskaičiuokite, kiek yra 

užregistruotų, neišaiškintų ir išaiškintų autotransporto vagysčių. 
Sudarykite formulę, kuri suskaičiuotų išaiškintų vagysčių procentą 
nuo užregistruotų vagysčių skaičiaus. 

6. Lentelę apipavidalinkite, suteikite jos antraštei norimą fono spalvą 
bei rėmelius. 

7. Išsaugokite failą diskelyje (A:\), pavadinkite jį prasminiu pavadi-
nimu, pavyzdžiui, autovagyst.xls. 

8. Pabaikite dirbti su skaičiuokle Excel. 
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3. Metodiniai nurodymai 
 
Susipažinkite su pagrindiniu skaičiuoklių Excel darbo langu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.47 pav. Pagrindiniai Excel programos lango elementai 
 

Kaip pasirinkti norimas mygtukų priemonių juostas? 
Norėdami pasirinkti mygtukų juostas taip, kad jos būtų matyti 

MS Excel programos lange, vykdykite komandą View→Toolbars. 
Ties  Toolbars pasirodžius sąrašui pažymėkite reikiamas priemones, 
pavyzdžiui, Standard, Formatting, Drawing. 

Jeigu išvardytųjų mygtukų juostų nematyti, užduotį pakarto-
kite. 

Jeigu išvardytos priemonių juostos pažymėtos, paspauskite 
View, taip atšauksite komandas. 

Formatavimo  
juosta 

Veikianti ląstelė 

Eilutės numeris 

Lapo 
pavadinimas

Stulpelio 
pavadinimas 

Formulės eilutė 

Meniu juosta Bendrosios 
paskirties juosta 
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4.48 pav. Priemonių juostų įjungimas ir išjungimas vykdant  
pagrindinio meniu komandą View→Toolbars 

 
Kaip parinkti popieriaus lapo dydį, padėtį ir paraščių matme-

nis? 
Pasirinkdami lapo formatą vykdykite komandą File→Page 

Setup. Skyrelyje Page parinkite A4 formato lapo matmenis (210x297 
mm). Puslapio padėties nustatymo dalyje Orientation pažymėkite 
vertikalią lapo padėtį – Portrait (4.49 pav.). 

Skyrelyje Margins nustatykite paraštes (4.50 pav.). Patikrin-
kite, ar parinkote norimus puslapio parametrus, pagrindiniame Excel 
lange sumažinkite mastelį, pavyzdžiui, 25 proc. Aktyviame lape 
(Sheet) bus matyti puslapių ribos. Iš naujo pasirinkite norimą mastelį. 
 
 
 
 
 
 
 
 
 
 
 

4.49 pav. Popieriaus lapo formatavimas 
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4.50 pav. Popieriaus lapo paraščių nustatymas 
 
 

Kaip išmokti žymėti ląstelę, sritį, stulpelį, eilutę? 
Atlikite lentelėje nurodytus žymėjimo veiksmus. 

 
 
 
 
 
 
 

4.51 pav. Pažymėtų darbo lapo ląstelių ir blokų pavyzdžiai 
 
 
4.12 lentelė. Ląstelių žymėjimas pele 
 

Žymimas objektas Veiksmo aprašymas 
Ląstelė Paspausti kairįjį pelės klavišą ties išskiriama ląstele
Sritis Paspausti kairįjį pelės klavišą ties kampine srities 

ląstele ir traukti žymiklį iki kito srities kampo 
Eilutė (stulpelis) Paspausti kairįjį pelės klavišą ties eilutės numeriu 

(stulpelio pavadinimu) 
Sudėtinė sritis Pažymėti pirmąją sritį, tada laikant nuspaudus 

klavišą <Ctrl>, pažymėti papildomas sritis 
Visa lentelė  Nuspausti kairįjį pelės klavišą ties stačiakampiu, 

esančiu stulpelių ir eilučių pavadinimų sankirtoje – 
virš 1, į kairę nuo A. 
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Kaip pakeisti stulpelio plotį? 
Į skaičiuoklės darbo lapą įveskite duomenis, pateiktus 4.13 len-

telėje. Jeigu lentelės stulpelio plotį reikia padidinti (sumažinti), tai 
atlikite traukdami pelę, kaip parodyta paveikslėlyje. 
 
 
 
 
 

4.52 pav. Stulpelio pločio keitimas pele 
 

Kaip į lentelę įvesti duomenis? 
Lentelės pavadinimą pradėkite rašyti nuo kairiojo lapo krašto. 

Du kartus spausdami kairįjį pelės klavišą pažymėkite ląstelę A1. 4.47 
paveikslėlyje matyti bendras lentelės vaizdas. Spausdami kairįjį pelės 
klavišą pažymėkite ląstelę, į kurią įvesite duomenis, ir juos surinkite. 
Duomenis į lentelę įveskite judėdami nuo ląstelės prie ląstelės ro-
dyklėmis (klaviatūroje) arba pele. 
 
4.13 lentelė. Duomenys apie autotransporto vagystes 
 

 A B C D E 

1 Duomenys apie autotransporto vagystes 
2      
3 Miestai Užregistruota Neišaiškinta Išaiškinta Išaiškinta % 

4 Vilnius 1076 901   

5 Kaunas 1001 793   

6 Klaipėda 589 478   

7 Šiauliai 298 218   

8 Panevėžys 292 243   

9 Marijampolė 123 117   

10 Palanga 48 45   

11 Druskininkai 12 8   

12 Birštonas 3 1   

13 Neringa 2 1   

14 Visaginas 29 20   

15 Alytus 25 17   

16 Iš viso     



4 skyrius. DUOMENŲ TVARKYMAS SKAIČIUOKLĖSE 232 

Kaip atlikti skaičiavimus lentelėje? 
Pagrindiniai aritmetiniai veiksmai: + (sudėtis), – (atimtis), * 

(daugyba), / (dalyba), ^ (kėlimas laipsniu), % (procentai). 
Pažymėkite ląstelę Iš viso–Užregistruota, t. y. B16 ir paspaus-

kite mygtuką AutoSum      . Sumuojami duomenys taps aktyvūs. Ant-
rą kartą paspaudus mygtuką AutoSum ląstelėje pasirodys rezultatas. 
Šiuo veiksmu susipažinome su dažniausiai naudojama sumavimo 
funkcija =SUM(B4:B15). Analogiškai atlikite skaičiavimą ląstelėje Iš 
viso–Neišaiškinta =SUM(C4:C15) (ląstelėje C16 galite parašyti 
funkciją =SUM(C4:C15) ir nuspauskite klavišą <Enter>. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.53 pav. Išaiškintų autotransporto vagysčių skaičiavimas sudarant formulę 
 
 

Suaktyvinkite ląstelę D4 (ties antrašte Išaiškinta) ir įrašykite 
formulę =B4–C4, pagal kurią bus skaičiuojamas išaiškintų vagysčių 
skaičius. 
 

Kaip kopijuoti formulę? 
Įvestąją formulę kopijuokite į ląstelių sritį, vykdydami ko-

mandą Edit→Fill→Down arba traukdami žemyn pelės žymiklį. 

Parašę formulę 
spauskite 
klavišą 
<Enter>  
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4.54 pav. Formulės kopijavimas pele 
 

Kaip skaičiuoti procentus? 
Ląstelėje E4 ties antrašte Išaiškinta % parašykite formulę 

=D4/B4, paspauskite klavišą <Enter> ir gausite rezultatą dešimtaine 
trupmena. Norint gauti procentinį rezultato pavidalą formatavimo 
(Formatting) priemonių juostoje spaudžiamas mygtukas Percent 
Style %. 

Ženklus po kablelio galima suvienodinti pažymint ląsteles, ku-
riose tai reikia atlikti, ir paspaudžiant formatavimo (Formatting) 
įrankių juostos mygtukus             – jie didina ir mažina ženklų skai-
čių po kablelio. 
 

Kaip apipavidalinti lentelę? 
Norėdami įrėminti lentelę, ją pažymėkite ir iš mygtuko Bor-

ders išplėstinio sąrašo parinkite patikusį rėmelių variantą. 
                                                         

Rėmeliai   Spalvinimas  Šrifto spalva 
                                                                     Border      Fill Color     Font Color 
 
 
4.55 pav. Kraštinių braižymo ir spalvinimo priemonės 

 
4.55 pav. Formatavimo priemonių juosta 

Įvestąją formulę 
kopijuokite 
traukdami žemyn 
paveikslėlyje 
parodytą pelės 
žymiklį. 
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Jeigu norite nuspalvinti lentelės ląsteles, pavyzdžiui, lentelės 
antraštę, ją pažymėkite ir mygtuko Fill Color spalvinimo skydelyje 
parinkite spalvą. Šiuos skydelius galima perkelti į kitą vietą (tear off) 
– perkelkite skydelį į darbo lapą galėsite jį daug kartų naudoti ląste-
lių formatams tvarkyti. 

Pažymėkite tekste ląsteles ir pakeiskite jose esančių duomenų 
šrifto spalvą. Tai atliekama iš mygtuko Font Color išplėstinio sąrašo 
pasirenkant šrifto spalvą. 

Įvairesni įrėminimo būdai parenkami vykdant komandą For-
mat → Cells→ Border. 

 
Kaip failą išsaugoti? 
Norint išsaugoti skaičiuoklių darbo knygą reikia vykdyti ko-

mandą File→Save As. Komandos dialogo lange reikia: 
 Išplėstiniame sąraše Save in nurodyti aplanką, kuriame bus 
saugomas dokumentas; 
 Teksto lauke File Name įrašyti pavadinimą, kuriuo bus sau-
gomas failas, pavyzdžiui, autovagyst (.xls plėtinio galima 
nerašyti). Atlikite šiuos veiksmus ir paspauskite mygtuką 
Save. 

Programos Excel lango pavadinimų juostoje turi atsirasti failo 
pavadinimas (pvz., autovagyst.xls). Jeigu failo pavadinimo nėra, už-
duotį pakartokite. 

 
Kaip įkelti (atverti) diske esantį failą? 
Norint įkelti iš disko dokumentą, reikia vykdyti komandą 

File→Open. Komandos dialogo lange Open reikia: 
 Išplėstiniame sąraše Look in nurodyti aplanką, kuriame yra 
saugomas dokumentas; 

 Sąraše pažymėti failo pavadinimą ir paspausti mygtuką 
Open. 

 
Kontroliniai klausimai 
 

1. Kokius žinote formulės sudarymo būdus? 
2. Kaip galima kopijuoti formulę? 
3. Kaip pataisyti ląstelės turinį? 
4. Kokias žinote priemones ląstelių formatams tvarkyti? 
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4.12.2. Duomenų vizualizavimas.  
            Diagramų sudarymas 
 

1. Darbo tikslas 
 
Susipažinti su duomenų vizualizavimo skaičiuoklėse pagrin-

dais. Išmokti grafiškai pateikti duomenis, taikant skirtingus diagramų 
tipus. 

 

2. Darbo užduotys 
 
1. Iškvieskite Microsoft Excel programą. 

Nustatykite A4 formato popieriaus lapo matmenis (210x297 mm). 
Parinkite paraščių matmenis: kairiosios – 1,9 cm, dešiniosios – 
0,9 cm, viršutinės – 1,5 cm, apatinės – 1,5 cm. 

2. Įveskite lentelėje pateiktus Baltijos šalių nusikalstamumo rodiklių 
duomenis ir apskaičiuokite vidurkį. Įrėminkite lentelę, jos antraštei 
suteikite norimą fono spalvą. 

3. Tame pačiame darbo lape nubraižykite dvimatę stulpelinę diag-
ramą „Nusikaltimų dinamika Baltijos valstybėse 2000–2004 me-
tais“. 

4. Tame pačiame darbo lape nubraižykite dvimatę skritulinę diag-
ramą „Nusikaltimų dinamika Baltijos valstybėse 2000–2004 me-
tais“. 

5. Tame pačiame darbo lape nubraižykite dvimatę linijinę diagramą 
„Nusikaltimų dinamika Baltijos valstybėse 2000–2004 metais“. 

6. Nukopijuokite diagramą ir ją pakeiskite kito tipo diagrama. 
Parinkite jums patinkančią ir tinkančią vaizduoti pateiktuosius 
duomenis diagramą. 

 

3. Metodiniai nurodymai 
 
Kaip taisyklingai įvesti duomenis, užrašyti lentelės pavadi-

nimą ir suskaičiuoti vidurkį? 
Įveskite lentelėje pateiktus duomenis. Suskaičiuokite vidurkį. 
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4.14 lentelė. Nusikalstamumo dinamika Baltijos valstybėse  
                     2000-2004 metais (nusikalstamumas 10 000 gyventojų,  
                     visų tarnybų duomenimis) 
 

Valstybė 2000 m. 2001 m. 2002 m. 2003 m. 2004 m. Vidurkis
Lietuva 210,90 208,30 222,50 214,50 210,00  
Latvija 147,90 180,20 211,30 215,00 219,00  
Estija 314,40 356,70 419,80 428,00 435,00  

 
 

Lentelės pavadinimą pradėkite rašyti nuo kairiojo lapo krašto. 
Įveskite 4.14 lentelėje  pateiktus duomenis. Jeigu lentelės stulpelio 
plotį reikia padidinti (sumažinti), tai atlikite traukdami pelę, kaip pa-
rodyta paveikslėlyje. 
 
 
 
 

4.56 pav. Stulpelio pločio keitimas pele 
 
 

Įvedus duomenis, galima atlikti analizės veiksmus. 
Vidurkį galima skaičiuoti pasitelkiant vidurkio funkciją 

=AVERAGE(B5:F5). Įterpti funkciją galima vykdant komandą 
Insert→Function ir iš sąrašo pasirenkant reikiamą funkciją. 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.57 pav. Aritmetinio vidurkio skaičiavimas pagal formulę 
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Kaip vaizduoti duomenis dvimate stulpeline diagrama? 
Lentelėje pažymėkite duomenis, kuriuos norite vaizduoti dvi-

mate stulpeline diagrama (pvz., 4.60 pav. pavaizduoti trijų Baltijos 
valstybių 2000–2004 m. laikotarpio duomenys) ir iškvieskite ben-
drojoje mygtukų juostoje esantį diagramų vedlį (Chart Wizard). Jis 
pateikia keletą dialogo langelių, kuriuose vartotojas paeiliui pasi-
rinkdamas pateiktus objektus ir parametrus nubraižo diagramą. 
 
 
                                                                                     Chart Wizard 
 

 
 

4.58 pav. Bendrosios paskirties priemonių juosta ir mygtukas  
Chart Wizard diagramų vedliui iškviesti 

 
 

Dialogo lange Chart Wizard – Step 1 of 4 pažymėkite dvimatės 
stulpelinės diagramos tipą. Diagramų vedliu paeiliui (Next) pasirin-
kite reikiamus parametrus ir programa automatiškai sudarys diag-
ramą. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.59 pav. Pirmasis diagramų vedlio dialogo langelis 
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4.60 pav. Dvimatė stulpelinė serijinė diagrama  
 

Kaip nubraižyti skritulinę diagramą? 
Atlikite lentelėje nurodytus žymėjimo veiksmus, t. y. pažymė-

kite valstybes ir jų nusikalstamumo vidurkius, iškvieskite diagramų 
vedlį Chart Wizard. 

Užduotį atlikite analogiškai kaip ir braižydami stulpelinę diag-
ramą, tik pirmojo veiksmo metu pasirinkite skritulinės diagramos 
tipą – Pie. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.61 pav. Dvimatė skritulinė diagrama pateikiant  
aritmetinio vidurkio duomenis procentais 
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Kaip nubraižyti linijinę diagramą? 
Lentelėje pažymėkite reikiamus duomenis, iškvieskite diag-

ramų vedlį Chart Wizard. 
Pažymėkite linijinę diagramą ir pasirinkite reikiamus paramet-

rus diagramai pateikti. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

4.62 pav. Dvimatė linijinė diagrama, vaizduojanti nusikaltimų  
dinamiką nuo 2000 iki 2004 metų 

 
Kaip vieno tipo diagramą keisti kita? 

 
 
 
 
 
 
 
 
 
 

 
4.63 pav. Diagramų priemonių juostos mygtukai 
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Darbo lange nesant diagramų keitimo priemonių (Chart), vyk-
dykite komandą View→Toolbars ir jas iškvieskite. Nukopijuokite 
vieną iš lape jau esančių diagramų, jos kopiją pažymėkite ir mygtuko 
Chart Type išplėstiniame sąraše parinkite tinkančią vaizuoti reikia-
mus duomenis diagramą. Susipažinkite su Chart juostos mygtukais. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.64 pav. Trimatė piramidinė diagrama, turinti tris ašis:  
reikšmių ašį (Z) – aukščiui, kategorijų ašį (X) – pločiui ir  

sekų ašį (Y) – storiui (gyliui) vaizduoti 
 
 
 

Kontroliniai klausimai 
 

1. Kokius žinote diagramų sudarymo būdus? 
2. Kaip nustatomos žymių reikšmės linijinėje diagramoje? 
3. Kaip parinkti parametrus, kad skritulinėje diagramoje būtų vaiz-

duojami procentai? 
4. Kaip vieno tipo diagramą pakeisti kita? 
5. Kaip suteikti duomenų vaizdams diagramoje (stulpeliams, skritulio 

skiltims, linijoms) kitas spalvas, raštus. 
6. Kaip įrašyti diagramos ir ašių pavadinimus? 
7. Diagramos teksto redagavimo priemonės ir būdai. 
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4.12.3. Pajamų planavimas ir analizė 
 

1. Darbo tikslas 
 
Susipažinti su funkcijų taikymo pagrindais planuojant bei ver-

tinant pajamas. 
 
2. Darbo užduotys 
 
1. Iškvieskite Microsoft Excel programą. Susipažinkite su skai-
čiuoklės Excel funkcijomis. Išmokite iškviesti metodiniuose 
nurodymuose pateiktas funkcijas, išsiaiškinkite jų paskirtį. 

2. Parinkite A4 formato popieriaus lapo matmenis (210x297 
mm). 

Parinkite sudaromos lentelės paraščių matmenis, pavyzdžiui, 
kairiosios – 1,9 cm, dešiniosios – 0,9 cm, viršutinės – 1,5 cm, apati-
nės – 1,5 cm. 

3. Sudarykite darbo lapą planuojamoms I, II ir III ketvirčių 
biudžeto pajamoms apskaičiuoti. 

I ketvirčio pajamos pateiktos 4.15 lentelėje. Kitų ketvirčių pla-
nuojamas pajamas skaičiuokite remdamiesi I ketvirčio duomenimis. 

II ketvirčio planuojamas pajamas apskaičiuokite pagal toliau 
pateiktas sąlygas. Įvertinkite I ketvirčio biudžeto pajamų dydį. 
Jeigu jos yra mažesnės negu 600000 tūkst. Lt, skaičiuodami II 
ketvirčio pajamas jas padidinkite 3 proc. Jeigu I ketvirčio pajamos 
šios sąlygos netenkina (t. y. jos yra didesnės arba lygios 600000 
tūkst.), skaičiuodami II ketvirčio pajamas joms suteikite tokią pa-
čią reikšmę kaip ir I ketvirtyje, t. y. jų nekeiskite. 

Skaičiavimams atlikti naudokite loginę funkciją IF. 
Planuojamas III ketvirčio pajamas apskaičiuokite pagal šias 

sąlygas. Skaičiuodami III ketvirčio pajamas, įvertinkite I ketvirčio 
biudžeto pajamų dydį. Jeigu jos viršija 1000000 tūkst. Lt, skaičiuo-
dami III ketvirčio pajamas jas padidinkite 3 proc., sumas, kurios vir-
šija 600000 tūkst. Lt ir yra mažesnės arba lygios 1000000 tūkst. Lt, 
padidinkite 2 proc., sumas, mažesnes arba lygias 600000 tūkst. Lt, 
padidinkite 1 proc. 

Skaičiavimams atlikti naudokite dviejų lygmenų loginę funk-
ciją IF. 
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4. Pajamų vidurkį suskaičiuokite pasitelkdami funkciją AVE-
RAGE, „iš viso“ – naudodami funkciją SUM. Naudodami 
MAX ir MIN funkcijas pateikite maksimalias ir minimalias 
pajamas. 

5. Pateikite minimalias ir maksimalias sumas, ties sumomis 
įterpkite jas aiškinantį komentarą. 

6. Lentelę apipavidalinkite: parinkite rėmelius, antraštei sutei-
kite tamsesnį foną. 

7. Failą įrašykite į diską, suteikite failui pavadinimą, kuris at-
spindėtų jame saugomos informacijos prasmę, pavyzdžiui, 
pajamos.xls. 

 
4.15 lentelė. Duomenys apie planuojamas biudžeto pajamas 
 

B i u d ž e t o  p a j a m o s  ( tūkst. Lt) 

Pajamų rūšys I  
ketvirtis 

II 
ketvirtis 

III 
ketvirtis 

Vidur-
kis 

Fizinių asmenų pajamų mokestis 782696    
Juridinių asmenų pelno mokestis 289183    
Pridėtinės vertės mokestis 1266293    
Akcizai 498025    
Tarptautinės prekybos ir 
sandėrių mokesčiai 

251647    

Kitos mokestinės pajamos 205300    
Nemokestinės pajamos 106459    
Iš viso     
Minimalios pajamos     
Maksimalios pajamos     
 

3. Metodiniai nurodymai 
 
Kaip parinkti darbo lapo paraščių matmenis ir lapo dydį? 
Vykdykite komandą File→Page Setup. Skyrelyje Page pa-

rinkite lapo dydį – A4, vertikalią lapo padėtį – Portrait. Paraščių 
skyrelyje Margins nustatykite paraštes. Patikrinkite, ar parinkote no-
rimus puslapio parametrus. Pagrindiniame Excel lange mastelį suma-
žinkite iki 25 proc., aktyviame lape matysite puslapių ribas, tada 
mastelį vėl padidinkite iki 100 proc. Darbo lango dešinėje bus matyti 
punktyrinė linija – jūsų lapo dešinioji riba. 
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4.65 pav. Komandos File→PageSetup dialogo langas  
lapo dydžiui ir padėčiai parinkti 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4.66 pav. Komandos File→Page Setup dialogo  

langas paraštėms parinkti 
 

Kaip duomenis taisyklingai įvesti į lentelę? 
Į lentelę įveskite reikiamus duomenis. Jeigu lentelės stulpelio 

plotį reikia padidinti (sumažinti), tai atlikite. 
Lentelės pavadinimą pradėkite rašyti nuo kairiojo lapo krašto, 

ląstelėje A1. Bendras lentelės vaizdas matyti toliau esančiame Excel 
lange (4.68 pav.). Spausdami kairįjį pelės klavišą pažymėkite ląstelę, 
į kurią įvesite duomenis, ir juos įveskite. Įvesdami duomenis į lentelę 
iš vienos ląstelės į kitą judėkite rodyklėmis (klaviatūros) arba pele. 
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Funkcijų taikymas sudarant formules 
Funkcijos taikomos įvairiems skaičiavimams palengvinti, jas 

galima derinti tarpusavyje bei naudoti sudėtingesnėms formulėms 
sudaryti. Kiekviena funkcija turi savo sintaksę. Tinkamai įrašius ar-
gumentus, funkcija apskaičiuoja rezultatą ir įrašo jį į ląstelę, kurioje 
ji yra sudaroma. 

Funkcijų grupės yra tokios: 
 Visos funkcijos (All); 
 Finansinės (Financial); 
 Datos ir laiko (Date&Time); 
 Matematinės ir trigonometrinės (Math&Trig); 
 Statistinės (Statistical); 
 Paieškos, nuorodų (Lookup&Reference); 
 Duomenų bazės (Database); 
 Tekstinės (Text); 
 Loginės (Logical); 
 Informacinės (Information). 

 
 
 
 
 
 
 
 
 
 
 
 
 

4.67 pav. Paste Function dialogo langas  
 

Funkcijos gali būti įterpiamos į formulę įvedimo eilutėje įra-
šant jų pavadinimą ir skliaustuose nurodant argumentų sąrašą arba 
iškviečiamos automatiškai vykdant komandą Insert→Function. 

Atsivėrusiame lange Paste Function galima pasirinkti funkci-
jos tipą (Function category) ir nurodyti funkcijos pavadinimą (Func-
tion name). 
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Dažniausiai naudojamos funkcijos 
 
Sumavimo funkcija 
SUM(skaičius1;skaičius2;…) susumuoja skaičius. Norint suda-

ryti funkciją galima naudoti iki trijų dešimčių argumentų. 
Vidurkio skaičiavimo funkcija 
AVERAGE(skaičius1;skaičius2;…) apskaičiuoja skaičių arba 

ląstelių adresuose esančių skaičių aritmetinį vidurkį. Šiai funkcijai 
sudaryti galima naudoti iki trijų dešimčių argumentų.  

Minimalios reikšmės išrinkimo statistinė funkcija 
MIN(skaičius1;skaičius2;…) funkcija išrenka mažiausią skait-

meninių duomenų reikšmę. Šiai funkcijai sudaryti galima naudoti iki 
trijų dešimčių argumentų. 

Maksimalios reikšmės išrinkimo statistinė funkcija 
MAX(skaičius1;skaičius2;…) funkcija išrenka didžiausią skait-

meninių duomenų reikšmę. Šiai funkcijai sudaryti galima naudoti iki 
trijų dešimčių argumentų. 

Sąlygų nustatymo loginė funkcija 
Jos reikšmė priklauso nuo loginės sąlygos pateikimo. 
Funkcija IF(sąlyga;reikšmė_jeigu_sąlyga_tenkinama;reikšmė_ 

jeigu_sąlyga_netenkinama) apskaičiuoja reikšmę, priklausančią nuo 
loginės sąlygos. 

Atliekant šią funkciją patikrinama sąlyga (logical test) ir, jei 
jos reikšmė yra TRUE, funkcija įgyja tenkinamos sąlygos reikšmę 
(value of true). Jei jos reikšmė yra FALSE, funkcija įgyja netenkina-
mos sąlygos reikšmę (value if false). Sąlygą nusakantis loginis reiš-
kinys sudaromas iš ląstelių koordinačių, kintamųjų pavadinimų ar 
konstantų ir šių santykio operacijų:  

>    daugiau; <    mažiau; 
>=  daugiau arba lygu; <= mažiau  arba lygu. 
<>  nelygu;  
Konstruojant sudėtingus loginius reiškinius IF funkciją galima 

įterpti į argumentus iki septynių kartų, tačiau formulė negali turėti 
daugiau kaip 1024 simbolius. 

 
Kaip taikyti funkciją IF skaičiuojant biudžeto pajamas? 
Sudarysime IF funkciją II ketvirčio pajamoms pateikti. Ji turės 

patikrinti sąlygą nustatydama, ar I ketvirčio biudžeto pajamos ma-
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žesnės negu 600000 tūkst. Tada II ketvirtyje jas didinsime 3 proc., 
priešingu atveju jos liks tokios pačios kaip ir I ketvirtyje.  

II ketvirčio pajamoms pateikti pagal anksčiau nurodytas sąly-
gas ląstelėje C3 sudaroma formulė  

=IF(B3<600000; B3+B3∗3%; B3). 
Įvestą formulę kopijuojame taip: gauname II ketvirčio planuo-

jamas pajamas pagal pateiktas šios užduoties sąlygas. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.68 pav. II ketvirčio planuojamų pajamų skaičiavimas  
naudojant IF funkciją 

 
 

Sudarant formulę III ketvirčio pajamoms skaičiuoti IF funkcija 
įterpiama į argumentą, nes sąlyga yra sudėtingesnė. 

III ketvirčio rezultatams gauti ląstelėje D3 sudaroma formulė  

=IF(B3>1000000;B3+B3*3%;IF(B3>600000;B3+B3*2%;B3+B3*1%))  

arba, užrašant trumpiau, 

=IF(B3>1000000;B3*1,03;IF(B3>600000;B3*1,02;B3*1,01)) 

Nukopijavę įvestąją formulę gauname III ketvirčio visų pla-
nuojamų rūšių pajamas. 

Įveskite funkciją, 
suskaičiuokite rezultatą ir 
kopijuokite funkciją lentelėje. 
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Kaip apskaičiuoti ketvirčių duomenų sumas? 
Eilutėje Iš viso išskirkite vietą rezultatui – ląstelę B10 ir 

spauskite mygtuką AutoSum       – sumuojami duomenys taps akty-
vūs (jeigu aktyvūs duomenys jūsų netenkina, galite pažymėti juos 
pele). 

 
Kaip įterpti komentarą? 
Pasirinkite ląstelę, į kurią norite įterpti komentarą, ir vykdykite 

komandą Insert→Comment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

4.69 pav. Ląstelės komentaro pavyzdys 
 

 
Norint, kad komentarai būtų matyi tik ląstelei esant aktyviai, 

reikia vykdyti komandą Tools→Options→View ir įjungti Comment 
Indicator Only. 

 
Kaip suvienodinti skaitmenų skaičių po kablelio? 
Skaitmenų skaičių po kablelio galima suvienodinti pažymint 

ląsteles, kuriose tai reikia atlikti, ir spaudžiant formatavimo (For-
matting) įrankių juostos mygtukus, kurių vienas mažina, o kitas di-
dina ženklų skaičių po kablelio (4.70 pav.). 
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                                            mažina skaitmenų skaičių po kablelio (apvalina) 
 
 
 
                                                        didina ženklų skaičių po kablelio 
 

4.70 pav. Formatavimo priemonių juosta 
 
 

Kaip apipavidalinti lentelę? 
Lentelei apipavidalinti naudokite formatavimo priemonių 

juostos mygtukus. Norėdami įrėmint lentelę pažymėkite ją ir iš 
mygtuko Borders išplėstinio sąrašo parinkite patinkantį rėmelio va-
riantą. 

Foną suteiksite pažymėdami lentelės antraštę ir mygtuko Fill 
Color išplėstiname sąraše parinkdami spalvą. 

Pažymėkite tekste atskiras ląsteles, pakeiskite jose šrifto 
spalvą.  Šrifto spalvą parinkite mygtuko Font Color išplėstiname są-
raše. Pažymėkite ląsteles, kurias norite sujungti, pavyzdžiui, rašy-
dami pavadinimą (A1:D1) Biudžeto pajamos ir paspauskite mygtuką 
Merge and Center. 

Įvairesnių rėmelio variantų galima atrasti vykdant komandą 
Format→Cells→Border. Tuomet komandos dialogo lange galima iš-
sirinkti rėmelio linijos pavidalą bei spalvą, įrėminimo būdą. 

 
 
Kontroliniai klausimai 
 

1. Kuo skiriasi formulė ir funkcija Microsoft Excel programoje. 
2. Ar galima funkciją panaudoti formulėje kaip formulės sudedamąją 

dalį? 
3. Kada patogu naudoti sumavimo funkciją? Kiek argumentų gali tu-

rėti sumavimo funkcija? 
4. Paaiškinkite vidurkio skaičiavimo funkciją. Kada patogu naudoti 

vidurkio funkciją? 
5. Ar funkcijos argumentu gali būti kita funkcija? 
6. Paaiškinkite loginę funkciją IF. 
7. Ar į loginės funkcijos IF argumentus gali būti įterpta kita IF funk-

cija? 
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4.12.4. Atlyginimų apskaitos darbo lapo  
            sudarymas 
 

1. Darbo tikslai 
 
Išmokti darbo lape sudaryti sąrašo tipo duomenų struktūras, 

atlikti skaičiavimus, pasitelkiant skaičiuoklės MS Excel formules ir 
funkcijas. 

Susipažinti su darbo užmokesčio apskaitos algoritmu [26]. 
 
Dalykinis žaidimas 
 
Reikės apskaičiuoti darbuotojams išmokamus atlyginimus. 

Darbuotojai priimti dirbti dviem būdais: pagal etatą ir valandininkai. 
Etatiniai darbuotojai dirba užimdami tam tikrą etatą, už kurį moka-
mas nustatytas pastovus mėnesinis atlyginimas. Valandininkams 
mokamas atlyginimas už idirbtas darbo valandas ir viršvalandžius. 
Už viršvalandžius darbuotojui mokama dvigubai. 

Taigi darbuotojų atlyginimai gali būti apskaičiuojami dviem 
būdais: 

1) Etatinių darbuotojų – pagal mėnesio tarifo atlygį; 
2) Valandininkų – už dirbtą laiką ir viršvalandžius pagal 

valandos tarifo atlygį. 
Šio darbo užduotis – priimti į grupę 6 darbuotojus, surinkti jų 

duomenis, apskaičiuoti atlyginimą užduotyje nurodytu laikotarpiu, 
išskaičiuojant būtinus mokesčius (pajamų, draudimo, ir kt.) pagal 
šiame praktiniame darbe pateiktą algoritmą. 

 
2. Veiksmų eiga kuriant atlyginimų  
    apskaitos darbo lapą 
 
Ši darbą bus lengviau atlikti laikantis tam tikros veiksmų atli-

kimo eigos rekomendacijų, pasitelkiant skaičiuoklės Excel priemo-
nes. 

1. Skaičiuoklės Excel pagrindiniame lange pagal 4.16 lentelėje 
pateikiamą pavyzdį sudarykite asmenų grupės darbo užmokesčio ap-
skaitos darbo lapą Sheet1. 
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Darbo lapo 1–7 eilutėse įrašykite jo paskirties antraštę, t. y. 
dalykinio žaidimo įstaigos pavadinimą, darbo lapą sudarančio as-
mens pavardę, vardą ir grupę bei kitus rekvizitus. Remdamiesi 4.16 
lentelėje pateikta struktūra suteikite laukams (stulpeliams) prasmi-
nius pavadinimus. 

Kad būtų lengviau taikyti užduotyje naudojamas formules, 
ląstelių koordinatės ir stulpeliai turėtų atitikti 4.16 lentelėje nurody-
tas koordinates. 

Rinkdami duomenis laikykitės tam tikrų reikalavimų. Įrašę 
duomenis į ląstelę paspauskite <Enter>. 

2. A1 ląstelėje nustatykite ataskaitos datą, kuri atitiks kompiu-
terio laikrodžio duomenis. Tai atliekama iškviečiant funkcijų žynį ir 
pasirenkant funkciją NOW(). 

A1 ląstelės duomenis formatuokite vykdydami komandą For-
mat Cells. Komandos Number kortelėje pažymėkite Date formatų 
grupę, o jos formatų sąraše pasirinkite reikiamą datos formatą, pa-
vyzdžiui, yy-mmmm-dd arba dd-mmmm-yy. 

3. Grupės darbuotojų sąrašą pradėkite rinkti nuo B10 ląstelės, 
įrašykite 6 asmenis. Darbuotojus surūšiuokite pagal pavardes abėcė-
lės tvarka. 

4. Darbuotojams pasirinktinai nurodykite bankų kodus ir skir-
tingą kiekvieno darbuotojo sąskaitos numerį. 

5. Nustatykite atlyginimų apskaitos mėnesį, duomenis įrašykite 
į stulpelį Mėnuo. Į A10 ląstelę įrašoma pasirinktojo mėnesio pabai-
gos data, pavyzdžiui, 04 01 31, ir pasirenkamas atitinkamas datos 
formatas – yy/mm/dd. Vienodai užpildykite visų pasirinktų darbuo-
tojų mėnesio darbo apskaitos datą, kopijuokite šiuos duomenis į 
A11:A15 ląstelių bloką. 

6. Grafoje Tarifinis atlyginimas įrašykite skirtingą darbuotojų 
atlygį (įvertinama valandininkų darbo valanda: litais už dirbtą va-
landą; etatinių darbuotojų – visas mėnesinis atlygis). Grafoje Dirbta 
valandų nurodykite valandininkų dirbtų valandų skaičių per mėnesį 
(pasirinkite 2–4 darbuotojus, kurie dirbs valandininkais). Dirbančiųjų 
pagrindiniu etatu dirbtų valandų skaičius nenurodomas. 

7. Tarpinius duomenis išsaugokite kietajame diske ir diskelyje 
(diskelį būtinai patikrinkite antivirusinėmis programomis). Šių duo-
menų reikės tolimesniems praktiniams darbams atlikti. 
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8. Įkelkite failą ir pratęskite lentelę įrašydami stulpelių pavadi-
nimus, kaip pavaizduota 4.16 lentelėje. 

9. Naudodamiesi skaičiuoklės Excel programos funkcijomis, 
duomenų formatais ir formulėmis, pagal šio darbo 3 skyriuje pateiktą 
algoritmą sudarykite grupės darbo užmokesčio apskaitos darbo lapą. 

Pagal pateiktąjį algoritmą grafoje Apskaičiuota suma įrašykite 
kiekvieno darbuotojo nurodytojo mėnesio darbo užmokestį (4.17 
lentelė). Apskaičiuokite bendrą visų darbuotojų atlyginimą, sumą 
įrašykite į atitinkamą eilutės Iš viso per mėnesį ląstelę. 

10. Išsaugokite duomenis File Save komanda. Išanalizuokite 
gautus duomenis. 
 
4.16 lentelė. Pradiniai darbo užmokesčio apskaitos lapo duomenys 

 
=NOW( ) 
Format->Cells, Number, Date, dd-mmm-yy 
 
          

 
 A  B       C     D      E        F                G 

1  

17-Kov-04 ĮSTAIGOS 
PAVADINIMAS

  

2  GRUPËS UÞMOKESÈIO APSKAITA   
3      
4  Ataskaitos autorius: V. Pavardė (grupė)   
5      
6      
7     
8 Mėnuo Pavardė Banko 

kodas
Sąs-
kaita 

Dirbta 
valandų 

Viršva-
landžiai 

Tarifinis 
atlyginimas 

9    
10 04 01 31 Aušraitė Dalia 6761 12149 1640 60 8,00 Lt 
11 04 01 31 Augutis Kazys 6761 89321 1560 20 5,00 Lt 
12 04 01 31 Babraitienė Jovilė 8938 10100 500,00 Lt 
13 04 01 31 Jonaitis Petras 6763 98700 1640 40 4,00 Lt 
14 04 01 31 Petraitis Giedrius 6763 35333 1640 21,56 Lt 
15 04 01 31 Ramanauskas Jonas 6761 90154 180,00 Lt 
16  Iš viso per mėnesį    
17  % nuo apskaičiuotos sumos   

 
 

04/01/31 
Format->Cells, Number, Date, dd mm yy 

 
 
 
 

 

A1 ląstelėje nurodant 
einamają datą taikoma 
funkcija NOW( )

A10 ląstelei suteikiamas 
datos formatas ir įrašoma 
data

Kopijuojant duomenis į A11:A15 
bloką, užpildomi visi darbuotojų  
mėnesio darbo apskaitos duomenys 

Valandininkai 

Etatiniai 
darbuotojai 
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4.17 lentelė. Mokesčių skaičiavimo duomenys 
 
 H I J K L M N 

1 MGL  Lengvata Neapmok
Suma 

MGL 
dalis 

Apmok. 
suma 

Mokestis 

2 200,00 Lt  1 lengvata 110,00 Lt 1,2 120,00 Lt 21,60 Lt

3   2 lengvata 100,00 Lt 1,8 180,00 Lt 33,60 Lt
4   3 lengvata 90,00 Lt 2,8 280,00 Lt 57,60 Lt
5   Be lengvatų 80,00 Lt 3,8 380,00 Lt 85,60 Lt

6       
7       
8 Apskaičiuota 

suma 
Leng-
vata 

Neapmok. 
suma 

Pajamų 
mokestis 

Draudi-
mas 

Kiti ats-
kaitymai 

Išmokėtas 
atlygi-
nimas 

9       
10       
11       
12       
13       
14       
15       
16       
17       

 
 
 
 
 

=1,1*$H$2 
=1*$H$2 
=0,9*$H$2 
=0,8*$H$2 

=IF(E10>0;E10*G10+2*F10*G10;G10) 

=SUM(H10:H15) 

=L2*$H$2 

=M2*18% 
=N2+(M3-M2)*20% 
=N3+(M4-M3)*24% 
=N4+(M5-M4)*28% 

 

 
3. Atlyginimo apskaitos algoritmo  
    aprašymas 
 
1. Nors E, F, G stulpelių duomenis galima parinkti laisvai, re-

komenduojama laikytis tokių taisyklių: 
 Trečdalis visų darbuotojų yra valandininkai, dalis iš jų dirba 
viršvalandžius, likusieji yra etatiniai darbuotojai; 

 Valandininkų darbo valandos apskaičiuojamos taip:  
  h = 8*n, čia n – mėnesio dienų skaičius; 

 Etatinių darbuotojų valandų skaičiaus nurodyti nereikia; 
 Tarifinis valandininkų atlygis a gali būti skirtingas, atsi-
žvelgiant į darbo pobūdį, ir įvairuoti nuo 4,00 Lt iki 150,00 
Lt už 1 darbo valandą. Už viršvalandžius v mokama dvi-
gubai. Šiame stulpelyje nurodomas etatinių darbuotojų mė-
nesinis atlyginimas. Šiuos tarifinius atlygius galima nu-
rodyti priderinant prie konkretaus laikotarpio atlyginimų 
dydžio. 
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2. Grafos Apskaičiuota suma duomenys formulėje bus žymimi 
S ir apskaičiuojami pagal formulę: 
 
            h*a+2*v*a,    jei h>0    (valandininkų); 
            a,                    jei h=0    (etatinių darbuotojų),     (3.1) 
 
čia h – dirbta valandų (stulpelis E); v – viršvalandžiai (stulpelis G); a 
– tarifinis atlygis (stulpelis F). 

Darbo lape surinkite darbo užmokesčio apskaitos formulę ir 
apskaičiuokite visų darbuotojų pirmojo mėnesio užmokestį. Šiuos 
duomenis surašykite į stulpelį Apskaičiuota suma. Norėdami surinkti 
šią formulę reikiamoje vietoje, pažymėkite ląstelę H10. Iškvietę 
funkcijų žynį (fx), parinkite norimą funkciją, t. y. šiuo atveju rei-
kalinga sąlygą įvertinanti funkcija IF (…). 

Funkcijos IF(…) sintaksė: 
 

=IF (sąlyga;reikšmės_apskaičiavimo_formulė_jei_sąlyga_tenkinama;reikšmė_jei_sąlyga_netenkinama) 
 
=IF(E10>0;E10*G10+2*F10*G10;G10).             (3. 2)  
 
3. Excel programa reikia automatiškai apskaičiuoti kiekvienam 

darbuotojui skirtą sumą. Prisiminkite, kaip kopijuoti formulę į stul-
pelį ir eilutę. Pažymėkite bloką H10:H15 (H10 ląstelėje turi būti su-
rinkta 3.2 formulė). Nurodykite Edit Fill, Down komandą (taip 
formulė nukopijuojama ir perkeliama į stulpelį, apskaičiuojamus 
duomenis perduodant ir keičiant santykinėmis koordinatėmis pagal 
poslinkį). 

4. Nustatykite bendrą visiems darbuotojams skirtą sumą. 
Tuo tikslu pažymėkite H16 ląstelę ir surinkite formulę naudo-

dami funkciją SUM(skaičius1;skaičius2;…), t. y. =SUM(H10:H15). 
5. Išsaugokite duomenis. Jei yra galimybių, dalinę ataskaitą iš-

spausdinkite. 
 
Pajamų mokesčio apskaitos algoritmas 
Pajamų mokesčio apskaitos algoritmas grindžiamas vienu pa-

grindiniu dydžiu – MGL (minimaliu gyvenimo lygiu), kuris įvertina-
mas litais ir apskaičiuojamas pagal ekonominę šalies būklę ir kinta 
atsižvelgiant į lito infliaciją bei kitas priežastis. 

S=
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Pajamų mokestis apskaičiuojamas remiantis Lietuvos Respub-
likos pajamų mokesčio apskaičiavimo įstatymu. Pateiksime ištraukas 
iš pajamų mokesčio apskaičiavimo įstatymo. 

„5 straipsnis. Pagrindinėje darbovietėje gaunamų pajamų, su-
sijusių su darbo santykiais, neapmokestinamas minimumas yra: 

1. I grupės invalidams – 1,1 MGL (minimalaus gyvenimo ly-
gio, nustatomo pagal Lietuvos Respublikos gyventojų pa-
jamų garantijų įstatymą) pajamos (t. y. 1 lengvata); 

2. II grupės invalidams – 1 MGL pajamos (t. y. 2 lengvata); 
3. III grupės invalidams – 0,9 MGL pajamos (t. y. 3 lengvata); 
4. Kitiems šio straipsnio 1–3 punktuose nepaminėtiems asme-

nims – 0,8 MGL pajamos (t. y. be lengvatų)“. 
„1 priedas. Pajamų mokesčio tarifai, pagal kuriuos apskai-

čiuojamas mokestis nuo pagrindinėje darbovietėje per mėnesį gautų 
su darbo santykiais susijusių apmokestinamųjų pajamų: 

1. Apmokestinamųjų pajamų daliai iki 1,2 MGL imtinai taiko-
mas 18 proc. tarifas. 

2. Apmokestinamųjų pajamų daliai, viršijusiai 1,2 MGL, bet ne 
didesnei kaip 1,8 MGL, taikomas 20 proc. tarifas. 

3. Apmokestinamųjų pajamų daliai, viršijusiai 1,8 MGL, bet ne 
didesnei kaip 2,8 MGL, taikomas 24 proc. tarifas. 

4. Apmokestinamųjų pajamų daliai, viršijusiai 2,8 MGL, bet ne 
didesnei kaip 3,8 MGL, taikomas 28 proc. tarifas. 

5. Apmokestinamųjų pajamų daliai, viršijusiai 3,8 MGL, taiko-
mas 33 proc. tarifas“. 

Pradedant mokesčių apskaitą mokesčių išskaičiavimo duome-
nys turi būti jau nustatyti (žr. 4.17 lentelę) taikant atitinkamas for-
mules ir įrašyti konkrečiuose stulpeliuose J, K, L, M, N. Nustatoma 
tokia laukų struktūra: Lengvata; Neapmokestinama suma; MGL da-
lis; Apmokestinama suma; Mokestis. 

Minimalus gyvenimo lygis – MGL įrašomas į H2 ląstelę ir yra 
lygus, pavyzdžiui, 200,00 Lt. 

J2:N5 bloko informacija gaunama pagal formules užpildant 
atitinkamus stulpelių elementus. 

M stulpelis užpildomas į M2 ląstelę įrašant formulę =L2*$H$2 
ir automatiškai užpildant stulpelį M2:M5; jis pažymimas ir nuro-
doma Edit Fill, Down komandų grupė. 
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4.12.5. Pajamų mokesčio apskaita skaičiuojant  
            atlyginimą 
 

1. Darbo tikslai 
 
Išmokti sudaryti darbo lapą, jame atlikti sudėtingesnius pajamų 

mokesčių skaičiavimus, naudojant skaičiuoklės Excel formules, 
funkcijas, duomenų formatus, grupių sumas. 

Susipažinti su darbo užmokesčio apskaitos, pajamų mokesčio 
dydžio skaičiavimo algoritmu, nustatant pasirinktos darbuotojų gru-
pės atlyginimus [26]. Sudaryti grupės darbo užmokesčio apskaitos 
darbo lapą, pagal kurį skaičiuojamos visos atskaitomos sumos ir iš-
mokamas atlyginimas. 

 
 
2. Darbo užduotys 
 
Dalykinis žaidimas 
1. Šio žaidimo metu naudosimės anksčiau pradėto kurti užmo-

kesčio apskaitos darbo lapo duomenimis: t. y. darbuotojų sąrašu, 
dirbtų valandų, tarifinio atlygio ir apskaičiuoto atlyginimo duomeni-
mis. Jeigu šie duomenys saugomi diskelyje, būtinai jį patikrinkite 
antivirusinėmis programomis. 

Reikės sudaryti formules pajamų mokesčiui apskaičiuoti atsi-
žvelgiant į kai kuriems darbuotojams suteiktas lengvatas, nustatyti 
neapmokestinamų sumų dydį, apskaičiuoti darbuotojų pajamų mo-
kestį, atskaitomą draudimo, kitų atskaitymų dydį ir apskaičiuoti iš-
mokamą sumą. 

2. Atverkite darbo užmokesčio apskaitos lapą, sukurtą ir išsau-
gotą ankstesniųjų pratybų metu. Šią darbo lapo dalį turi sudaryti jau 
užpildyti duomenimis stulpeliai: pažymėtas mėnuo, už kurį atsiskai-
toma, darbuotojų sąrašas (pvz., šeši darbuotojai), t. y. užpildyti lau-
kai: Pavardė, Banko kodas, Sąskaitos numeris, Dirbta valandų, Virš-
valandžių skaičius (valandininkų) ir jų darbo valandos tarifų įkainiai, 
arba etatinių darbuotojų viso tarifo atlyginimas. Apskaičiuota suma 
nustatoma pagal 3.1 formulę iš 4.12.4 praktinio darbo. 
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3. Pratęskite darbo lapą, užpildydami duomenimis laukus (t. y. 
stulpelių I8:N8 pavadinimus ir duomenis), kaip parodyta 4.18 lente-
lėje. 

Prieš rinkdami duomenis ir formules blokus, kurių duomenys 
bus išreiškiami piniginiais vienetais, suformatuokite, t. y. suteikite 
H10:H16, J10:N17 valiutos formatą – vykdykite Format Cells, 
Numbers, Currency komandas ir pasirinkite tinkamą valiutos išraiš-
ką. 

4. Pasirinkite darbuotojus, kuriems bus taikomos 1, 2 ir 3 
mokesčių atskaitymo lengvatos. Lauke Lengvata nurodykite skaičius 
1, 2, 3, t. y. lengvatų, kurios taikomos trims pasirinktiesiems jūsų su-
darytos darbo grupės darbuotojams, tipus (dydis l). 

5. Atitinkamai nustatykite neapmokestinamos sumos dydį, ne-
apmokestinamą sumą N, priklausančią nuo lengvatos tipo l, apskai-
čiuodami pagal tokią formulę: 
 
                                N1, kai l=1; 
                   N=        N2, kai l=2                             (2.2) 
                                N3, kai l=3; 
                                N4, kai lengvata netaikoma. 
 
 

Dydžius N1,…,N4 perrašykite iš praėjusiame darbe apskai-
čiuotos neapmokestinamos sumos, kuri buvo nustatoma pagal MGL 
dydį, atsižvelgiant į kiekvieną lengvatos tipą. Šių skaičiavimų duo-
menys įrašyti į K2:K5 (žr. 4.16.lentelę). 

Norėdami apskaičiuoti neapmokestinamos sumos dydį, ląste-
lėje J10 surenkame formulę, taikydami sąlygos įvertinimo funkciją 
IF( ): 

 
=IF(I10=1;$K$2;IF(I10=2;$K$3;IF(I10=3;$K$4;$K$5))). 

 
 

Ją kopijuojame į J10:J15 bloką, taikydami Edit Fill Down 
komandą, kuri perskaičiuos formulę pagal santykines ir absoliučias 
ląstelių koordinates. 

Atkreipkite dėmesį, kaip automatiškai užsipildė šis blokas. Jei 
pastebite nukrypimų, dar kartą patikrinkite, ar teisingai surinkote 
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formulę ir ar teisingai atlikote visas automatinio užpildymo koman-
das. 

6. Apskaičiuokite darbuotojų pajamų mokestį (dydis P) pagal 
tokią formulę: 
 
                          M4+(S-N-R4)*33%,    kai  (S-N)>R4; 
                          M3+(S-N-R3)*28%,   kai  R4>=(S-N)>R3; 
         P =          M2+(S-N-R2)*24%,   kai  R3>=(S-N)>R2; 
                         M1+(S-N-R1)*20%,   kai  R2>=(S-N)>R1; 
                         (S-N)*18%,                kai  R1>=(S-N)>0; 
                           0,                              kai (S-N)<=0.            (2.3) 
 
 
čia: P – pajamų mokestis, S – apskaičiuota suma, N – neapmokesti-
nama suma; 

R1, R2, R3, R4 – ribinės apmokestinamosios sumos, kai at-
skaitymų procentai skirtingi (šie dydžiai turi būti apskaičiuoti ląste-
lėse M2:M5); 

M1, M2, M3, M4 – ribinių apmokestinamųjų sumų pajamų 
mokesčiai (šie dydžiai apskaičiuoti ląstelėse N2:N5 pagal praėjusio 
praktinio darbo duomenis, žr. 4.17 lentelę). 

Tuo tikslu, darbo lape pažymėkite ląstelę K10 ir surinkite joje 
pajamų mokesčio apskaitos formulę (žr. 4.18. lentelę): 
 

=IF(H10-J10>$M$5;$N$5+(H10-J10-$M$5)*33%; 
IF(H10-J10>$M$4;$N$4+(H10-J10-$M$4)*28%; 
IF(H10-J10>$M$3;$N$3+(H10-J10-$M$3)*24%; 
IF(H10-J10>$M$2;$N$2+(H10-J10-$M$2)*20%; 
IF(H10-J10>0;(H10-J10)*18%;0))))). 

 
 

Kadangi daugelis formulės dalių kartojasi, tam tikras formulės 
dalis kopijuokite pasitelkdami Edit Copy, Paste komandas. For-
mulę dar kartą atidžiai patikrinkite. 

Šią formulę automatiškai kopijuokite į K10:K15 ląstelių bloką, 
šį bloką pažymėkite ir vykdykite Edit  Fill, Down komandą – bus 
perskaičiuotos santykinės koordinatės.  
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7. Apskaičiuokite atskaitomą draudimo dydį D, kai draudimo 
procentas lygus 7.1. Ląstelėje L10 surinkite formulę, skirtą pirmojo 
darbuotojo draudimo įmokai apskaičiuoti: 

 
=H10*7,1%.  
 
Vykdydami Edit Fill, Down komandą, automatiškai kopijuo-

kite formulę į L10:L15 bloką. Taip bus perskaičiuotos santykinės 
koordinatės ir gauti visų darbuotojų draudimo įmokų rezultatai. 

8. Stulpelyje Kiti atskaitymai surinkite pasirinktinai dviejų arba 
trijų darbuotojų atskaitymų sumas, nustatytas, pavyzdžiui, esant ko-
kiems nors įsiskolinimams. Kiti atskaitymai (žymimas dydis K) –tai 
iš atlyginimo išskaičiuojamos baudos, alimentai ir pan. Atskaitomas 
sumas pasirinktinai užpildykite stulpelyje M10:M15, nurodydami 
konkrečius dydžius valiuta (pvz., litais). 

9. Apskaičiuokite išmokamą atlyginimą, t. y. dydį A, skaičiuo-
jamą pagal formulę: 

 
A= S – P – D – K, 
 

čia S – apskaičiuota suma (šie duomenys pateikti stulpelyje 
H10:H15); 

P – pajamų mokestis (šie duomenys pateikti stulpelyje 
K10:K15); 

D – draudimas (šie duomenys pateikti stulpelyje L10:L15); 
K – kiti atskaitymai (šie duomenys pateikti stulpelyje M10: 

M15). 
 
Norėdami apskaičiuoti pirmojo darbuotojo atlyginimą, ląstelėje 

N10 surinkite formulę: 
 

=H10-SUM(K10:M10) 
 

ir automatiškai užpildykite bloką N10:N15. 
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4.18 lentelė. Pajamų mokesčio apskaita 
 
 

 
Pajamų mokestis: =IF(H10-J10>$M$5;$N$5+(H10-J10-$M$5)*33%; 

  IF(H10-J10>$M$4;$N$4+(H10-J10-$M$4)*28%; 
  IF(H10-J10>$M$3;$N$3+(H10-J10-$M$3)*24%; 
  IF(H10-J10>$M$2;$N$2+(H10-J10-$M$2)*20%; 

    IF(H10-J10>0;(H10-J10)*18%;0))))) 
Neapmokestinama suma: 

=IF(I10=1;$K$2;IF(I10=2;$K$3;     Išmokėtas atlyginimas: 
   IF(I10=3;$K$4;$K$5)))          

         =H10-SUM(K10:M10) 
          Draudimas: 
  

         =H10*7,1% 
            
 G H I J K L M N 

1  MGL  Lengvata Neapmok
Suma 

MGL 
dalis 

Apmok. 
suma 

Mokestis 

2 200,00 Lt  1 lengvata 110,00 Lt 1,2 120,00 Lt 21,60 Lt 

3  2 lengvata 100,00 Lt 1,8 180,00 Lt 33,60 Lt 
4  3 lengvata 90,00 Lt 2,8 280,00 Lt 57,60 Lt 

5  Be lengvatų 80,00 Lt 3,8 380,00 Lt 85,60 Lt 

6      
7      
8 Tarifinis 

atlyginimas 
Apskaičiuota 
suma 

Leng-
vata 

Neapmok. 
suma 

Pajamų 
mokestis 

Draudi-
mas 

Kiti ats-
kaitymai 

Išmokėtas 
atlygi-
nimas 

9      
10      
11      
12      
13      
14      
15      
16 Iš viso per 

mėnesį 
     

17 % nuo 
apskaičiuotos 
sumos 

     

 
Apskaičiuota suma: 
    =IF(E10>0;E10*G10+2*F10*G10;G10) 
 
           
          Iš viso per mėnesį:   =SUM(H10:H15) 
 
            % nuo apskaičiuotos sumos:   =J16*100/$H16 
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10. Darbo lape apskaičiuokite darbuotojų grupės mėnesio ro-
diklius, t. y. B16 ląstelėje surinkite tekstą Iš viso per mėnesį, B17 
ląstelėje surinkite tekstą % nuo apskaičiuotos sumos. 

Apskaičiuokite stulpelių H, J, K, L, M ir N sumas. Tuo tikslu 
pažymėkite H16 ląstelę ir spustelėkite automatinės sumos mygtuką. 

Naudodami mišriąsias koordinates apskaičiuokite mokesčių 
procentus nuo apskaičiuotos sumos. Prisiminkite, kaip apskaičiuo-
jami procentai. Pažymėkite J17 ląstelę ir surinkite formulę: 

=J16*100/$H16. 
Kopijuokite formulę į J17:N17 bloką. Bloką reikia pažymėti ir 

automatiškai užpildyti vykdant Edit Fill, Right komandą. 
11. Naudodamiesi skaičiuoklės MS Excel programa sudarėte 

darbo užmokesčio apskaitos lapą. Duomenis išsaugokite. Jei yra ga-
limybių, grupės užmokesčio apskaitos duomenis išspausdinkite. 

 
 
 
Kontroliniai klausimai 
 

1. Pademonstruokite ląstelėse surinktas formules, paaiškinkite surin-
ktųjų formulių prasmę. 

2. Kaip paaiškinsite atlyginimų apskaičiavimo algoritmo atlikimą MS 
Excel programos priemonėmis? 

3. Pagal kokį principą skaičiuojamos lengvatos? 
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Vadovëlis skirtas aukštøjø mokyklø studentams, dëstytojams ir visiems besidomin-
tiems informaciniø sistemø kûrimo klausimais. Vadovëlyje pateikta teorinë medþiaga, 
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duomenø valdymo struktûromis ir informacinëmis sistemomis. Svarbu suprasti organi-
zacijø aplinkà ir susipaþinti su pagrindinëmis duomenø išraiškos priemonëmis, mode-
liais bei valdymo ypatumais, uþtikrinanèiais efektyvesnius darbo metodus. Reikšmingà 
vaidmená šiuolaikiniuose informacijos valdymo procesuose vaidina duomenø baziø 
valdymo sistemos, skaièiuokliø darbo aplinka, interneto technologijos. Jø teikiamos 
duomenø apdorojimo priemonës ágalina lengviau tvarkyti ir valdyti duomenis, juos iš-
saugoti, rûšiuoti, vykdyti paieškà, skleisti informacijà kompiuteriniuose tinkluose. Sa-
varankiški ágûdþiai, ágyti atliekant praktines uþduotis pagal šiame vadovëlyje pateiktus 
metodinius nurodymus, skatins taikyti modernias kompiuterines technologijas ir ieškoti 
naujø galimybiø susipaþinti su šiuolaikinëmis informacinëmis sistemomis. 
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